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[ O 4T PE LB AT B ¢ 215 1 (HIPAA: Health Insurance Portability and Accountability
Act)id. WebRXR—ZAD 77 V7r— av &M 4 2~V A7 78R o T R 27— F&A4E
BB BECRE T 2720 DT H DR E #5875 ] 1 T £ 9. Fortify Weblnspect ©
E. 7705 —y 2 EFFli LTy 77 V75— av A COHIPAAKR Rl (2 EOFE FE HEHL L CTus 22
VA 207 A T VAL E— MEE R T A ENTEET,

- 40 &

22— EMEF1OLL F OB o— 2> N EE SR CEE A 33T S5A TV AT
TL— ER L ET. 128218 T 7705 —y 2 TER RO 74—V FEFH LEEA ] 2
EDRAT—MAY MERIGE RN EE O BENTEET COBEM X §2a 7 54T RA%T
AT B 1—v 2> ME . IDTE 54727 DM JE £ 7R 7 +— 418 (Hidden Form Value) ("
JEI) 72 7% A MER 7L —7" X—=vA401f #h 22—Y 22 fD1D) T,

AT SAT VAT YL — MEAE R (ST T, B A CE ) F R R T A2 e
TEFT MBIV 2 N NEE"Z L 772" X—240%B N L2 08I FR Lzl <. Bk %
BHEFTRELTEES ZHMM 2R ABeEmD» 22000 MEHOI—Y = MEERL LT,
2—HHhER LB CHE B8 TEET.

Fortify WeblnspectiZid . &t OFF 8 OEAH 1cH b THREE TE 29> 7 VDar7r 547
ATV7L— Mg ENTHET,

BV —DEROFE LOWFIE OO "a 7 54 7 A7 27 L— FOVE R I D_A—3 |
EZ M LT 7 &,

Web+H A bD a7 A7V AET AT B2
1, WEOG LT, a7 5AT7 VAT 7 L— b aERR £ 3 FE L £,

2. Web#% A bz AF v LET,

3. Fortify Weblnspect® B \—(Start Page)] . [ ®*— rD4: ik (Generate a
Report)] #7 Vv /L 7.

I R— D4 1% (Generate a Report)] 7 1> KU536] & 97,
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VIV HA R
% 3: Compliance Manager (Fortify Weblnspect®d 4)

4. AF x> T —R0H DT —ARN—RIKG A ST 3354 1&. DBODZE B (Change DB)]
20Uy LT —AR—2AZRINL &7

2% vV HEIR LET (LT URL. £7IP7 FL AT 5 ).
W A(Next)] £ 7y oL £,
b>7'54 7> A(Compliance)] ZiE R L £ 4.

TRTDL A= PEIDD XA & ED 2D T % & il 7 DL R— M I O X7 K
354 id. R O&7TLR— %5 (Open Reports in Separate Tabs)] %% 4R L
9,
9. LA—MER &L T. Adobe PDF] & HTML] DWW i #iER L EJ .
R—27 W7 =L X (PDF) TOD L R — DFi AIA & 121E « Adobe Reader 7 DL & 234 %
T9,

10. 2T IATYAT YT L— bR E LET . VA MPAST 74V bDT V7L — bR § 2
s R AR 27V LTHERIE A DT> 7L — %5 8 § 2%, Compliance
Manager B W T AHARLT > 7 L— b eE T B2 ENTE LT

11. B2 T (Finished)] %2V v7L £,

12. Fortify Weblnspect23L £— b &4 1% L TX7WR IR LIz, V—u N —0 | F— hOfR
17 (Save Report)] 74 2> %7 Vy/LTZDL K— beARAF T& &7

CHHH TS LFan
"V T SAT VAT 7 L— hOER"

©® No O

AT SA T VAT 7L — FOE K
AT AT VAT T L— bEERR T B2

1. Fortify Weblnspect] A=2—/3—7., P—(Tools)]> Compliance Manager] # 7
IV & o
Compliance Manager] 7 1> N5 & L7 > 7L — FOMBE 2358 78 St &9

] Compliance Manager
File  Help
[ Mew [ Open | Sawe hd e Up Fonwve Dowen

=l Compliance Description
Mew Compliance Template

< lick here to add a new category. .. =

2. T Lwayr 547> A7 >71L— NNew Compliance Template) | £ 9 7L —RX %27y
JLET
Compliance Manager® 7 1> RUD | 73 WG 4E T VT RN S E7,
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V=)V HA N
% 3: Compliance Manager (Fortify Weblnspect® )

3. wETYZT. TH Lwar7 547 A 77 1— NNew Compliance Template) ] &9
ZL—RX % A T 27> 7 L — bOR ] (ZOF TETHIPAAL)ICE &R 2 £7.
& Compliance Manager > B

File  Help
13 Mew [ Open |l Save Miawve Up e Down

[=] Compliance Description

<Click here to add a new category... =

Compliance Description

Description:  [H1paa)|

Mewr Cornpliance Template

4. T<H LLA7 T VBN 22id 2% 27 Vv 2...>(<Click here to add a new
category...>) ] LW ITL—XE 7Yy L &£T
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V=LA AR
% 3: Compliance Manager (Fortify Weblnspect® )

5. ME T V7T H LLATTIDLAT W] NI LET. COF T ZRTIET A RT—
MR % (Password Protection) ] T+ it BT S 27— FON ) HEE D L& F 297«
w4 r 9 2(Maintain security during entry and transmission of passwords) ] T4 .

& Compliance Manager = g
File  Help
] Mewr [ Open s Save arve Up IMave Down

=] Compliance Description
HIP&A

Password Protection

<iZlick here to add a new category... =

Compliance Category

Mame: Password Protection

Maintain security during entry and transmission of passwaords.,

Description:

MNew Cornpliance Ternplate

6. 7Z7ARL 5mE 7Yy LT\ [ /27— PR # (Password Protection) | £0> 270 Dff L
fo/—FREREHLET.

7. T<¥r LOE R 2B N9 212d 2% 27 Vv 2. >(<Click here to add a new question...>) |
EWITL—X% 7Yy LET,

8. I#H L& [H(New Question)] £ 57L—X% 27Uy 7L £,

GEE TVTIZ AT HRE R SN BDT, 2N 6D X7 EMH LTl A 27— MRS | 7T 0
FAIE 5 28 B 21E § 22T & &,
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VIV AA R
% 3: Compliance Manager (Fortify Weblnspect®d 4)

9. ER(Question)] TV7iz. A7 I VCHE T2EM AN I L&T. COBITETAT
SN2 RAT— RO L F AL T ARYAR 7 EL TR R ST 3H7?(Is each character of
entered password displayed as an asterisk?) ] W YEH ] 2N JJ LT &9,

- 0

&y Compliance Manager

File  Help
[ Mew [ Open sl Save hove Up i owve Doen

=] Compliance Description
HIP&&
=l Password Protection

15 each character of entered password displayed as an asterisk?
<Zlick here ko add a new question,.. >
<iClick here to add a new category. ., =

Edit Question [ Threat Classes I Yulnerabilities [ Custamn Checks & Agents ]

Cateqgory: Password Protection w

Question: |15 each character of entered password displayed as an asterisk?

Carnrment:

[] Include Broken Links

MNew Cornpliance Template

10. COE M %#. #Z i 77 A, Micro Focus23iE 35 L2fE 95 M . /2 LLRT WCHE Rl LIz A K
AF xR T—y =y M2 e TEET. COBl Tk, e
(Vulnerabilities)] 7% 7V v LT 5. [DEN(AIdBYID)] %#2Vy2L £,

VE MM 27238 B 25 AFIRR L Thal g2y rd 2282 & -T ZDNEF M
1B B 272 % COH [ O IR L1-HE 55 i (Selected Vulnerabilities)] & 7z(4
BN L& B 75 A(Selected Threat Classes)| Dt /> sl & » 3l T& &

EE

11. D& 3Fxzy70iE iN(Add Check By ID)] 71> b7 ¢, 47241 N1 LT DK %27
Voo L &d. 4724151 ~ A /3t fz/S 27— K7 4—)1 N(Password Field Masked) ] &9

Fzy/DIDTHE 5 TTo
H:EHOIDZEMTEET(MTRKIDTDEMLET).
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V=V A K
% 3: Compliance Manager (Fortify Weblnspect®d 4)

12.

13.

14.

foE LizF zvoh BBIR LI §5 14 (Selected Vulnerabilities)] =V 7ic £ /s S £
ERS

al Compliance Manager

File  Help
[ Mew [ Open |l Save Ploece Up Pl e Divivr

=] Compliance Description
HIPAL
=l Password Protection

Is each character of entered password displayed as an asterisk?

<Click here to add & new question. .. =
<iZlick here to add & new category... =

Compliance Question

Edit GQuestion [ Threat Classe, Yulnerabilities [ Custom Checks & Agents l

AllVulnerabilities

----- [1°  MPCScftweb Information Disclosure (4603) A
----- | Webalizer webalizer conf Configuration Disclosure
----- [ webalizer Usage Page Discovery (4629)
----- | ‘WeblWiz Guestbook Database Information Disclos
----- [C]"  webwiz Mailing Information Disclosure (46353 =
----- O BadBlue Webserver ext.ini Information Disclosure
----- | FT&atePro Information Disclosure {4665)

----- []%# Hassan shopping Cart shop,pl Remate File Yiewin

----- ] iPlanet Administration Arbitrary File Source Disclos
----- [ Divine Content Server Cross-Site Scripting (4715)
----- g Password Field Masked {4724) o
. et o el .

CheckIlD Mame Pass If Detected  Exclude

4724 |Password Fisld Masked | ®m | = |

<

Dekail

MNew Corpliance Template

B LM 55 1 (Selected Vulnerabilities)] = U7 121& . IRD2DODF zy /R w7 A0 D

NE9,

o [H an135E & & ¥ (Pass If Detected)] -7 =745, 77 Ur—y s>t % 207 4
CH ST E M AR TAEEHM ELIZEDTH B EE. COATY av 4R R
LE&d. kézlE av 7547 A7 0l 5 50— Td 37 71 v(Privacy Policy.html
BEYDFAE B F 29l T DHARRLF ey 2 R T 26 & 2047y v &1 H
T&&f7.

« B4 (Exclude)]-F =y /D L —7EBII LT 2 L& 2D IO E DF =9/ %
BRAN 4 285 S d. COATY av 5IBIR LET .

COBITIE. EBEDF zy R v/ ALEIR L&A

AT AT VAL R—NEEN VY ID VR MR T3S Bl 2803

(Include Broken Links)] 7 =/ H v X% 412 L £9

CDF 2ol R I AEFNILTWBRIG S AT AT VAL E— 1 EHEIT 728 B ono

NI IRLA— MO B BERRNINET EN LV I T 7 L— NN D

HRIWCEHEST e Tw a6 ZOE M IR L Ty—r3n E7.

B A WEFME . FE ARARLF 2o DB N 5547 LTy a7 54 7> ADY [
WKOWTTINVr—y a5+ DB T 23120DFXTOF zy/7&2B ML ET,
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VIV AA R
% 3: Compliance Manager (Fortify Weblnspect®d 4)

15. IBIMOEM &A7TVE LR OFIETIER LT av 754 TV AT > 7' L— h5E Il &4
7.
16. fEfE(Save)] #2VvrL &7 .

i FH @ £%€

o NTINEIIZIEH 2 R"F 2 2WE THH 2B R LT [EABE] &2 FABH] %
VAN VA& B

e ATTVEFIEB 2N TGS #7IVFREEM %54 2y LTy ¥ 3= My b A
2= AN ZERLETHH A IBIRLALIEH O LN S £7.

o DM DE N, G £FE B B ICHTMLY> 22BN T&E T,

ompliance Category [ |

Mame: |F'assw::|r|:| Prokection |

Maintain security during entry and transmission of passwords,

v pebools . comyguides)password)]

Description:

— B T XA MER 7L —

F 27 1L 7 hVFI| Z5 (Directory Enumeration) T> ¥ i o TfE sSh 32D x—y = 7
W=7 A MHEZITXNTOH BLIORIMDAREENET ] 7 OF =y 2id . A
(Accounting &4 5% |if DT 4L 27 MIDKE R T & 2) %> AZ (Zips & % BT DT 4L 7 MDD
MR TEDR)ETDTN TRy NEIZZ V=7 &h 4. ZOZ )L—712i4 . Microsoft
FrontPage-Microsoft Internet Information Server® o7 7 71 )L, (W3SVCnn)(Z B & -} ( 5
NTWBT AL MEEDE DM DRATDT 4L 7 MIDF zvs b N TH&ET,

fif AT BE 2 §RTCDT—v x> FOFEAN DWW Tl Policy Manager #12 % & 2—CB 4
L. M % 7+ A M& ‘% (General Text Searching)] /— M2/ LT . E R DT—Y =
N 7w LT 2 &0,

B oo
Web Application Security Consortiumid . Web# 1 bD ¥ & 2U7 2%} 3 2% B W i1k

LTI 327200, EREEOHGEEERLTOET. 2 slk BB 77 A(Threat
Classes)] X7 Z YA RSN T &7,
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http://www.webappsec.org/

V=LA AR
% 3: Compliance Manager (Fortify Weblnspect® )
2N 60 Ak 3 MG IIVE B AF vz & DHIB Licm & ama R E § B12id:

1. B 77A(&E 2Dy R—% Y MOWT ) IR L 7,
2. [&7Vy7 LT 2 & COE M O BIR h 128 B 25 A(Selected Threat Classes)]

EBET,
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B4 T2 a—KF 3—X

ZDY—)VIZ &V, Base 64. 161EH . MD5 % EDAF—LZFH LT H 2Ty a—FB &V
Fa— N T & &7, L F 5] #Unicode s 7 71| 12 > a— ¥ % C &%, URLORE 5% T4 ik 3¢
FEMH T2 TEET,

AF U AE R O M, Ty a—RERERE S A Sh e R B b 230 F 5 058 sh
1235 41 L F A & 2 ¢—L T Encoders/Decoders V—)V B Off F. Fa—F
(Decode)] #7 Vv o4 31200 T,

¥ Encoders/Decoders |Z| @| E|
File  Edit Help

= - |@Encnde @Decude |Enn:c:ding: ROT 13 &
Teut Encoding Character éet
1234587830 Select By

(") Character Set Name  (®) Display Name

Westem European (Windows)

Westem European (Windows)
Character Set "Windows-1252"
Code Page 1252

Hex Display

21 3P 3305435 26 37 3R03% 30

(] Prefixed (e

Length: 10

YEH DLy a—F 47

LFEH ATy a— N B2

1. FFRAMNText)] TUTCLFA #N 19 2( 72085 0T )0, A=a—h6 Prfiv
(File)]> BE 4Open)] %i&R L TT7 74 VDN A %t HIA & £4 .

2. [ v h4 (Character Set Name)] 721 &7 4 (Display Name)] D\ 1 7%
FHLTIYa—T 42/ L F ey bR L &7
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V=LA A R
w4 T a—RK|7 13—

3. [Eva—74>7(Encoding)] VA b ol 5 OFESE 2B R L 3. sF 4l DT I
Ty aA=T AT ZA TR DA—V ] #Z H L TS0,

4. LELGE LT, BF—(Key)] 74—V RCF—2AN S LET. AR ¥—5N 1T 5 &
fr > a— NEncode)] £ 2> & F a— F(Decode)] K &> H W& DET .
5. E¥a—REncode)] #7VvrL &7,

P+ 2 NText)] £ V712id T2 a— RSN F I o8 Sh & 9. 16 R IR (Hex
Display)] = V7i2i& T>a— F&N 230 F 51 N D% 35 D163 fiF A3(IE R L 7230 F
Ly C7r—vybhSN KRR INET,

P'v 7492 24+ &(Prefixed)] ZiE R 4 2 & 163 F O H T Oxy #5E I S &9, C
B OB LA L D5 58 (C++. C#. Java. JavaScriptZ £) Tld . 161 £ 05 58 1
roxJ %4t Ui@“(t&x FOX5A3). 55 B DO & >TA—H Bl T 22 L4 L £
T IxXJE16EEH 2K L &7,

L H OF 3
FH) T a— N Bl

1. FFRANText)] U7 FH) 2N J1§ (£ 1230 OFF T 8) s x=2—h 6 Praw
(File)]> BE {Open)] %iER L TT7 7/ VDN A it HIA & £4 .

2. [E>a—74>7(Encoding)] VA h ol S OFHH 218 IR L £

3. WEG LT, FBE—(Key)] 74— Ricx—2# AN L&,

4. F a—N(Decode)] #7VyrL &7,

HTTP Editor ©. WeblnspectD > a—7 4> 7 B SV F a—F 4> FHBE 2 T § 2284 T

EFET. vy OEET A 2T BE AT AT ET AT AT DA TS T

JEXATEET,

> a— RSN 1230 F 4] OFRAE

Ty a—RFSNIE RO FH2iE BIRIA T BE 2 L FE DT ENTH G 08H0ET .
% 1/\——;«))1‘/:!*‘?‘4‘/7 AF—LFlEF—EUEET 20T A>T AF—LEH
H 323562 SUASHBCH A LET. BRI ] B8 4 3C F i Windows 7 ) w7 R — Kz 3
E—7T %&L:@T Ho4li izEncoder/Decoders» s at—L 7z 0, ZHCHE OfF /7203 32 &k
T&EHA. 12120, COHIR 2B 5 2720020077 1EHDHVET .

o IVI—RNRENTLFENETANARIE L TBE, ZNET I— N B EL&ITE A=2—05
P 71 v(File)]> B {Open)] #i# 4R L T. Encodery—ivizo— KL &9 . ZD&. LD
TiEYREHR TG ) F—&2EH LT a—r L &7,

o e IR Lfczya—T 4>/ N exF—2H LT FA 2> a— LR EROD
Y4 #Base 64T R A H LTy a— R T 23288 TC&ET. Z2DB . 2O FEH %57
Vo7 R—RZaE—L. 2V R —RFOWN & &1L Off U, Base 64 {1 L T7 a— LT
5. LD LFEH TG &) F— 52 LTH YT a—FLET.
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=LA R

T4 T a—KI7 3K

I aA—T AV T RAT

Encoder/DecoderCld . IR DR WZECH SN oy a—T 4V 7 XA 7 5B IR TE £ 7,

rya—
7 AT &AL
79

3DES

Baseb4

Blowfish
DES

Hex
MD5
RC2

RC4

ROT13

SHA1

E &

Triple DES. 7—&%3[n {5 5 1k 3 2DESK; 5 1L 7)v 3 VR LD E— ML F
P 531G 51k S, 2O S oG 51k S, 2045 OG5 7 F R M3
H OIS 54k 2T bh £9). F—3128 v M F7213192 6y M163LF &7213
24 F)TRUNIE R VEE Ao

8ty bF 27 v D3O 5. AL F DI/ N—7EL Ty a— FB LU T a— L
FT. /% LFEV—ATHB24y hOF D6Ey M EE L i . ASCIE LU
EBCDICO$RTDNANTY MIF EN AL FRIEFH §2280 &0, i1
Dxya—7 4> 7R CH 2 G M 20 & L THET,

DES7 VT VX LD o HEL TfE T &3I4 7V T VX 4

7 — XM AL EE HE , TR 20009k i 2 25 & 27 54 X— hD(HDF % D)
BB F—4 ] T&x 2. 5 YEH S Tw a7 —&1E 240 . EE T
Ea—H DM 7 2E CA &l 2 H T 20 EAHDET,

163 % .

I ChHNANT] LicT —Rxt LT, 128y FOTFRAL ] &/oid T Aot —2 XA
VA M EERLET,

Ronald Rivest & 5t LI=A] 25§ -4 XD 7 0y /g 5 . 7'av 44 X364
By Ty V7 N7 27 TIEDES & V&) 242 7 534% & 3 T3

Ronald Rivest2i& &t L7122 bU— ARG S . Chid. 231 ME A O AE 24T
I A 2SS H A XD b Y— LIS T3 . RSA SecurPC 7% EDOBL i D7 74 L
g S AL s aZaichn 2. SSL7 e bav &{E ] L7224 e Web+- 4
DR D b5 749700 54 D & AC, 24 2B U H &N 4.

BXFETIV IRy NCI3L FR I HIZLFICE SR AT, 7F A MR
2 Ab 2o d H &h 2 Hi 4l e Caesarfig = .

LF 27wy 27T YR Lo NISTIZ & >R % L. iEHEFIPS 180 CE &
SN TWB.— ANy 28 8. SHA-11E 19944 (2 F AT Sh 1220 5T I
T, ANSHZ#X9.30(/A— R2)IC bRl Sh T &9,
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VIV AA R

T4 LY a—K]7 a—XK

>va—
?:4‘/7 &4
7

SHA256
SHA384
SHA512
ToLower
ToUpper
TwoFish

Unicode
URL
XHTML

XOR

E 3

256 Ly MG Sk 2 ] § 28 % 27/ v 27T VX 4,
384y M S 21l 2L+ 27/ vy a7 LT YR A
512y M 54k 2 il 22 F 27/ v a7V T VR A,
R F 2N LFEEELET.
INLFERLFREE L ET.

LT OBlowfishiz 3t 2 i 54k 7L 3 VR A,

T IyNTr— b 70l A BIUFREICHR L KX LTEA O
HiE#fe e LEd.

R O F LS OURLT Y a—F 4> 7 I Tx 2l #E R L. 20
EHR— P BT SUHFRT ST TCRRNTEBRENLET .

AN INT—RETF A MRT T, <text>7T —Z</text>D & HZ A7 ik L
EQC N

XORIGH L I OREEAME #=4T LT . ¥—4IEE T AL ELRHVES, F—
WFEHOE S L ELTORES . 2O FiE. > a— R NF a— RN F4|
W O& S F ekt LCORMLER &h £9,
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ES5HTTP 7 1 &

HTTP Editorid . 23R #1E A /213804 L TH— NS Ly B & 24 OHTMLTE R L1z
D, 7L YRV L TR R LIEDT 22020 H L9 . HTTP Editorid &) O\ v+
IV TH B fEFHICIEHTML. HTTP. 8 SUEE R Y o RO 78 501 3k 250 ¢

o

7R YN TA=RE LURRAE N T A—RER T T 210 BE I LT L (Edit)]>

(Settings)] iR L 7,

{5} Hitp Fftor
Bie [t Yew pep
i) B b | Chsend asts @) Show Mstory

Locabory Prm ) taes, s pnascs ooee: 30|

I
[oebect g recuss Bcion] = dpoly | 34

GET / MTIRS1.1

User-Rgent: Mozillasl4.0 [ocompatibler HSIE 5.01; Windows EHI 5.0)
Comnpecciony Heep=-Alive
Hose ' wnw . spidymesios.com

| rcreoner I e ]
Chumioed | M Compression - 4
HITR/1.1 200 OX =
Date: Fri, 17 Pek 2006 18:58:13 GMT

dervess Apache

Heep-Riive: timeout=13, maw=100

Compecticn: Keep-Alive

Iranafer-Encoding: chunied

Comugnt~-Type:! texc/huml

1000

44 2 1fE html PUBLIC ==//WIC/ /L0 XHTHL 1.0 Stanmiticha - B

“<html =mlns="http:/ /ey, sl ocg/ 1993/ Khtml™> =
[e] | ¥
Ry
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V=L H AR
=5 HTTP =7 41X

75k ¥ 2—7(Request Viewer)

Ei >k £ 2—7(Request Vlewer)] WIEHTTPE R Aot —Y KRR SINET. ZD AvE—Y
X IRDETEFH LT4DDR % 2L N TRRTELT,
o A (Raw)-E R Avt— 47 FAMER CMTFFOERRLET.
o #£40 (Details) -\ v&% £74— L ME 27— WL CE R LET.
o 161 (Hex) - vt —2 #1612 LASCIIOR L TRRN L &7,

o XML-Ayt—Y AR OXMLIY 7>V ER R LET (ZDOX7IE ERICXMLIE X OF —
BV ENTL R HICDAE R SN ET).

Jts 2 € 2— 7 (Response Viewer)

[ % £2—7(Response Viewen) ] IZIEHTTPIG & Ayt —YBE R SN &F . CD Ayte—Y
G IRDETE#EH LTA4DDR 4 2L XA TRRT& LT
o E(Raw) -G & Avt—Y 7 FAMER TMUT ¥ OR R LET.
o TIVH LB Avk—YETIVFIL VAV LTRRNLET
o 163 B (Hex) -Jti & vt — #1635 LASCIOE L THE R L ET.

o XML - A=Y AR DXMLIY 7> V&R RLET. (COX7IE G E XMLE R D7 —
B EN TV B CDARIR SN £T).

HTTP Editor® A==

P 71 v(File)] A=a2—
P71 V(File)] A=a2—Zid . IRDAT'> > HBH DET

o ¥ E R (New Request) -LLRT Dt v avm oD X TOME R &1k L. vr—y 3
URLZYE v L &7,

o FE3R %P {Open Request) -LL i Dt v st (- 1E SN HTTPE R 285 A 7 74
Wen—RNT&Ed,

o SR O (Save Request) - HTTPZE K #{# 7 T & £,

o LT 241 TER %12 7F (Save Request As) - HTTPE R #{# £ T& £7.

« URLF #(URL Synchronization) - S #1%4R 72 &, [P FLRA] VR R w2 RN T L
1230 7 5 HTTP# 3R 47 ORequest-URIIZIE il 811 &9,

e ZD ¥ % 5 (Send As Is) -CD A7y s HIRR LG & BN Lz 2Dt Ok 2 cﬁi
{& % < HTTP Editorid 2R 225 L&t Ao S &Ml 92 & BRI ik o7 Ui
A= FIE G T AIENTEET. COATY av#H 26 BAF B LU 7 mF: /O)
REEECEET .
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=LA R
E5 HTTPZ7 4 &

WH: 7 ox 2R M 3L 0B R EFEH THE T 22LE TEETH. L DFE#E
HTTPZ o> 4—/ Nd JFHEHL OHTTPE R 2L ¥ T& &t A

o # 7 (Exit) - HTTP Editor £/ U £,

i 48 (Edit)] x=a2—
fi 4 (Edit)] A= 2—WE IRDAT Y o 0bVET.
o U] VB Y(Cut) -IER LIz7F A bEHIFR Ly Z2Vv7 R—RRGF LET,
o aE—(Copy) iR LT F A MYy R— MR IFE L ET .
o B Ut (Paste) -2 )7 R—Fh a7 F A MEHEAN LET,
o« MEFind)-FR & LT FAMNMR T 20D 70/ R/ AR R LET .
o 3% 5E (Settings) - HTTP Editor DE 3R /3 5 4—&, REE AT A=K, BEU T OEF /85 A—
RERETEET .
R (View)] x=a2—
BR(View)] A= 2l IROATY o 03b DT .
o JB B DF 7R (Show History) -i% /& L#zHTTPE K #— B o Li=RA V&R R L ET,
o 3 VIR L(Word Wrap) -5 XTD7* A b E DR AW UL 7.

V7 (Help)] A= a2—
PVZ(Help)] A= 2—i2id  IRD a~> FRH VLT,

HTTP Editor~\ )L 7(HTTP Editor Help) -~ v 7" 7 7 L6 & H ¥ (Contents)] X737 2
TAZWZ R NET .

A4 >7 v R(Index) -~V7 7 A VhB & W7 v A(ndex)] X707 7T 47 % DET .
M & (Search) -~ V7' 7 7AW HBH & BE (Search)] X717 77 4702k D&Y,
HTTP Editoric Dt»T(About HTTP Editor) - HTTP EditoricB 3 21k 2R m L &£

3k 7 73 32(Request Actions)

B3R b 2—7(Request Viewer)] X1 >® B3R 77 3(Request Action)] VA b5l
ROA7y av & TEET .
PUT 7 74 L ® 7 v7"u— F(PUT File Upload)

PUT #xV v Fi& . 48 7€ L7:Request-URID N WCHE NN DT> 747 %G T2 &2 ZR L
X9
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E5 HTTPZ7 4 &

H— N7 IV EE ZIN DI

1. [k ea—7(Request Viewer)] X1 > D Favy7 X7 YR+ 5 PUTZ7A VDT v7°
o— N(PUT File Upload)] #i# R L £ ¥

2. VRAPDAMNICERIR SN BT F A PRI A, T7A VD7V AREN T LET S
- Freld -

v % (Open Folder)] 714 a> %27V L T, 7v7'a— T 277/ )V EIEIR L &
ER

3. BHApply) #27VysLEd. Chicsn, av 7>y EOHEE LT b £,
Content-Length®%% ¥ (Change Content-Length)

WH E—NTE 2= AR DO Ay —V R &4 4 92 & HTTP Editor2s 2> 7 > /&
%F#HH LT, Content-Length~ vX N O Zid V) zofifi 0B & 2 4. Lo, BDEE
%15 (Send As Is)] A7 s> Hl 4 235 & (& HTTP Editorid 2> 7>V R #48 L &¥
Ao BEIR #IEAT 9 BH1C COFFHE 298 6l 10123 4T 3 512E . Content-Length®ZE &
(Change Content-Length)] £ 4R L < & H (Apply)] #27Vv2L &7

5 2—54d ODURL > 2—7 4> 7|7 a—7 4> 7(URL Encode/Decode Param Values)

URLODAL: 1% (RFC 1738, 944124 )id - URLIWZffi ] T & 23 F %, US-ASCII XL F £ v hD
H7 ey MIRE LT &Y. — 5+ HTMLTIZ1SO-8859-1 (ISO-Latin) 3 F & v hD 4 i [
ERF AV M CxET. £7-HTMLA T ] T & 2305 OFE P 2558 S TH 0.
Unicode XL 7 & v Mk $8I & g T E 4. COH| R O #E 5 &L Tid . JEE%E D
FHEIVI—TAVI LT ZNEETR— T BT SUHRT S/ TRRNTEBLENCT BE
WITERDVET,

VFOURLZY a—7 4> 713 %150 5 DB (72D F DISO-Latin 2— RH A > D247 D
161 K 5L 2% Lm0 4. ) 218

o 7TAXYRZEL 5 *]1=1SO-Latint v FD10#E % D42
o 10if ¥ D42 = 163 B D2A
o 7ARYAZDOURL I— F= %2A

URLT>a—7 1> 7 #Mi F| 3 2 &, ISO-Latin & v b & 2 ] L TE R Xvt—Y 2%
TITEETRHREDF—7— P2 § 28N ERAEMRE > A7 A(DS) /N /SATE& &
¥, 221X IDSWEMNogin] (ISO-Latin)id i R T& £9 4. COHFE #URLTY a—7 4> 7 L
2L DT BT %A4C%AF%47%49%4E | IR LEE A

Ay —V R TR I A—REURLI— RICHE & 2 212, PSSA—XEHDURLT > a—7 1
>Z7(URL Encode Param Values)] #i# 4 L. [ (Apply)] #2Vvo/L &7 .

URLZ Y a—7F 427 & 1285 4—K%ISO-Latinic 2 #2 + 3121d . pPNFA—ZfEH OURLT
a—7" 4>7(URL Decode Param Values)] #i# 4R L. EH (Apply)l £ 27Vv/L &£

E R DOUnicode = > a—7 1> 717 a—7 1>/ (Unicode Encode/Decode Request)

Unicode Worldwide Character Standard Cid . A D4 XTOF E 45k S B O F .
B RR L A)at sl BIUERRE S 2.8l — S ey a—FPRF—L 2l H LT
EFRLTOET, 2547 M—AA 77075 —3 3o %0Web+ 1 ~MZUnicode #8H A A ¢ &,
REROL Ty e T 256 L RXTRIECIA NEHJR CE2R[REE DD DE T,
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V=L H AR
=5 HTTP =7 41X

Unicode #ffi ] 9 2&. 1200 Y 7 by =78 i 272131 D0OWebH A b, > v =7 V7 %
LTHEBOT S5y 74+—4, il BIOCEHCH U TR TCEET, $12 OR L BT
LH CT—REWIB T2 Gk T&LT.

FoR Ayt —U 4k #Unicode 28 2 3 31213 . EER DUnicode = 2—7 4> 7 (Unicode
Encode Request)] %% 4R L. A (Apply)l £2VUv/L &7,

BLR Ayt —Y 44K #Unicode SISO-LatinicZE # 3 2124« B3R DUnicode7 2—7 4>
7 (Unicode Decode Request)] #i# 4R L. & H (Apply)]1 #27Vv/L £7,

)l F/3— pPost DIE % (Create MultiPart Post)

POST xV v FiE . E R K OFEIR N of2 > 7 47 1%, Request-Line DRequest-URI T1&

E SN2V —RADH LWEJE VY —AEL TR AN B LD, BE L/ NWCER T 5720

AEH] S &9 POSTE R Ave—Y & AE LT 7—RD7 v7'a— Neil & 5 ENTE &

ERD

T7AIHET —REFN T 5124

1. Bk e2—7(Request Viewer)] X1 >® 7 a(Action)] Ko v7’ X7 YR +ns [
)W F 83— FPostDAE i (Create MultiPart Post)] 1% L £9,

2. P73y a/(Action)] VA MDA ICH BT HF A MR YI R Z7ANVD IR AENTT L &
ER

- &2l -
P &%G {Open Folder)] 742> % 27Uy LT AN T 3774V EIEIR L £,
3. ®WHApply)l&#27VysL £,
)l F/3— FPost DHI k& (Remove MultiPart Post)
VT A= MR D TH BT 7V EHIBR 2113 . K ©2—7(Request Viewer)] ~
1>® [F7¥ a(Action)] VA 5 v F 23— FPostDHl Bk (Remove MultiPart Post)] %
IR £9,

> A 8
BT 7Y 3
I % ©a2—7(Response Viewer)] X1 > D X7 D4 LT D7 IRDIDD 3> ho—
WRHNET
* PF+>7(Chunked)] + &>
« BY7¥»va—7 4>7(Content Coding)] Fov7' X7 YA h

* B Rgy, N A T 2L 5% M Z (Find In Response)] 4 707 £ v A5 &.
ZITCTFAMLFHERELULEN TR C&ET.

F %> 7(Chunked)

Y S DOEFHRE 2R 2RI 2O B OIS 56 T 235 4 A Ak a2/
SHF v 2 E LUER CEE LET. SO & %2 il I Transfer-Encoding:
chunked] £V INYEDBEH EN TV ET . F o>y 7 A=Y AR, —HDF v 7055 &
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=5 HTTP =7 41X

. ZOWTO1(E 0)DAT 2358 & ZOB AT Y 2D 7yRET AT %8 &7 . & F v

21 IR D2DODEI; THERL S &5,

o 1BHEXL DF v> /7 — KU A X% AT « YAXDIE L 338> BB I D /85 A—RH %
WTWAGAEBDHVETH. TN SEEN TEFTFHR N TEOT N LEETEHNEE
A)o AT DA IGCRLF T,

o T—RZDLD., D% ICCRLF A%t & £ ¢ .

av 7>y a—7 4>/ (Content Coding)

HTTPJG 25 (L4 7 — 208 EN TV ARG EE KD YA M H B4 T 2D N H%fd
H LT —R&L4i R C&£7,

o GZIP-GNU7 oy =7 N WAE il S i B4 2— 7 4 V7 4T ¥

« Deflate - RFC 1950 [31] T 3 & Tw» 2l zlib ] JE A %#. RFC 1951 [29] CELIA &4 Tua
2l deflate | £ 45 A=A L L AH LTI DTT,

IHHH TSI Ean
B SR & 21 S DR R IR DR—D

FLR O# 45 LEAE
BOR 24 L CGEE T30

1. E R ea—7(Request Viewer)] XA > CER Ayt —V &2 FH L7,
TXFAMNLFHN 2Ty a—NEfld 73— T 2. 7TFANERIRLTE Z2VvoL. Ry
7T w7 A= a—h 6 v a—7 4>7(Encoding)] £7/2i& § a—7 4> 7(Decoding)] %
EIRL T,
PR OFF e OIEH 22 8 ¢ 3121 P27y a(Action)] YA b»alEH #1EIR L. &
B (ApplY)] &7V v s L& 4. BEATIC DL TId. TTHTTP =7 48 A"— 46 55 [l LT <2
Sy,

2. BEfE(Send)] #2Vy/L T HTTPE R Aot —Y ik fE LET.
HTTPIG & Avb—Y 5% (5 T 5 &, b2 Ea—7(Response Viewer)] XA V2 ZD Ay
L—UNERIRN SN ET

3. WWEETIVFILYRYY T LTR IR T B PIU4 (Browser)] X7% 7 Uy 7L &
R

4. P'Zv4(Browser)] £71zL > XY 7 S f:HTML 2> ho—)v £ /zid JavaScript 2> +
oA LT IRICEAS 3 2HTTPE SR 21l T &9, COMERE 2 H 4 212
& fHEE 8 e7 —2 a/(Interactive Navigation)] # 7> 22( §i4E (Edit)]> e
(Settings)] # 7 Vv ) EIEIR § 2L EHLH VLT
a. B Fr(Location)] 7+ FIZURLZA 1 L. {5 (Send)]1 #27VUv/L £7,

T7Nr—y avhal A7 r—L&R LET.

b. % (Response)] X1>T. P74 (Browser)] x7%2Vy7L &d.
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Y=L HA K
E5 HTTPZ7 4 &

C. LYRUYITENA—Y T, 2—H 4 ENXRAT7—FEAN 1 L. 15 (Submit)] 27Uy
7LET
YK O % O & HzHTTP Editor 733 3R (Login.aspx URLADPOST xV/ v N4 il 4
B)e7+—~vvhl. L% B3R v2—7(Request Viewer)] XA IR R LET.

- - -

0 b Dhsendasts 8 Show Hanry |
Locason; = prsennn G ey i, S e gty - ﬂs.ﬁl
| mebectaregueds aoven] = Asely | AN

PosT '.';Hn'."p: HEIDALA

ser=Ryenr: Morillsaf4.0 [cossaribler MSTE 5. 54 Wimdaws NT 5.0)
fost: hacmebank.qs.spidynamics.com
ane=rian: Hesp=Rliwe
CoOnCEnT-TYypel Applicacion/x-wwe-Eform-urlenooded
AEERE=-28EgTHh: 11¥
EVER L & furtinh .1 ™) EVERTAAGUALEI =L VIENITALIL=drtih] Uk AN e BglrrrE R0 i nh i T L

d.
||
Hacme Bank™! 53 a software security traiming application provided by
Foumdsione, Inc, This spplcaion & desgeed to teach sppication developers,
prograEners, achitects and secusty professonals how to create seome
softviare. Hocme Bank was designed with knawn vulnerabibites winich allow
users 1o e fenl explosts and 1o demonstrate how 1o buld more seome =]
| 5

d. BEE(Send)] 57157 T, 7oy b SRS B (24 &8 RT— FEH ©) &
P— NIEfE LET.

5. TR #R A7 7 212k Pr1v(File)]> E R Offf(Save Requests)] #i# i L &
ER

CHELHTSH S En
"BELOR £ B DM RN

Bk 30 O &
BER FLEIEDTFAMNEMRE T 21201

1. B3R e2—7(Request Viewer)] N1 > &fzlx & & € 2—7(Response Viewer)] XA >
DOFNHTI o)7L 57,

2. ESRN O Z(Findin Request)] 74> N7 & fzid [5& N O & (Find in
Response)] 74> P&l LT, LT &I IER R 2N 1 3B/ L&,
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3. MEXFH ELTERRH 2EH 2551, Regex] Fzv/R v/ A#E R L &
7T,
4. BERFind)]52Vy2L %7,

7% 7€ (Settings)

HTTP EditorDs% i€ #2454 3123 L (Edit)]> B E (Settings)] 22V v 7L, IR D>
THNOORTEFERLTEHE 2MZ. DKl 227Uy L &7,

o 7'y 32/(Options)
o 2 AE (Authentication)
o 7' 3(Proxy)

B BRTODHEIWZOVTE RDE sy 2T LFEFT .

br~"> 22(Options)] &7
B3R 7 v—7(Request Group) ] lCIE IR DAT'y av b DET .

e ZD % ¥Xf5(Send As Is) -CDA 7'y s #IER LG A L IR Lz 2 DM D% & (B
272\ HTTP EditoriZ R #85 FH LERA. CNEHFH T8¢ E [ 12ER > e L
oAy —VEIEE TBIENTEET. COAT7 Y a2 §2&. BRBAE
(Authentication)] 6 S U° P'r¥ 3 (Proxy)] Ok & & RN 12 V&,

VE: 7ox s T 3L W EREATE CHE T BALLTEETH, IF LALDRE
EHTTPZ o+ o4 — NI E YL OHTTPE R 2 TE EH A

o R O 4E (Manipulate Request) - CO A7 v £ 4R L1235 & - HTTP Editorid {X ©
NIA— IR G T & NCER LT LT
« JR 88 D3FE F (Apply State) - 77 V7 — s>, Loy N OIRRE 24 5 272017y
F—, URLF #F &IA &, &/2ldPOST7 —2DH: i1 #1fi | 9 %35 & - HTTP Editorid %
O RERFE L. TN TS BE 2R E LLIEL £,

o 7'0% > OiF F (Apply Proxy) - O 47> v #1# R L1235 4 - HTTP Editorid 22— 4
B L7 o SR E I >CTERZETH LT,

o 74VvADIE A (Apply Filter) - 2D 47> a4 . Fortify WeblnspectDfifi H /1 iz A% v
BTN TH—AADD BEE(DE D AF v &5 WIAR D AF v DEATH)ICHTTP
Editor ##2 #) L7125 & DA R IR S & F. COA7'Y av IR S T 2854 L HTTP
Editorid . Fortify Weblnspect® PifE D 2 * v>i% 5 (Current Scan Settings)] 12 & 3

D v X(Filters)] i% i€ %3 ] LT HTTPE R 8 FUIGH DM R 6 FUE R DL—v
FEIMLET.

VE: HTTP Editor 2T O 3781 12 BLAE D A+ v &% & (Current Scan Settings)] #
THLTH R EDHVEE A HTTP Editorid . A v> O 4 5 (2 2 Td o1z

A E EfEH L&d
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o N vXDiE A (Apply Header) - CD 47> 14 | Fortify Weblnspectdfii F H (2 2% v
BTN TA—NADD B EE(DE D AF vV EH WIAR D AF v > DFEATH)IZHTTP
Editor£#2 ) L2 & DA R IR SN & T, COA7Y o NE IR S T35 4 L HTTP
Editor(s . Fortify Weblnspect® Bi7E ® 2% +>&% % (Current Scan Settings)] (2 & %

P v¥ —I~ vX(Cookies/Headers)] &% i& #HTTPEL Rk D=zl H L £ 7.

VE: HTTP Editor 2 O 3781 12 BLAE @ A+ v &% & (Current Scan Settings)] #
BHELTH. R IEHVET A HTTP Editorid . A ¥ v> DB 1f W5 I0H %) TH o7z
REEEHLET.

i e7 — a7 )v—7(Navigation group)] ©. E: L(None)]. ki3EZY (Interactive)].
1z2i& 574 £— F(Browser Mode)] ###R L £ 4.

[i: % £ a2—7(Response Viewer)] (T &8 X1 )T P Zv4 (Browser)] &7 % R 3 % &,
Y NGB ETSTFICL VXY LTR IR CEET . i EE B (Interactive) ] # E 234 %
W oTW A & d. 7775 L v XYy 7 S fzHTML 2> ~o—)v & fziX JavaScript 2> b
o=V E R LG IRICIES 3 2HTTPE R 21 flf T& &7,

) HTTP Editor [ = =]

File  Edit ‘iew Help

5 | send 2515 @) Show History
.Location: httpiffzeroavebappsecurity.com: 80/ loginhtml - ﬂ Send ]

|Request Yiewer |

Raw I Details T Hex ]

(Select a request action) * Apply Search Text - 3 @RegEx
GET /login_html HTTPF1l.1 T‘

Uzer-Lgent: Mozillaf4.0 (compatible; MSIE 7.0; Windows NT E.1; EW1; .NET CLR 1.1.43ZE)
Host: mero.webappsecurity. com

Fi-RegquestManager-Memo: StateID="3"; sc="1"; ID="f44£435a-91lce-4ell-aclb-40a?dE2alaca"
H-Degquest-Memo: ID="40Z2c33eb-4335-4a81-8162-0£02b31cilbe"; =sc="1"; ThreadId="1";

J,

Response Yiewer

Ra Browser I He:x ]

Log in to ZeroBank

Login (7]

m

Password ||

Keep me signed in

Request caomplete
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1z £71E | http://zero.webappsecurity.com:80/login.htmlD o7 4 > X— (L O {% D £ D)
#4335 4 1E. Login] 4 i (Tusername ) & Password] (Ipassword]) &\ 77 LT
#5 Bignin] &2 Yv /T & &4, HTTP Editorid « % 3R (signin.html )/ —ZADPOST A v
NE 4 2) 5 7+—<y L. RO R D & 2B R % B R ©2—7(Request Viewer)] (2
RRLET. 20 04> Avb—V e tE T 20 B 5B 8). 20 ££7:77 LS
(Send)] &2 Vv s L TH— TS LET.

t;) HTTP Editar (= = [[=2 |
File  Edit  Wiew Help
N 5 A | Esend 2515 @) Show History

.Location: http:fizerovebappsecurity.com/signinhtml - B Send 1

|Request Wiesaer |

Raw I Dietails I Hex ]

(Select a request action) > Apply Search Text S ! [ RegEx

POST fsignin html HTTPS1.1

Tser-Agent: Mozilla/4.0 {compatible; MSIE 7.0; Windows NT S.1; SV1; .NET CLE 1.1.43ZZ)
Ho=t: =mero.webappsecurity. com

(-LequestManager-Memo: StateID="3"; =sc="1"; ID="fdd&d36a-9]lce-dell-aflb-40a7dE9a8a65" ;
H-Regquest-Memo: ID="40Zc?Peb-4332-4a81-8162-0£02b31lcZlbe"; sc="1"; Threadld="1";
Content-Type: application/x-www-form-urlencoded

Content-Length: &7
izer loginsusernamesuser passvordspasswordisubnit=Signtin

J,

Response Yiewer

Ra Browser I Hex l

Log in to ZeroBank

Login | username (7]

m

Password sessenee

Keep me signed in

Request complete

P94 £— F(Browser Mode)] 47> 2> #1#4R 3 2 &, kF55 (Interactive)] €— &
iz DET A, HTTP Editorid H BICE R #IAE L& 3. SR lcz—H%E C& 2L I E
3R % B3R ea—7(Request Viewer)] (LR /R T2 8E LEF A

Vo747 a>7 Y %E ¥j2 3 3(Enable Active Content)] 7 v /K v/ A% A 12T B &y
TXTO7 FU4 7 1> K CJavaScripts LM DX A F 3y 7a> 7Y ERIT C&D LN %
N4,

I LA EDWebX—1Zid I H T NELF 2y b7 75 IR T 2B AE g T &
T . CO$E R & HTML R 2 2> fOHEAD & 73 3> @DContent-Type)is & \ vX( & 121k
HTTP-EQUIVJE 1% #4+F DMETAXZ) & L TiT b &d. X F v a7 F 7Y ALTW
WA=V (CHTTP Editor i Fl 9§ RXEXLF v MR € T& 7. EE ZHTTPENT
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(Advanced HTTP Parsing)] 7 v —7"¢. & &h 3L F € v ] x> 31— F(Assumed
'charset' Encoding)] #i# 4R L £ 9.

2 &k (Authentication)] &7

FRRE 2 25 A & BB AE (Authentication) ] YA b SR 7 ZIEIR L & T o FE A v F
FIER L7145 1*‘*7“?% ENAT—=RENTLET . GBAE AV v FEIR D EB VT,

 H &) (Automatic)

 HTTP# Z (HTTP Basic)

« NTLM

AL AV v NEIEIN LIztE . B—4%4 (User name)] & PSAT7— N(Password)] (C A\ 77 L &
To N1 3IR%R <fevy PSAT— FOBERR (Confirm Password)] 71— NIZ/SA7— %
HANNT2LERDNET

P o¥ 2 (Proxy)] 47
7'oF o H— %A LCHTTP Editoric 7 7t A4 2113 IR D% E 2 L & 4.

o H¥EEH (7 o+ &%) (Direct Connection (proxy disabled)) -7 & o +—/3 %4 [f]
LW &k COATY s 2& R L LT,
o 7'mFx Uk E OH &) # i (Auto detect proxy settings) - WPAD (Web Proxy

Autodiscovery Protocol) & i 1] L’C7°Dﬂf SHEIRE 77AVER DT, ZREH LT
7' 774 DWeb7' v ¥ iR E #1T W G ld. COAT Y v #IERRN L&,

o YRFLDT X K E %% H + 3(Use System proxy settings) -o—#L v 2670
FoH—MER AL VR— MBI COF T RN L ETS

« Firefox7' ¥ 5% & #1# F 3 3(Use Firefox proxy settings) - Firefox»> 57 o 3 +#—
IER A Vv AR— T 2. COATY 2 5IBR LET.

W 7S50 iR EAE R LT, 7O YW TV Ry NIT I
ATEBREL L HVEE A Firefox 7S5 04 E NI 7 oxs 2 LR ESNT
WBIEA . ZoF i S Et A

o 7'o¥ v EHRKICER E 7 3(Explicitly configure proxy) -7 o & 4 — & i TA > X—
A2y MIT 2R AT 2 COATY av FIER L ZR SR IE R ELL T DL AT L
9,

a. B—/3(Server)] 74— K27 0% v —ADURL £ 12X IP7 FL ZZA F7 L. 50 C
( B— MPort)] 74— Fi2) £ — 1E 2 (80804 £) &N J1 L &7

b. 7o 4 — &K HDTCP 774y /7D Df-p D71 ha) %, SOCKS4,
SOCKSS5. &7-i3 RO »haiBIR L &7,
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V=L H AR
=5 HTTP =7 41X

X7
\

FRRE I 23 A d . ERAE (Authentication)] YA AR 7 EIEIR L L7,

[e]

o

o

o

o

H 5 (Automatic)

AT HEMH 218 € 758 AF v DULE B < NEd . 88 LTWh 35| D
FEE XY yREISE T B AF v DA 74— R KIEWCH ELET,

3 A& (Basic)
£4 Y =X MDigest)
Kerberos

4 I¥ x— MNegotiate)

NTLM

7'0F Y — N TRAE AL B 25 A . A& & —¥4 (User name)] & PRAT—
M(Password)] #A Jj L 7.

B E DIP7 L AN 7 A MA M OV T 78 AT 27 ax o 4— i ] &

PLE RO EIE. Vo4 RT 244 MBypass Proxy For)] 74— K

7 FLAZIIZURLEN I LET. =2 MEX V) 25 6 ik Av~&EH LET.

« HTTPSH O # 7' u¥ > %48 & ¥ 3(Specify Alternative Proxy for HTTPS)
HTTPS#: 4t 4% AN 37 nx v+ — 0 & k. HTTPSHORE 7oxs 28 E T
%(Specify Alternative Proxy for HTTPS)] 7 =y /4 v/ A% IR L, B3R sn -t &
ANNTLET,

IR B

EBRBHOARZ—G N R L FR— A& EH LTER S 4. IRODF 2. h
SO FD—# &/ L. 2O B 2T HG 2n Lad. R 72O &L T
'Regular Expression Library | 3% D &3

B

WO ERER L FEELT—2LET . ME XL FEInJic—FH L Ed., v—F >
ANn/iE s AT X F e LT,

ANJ] AT ORI LET.

NFIFREEVIEH 728 BE X TFEERLET . 12821 contentT (L
2 M YN Dlcontent/en & & Uf/content/ca ZFk <9 X T &k 4h 3 21214 /content/[*
(enfca)] L &1 il L &9 .\S\D\W &2 i LT <2 &0,

AN ERBATOREIC—FHLET,

5647 ¥ 3307 OO BA ORI & F L&, 120718 Tz1 £6Tz00) &6 5L L
7.

WAT I3 FO1E L E OB &~ LET. /zoHdTzoo ] lo—F L &§ 4.
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http://regexlib.com/Default.aspx

=L HA N
E5 HTTPZ7 4 &

XF #H
[zJi2iE—8 L&A

? BAT T 2L F D0 F2E 10 O I &—F L 9. /a?ve?/idnever] Dl ve]
W—LET,

AT X F 2B EBE DI FIC—H L&,

[xyz] LT b FEINHN OMFEF D17 — B L &7 . /[abc)/idTplain] Dlalic—
FLET.

\b AXN—RG EOBGES Fic— 3 L &9 . /ea*r\b/id . Tneverearly | Dler]ic— 3L
L&d.

\B HEE LA OFF FLic—F L 9. lea*r\B/ix never early ] O Dlear] &— 2 L
Eq A

\d 100%F e 5 L. [0-9]4F LT,

D BT LS OI LTI LgT. [F0-9]¢F LT,

\f WA= FIC—FHLET,

\n - HUAT I EILET,

\r F o)y YR FI B LET,

\s AR—R, BT\ A=Y EOF HIWC—F L FJ . [\An\nt\v] &[F LT

\S FEXFUASOLFC—FLET. [P\An\ntWV] &F LT

W TYR—RATES CIEE OME LT L&, [A-Za-20-9_] EF LT,
W EEF LA O T — B L £, [*A-Za-20-9 | &F LT,

IHLHHTHR G EN,
"IE R AR I OFPLIR" R

IFE 5 3R i 0L 58

38 O IF #1138 T S 1ox) 9 235 58 AMicro Focus D > ¥ =712 & VB F¢ 8 L OVE I an
TWET, FRERAER T 25 85E.IROKXTEHEAE T 4#EH & %7,
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=LA R
E5 HTTPZ7 4 &

IE R %7

[HEADERS]
[COOKIES]
[STATUSLINE]
[STATUSCODE]
[STATUSDESCRIPTION]
[ALL]

[BODY]
[SETCOOKIES]
[METHOD]
[REQUESTLINE]
[VERSION]
[POSTDATA]
[URI]

MR B A 7

AND
OR
NOT

[]
()

1

(@) AT —RATICAT—RAI— 2001 3% &M TH O 5 D(b) Ay —Y R IL D E I
MNogged out] & FREF) 038 FN TH AL L 1 H 77212 IRDIER K H 2 H L %
ER

[STATUSCODE]200 AND [BODY]logged\sout

TR SN2 YV —AB— B OURI (URA L & NCHETE § 3 28477 LTH 0. ok
% DEIHIZ AR Login.aspl NDS B A& £ 20 % M H 9 51201 IRDIE R B
L £,

[STATUSCODE]302 AND [ALL]Login.asp

(@) A7—xAa— F»3[200]. 7Dl logged out] %7zl session expired] &> 555 f) 234
LDEIMIZE FNTnd, &12iE (D) AT —XAT3— K302 DG E DETMII/RA
[Login.aspl ~D% M A £ T2 E OLF %R T 2123 . KO HEH %
fERHLET,
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=L HA N
E5 HTTPZ7 4 &

([STATUSCODE]200 AND [BODY]logged\sout OR [BODY]session\sexpired ) OR (
[STATUSCODE]302 AND [ALL]Login.asp)

MB35 90 & 723 TEA U135 90 ORI 4 1 AR—A(ASCI 32) 65 0 2L E A H VLT, 29
Lawe FEIARR sTIEHR BRI O—F el s 9.

o UXAL 7 hLocation™ y&XD & Zhizllogin.aspx] BN 3 VKA L 7 MG E 218 3 21
G IROIEREFEHR 2 H L&,

[STATUSCODE]302 AND [HEADERS]Location:\slogin.aspx

o A7—XA{T DReason-Phraseif (2 4F i D F ¥ (T Please Authenticate | & £) 258 £
BIGE R T3 IRDIER KRR 2EH LEd.

[STATUSDESCRIPTION]Please\sAuthenticate

CHhoH TS LFan
"EH I A— 5T
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% 6: Log Viewer (Fortify Weblnspect®
# )

Fortify Weblnspect i il 3 23 &S &4 0/ #Mi f 3 2121d - Log Viewerzffi FH L &7 C
DR RE Ik F 12 B ShicA vy 7 > b E § 2720 CFortify A X &~ A — b )L—712
ST s &7

07 774V ERIN T BIZ:

1.

PF—(Tools)]> Log Viewer] #7Vy7L &9,

AF YU EN BRI T H— A AN D B L& ZLog ViewerzB] WG & . 70l S 4
2—HFRZDRAF > DOl KR LEIELTWBLDER L &T . AT v741CiE A &
KR

R ¥ %P8 {Open Scan)] #27Vv/L &,

[A¥ v> %5 {(Open Scan)] 74> N7 T, 07 2K /N 2AF v 2iE IR L. B <
(Open)] 52Uy 7L &3, Bl DF—AR—ADAF vo 4B SR id. F—RR—RDE
¥ (Change Database)] # 7 VvZ7L £ .

b7 247(Log Type)] VA thomy #IEIR L £ 4. 1 F 7] 5 & X1 7' . (Fortify
Weblnspect® [77'V7—3 a2 5E (Application settings)] T) 2D 2 ¥ v>1xf L TIE R
SNfeaZ LN E TR A VLT,
/R OFEAMRE T B Y—LA—D RE(Find)] &2 )7L £5.
- &l -

B4 (Edit)]> B & (Find)] #1248 L £+,
07 7 7AW ERTE T Bk Y= 3—D EZAR— MExport)] £ 27V v L £ .
-l -

P 71 V(File)]> BZDxZA:K— MExport Logs)] ZE 1 L 7.

L FEE DAF oI L ves 2588 3512 Y—v3—D Weblnspectn/

(Weblnspect Logs)] #7 Vv L £7
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B2 R)y—2a—Y ¥

R Y —&id | Fortify Weblnspectz’\Web 77 V7 —3 2> DB & £ 7213 WebfR &R £1T K& &2
FHT2BEE IO BIORBEI—Y 2> bDIL 7Y 32T K avR—% 2 Nk, 71
AP A MRIVT T AT DRZIRT IOT A M HA bV V—OFE SR . BE A 05— e §5 % 07
O—7 R ENFEDRRAINDHNE T, N H6DIAVHR—F Y NI IR D7 )V—7W 0 i &
T

D e A

e A ATy v

o M ETTVr—y 2T AR

o M B THEAMER

o H— RN —F74DWeb7 7' V75— 3~

e WebD 7L —L7—0/= 55

e Web#—

o Web# 1 rD#E H

o« HARLI— z b

o NARLF zv/

A T OV R AN 6T RTOaYyE—F Y M, D THEBE I/ V—TUTITN 3. &
BB T —7121d . WebH A MO §gME 2 F =/ BH | DEY a— (B —Y x> b &
IS B)DH 77 V—T W N THET .

Fortify WeblnspectiZid \ 1 &A ED 22— E A2 H& ARG Sy FHET A vr—ofk &
NERV—DRN T FNTHEST. IRXTORY—CE I RE 2 T RXTOE A >y
VET—V Y MG ENTOLETA, TN ADIVFE—2 Y FDIBH RSN 2571 v M.
RV =Tl R A 0EST. RV—  BE IO BLO &M Y OB —y 2> N &
g =2z MO V=) ) E1IE R T B ETHETEE T RV —%ER T3
B OR Y — 58 E LT B LOL AT CHRELET.

Ea2—

Policy ManageriZid . ¥ L2— YR B La— D2 IE DL 2—RHNET. N sld Ba—
(View)] A=a—h5Y—nA—D7 A 3% 209/ LTH) OB 2 2enTE T
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V=L HA RN
BT R —4r—T %

P P a—

CDE2—lk. 7 74V hCRTDOFE LA L SN I2F 2y /D YR MR IR S &
T PRy 7R YA M LT B /L —7 T B RE T BLUOF B 7F7RZ &2
FrylERKNTBHIELTEET (45414 . Web Application Security Consortium @43 % (2
W o1z DIZHNET).

Sewen Pernicious Kingdoms j Attack Groups j Severity j Threat Classes j
E||:|Q Standard E||:|O Standard EDO E||:|Q

B[]\ APL Abuse [B]iFy Audit Engines 5[] i Critical B-[H] 1) Authertication
E-[7] () Cade Quality 7[5 General Application Testi &-[E] & High B1-[HIER Adthorization

D@ Encapsulation [B](F General Text Searching |:| TMediunm D@ Client-side Attacks
B-[H]IEg) Enwironment [H](E Third-Party Web Applicat &[] 63 Low -[H](E) Command Execution
B-[E]( Errors [B]IE7 wweb Framewarks/Langu: &=-[H] (g Infa E-[8]I5g) Information Disclosure

D@ Input Yalidation and Rep [H](E Web Servers D@ Logical Attacks
B3-[E](f Security Features -[H]IfR Web Site Discovery
@ Time and State

----- 1P Custom Agents

..... [l Custom Checks

VR —F Y MR EEER T 2I2E . avE—F Y M EAT AN TW B3 F 2y oKy
JAEA > FlIE AL ET .

BH ST /— RO ICH B F 2y /Ry R, /— NN DAT7Y =7 FOTIEIR | A7—
ZA%ERN LET,

IF Authorization
=-[M]IER Client-side Attacks
-] Command Execution

o Frylld, TRTOATY 27 MEIN SN T BZEER LET.
e BFEONMIL. —HWOATY 7 MBI S T3 les R LET,
o« BORYIRE . AT 2/ MAEo- QRIS ThAa LI ear LET,

/a2 7R TmE Yy ILET

EI'-@ Authorization

H-[+] I CredentialfSession Prediction

[+l Insufficient Authorization

[+l Insufficient Session Expiration

&-[+]I[F Session Fixation

----- H 115 General Authentication Bypass {10854)

----- [] £ CORS Unsafe Methods Allawed {11278)

----- [w] €% Overly Permissive CORS Access Policy (11279)

----- [+] &% Prolonged Caching of CORS Preflight Response (11280}

----- () CoRs Functionality abuse {11282)

----- (1)) Session Token Discovery {11287)

----- f-j Insufficient Session ID Length (11288)

----- €9 Insufficient Session ID Entropy (11289)

----- 9 Predictable Session ID {11303)

----- Insecure Domain Access Policy For Session Cookjes (11304)
----- 88 HTTP Verb Tampering - Metwork Authentication Bypass (11499}
----- 9 Cross-Site Websocket Hijacking {11587)

----- 8 T Mone Algorithn Attack (11595)

&-[0] [ Client-side Attacks

[]D@ Command Execution
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V=L HA RN
BT R —4r—T %

BmEpra—

COE2—Tld FHE VA MBI LB DO TR B —Y o MR R TEET,
e Mas51EID

o fifi 55 1% 44

o« IV VERAT

o B KT HT H R

« CWEID

o Gt

o fBfEE
o FAT
o 218
o ZIRTER

COBERE G BN T 2F x5 DU 2cm b & i sn £9. 7282018 PHP A2 Y
TN E BTV —y R AF T A A ME 74—V RCIPHPL 21 R T& £ 9
MR KA &— B 3 2 = — = (3Policy Managercp DA RSN 26, FDIT—Y x> M
LUt O F 2y R 252 VT L CI—Y 2y MERBHICTEE T, ZDB A LIKY
~/~>:r1%7(?“9“%>(%0)¢ V2 —DZE T ARG T B) e 28 LicR Vo — &4l I E D A
FAOWlEH TBIENTEET,

ﬁ Policy Manager H=] B3

File Edit Wew Tools Help

+ 5 | | <2 standard Yiew |- Search Yiew

Criteria:

Surnmary * | |contains | |PHP Search
| = =) _searh |

¥ulnerabilities {1325)

| Mame | 1D | Type | Severity | Last Lpdated I;
[ Pharum comman. php Arbitrary File Source Disclasure 1360 3556 High 10/19/2017 8:136:53 PM |
- Fassible PHP Source Cod sa¢ Jwooe  JHgh 1o/
Possible PHP Source Code Disclosure 1384 10023 High 10/19/2017 8:04:15 PM
|_ php\Weblog Administrative Access 1425 3856 High 10/19/2017 §:36:52 PM
[ Piranha Configuration Remate Execution 1590 3556 Critical 10/19/2017 8:36:31 PM
- PCCS-MySGL Database Administration Configuration Information Disclosure 1961 3556 High 10/19/2017 8:36:14 PM
[T Basilix Webmail Configuration Information Disclosure 1970 3856 High 10/19/2017 8:36:12 PM
[T Badelue Configuration Information Disclasure/D0OS Aktack 2214 3856 Mediurn 10/19/2017 §:35:53 PM
C cbeoo bk it ik = Pt ik 1nf1niong ST
Attack Group:  General Text SearchingiSource Disclosure
Summary
-
Summary: Possible PHP Source Code Disclosure :I
Vulnerability 1D: 1384
CWE ID: 200

Kingdom: Envirenment

A serious vulnerability in the web application has been detected due fo the presence of publicly available PHP source code. Obfaining PHP

source code on a system allows an attacker to view the logic of the script and extract extremely wseful information such as code bugs or

logins and passwords. Recommendations include removing this script from the web server and moving it to a location not accessible from the -
< o™
Find %ulnerability in Standard Yiew

Ready
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V=L H AR
BT R —v2—Y ¥

CHHH B JZ8n

" Yy —" R—v85

"RV —OfE R Kk A" T
"HEE DI—Y 1 POMR" X—VT5
"HARXLTF I DAE R IR DRX—Y

AV —DFE B & 7213 A 5

Fortify WeblnspectiZld . £ {D2—H 1k s T& B & UK ET S e Fi S vr—of &
NERV =D O ENTHET, W ADR Y —EAMNICET §328ITEEY
ho 212U, I BDWTNAET 7 L—eLTH & WA FEHE LTHRRLR VY —%/E
B Uy AARSA X LI CDR Y —%5F LOZH CIRIF T2 8E TEET . HWARLKRYY—
E AT AR E T WHME B LIRF TEET,

RV —58n 5 23 E KT 2120

1. v—nu3—7T. Policy Manager] =77l £7.
- &2l -
E’—i(Tools)]> Policy Manager] DJIE (R L £,
Policy Managers3fi & &4 . 7 74V bClE L EEE R ) —HNo— RS 9,

2. LA WCERR Lic R Ve —(D & 0. ARARLR VY —) &8 EE T 2121 Pr1v(File)]> H
{Open)] DINFEIIEIR L. RV —#F IR L £
3. FAHl N vr—vM SR Uy —D1DER TR Uy —#E K T 212k, P r1v(File)]>

75 (New) ] DJIE (IR (£ 721 BB A V> —(New Policy)] 714 a>%27Vv2) L. #i L
WRVS—DET IS BRIV —ZIEIRN L L7

4. QBRI N—TWRIE T BF 2y /R v A& 2 VT (F1IGER) T B8 d->T . W8S
N—TERRN(EREE L ET. ZV—7 N OT— x> M FNICHER) & 72184 2
= o ﬁ%wwﬁﬁﬂsz*»e\azéu@“%%l/%/ﬁx%r%ﬁé%bi#

5. W7 V—T D4 A1 #ZH 3121
a. MBI Vv—7%4 7')‘77l,i?“0
b. ¥ Ay Ax=a—h56, BATZE E (Rename)] ZE#E IR L X7,
6. W WL—7%#EB T 31
a. MFEOWE I V—T%4H 7VvoL 1,
b. 7= btaybtA=a—mb6. BrFIBE 7 ) —7(New Attack Group)] #IZ R L £7.
[ W8 7 1 —7(New Attack Group)] & IH H 235@ §H s TR 8 S &9,
c. ZOF Lwv—"%4k 27Uy L. BREIZFE (Rename)] #1E I L 7.
d /IV—"TUCHBEI—Y > e NI/ 7Y RRayZ’ LTEM L &7,

7. HARLF 205 ER T AL TEET sf DO T T" A2 ZL T o 7 DVE R I
DR—v | #Z /L TIES0,
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VIV A AR
w7 Ry —v A —Y

8. HEI¥E # (Auto Update)] 7 =v 7+ v 7 AR R S Tu 335 4 « Fortify Weblnspect
& Micro Focus 7 —ZX—Zn AR 70— RSN B2 SN 21— o> MOF L
WEI—D x> NN T 20ER T 2%, TOWRH T— = bOSF BT 45 F 103k
DOTIRE LET. 12&21E . MicrosoftDIIS (Internet Information Server) %} % &3 %
W8 r—y > bR LT BHE)E# (Auto Update)] #i R 4 2 &. Fortify
Weblnspectid ¥ A7 AKX 7> a— T 3ISHE O 81—y x> MEF L EE A
Wz, RV —THA N 2T 2T—y o> M E T 28 LOE 21— x> MOFE T
SN I—v x> NIA RSN £7,

E: Av— N 7T — M & o TR yo— REN = LOETEE F 2o 2k . 2—5 D
YER LIz AR R LRV —ICH B TIIB TN & 2 A,

9. Pr4(File)]> BT 24t U TR (Save As)] DIEH ICIRIR L& 3. P A4 (File
name)] 7 t— NIZAARRXL RV —DZ R 2N J1 L. BRFF(Save)] #27YVy 7L T L
A Y3 —%Fortify WeblnspectOD* pollcyﬁ/fﬁ TIHRAFELET. 7 74 bR U —D BT (W
# (Assault). 75> 7(Blank). 12 % (Standard) % £) & ] L TR V> —%R 17 T3 28
T&EHF A

CHHH TS LFan

"HAZLT—Y 2 bOfE " R—76
"HfE DI—Y v FORR" R—T75
"HARLF 2y DIE " T

HARARLF 297 DIVE K

Fortify Weblnspectid £ 7F 7213 £ ¢ 2 F 207 4L DI 55 M 28 + 37291 CWeb+
A AR %z%ﬁ CHINET S, 77V —y [l O 51 2 3 3 AAKRLF =y
I E R A B NET

Fortlfy Weblnspectfﬁa% T3 20 EEE T IHIARLAF vl eER LIS %44 3
B O F 20 2 B L IR 0, 2O L F 292183505 S & ¥ AL 2ERIE . Fortify
Weblnspect(d il 7 . T (copy)] &> 5% 7497 ADfF 18 w77 v7 7 4L 7 MIERE 5

T AL M ZE F 2y FAT LET AR LIEARRL T 2003 L ERIRRIZH 7490 R
[(Copy) I Dt 13Tz 3 907 977 AL 2 MIRHRE § 2 F 297 C b 2854 1& . % 5114850
(327977 11 2 1 U((copy))(Backup Directory ((copy)))] &4 5% B O F v/ &M% 5 (2 L
%y &, Fortify Weblnspectid (207 4L 7 MET TR R LTOWBDT)ZDARRLF =y
RIEELEEA

ARRLF 290 EE R T BICiE:

1. Policy Manager#fi & 9

2. DLRT R LR Yy — 2§ 2121 Pr1v(File)]> B {Open)] DI &R
L. RU—%iERLET.

3. Hui Nvr—yfb anfeR Ve —E2F Sl LRV —%E il 335 v P
(File)]> Br#i(New)] DJIE (CIZ IR (& 721k Eﬁ%ﬁ A U —(New Pollcy)] 74’ avEIVY)
LB Lok ')/*-O)%T)I/CLT%)/T')/*"S: EIRL &,
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V=L AHA N
w7 Ry —v A —Y

4. fE#E ¢a—(Standard view)] 7E IR SN T T, £ DRA T ODHE FE L F N YA
PENTHBIEEMER L ET

5. WARZXALF zys(Custom Checks)] 4 2Vv/ L. ¥ 3 bAy b A=a—h5 PR HAK
4L F zy2(New Custom Check)] ## 4R L £ 7.

AARARLF 97 74— IR IR SN E7 .
Wizard |

Attack Type =
Select & type of attack to create. Q

—Description

Simple Attacks are attacks that are sent
File Extension Addition once for every server scanned.

Directony Enumeration

File Extension Replacement
Keyword Search

Parameter Injection

Simple Attack

Site: Search

o T T T e B

")

< Back MNeod = Cancel |

6. L N DBERATHH1DEERLET. F XA 7D & &, bl iR LZ
T,

« 7 4L 7 kY312 (Directory enumeration)
CDF xy/TEIRE LB R DT 4L 7 PR R S &7,
o W A7 7 41 7 14l % (Directory Enumeration)
o I % /directory_name/ (directory_nameld X 4 27 4L 7 NUD4 )
° ¥ 7 =F % [STATUSCODE]3\d\d OR [STATUSCODE]2\d\d OR
[STATUSCODE}40[13]
o 774 VHL5R F DB N (File extension addition)
CDRATDF /Tl T8 5E LI 7 A VIETR T 25 D7 AV R Sh &,

Fortify Weblnspectid Web$f & H (2] 65D 4§ & 60D 5R F D 7 71 (fz &4
I£' global.asa) &1 i 2 &, 20 LA CHA I T M Lidigk ¥ L2 —osfE L
TR R 7 W7 AV OHTTPE KR #1515 L& 9. /2&21E . =—¥ %8.backup &v»
27 74 ML 3R T 248 7€ L T 335 4« Fortify Weblnspectid global.asa &> 57 71 v
9 % &, %5 Ly Cglobal.asa.backup £ A7 A VAR L E T,

H . —/Ndglobal.asa 7 7 IVDER £ B L& 445, 70/ Seny—Eicy
OT7 9777 AN ER LTOT, ZO7 74 )W QYL TR T AMF T &
(global.asa.backup’ &£). 2D 7 71 )u(ZtLiZidglobal.asa” 71 IV D5E 4 &V —AD
FENTHE) S — PR LTLEI BEMERD VT,
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V=L HA RN
BT R —v2—Y ¥

K€ DIB N SNTALIR F 2FF D7 7AWV EM R T 3HARLF =y 7 B1E IR § 3121 .
AARLNF 297 74— RTCUL R 2N 1 LET.

o WM ZA7% 774 NILER T DI N (File Extension Addition)
o WE: ext(extid MR T 277D 77 IWAHLIR T ) JeBHIC Ky b&Tzid €UA R()
73‘;‘ D N g‘ —(“ j_ o
° ¥ 7 =7 % [STATUSCODE]200 AND ( [HEADERS]Content-Type:\stext/plain
OR [HEADERS]Content-Type:\sapplication/octet-stream )
o 77ANVIETRTF OB ¥ (File extension replacement)
CDEATDF zy /Tl FRIE LI 7 7AWILER T 2R D7 7AW R S £,

Jz &1 Fortify WeblnspectiZid #5598 1 .old B Wic 7 71 )V &M R 3 2EE HE D
FxyIhE EN T &3 . Weblnspectid Web#E & i ik ! 4 2/F & DL |l 6 £ O
2B OILER F D7 714 (12 £21E . startup.asp)ic DWW T 24 &4 B A CTHL 5R
ToldMf W TV 37 71 )U(12 £21E . startup.old) DHTTPE 3R #i% (5 L £7,

KrE DR T2 D77 MIVER R T AAARLAF 2o 0 BE LT B2k HARL
F 7 —RTCUL N 2N LETS

o W 2A7% 77 ALK T D HE ¥ (File Extension Replacement)

o W ext(Textl/EMR T B277A VD7 7ANILER F) e HHIC Ny hEzld EUA N
O £¢ 4.

° ¥ 7 =7 % [STATUSCODE]200 AND ( [HEADERS]Content-Type:\stext/plain
OR [HEADERS]Content-Type:\sapplication/octet-stream )
o F—u— i & (Keyword search)
CDEATDF 2y Tld 16 5E DR EE £/-13 55 A) (IE R LI CE H SN 3)BHTTPIS
BN IAFAE T 2hEMmEHELET,

X OFlE HTTPIG & T 2 fRIEH SR O O 7 MR L &9 (d=tE &
DHLT)o

o W R47" £—7— M K (Keyword Search)
o HUE:N/A
o ¥ 7 =7 ¥ [BODY)\d\d\d-\d\d-\d\d\d\d
o NI A—R&RA Y 27 a(Parameter injection)
CDRA7 DBEE Tl 51 BUE SBUECF I ICE &R 2 on &7
i :
http://www.samplesite.com/webapp.asp?ValidParameter=ValidArgument
DIRDE N SN &7,
http://www.samplesite.com/webapp.asp?ValidParameter=AttackArgument
REGA=BAL 2 273 SAE IR D & I B OhDFEERH V& T,
o I FE{T(Command Execution)
IvY REATOF 29Tl FER SCF 2 6% B30 FH S AL —T AT 2 AT A
LD avy RE A G DbE SN ET. ZNE(Web 77 Vr—y s BN 1 & F =y
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VIV A AR
w7 Ry —v A —Y

LT IE TE 2 WA ) Web 77 Vr—y 2R E O FH 2 LTavy
NEFAIT ST LT 2 ATT,
X O] Tl . support_page.cgi &y 97 m s SLCEE A N J1 RS 3k
T ATGA=RA Y 2y s R LT, IERR B & 8§ 27 — X0 HTTPIG
BT ENTwaGE. 770r—y 244 3wy FEAT T LTHESS vl ek
NEd,
o WH RAT" RS A—KA > 273 3(Parameter Injection)
o I % /support_page.cgi?file_name=|id|
« 7 =%y [BODY]uid= AND [BODY]gid=

o SQLA Y oy 3~
SQLA >y =y av b, 77 Vr—y 2ASQLI— R 1 4E T4 . Ch 50
BT HIESQLEE L O i TR S T 0. Web 77 U7y — avSQLAT—
boA> DA RS B CH B R O 2R L LA W T IO A 2 92
& ZDSQLAE L OWr iy 37 —RRN—AH—/NTHEAIT S &7,
o WM RAT" RS x—KA( > 273 3 (Parameter Injection)
o W (1DDT A ha74)
e V7 =F ¥ [STATUSCODE]5\d\d

° JuAH¥A MNA2Y7' T 427 (Cross-Site Scripting)
COME I KA F Iy E il S i2WebX—2 12, IE U AL S WA J1 A%
RSN TG AR ELLET. COGE . WBE LR SN 20— 108
= Dd sJavaScript i HiIA & BEODHZZOR—VEHE LI R D2—F D
VY YTCAINT MNEFEIT T RN TELT . 2—F BT F A M AvE—V A T&
YA ML COF LB LTHESS 2] BEtE b DT,
K O Tl . Fusion News 77 U7 —3y s> CD /R A A bAZ VT T 427 518 L
QA
o WH AT RS A=K1Y 273 3(Parameter Injection)
o I %2 /fullnews.php?id=<script>alert(document.cookie)</script>

o > 7 =7 v [ALL]Powered\sby\sFusion\sNews And [ALL]<script>alert\
(document\.cookie\)</script>

o FAL Y MY FIA—H L

7 AL 7 MY RIA—H L TIE L A IE AURLC 751 %15 L C. Weby— D av 7
YDA T 7 AL E T BUBE & M A=V 2 & LT,
=N DSFSELTAANET 7L ALEIELET, 12 EZ2E B H E2O0D Y
FRERZ 9y 203 F ()& &—4 vy BURLIZIE M L. h513—ZF 37 4L 2 b YD
W AEIES BN ¥ B8 EL 5T www.server.com/../../../..[password % £D
AT LANRAT—RZ7 ANV ER DU TENILT 7 AT B REHE D VLT,

K DF Tl « boot.ini 7 7/ VAR R S &9,
o WM AT RS A—KRA > 273 3(Parameter Injection)
o W) [./.0.0.0.1.1.1.].]./boot.ini
e V7 =7 v [ALL]\[boot\sloader\]
o FH N J7(Abnormal Input)
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w7 Ry —v A —Y

7.

FEHNSTOWBE L FHE . TR LN 881 S ThagwWeb 77 )7 —
YAy CRAFRGI AN 0l Z LM N a—F 4> 7 SN TH AR WIS—) 55| &
CTH RO B LT THER SN ET. Z DGE . RO FI I BFEA T 2 L.
T7Vr—y av DN AA=K LB T 2B R A R T 2T 7— Ayt —YH
P—NEORRSNET, V—AI—FLR SN 2G5 508 H0ET,

R OF| Tk N7 74 —"—=70—%5] &L CT 72012, IR WX FH 2515
a3 &4,

o WM AT RS A=K 273 3(Parameter Injection)

o T HE: AAAAAAAAAAAA.. . AAAAAAAA (3L 7 TAJD1000[0] D&% ik L)

e V7 =F+ [STATUSCODE]5\d\d

o H4h 7 % (Simple attack)

CDEAT DB I, Y—NEZAF v F 201 EE SN £7.

W OF Tk 2—7 v FOURL 7212 IP7 FL AN S Z 5] 21BN 3 2 2 &2 & 0.
UNIX S 27— R 7 71 )L OHL1E 23t & £

o B 217" 4 Y B2 (Simple Attack)
o I #: Jetc/passwd
o ¥ 7 =7 . [ALL]Jroot: AND [ALL]:0:0

#A4 M & (Site search)

CDRAT DB B ;. Web— N2 & G SN 22 enbh 771 V5 2H 1 TIT
BN ET. 22X IDTFE S 279D F 29/ Tld . log.htm eV I 77/ LA R L &4

R OH Tlg. Z—4 v FOURL 72 XIP7 FL A EE L 7 X 21BN+ 32 &2 & 0.
xanadu.htmlEW 37 7 VA E L &7,

o W ¥ A7 44 M %K (Site Search)
o I ¥ : xanadu.html
°© 3% =F v [STATUSCODE]2\d\d OR [STATUSCODE}40[1]

confidential.txt W IZ AT D 7 7 A IV EIR R T E2HARLF 2y BAE L § 2121 HAR
LAF oI —RCUL N EZANTILET,

o B 2A7" 44 M &K (Site Search)
o I % confidential.txt

o ¥ 7 =7 [STATUSCODE]2\d\d AND ([HEADERS]Content-Type:\stext/plain
OR [HEADERS]Content-Type:\sapplication/octet-stream)

IR N(Next)] #2717 L &9
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V=L HA RN
BT R —4r—T %

8. BE(Attack)] 71—V Fic . WM IfERH § 27— 1 L&Y
Wizard |

Signature =
Input the attack data to send. Q

—attack - Ex. fogi-binfissue. plzparam=/etc/passwd

I,l'persu:unnel,l'

—Signature
Search Far: |2IIIIII in |Response j I j
Response
Response Body Inzett |
Status Line
Headers

Skatus Descripkion
Cookies

< Back I Mexk = I Zancel |

FRODOT AL 7 MIFIZE OB DF v/ Tld. 2—7 v bMDOURLE7ZIEIP 7 ML A B H
% (Ipersonnell) ZiE fil & 2 2 &T. Tpersonnel] 057 4L 7 MUERR R L& .

9. 2 VU I/ =FrEIRET IV ELDHVET. v/ =F veld B2 2IE MR B H (IR A
K= &Rt & BRERR 2 7 % A N )T ¥ . Fortify Weblnspectid HTTP G 2 4% &
Ly 37 =F A Citih SNfc7 A MR DU 28, 20 vy i 55t 757 23 L
4. RS (Searchfor)] 74— FEFmy7 87> YR baAt ] LCIE 3 £ 37 #4F
W 2IENTEET VAV RVD RN HZTFA M I AIER KRR 2EEAN I
52EHTCEET,
R & xt % (Search for)] 74—v FEEH 4 21214
a. MRITB7TFAMEANTILES,

&t % (Search for)] 74—V NIZIE 7HF A MDA EAN T L &T . EHREKBEA
T LT 20,

ZOf (Tpersonnel] & 57 4L 7 MIEMIR §2)D5 6 7 4L 7 NIBMELE T 585
Bl — W AT—ZAa— F200%1R $ DT, BEXF %R (Search for)] 71— Rz
(2001 &N JJL&Ed. 22 LEB . 2007 4 £7213300% & D AT —KAI— R
P AT—RAT— 401 £7215403%22 TN N 2 & 4 HBTL £
. FayT R REE 7V L TR ER T AHTTPIGE D /7y v 2f e L& T,

C. (A7 NVEMABMREZER TG 5. 28H D kayr/ X727y /LT 7—
Vi 7 (AND. OR. #7213 NOT)#i#4R L £ .

d. #A(nsert)] Z/Vy/L &7,

e. (A7 2NEH LR EIT IGEE LB WS CTAT v7aradz4E DR LET.
THEDOTF A MRy AR N SN BIEH R 2446 £ d B 72288 T&&
ER
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10. A(Next)] #7UvrL &7,
Wizard |

Report information
Fill out the report information and set the vulnerability severity,

Surnmarty |Im|:||i|:ati|:-n Execution I Fix | Reference Info

Check Type: |vulnerability j Severity: Ian j

« Back. I Fimish I Zancel |

11. | A— rO15 3R (Report Information)] A4 L& 7% 27Uy oL, 3B ELTRRE T2
TEAMENTILET,

12. R D&A(7(Check Type)] YA b aTH H £3%4R L £,

13. E KB (Severity)] VA &8 K LNVEEIR L&,

14. 87T (Finish)] £ 7Yyl &7

15. 7 74V 4 TNew Custom Check] % F =y 27D H M 23 » 22 I L H L &7

Seven Pernicious Kingdoms j

E||E|g Standard

GI-[5][FF API Abuse

Code Quality

|E| Encapsulation

|E| Ervvironment

E-[5] I Errars

|E| Input validation and Representation

-5 Fecurity Features

&-[#]Ig8 Time and State

----- 1P Custam Agents

B[ I Custom Checks
L] ey Custam Check

16. HARLF v B o TOB(F v /— 0 W T B) IR L £,
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VIV A AR
w7 RV —vr—Y v

17.

Seven Pernicious Kingdoms j

=-[E]{g) Standard
E-[5]IE8 API Abuse
B[] Code Quality
&-[5]If8 Encapsulation
E-[5]I Environment
G&-[5] g Errars
D@ Input Yalidation and Representation
E-[5]IES Security Features
&-[¥]Ig8 Time and State
----- [ 148 Custom Agents

B-[v] g Custam Checks

Fov7' &7 YR Mps B 7 —7(Attack Groups)] 2R L. mx 27Uy C B

x> ¥ (Audit Engines)] 74VXEEB L £ 4.

Atkack Groups

[

Audit Options

Adaptive Agents

arbitrary Remote File Incude
Comment Checks

Zookie Injeckion

Cross Site Scripking
Directory Enurmeration
Directory Extension Addition
File Extension

Filz Prefix

File Suffix

Fixed Checks
Flashstaticanalysis

Fortify Agent Probe Engine
Header Injection

keyword Search

knoven Yulmerabilities

Local File Inclusion
Persistent Cross-Site Scripting
Postdata Injection

Postdata Seguence

Query Injectian

Query Sequence

Reclassify

Request Modification

Site Search

S0AF Assessment

SQL Injection
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V=L HA RN
BT R —v2—Y ¥

18. WMOEX2ZW L. MER LI2F 2wl RA7 0k LCHY) 2B E > oG ek T
WB(Fzyl~v— 00T LT B) EEHER LT,

BEOR(T... fEHT2EBEII ..

7 4L 7 |\ V¥l %% (Directory Enumeration) 7 4L 7 b V41 2% (Directory
Enumeration)

7 74 WAL HR T DB hn (File Extension 7 74 WAL 5k T (File Extension)
Addition)

7 74 WL ER T D B # (File Extension 7 74 WAL 5k T (File Extension)
Replacement)

*—7— N % (Keyword Search) F—17— M & (Keyword Search)
INFGA—=LRA ¥ =73 3> (Parameter Post7—%4 > =73 a2/(Post Data
Injection) Injection)

B 40 4 2 (Simple Attack) %€ F =y (Fixed Checks)

1 M ‘& (Site Search) 41 M 2 (Site Search)

19. P74 File)]> {77 (Save)] DNE (IR L £ 7.
20. LRV —OL I 2N S LT, E(Save)] £ 7Vl £4.

Fortify Weblnspect#3 3 X TDAARLF =y 2% T X TOAV—ITBM L &T. 12720, B2
KL LERA MDAV —THRRLF 290 %[ T B2 TR Vo —D1E i & 721 4 42
"A—UB51 SR L TS0,

ARRLF 27 BT B2
1. HARLF =yl #IERPLE T,

2. AT T2 F v R REF LT,
ARRLF 7 %HI B ¥ 3i2iE:

HR! RV hRRAF 2y &HIB§ 28 TDF 2o/ BRI XRTORYS—EV AT
LEAR ol B & F 9.

1. ARRLF 2o %4 2L 7.
2. v thvbAza—s BBk (Delete)] #iE R L £,
ARRLF 2yl %8R ¥ BI2is:

1. RU>—%B &£9.
2. ARARLF ool 5B L E7.
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=LA R
BT R —4r—T %

3. Policy Manager®4i XA > C. #ARXLF zvD7 07455 TH L&,
B Policy Manager M=

File  Edit Wiew Tools  Help

3 5[] e |

Seven Pernicious Kingdoms j Attack Type: IDirectu:ur',-' Enurmer ation ﬂ
EIDO Standard Check Type: I'v'ulnerability j
BI-[5] [ AP Abuse ) -
: 2 b
@ Code Quality Severity: ILDW
E-[E](E Encapsulation Attack: I,l'persnnnel,l'
B-[5] ) Enviranment Signature:  [[STATUSCODE]3\d\d OR[STATUSCODEIR\di OR [3 edc__|

E-[5] 15 Errars
D@ Input Validation and Represe
E-[E]IER Security Features & Folder named "Personnel” was Found on the webserver,
B[] Time and State

[ | Custom Agents

B-[+](FR Custam Checks

NS Fersonnel File Check

Surnnary |Im|:n|iu:atiu:|n I Execution I Fiz I Reference Info I

1 | B

Ready

4. [R{7(Save)] 7Aa>#2sVyrL &7,
CHHH TSR L3

"ERRB A—v97
"IEFL# I OB <98

B E DIT— 2 PO R

K5 & ONE 53 PE F o 2/(M B =—2 => N 1R § %121 Policy Manager® & %
(Search)] ba—%{fH L. 2D% . il * DI—y 22 b E D 205 T 20518 T &
9,

W8 T— o bR 312

1. V=3 —7T. Policy Manager] #7Vv7L 7.
-l -
E/—i(Tools)]> Policy Manager] DJIE (ZIE R L £
2. RYv—#ER LT 0GEE. B U—2F] {Open Policy)l 74> K6k ) —
FIER L. DK]Z27VvoL &9,
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V=L HA RN
BT R —v2—Y ¥

3.

©

7~ (View)]> [RZ&E (Search)] DJE IR L 4.

TRTCOYE T— > bOF I I M E . Bk, FIT R BELEDON L RA—h
T4V RIDE N TOET MRBEEE 2 H 728 IR LIL A— 71—V F TR
FELETFAMS OB -V M RETEET,

JE#2 (Criteria)] VA Mo R T 5L ER— b 74—V REIER L E T

FovZ7 &7 YA MralEH T 28R LET( B Lu@s)]. B YK &u(is greater
than)]. [ O/ Sus(is greaterthan)]. & ©(contains)]).

FTEAMNRYIA MM RETB7TFA NGB F AN ST LET
& (Search)] 2 27Vv/L &7,

Policy Manager® BFzvyZ(Checks)] VU7 MR R KM &~ BT 39X TCOB B 1—
VIV MAYA RSN ET . TIOT A7 T— =2 MO R DR IZIE . F =y 7 ~— 20 L
TWET . FryI R I REAANEIEANCT BIET, =V 2 N7 0T 47 (1214
ETITANTBIENTEET

[R7E(Save)] # 7y LT 8 LR Vo — %747 L& T,

HAARLIT— = NOff F

Fortify Weblnspect D 2 sk BE BB (& AHAK N O Y 7 b = 7B F & 03B 5 L. #ARA
T—Y x» &L TSecureBasell A LEd. I sld. RV —THZICLTAF x> DEAT
AE ] T 22N T & £9 . Policy Manger CAAR L T— > NEH R T 21213

1.

2
3
4
5.
A v EFEATTREXBMILEARRLAT—Y 22 N o255 O RV —5IBIR L &
ER

ROOTNHEFEITLET,

o NARLT—V 2 M 2yIDE T G LR Yy —2El 2. Priw
(File)]> Br#i(New)]> B DR Y3 —(Blank Policy)] DJIE (23 €K L T X7 v72(2
ALY,

o NARLI—Y zv Mzl BEAEDHR VY —HN DM O F =y 0 &4 (ZH #1738
BlE AT v72CHE A T
FRv 7B YR e, TOOFELR]#RINLET.
A& L T—Y x> MCustom Agents)] 7 v —7"%] & £5
DA MBS HARLT—Y 2> MR L ET.
P 714 V(File)]> {777 (Save)] DJE (ZiE4R L 7.

VE: B 3 E LR BEBE 21 A B L7215 & & Policy Manager 5 U T2 SH: B L
<A

WE] SNTeHARRLTI—Y = b ERE T 20 E n3HDFE T,
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V=L H AR
BT R —v2—Y ¥

FE

Web 77 V47— 312k« WebH 1 NAE R § 23— RI2U0 Tk % < WebH 1 F— R ICA
Bl LTI L DD T BB 7—F 7 /F vavRi—2 > b EN&4. Web77'Y
r— DL F VT AT T B L& T ICA B ST BE 4 120 Tl & < Web+
A N O 128 21D T 23R TCOarE—4 Y MEEBE LATRIEZDEE A,

Fortify WeblnspectidWeb 77" V7 — 3> 25 Hr L TEE N & 2 % 297 1.1 OKR B 245 &
L.#FA SN T Wa—NEFN6E2EH TEXB3EN% BHIIC. ¥ 2U7 1D B i ik
T 2DV E LT ORI AE L L. WebD & L340 Lt i 38A + Iv ok tita
Tl R DOEF VT V=V E L § 26 b B T . COM 28 % Ly
Micro Focus D& &t #— 24l VY 7 b7 27 M F & 272002 I LIzBEZn DN v v 7 F
1 ERLER LI AN A DF L 9P R—2AH0H 8) o S 24 ik st L& L. B8 0% .
VI 2TE T AT R DT 7V r—y 2% LTEN 6D/ yF 7 Fik #1332 — L &
T, F Ly RXR—2RIE ., Micro FocusDt ¥ 2)7 1DHE M F 20T & SFS £ —F3—
FADKF Dt F 207 AHAE LT F VAR M o)a ANE ST ET,

B LOLIL R 5 A & 3 & Micro Focus it SecureBase™ffi 55 1t 7 — &N—2 % 2D
HODbW7v7 7L —FKLET. L Fid.Web7 7 Vr— 2D v F 297 14 & Offi 55 1 25F
fili 3 % £ & ZFortify Weblnspect2Mii f|l ¢ 2% & Fik T1

IR 5 A— XA

IS A—BHEAE Tl URLAS S A—RE S A LT 22— A0 & 20 o8 F] T &% Wi 3R #8L

BLET, NIA—KBIE T NTA—RZ BLO 138 B 2250 BN, 8B L
Fo.HEAMC, FAGN T TUETA[RETT . NI A—KPENE BB L. Web)L— rD F D
TZ7AWVDE IR T —ARXR—Z05DB R OMH . BIME R DAL —T 4TV AT LL N

ATy RDEAT K E. WOROH P DIER DDA &4, COFF LI st L
T s £9.

o JTUNFEH . . Web77' V75— aid. 2547 ber— o7 —R&0E ¢ B )7k &
LTI FEN M 258582 BTt 72U FEINIE A=) 227 — &K
CHLEFEM L, Vo 23N iz_R—Y KR SN ISR #E 27504 WBE L2
T FH EE LT B BT —aR—2h o5 R 21 A2 0. Web 77 Vr—3 20D
T—% 7 7 F x5t Al #NTF L1z 0, Weby— N FE Cavr FEEAT L0 28] §E%: 23D
n& ¥ . Fortify Weblnspectid & 75 217 BE . & E & 7T U F V) BAE 2R 2 L TH—A
TOaVvy FOFEAT OEB M 2R L. 7T USCF A #AE okt 3+ 2Web 77 V75— 3> @
feggtk 28 LT,

o Post7—&. 7T UL FH DEAE L, 7V DT RLAN—IZTF AN T]§ 5L
BIITERED, 2 {DWeb7 7' Vr— 3> Tk GETTld % & 74— L EPOST XV v %
HAGDODE A T2282E 5T R—=YH] TCOF—KDZZ I LEIT >CH &3, 18
WL 7 IV TIEPOSTF —&NE R S Wi, — B D71l Sk 7—XD%E T i
Rl B & 720 A AT BE 72 & WA A T & 28, KR IL I8 T4, Fortify Weblnspectid /% 5
A—ZEEAE DPOST AV v FEFH LIz B oxt + 277075 —y 2O §5 1 24 2 L £
T
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w7 R —vr—Y v

o AKX, HTTPE K U2 Tld HTTP v — B 3 215 3R 05| &I Lz~ vxoMd ] &
NFd. % DWeb77 V75— ad b5 7497 D& 5115 3R 2N EE 4 27201l referrer] %
luser-agent] % EDN\ v & T —ZR—AZ 07508 LT BRI 6 kb 59 HTTPAN v& %
ANV THBER 2 LT W FEH Lo &7, Fortify Weblnspectid B 25 OB e\ v
SER G L CIESERNTAKME 22 FFE T el A 7,

o Ivk—. % {OWeb77 Vr—y i 2y —£Mi il LT, 2—HIDP XA LAK T 7% ED
BIREIIAT Y MDY VRAF LET BREODOHZ2—F k. T 5OfE 22 L7z 0,
Ik =% KAX =0T | L1200 BCEC A D2—FDT7HT Y bR IRICT 78 A ¢ 0]
REENDVET., T . WBEN2—HFDIvF—2E A IDENSAT— DN J] % EDRE
REENANRALT, 2= DT AV MCHE 772 A$ 2288 H D& T . Fortify
Weblnspectid AF x> I H SN 23 RXTD 7yF—% VAN B ERICZN 5D/
A—RDIEH 2 A £T .

RGA—ZEANEZ IR D 7y 3> T 24 9%, WOLDY T HTINH T 6 £9.
WNGA—BRA Y 27y 3~

NIA=BAL 2y 20y 2 BB T, G HE P L F A CE &SR isn £7 .

% -

[ http://www.site.com/webapp.asp?ValidParameter=ValidArgument ] %

[ http://www.site.com/webapp.asp?ValidParameter=AttackString | (ZZ8 ¥ L &9
URLICEHIH ¢ 2R 54— REEAFE L& T B2 A B BIRD L OB ICO%
v ES

vy FEAT

IV FRITWBOL TG FFR LT EARL—T 4V T AT ALV avy RO A&
DETHER SN £, Web 77 V75— 3o Ji WCEF R L7 2T € 5 COXLF A 54
RL—T AV AT LAY RO U LT 3258 COXFIDANL—T 4TV AT
ALV FOFET SN FT,

%1 5id;

Fortify WeblnspectizID av> FA EDE DL L awy FEEE LT WRF L E->Tavr b
DI SN THEAT SN 20 etk 2R L £,

SQLA>Y z7y av

SQLA vy =/ s did . REPEX L THLWSQLI— FE 77 Vr—y 32 T8 {/E
TT. N SO F 51X SQLIE L OWr Fr vyl il S TH V. Web 77 Ur— 3o
SQLA7T— b A bR AL 3 2B (S HT SRR € O F 2 32 2 &% <O F 4 #H H
T3 &, ZOSQLIE T OWr i 737 —ZR—AH— " TEAT SN &7,

#1:'+(SELECT TOP 1 name FROM sysobjects WHERE 1=1)+'

SQLYL FH 2 L Ca2— WM EI DYV AT LET TV r—y D7 /v AE 55 2 28%0
NHDHTHRAMa74() & EOBEE 3D Z0] Ge 14 2D BN 11k} 3 085 xf 3K 25 7 & »
LT WE MENEETEZENDNET,
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BT R —v2—Y ¥

JaAYA NRIVT T4V T

u@F”ﬁ-EFE & ZAF Iv 2 il S ieWebX—2 iz, IF L $&EE én?éew)\jj DR IR SN T

WA A WCHELET., OGS BE G R SN EZ2OR—UICE & O H 2JavaScript
5_,@&;;4& HE % 0)@5%0)/\~/’<?:F;§ﬁ LIAEE 0)1~47L0)7//’(7\7')7 NEFEATT 2
CUMTEET, 2T E R b A =Y E TR CEBH A M. CD & I B o6t LT

S anpettrnd nEd. COfEsEEE. LR L H e &7

ANTENIHMEF—7— N8B R TR Y

I5— 455 O FH 54 IR § 25— Ayb—

i 5% TC2—H IR R SN BN 75— A

22— EH D Avb— 2 Fe T & 2Web Ayt —Y R — K,

WEH N IR A NRAIVT T AV TR I T 2 &, B2 1 3R 75‘5@% SN0, 7yx—hi
VE #1235 S 120 B3 & 2—H DL D L iE 2 o1 20] Ge 1 23D 28 K HME AL S 7z
N.EBEODHZI—FR2—H DY AT LATEAT én#%%%m&%@iff

BENN

EENNTBBOLFZH G T LN ] BN S wWeb 77 ) 75—y 21280 T
RALFEGIINT 07 S LM TER WIS ) %G| &GS IR et 236 230 7 CHE L Sh &
T, Z DG E . RWUFEG A &8, 77 Vr—y avOW H AH=K L2 3 282 15
WEM R T35 Avbe—YBERENET, V—RAa— LR SN 2GS WD VET .

% %00

INTG A= RF—/"\—T7 10—

NIGA=ZF—N—=T70—I B TlL, R"FTA=RE L 7 vF—NvZDG| F 121k 35 A— K%
DR TWeb 77 V75— s KE D7 —XHhiEE S Ed. Web 77 Vr—y v FHI L
HOKBEOF— XYW TC&2LN 70/ L3N TOU AW S G [FE DAL —
TAVT VAT ALV I— RINEAT SN2, —EAE BIRE 25| &G 37204 27] {
HrRdEd.

Ny7 7D A—/3—T7a—

/\“y77®7f*‘/\‘*‘7m—‘1&$§61\ FEEDANL—F AV T AT L avy NEFEAT § 2zl
i s 20 et 23d 0 £ 3. Fortify Weblnspectid /Y v 7 7D A —/N\—7o0—K B 2%} L THfg
e 9/95%%% L N o770 F—"—=70—0Hi §5 1% 212 1E 3 2720 OFF 41 1% ik 2324t L
7,

i
http://www.site.com/webapp.asp?ValidParameter=ValidArgument
IR D ENAEH S F 7

http://www.site.com/webapp.asp?XXXXXXXXXXXXXXXXX B 512 T 1# O
7 ] XXX=ValidArgument

ROENEFE SNDGELHVET .
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w7 Ry —v A —Y

http://www.site.com/webapp.asp?ValidParameter=XXXXXXXXXXXXXXXXX [ 5i2#
T DI 5 IXXX

XS A—Z3B N

NEIA—ZBINILE Tk HIE SN Twa, i EL s Tnuanw 77 Vr—y o8 fE
T 7R ALIZ0. NER D77V r— avik 8 #8AE LIz Dd Bz HTTPZ R 12 Lus /s
Z A—RX(admin=true % £)3Mf N S £7,

77 Vr— ao T A7 £ Xy R7E— RD /NN A—XK

T7Vr—3 av 7 NyF Ny RT7E— D /AT A— R B RGE Dizdic7nl 5=l &>
Bhnan, LER SN TOH LR LTIV —y MEBE THBIENZ WEDTT. 73y
E— RNy I RTE—RET 72 ASN 26 Web 77 V75— s DN i AH=K LA0F B i
e b EE RSN Z VT A G nH NE T,

i
http://www.site.com/webapp.asp?ValidParameter=ValidArgument&debug=true
NRBAE

SAERAE L Tk, Webl— FD L D774 WAD T 21 A MR 58 DAA /8RR, 7 4
L7 M) —BEDEIR. £12E 77V Y —ADE IR D22, HTTPE 5k DRequest-URI & 7
BT &G INET NABIEDOF LG IRDEIGELDBHNET,

SADY] i T

NADY) 0FE TH B, 77ANVZ DL R OT 4L 7 MER B ZER TF. iz &0,
F AL 7 M) B ALK IR S B & A d D ET . Fortify Weblnspectid /3 2DV 0¥ T E5E 4T
Ls ZORRICT AL 2 NID— B AR R SN0 BE 25— E Lol LhEiER L
ES 2P

ViR

> 2121 http://lwww.site.com/folder1/folder2/file.asp ] 735 &4 235 & . /S A%V Ok CT
[ http://www.site.com/folder1/folder2/ | %°T http://www.site.com/folder1/] D &K 1T H&.
WebH—/3237 4L 7 PUDH 2 B 7R Lz Dy KRGS 3584 LIzl &5,

NETya—T 47

WFTya—7 4 BT B O VY — Akt ¢ B3E R O O A, i EE 2% 0
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Implementation Guide)lZi&. 77 V7 —y > OB B FE &K B + 3¢ 207 44K
VANDNET . CORY—I2E . DISASTIG </V\—2 22> % 4 % a—T 47 DEAN %
TV —3 3Nl 12§ 12D AR S DI E SN F 2o/ NE R ET . AR v —T1
& DISASTIGR VY —DEEH DN— s dFIE T 2585 HhHNET.

o BN ENAWAF UL ENANT T VT —y g e A— M BNy Ty Y —
EADM CHE SN -EE KK DL T, ¥ a7 L ORM s LEd.

« NoSQL® & U'Node.js: DK Uy —id. +—/ D H ) Webfk % 28 A TH Y. NoSQL
R—AD7 —LZX—ZA(MongoDB 7% £)*°. JavaScriptX\—ADH—{l| { > T7S5A N5 7F %
(Node.js7% £) &xf R LI2BE A ERFI ONE S5 D F =90 7 &FAT L £ 7,
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Testing) Bk 21 | 24 RXRTOF 2y /03 & N T &7,

o NV TRF ¥V Nyy T AFX xR Yy —Id | TR & T2 A7 a4 bEFEE S€ 4 KTHR
R e 77V —y 2 Offi 551t # A v LET. LieasoCL i — 0ot LT e
BUEITTEET, CORV—ICEoTHH SN A[E55 1 wid . S ADB /R ORI E ., =
F— Ayt —V OB, B LU LI E 245 D20 ORI E 7S g £7.

» PCI Software Security Framework </Y—2> 22> (PCI SSF </¥—2 2>>): PCI SSF {4 .
YRGBTV AT LAEL NG I oy 2 Y 7 by 27 BT B2 DEEAE &
HALY ADR—A54 VRt L& . COAR Y —i2id. PCISSFD% 4 4 a—F 47 D
B2 e ol B ECE DN ERDEF v/ EH N THET,
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W ENTHET., N, SIS Fn A0y 2oy B, PSUAR—NE DR F 2
TABERTIANS—ZENG FNETH. TAL 2 NIFIZER N 9o T7 77 74 L DFR
REEDT Ry —7 220 IE& N FA. CORV—IC & >THRH Sn 2 55 1%
FITNT. B E Lo H BN SN 2T REMERDHVET, CORY—% 54T

MUl RV — A DR THEH $ 22T, 25472 e — O Jj A3 —F B2 EN
T&&E9d.

e SQLA>Y z7y 2 SQLA > Y 27y R Yy —Id, SQLA > Y 27> 3> Offi §5 14 12 Db
T -Web77V7r—y 22Dt F 27 4AF ¥ H#EITLET. SQLA VY 27y av did . A
1R EE St v E0 E S T 2R L TWeb 77 )7 —3 avh AF 5 OSQL 2T )% 2
VU REE L. Ayl TY FDF—ZR—ATCHEAIT S 20 BT TT,

o MIVAR—ME F V74 COHR VY —ldk, %4 THOSSLTLSER E . IV AHA— b
J& DFE K % ¥ 207 4ffi 55 ¥ (Heartbleed % % . PoodleX{ % . SSLF 2> T — 3
B 2 DB T Web 77 )r—y oDt % 2 V7 5]l #5247 L7

e WebSocket: COK V> —Id. 77 U7r—3 3N DWebSocket s 25 (2 B i + 2/ 55 1 %

MmELET.

AR R L

ARRLNTI N—T11F s 2—FMERR LI TR TOR Yy —&, 22— LI ARRLKRY
S ENET .

ja b

fa g 7 v—712ik I b — A\ DfEE 5] & ST B8 S 2 —EAE R IE 4 ED
Gl 2 AR F vl 55 ATORR) =0 N Fd. COR Y —IE, IEH LA OH—
NBE LV AT LDE AT H LT &0,

o BF 1yl B F vyl AF v E T NDHFIWebiR B 1 E &1L TB 0O, 7T —KZX—ZT
&b 2SecureBase D7 /7 A7 KT NTDF zy 7% FKAT LET . CDOARF v12id . FortifyD
Web 77 V7 —3 3 EWebH—E 2D 551 D A ¥ x> Dz 08 5 ©F| H 7] G % 2>~
SAT VAL R—MIYAPSNBZETXRTDF 2oV E N F9 . N id . WebH— 3 |
Web 77 V75— ax4—NJE | 8LUOWeb 77 V77— & TORE &N &K 41 DJifE 55 14 D
F oG ENET,

VEE! 2 Fzv/AF ¥yl T—BER—ALT—REE ZIAALY, 7r— L5815 E L
20, H—EAE BIRE 2R A SU 0T B[R DH B F 2o s N T &Y,
Fortifyld . 45 F xy2H Vo —Id 7 A MR COARME ] 32 L4560 6@ L &7,
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VI EAE T BIET  Web 77V r—y D F 2 YT ARF v EET L. TSV —

Yoo i Rl 4 B DB B DA ZEFE LET. TVX—TF( AL )LDWeb 77"
T—3 DAF Y EFET TG E5E. 7T7)V5r— DA DKR IV —457 5y N 74— LD
ADENV—UHAGOETHH T22ET. AF v O JE XU & £tk LT
1280y,

W EFEHER): BB, 2+ vl — D B WebiE R 25 £ TH ). WebH—
& . Web77' Vr—y avH—N\E ., 8ELUWeb 77 V77— avf@ THEH 8 £ UK H1 DJifg
FMEDOF s B ET LET, B ZF vk —ERIE BIR RE 25| & 240 Gt
NHDF oSG N T, B AX v E T A MNERE COAMETH 228455 <BEID L
ES

R OF o7 77./00 D54 7H A 2IVHE D DA o, FHR BN 6% 21 LT
WD O FE A B ofeFzvoaR )y —moll T30 ERAHNET. JF4E
BOFzyrRVr—i2id B OE KPR CHE DOTIRE 28 20l st feF =y
7%, a7Weblnspect 7L — A4 7— 7D I OYL 5R B BE 216 F 3 2 A~— TR R &
BETVIVALEGH L THEE SO F oo N &7,

BIREHEGEER): HRE A v lld ¥ — O B)WebiR Z 25 Fh TH H. Web 77
Vor—s g IR E LIBERT 6 SOR K OB 55 O F =97 FAT LET. COR Yy —
. —ERAE SR 25 SR ST A REME DD 2 F 2o 2ld EAT L wWOT E ] v A7
LATREBEIIFEITTEET,

OpenSSL Heartbleed(FEH#HER): cOR Ve —id. B K ATLS/— he— it A B OA—
N=F D 55 DN T Web 77 )7 — Dt ¥ 207 14l 2247 L&d. COff
B SN BEOH BN, A bR A TORH—NIAE LR D N—e—
NESR 21805 L1551 =3 AT VN OE B 24— 86 L UWeb 77" )7 — 32D
TN AT B REE D VLT,

OWASP Top 10 Application Security Risks - 2010 (JE#2R): COR V> —ik. Web 77
Nr—y >t F 297 4O5 K IR DX HE 242 it L £ 9. OWASP Top 10i& . Web 77" V7 —
YO VERKLLF 29T AL DREICOOTONE AV arve 4 AR LET,
OWASP Top 1004k 4. B2 5 MAR A OV 7 by =75 58 Mk &% 42 % a— P&k
A TN LI SE 210 DH LRI LA DAT V7 EF 247 COKR Yy —IZ
42010 Top 10 VA MZ[E A OE R A £ T & 9. FF A DL Tl TOWASP Top
Ten Project] #Z il L T2 &0,

75y b 74— AFEHER): COR Y —id. B IcWebH—/3 8 S UL 5 OWeb 77" )7 —2 3
X LT B 2155 $22EC . Web 77 Vr—y 22759 b 75— LDt F 27 1A% %
VEFEITLET. TVE—TFA ALV DWeb 77 V5 —y 2D A* v 54T 4 2155
EN T T9 74— LDEDRNV—,T7TVr—2 2> DADR Y —tH A H b Tl 7
BIET AF v D E LAV & 2508 1 LT <280,

QA(FEHER): COAR VY —id. QA K K HAWeb 77" V7 — a & ¥ 207 AOF S » o7
7 NY)—ADIRE 2 F TR BET. k. Web77 Vr—y 2o DB H B £
KA OW T D F 292 5E4T LET, 2P, G 2E sARF 2o 3 FEAIT La 0w
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Web 77 Vr—y avt—nfE | 8LUWeb 77 Vr— avf@ T, AY y—/\y7r—v D
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REBEECSEIUNREDODZ2F 2o ld FEAT L Wicd EH Y AT A TR WHEIT T
RES

o t—7AEHER): t— 72 F vlid . — D[ B WebiR R 2% £ THE D, WebH—
B . Web77' Vr—y avH4—\J& . 8ELUWeb 77 V75— avf@ T, AY v—/ 97 —v D
BE &N DG 59 PE DIZ LA E & RFIDHETFE DL OMICDNWTDF 292 %8FEIT LET,
C—TAF ¥ EEEDORE OV AT LATYH, —EAE SR RE 25| &8 2o nl fEH D
HBF I EEAT LEE A

o REVE(IEHER): AT UE RS ) A Vs —id  R12015 Y )—ATHEG] SN BHT D b &b LOIE:
WRY—LEI CEDTT ., FEHE 2% v2lid . — 3D BIWebiR B 238 Fn TH Y,
WebHy—\JE . Web 77" V7r— av4—\JE& . 5L UWeb 77 Vr—y av @ CREAI & L O
RKEOME I D F xvr#FAT LET. FE XX vid . Y—EeREBRE2ELCSE D
A REME DD 2 F 2o 2ld FEAT Lo BH VAT ATCE R FEITTCELT,

CHHH TS LFan

"Ry AU RX—U62

Policy Manager® 7 A 2>
X D3 Tl Policy Manager® > Y)—bt2—Ti H S 274 3> D0 TR LTwW &4,
74av R
<@ Ay —,

W 7 V—7"7 5V Wa 55 PEREA 25 & 74L&

=

& R T BETEEMM T 2720202 v b, LEZE A MRR
EEETFILO T PIEROFATCOOTE T FIA" =277 ]
EBW LTSN,

o W E N — N Tavy FeFEAT L0l NE R 20AE 68 S O0E
WL TE2a et Db 28 K 2 la 59 1 .

® LNV EE . — . YV—Aa— R, Webv— MDD 7710, B
JUOBEBZE M DE WI5— Ayt —Y ORI NET,

e thL OV DS 55 1 o B 5 M Ve WAT BE T O BHTMLEL A D = 5— &

TSR &7m L&,

- MLV OMEEEM . I H $XREME, £23 05 L)L E 2
% BAREME DD B E A8 LET
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Fortify Weblnspectid LA F OB & 2> v & L & 4.

7&7 7 47— = MAdaptive Agents): —# Dfi g5t id. 2OMECKEDORY v7
EFBEELET, 82 Ny rA—n"—T7o0—=JRunF zv 2t i 551 7 —ZR— R A
HUTT & =030 59223 32030 0& 3. 2ROV, BY) & 2 oY vl
27877 471—Y 2> MERR LT, CORE £ § 2N TEET. COAV—
b 77'a—F12 & 0. Fortify Weblnspectis . £ & O 77 Vr— a IR E5 (A of-1d ) %
STAR VY — R EAR G ) I L E T,
£ & D VE— b7 71 VD &I\ & (Arbitrary Remote File Include): 2O x> vk, B
12 MR T B(E E OURLA A7 — K& 7xyF L TH AN &S R 240 &hia e Ofifi 55 1
DEWhEFzyIL &7,
I A bF zyZ(Comment Checks): I 4> ME# Tld. a4 MY IZ 7714 7213 URL
D ahE, vy LA L ET. 77V HA FREURLE I 328, 2D 771 )L &
I URLDFAE T 20 E e LET .
7 9% —A Yz a(Cookie Injection): 7 v¥ —E LUNYKXIE, 7+—LDTF A M 74—
WIRERI ConA >y 27y s R LTI T Z7oF—A > Y 20y 3k RIRGE
DT —RIN2—H DT ITHFILE>T I vF—D—F ELTHEE SN BEXHELET. 7y
F—A > 273 3(Cookie Injection) i 2 T> U i3, SEZE L /vF—lH N LT, 3
R DNRS A=, vy 20y BB R A £,
I RH¥A bR 27 V77 4> 7(Cross-Site Scripting): COT> Y >k, 70AHA MRIVT T 4
YINRGA=RAL vy 20y M BEFATLET . 77V r—y b — R S 305
A7 MEE 7T — XM R H BEY W70V LR /G HGE L we, 77 05—y avid
N DB T A NET,

7 4L 7 b Y% (Directory Enumeration): 7 (L 7 N V3| 25 Tl . B EBE M T AT B
AREMEDHZBE LT AL 7 VB D 77 Vr—y 22— LEDIFXRTDT 4L 7 hNYRRE
ZORREME DD 2 L DA R Sh 9. g . Fortify Weblnspectss &—% v MF A +D5%
EpDIEME 2~y B E T 2D L BET

7 4L 7 b V3L 3R F ODIE b (Directory Extension Addition): 7 1L 2 b WL GR T F =92 T
s 7 AL 7 ORGSR T 2B L KE DR T v 28HIBR LT, 4— 3 B iik oTh 3
T—AATT 4L 7 MIEMER T % L0 B AE 24T b £ 5. Fortify Weblnspectid . X %
R H s a82n b B, — LI SN RTOT 4L 2 MR R il & £7.

7 74 WVHL5R F (File Extension): 4 v b7 — 28 # P FEH & v 7 97 D774 )L%
A7V bEWebH— N EIHR T ER LD NET 44 MDD F 207 1%21FE 3 27201fF
I CEBERNDIN DT A NIEE FNTHRIELE LD VELA LR T Fzv/T
E Z7AVOILR T 28 &R 2T A MUREE SN TH B H W A=Y 320 R w7 o7
N—=D VBB T EEOHREMTON LT, 12821 hiaspz R DU 2 B3 &
hi.old%°hi.back## & L TZD A2 V7" bD YV —Ra— F5HL153 4 30 G A3 D £ 7,
Fortify Weblnspectid . B8 (ZF H s 26820 03H 2. — N B ik St iz XTO
77 ANV R Eil A £7.

Z7AWV7'L 74y A(File Prefix): & v b7— 28 3 L FEEH & v T 7 DT 700
2297 bEWebH— 3 E ik e E D VET . YA bDLF 2UT7 1%1RE 3 271201041
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Ty YA MR SN TO B WA= 20Ny 7 w7 N =Y sV R R T 2 L0 HTEDT
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L&d. [lE Foo/B A it B 21X 20T AL 7 MG 27 0—7 L sl Bk
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« FlashStaticAnalysis: Flash Y —2Z 23— F4 #T #E4T L a5t #4  L 9.

 Fortify=—% => b7'm—7"2> ¥ >(Agent Probe Engine): CO x> Vi K iE D35
A=RETE AV 2oy R A Y M RN ) TR E S IEB Y 22 F 1Zxf LT
Wi 58 T 200 %&R T ey bR Bl 7 n—7 ik G LT,
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SOOI 2 2 o7 —RERAE L &5
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OV AT L OEIRCHE 7 — (22— 7 — K& ©)2Web+ 1 MIBIR &€ 277
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B FzvILET, COBBETE. ZOLEILTAAINDE FNTHBRIENT H>TH 5
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D77AVDNEDERR St E . TOBE 2 ER 2L &7 .

o FHAE yuRYA PRIV T 4> (Persistent Cross-Site Scripting): #7 4t ! 7o A4 A
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o H4r¥ (Reclassify): COT> Y Yk K E D77 Vr—y s CEH B Tld & v— B I 2
Bk T BB T L S E OIEIITE A Y AX REBE M O 77— g 5P
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« ERZF ¥ (Request Modification): » 27 DX % Tix . A IE RN OE R 2 LT,
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DB 7N SN B & T — 2 W OH— R ET7 7V — v DB 38 S 2 0fth D% 2
B TG A MOEH T 7 AFR 8LTT VI DY —Ra—NH
BIEROIN AT 285 R 20 B Rd D& T,

o SOAP7 A *> MSOAP Assessment): Web+—E R &l (2—4 Tk & b O 771
F—y v HEE LB ROERISE T2707 F4TT . 1A EOWebHT—LE R
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o PRE SN TH B L FH ZB I SN A& EL =N AN LA vy 20y 3

e WAFBH: COT> Y i . Web 77 Vr—y 2o 774 77 +—IVOLEE 2 L7,

A °

BEATY 3~
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e CVS=x Y/S—H(CVS Entries Parser): CO > vid. WebR R 70/ 541> 12
BINT 3V 2DOAF x> T SN ey M7 2V ERIT L &7

 Robots.txt/S—#(Robots.txt Parser): 2O > vk WebfR & 7'/ 541> VIliE
430220 2% v T SN fzrobots.txt 7 71 )V & T L £ 9.
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[SCANNED-BY-HP-] £\ 57 F R b4 —NEE LET. 2OT7F A MEWeby—3D
TICRIN SN AF o DFEE LIZEERLET.
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TUWNE =DV — M H BB T AL 7 VEMH 37 4L 7 MBI ZE NS N 4. £
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V=L H AR
w7 R —vr—Y v

WebD 7L — L T7— /= &8

DI N—TDIT—Y > Mt Web 77 Vr— so4— N2 B i 4 2085 50 O 55 1 28 H L
¥, IR EDAIVI M B CHAE TR ORENEA—7 by AT LATERH SN 3
Al REME LHIMT L E 4,

Web+—/\

DI N—7DIT— x> ME, LLF OWeb+— MBI 3 2BE 51 Off 55 PE 24 L £ 5
» Apache

e |IS

e Lotus Domino

e vA 7+ —(ATPhttpd. 4D. Abyss. Alibaba. ¥ £ U'BadBlue’ EOH— 3D aL 73 3v)

* Netscape/iPlanet

e Secure lIS

» Website Pro

» WebSphere7 o+ >

e Zeus

TR 2T XRTOIT—Y 2> MZOWTHEA 2R § 2121 Weby— 1D /— F&RE B
L. EEDI—y 2> b2y LTSN,

HARXLIT—Y 2/ b

Fortify Weblnspectid il i D A ¥ v> e T O x1—o = b 2L ) L TWeb 77 U7y — 3>
ERTAN U E 425, B R FH G 25 £ 77—y B afE E 0% %
Fryr§ 3L TEET. 2D L %5 B 5 & (dWeblnspectY 7 b7 =75 7 34 % v b
(SDK)#ffi ] L CAHRRLT—Y =V MAER T2 &N TEET AEK LI ARRLT—Y 2>
M . Policy Manager#f#i il L T12LL E DR Vs —&i & T& 47,

CH6H B SEsn,
"HAARLT—Y 2 PO " K—T76

HARINTF =7

AARLF 297 FEEDF 2o/ T CELWIF EOM M 2 + 22— EFOD
TO—TTCF . HDARLF 2o lE VTN I —RE A L ER c& 7.

CHHH TS FFEn
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VIV AA R
BT R —v2—Y ¥

"HARLT 2y DNE " N—66

1AL R B

EM B O AR KR A F R —r Y A LUER Sh &9, IROF 2. 2h
SO FD—H &/~ Ly 2O B 2B 28 Lad. R T2 DS &L T
'Regular Expression Library | 3% D &3

X
\

[xyz]

\b

\B

\d
\D
\f

it B

WOL F 5 »R L F L T~v—2LF T ECFEInjie—s LEd. >—7 >
AN/l BAT L F I L &Y.

AT ERIEATOHRTEIC—HLET.

T IFREEHVMH T8 B E LT H#EIR LET. /L2 contentT (L
2 MY D/content/en® & U/content/ca #Fk <3N T#FR4M 3 21214 /content/[*
(en[ca)]*L* &1 I L & . \S\D\W 2 i LT 2 &0,

AT &REATORRBIC B L&,

HAT 3L F D0 L EDORIE E—FLET. /zo*idTz1 &bTzool 65— F L
QN

HAT I BLF DAL EDOxIE &L ET. /zoHdTzoo lo— B L F3 4.
[zJiE—8 LI A,

JAT T3 F D0 /-3 1[H OH B &— 3 L 9. /a?ve?/idTnever] Dlve]
B LET.

BAT X F 2R EE DI F I L&

Ly e FHINH OIFEE D1 Fe—F L E7 . /[abc)/i&plain] Dlajic—
HLEY.

AN—RA% EOHEEE FLc— 8 L £9. /ea*r\b/id . Tneverearly] Dler]ic— %
L7,

BEE LA OB L ic— 3 L 9. lea’r\B/ik never early | O Dlear] &— 21 L
ES 2N

1208 71— L&+, [0-9] [ LT,
B LA 010 7 ic—5 L& 3. [*0-9] & LTTs
A= I LET.
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http://regexlib.com/Default.aspx

V=L AHA N
w7 Ry —v A —Y

XF wH
\n AT LTI L &S,
\r F o)y YRV F B LET,
\s  AR—AL KT WA=V A EDFE HIC—F LT [\ &R LT
\S FEAXFLUAOLF I LET. [P WMn\tW] EFE LT,
\w TYR—RAAT7 % & AR OBEGE L FI—H L Ed. [A-Za-2z0-9_]EF CTT.
W EHFE LA O F I L ET. [FA-Za-20-9_| & LT,

IF #5380 58

38 O IF #1138 B SC 1okt 9 235 58 A5Micro Focus D > ¥ =712 & W F 8 L NE 3 san
TOWEd, FHREBERAER T 25851 IROXT EEE T2 H & £7,

IER R %7

« [ALL]

[BODY]

[STATUSLINE]
[HEADERS]
[STATUSCODE]
[STATUSDESCRIPTION]
[COOKIES]

IR B T

« AND
« OR
« NOT
* [l
« ()

1

o QAT —RAMTILAT—RAI— 2001 H53F EN THE D, 5 O(b) Ay —Y KL DEIHIZ
MNogged out] & FREA) 03 FN TH AL L M H 7212 IRDIEHR K H 2 H L &
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VIV A AR
w7 Ry —v A —Y

ER
[STATUSCODE]200 AND [BODY]logged\sout

o TR SN F2 YV —RAH— B I OURI (VKA L 7 NCAETE 3 3 2455 LTH D, hofis
% D EIHIZART Login.aspl NDZ I 258 Fh 25 £ H T 2121k IRDIEHR R B
HERA LT,
[STATUSCODE]302 AND [ALL]Login.asp

o (a) A7 —xAa— FH»I200]. »Dllogged out] & 721 ['session expired] &u» ik B 234
L DEIHIE FN TS, &1zl (D) AT —XRAI— K302 DI & D ETHIZ/AR
[/Login.aspl NDZ B NE 4N TH ARG ZEDWT N4 21k IROIEH EH %
fEHLET.

([STATUSCODE]200 AND [BODY]logged\sout OR [BODY]session\sexpired ) OR (
[STATUSCODE]302 AND [ALL]Login.asp)

YE: TBH X 4590 £/21 3 TR CIHE 9K ORT 18 1c AX—A(ASCI 32) 25 » 20 B dH D &
To FOLBWVLE FEINDRS>TIEREBHO—E ER 3 £9,

e X1 L 7 hLocation™ vyXD & Zhizllogin.aspx] I B VXA L 7 M & 2% H § 212
EIROIEHFH KRB 2 H L £7,
[STATUSCODE]302 AND [HEADERS]Location:\slogin.aspx

o A7 —XA{T DReason-Phraseifl (2 & D F % (T Please Authenticate | & £) 238 41
BIGE M T IROERRHR 2 A L &7
[STATUSDESCRIPTION]Please\sAuthenticate
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m8 MR =7 4K

FHER LG CFHDOL Y NERTNAR—2TF. ERHERIE., S0 E T 44 H
LTPhSREHAE LT BIEE>T R LR sn 3. EHR B CEH I3

EHMW M55 oL 8 2a— R UNCOMRE 2 $XXT7.

EHREFEHROFZ N

Regular Expression Editor & ] L T IX D & NCIE R LT 27 X M LORGEE L £7

E/—i(Tools)]> Regular Expression Editor] z7V»7L £7°
Regular Expression Editor] 7 1> N 7235 & 7

& =
8 Regular Expression Editor |Z]@|g|
Eile Edit Help
pression ] E]

grialely
[[] Beplace ‘with

[] Match case

Dr. Gray has grey hair and a grevhound. = Gray

< | >

[ wiord wirap

Execution Time: <1 ms; 3 matche(s)

B (Expression)] U7 MR 27 ¥ A MR, Oh 2L b 3IE R EH 2N ) £

IR O T £

A E 2 g e s 0u s LAY 24 rO VA MERE L. CRICH
URLUPT7 FLAZER TEIARL FEERM BB DG IN . A7V =0 7Y/l T

ALET.

F: FEHEHOIERE 2 H LT EDOZYZ7OHTTP Avt— MR 25| R 4 3

ZELTEET,

E Arvy single character

Zeto OF moare

Qe or more +

or |
Word boundary b
IPv4 address {0k
LIRL Lk
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IV AR
8 IEH KRB 171X

6.

7.

A 71 LT3k OH% S #3Regular Expression Editoriz & > THi 25 &h. @ (%) 25 4) &
1213 (M5 235 B )RR S & TS
BMELO7FF 2% BRE 7+ X MSearch Text)] TV 7 1 L& (/5 0ff U &
EBE
1214 LLHTWCHTTP Editor 2 H U TR A7 LIGHTTPEL SR /21 s & Avte—Y 2R D
AL TCae— R NT&£T,
a. P 71(File)]> E3K %258 {(Open Request)] #7Vv7L &7
FR 770k EERICIEHTTPE R 5% Ol Jj 07 —REH &t vy a2 TT.
b. HE¥ED 77/ VIR 74> P LT RTE SN vy 55 L 771 L 5N
LEd,

c. ER(Request)] #7214 5% (Response)] #iE R L 4.
d OKl]#7VUvyrL &9,
KORKLFUNLF e~ T 2HBE QA &R T 212 RIXFIPLFEX
71l 3 3(Match Case)] 7 =v /K v/ A& AL EFF,
IERLR B & 0T S 12308 2 O 74 TH &R 2 2121k DL O fE %
KAITLET,
a. B F % (Replace With)] F =2k v 7 A% L £,
b. Fov/XoravRRys A& LT FEI 2N )] Flzid# IR L &5

FAMNTest)] #2707 L ERKRBIC—H T 2L FINER—7 b TFAITHEL
9. —HLA O TR R SN T,

E#(Replace)] 77’y s #IZ R L1355 k. B#R(Replace)] #7Vy 7L T\ MR
SN FHN T RTCEEBR LT LB &S] 2L &7

CHELHY TSI FEn
"IERRE R
"IE H R B 0L R X—2103

IS 7]

EM BB DAR=2E R A F =7 Y AR LUER Sh &9, IROF 2. Th
SO 7 D—HB &x L O 12 ] 25 LEd. #ESE 3 2 DS M5 &L T
'Regular Expression Library | 3% D &3

X7 B

\ WO ERER L FEELT—2LET . ME X FEInJic—FHLEd, v—F >
AN AT P — L &Ed.

NN ERAT OG B I L &S
WP IR 28 BEX T 28R LET. L2 content7 (L
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http://regexlib.com/Default.aspx

W—ILAHA RN
B8 IF R 7 4K

XF

[xyz]

\b

\B

\d
\D
\f
\n
\r
\s
\S
\w

\W

it B

2 MY D/content/en® & U/content/ca #Fk <3N T#FR4h 3 21214« /content/[*
(en[ca)] L. &1 I L £ . \S\D\W 2 [ LT 2 &0,

AT &REATORRBIC B L&,

HAT 3L F D0 ML EDORIE E—FLET. /zo*idTz1 &bTzool 65— F L
QN

AT I BLF DAL EDOxIE &L ET. /zoH/dTzoo lo—F L F9 4.
[zJWiE—8LEE A,

JAT T2 F D0 /-3 1[H OH B &— 3 L 9. /a?ve?/idTnever] Dlve]
B LET.

MAIT L F 2R T EDILF e LET,

LT tyh. FEINH OIFEE DI FiC—F L &9 . /[abc)/ikMplain]Dlajic—
HLEY.

AN—RA% EOHEEE L ic— 8 L £9. lea*r\b/id . Tneverearly] Dler]ic— %
L7,

BEE LA OB L ic— 3 L 9. lea’r\B/ik never early | O Dlear] &— 3 L
ES 2N

100K Fie—FHL£T.[0-91LF LTT.

AU DI Fic—F L&, [0-9] L LTT.

A=Y FIC—FHLET,

AT XL &

F o)y YR—2 LTI LET,

AR—RA, BT P AR—V R EDF I L &9 [\Wn\n\t\W] &F LT,
FTHXFLAINOL Fic—F L &3, [*\A\n\nt\v] &F LT

TYR—RAAT %% CAEE OBGE L T IC— L ET. [A-Za-2z0-9_]&F LT,
BT IO FIc—F L ET. ["A-Za-z0-9 1 EF LT

Micro Focus Fortify Weblnspect (22.2.0) N—102/379



IV AR
B8 IF R 7 4K

I 5 3R i O 58

38 O IF #1 38 B SC 1okt 9 235 58 A5Micro Focus D > ¥ =712 & W F 8 L NE 3 san
TWEd, FREBERAEM T 2585 IROXT EEE T2 H & £7,

IER R %7

« [BODY]

« [STATUSCODE]
« [STATUSDESCRIPTION]
« [STATUSLINE]
« [HEADERS]

« [ALL]

« [COOKIES]

« [SETCOOKIES]
« [METHOD]

« [REQUESTLINE]
« [VERSION]

« [POSTDATA]

« [UR]]

« [TEXT]

MR B A T

« AND
« OR
« NOT
* [l
* ()

17

e QAT —RAMTICAT—XZRI— 200125 N TE D, 2 D(b) AvE—Y KL DEIHhIZ
MNogged out] & FREA] 037 FN TV R E M H 77210 IROIEHR KB 2 A L £
ER

[STATUSCODE]200 AND [BODY]logged\sout

o BR SNV —AN—KEHIZH OURI (VEAL 7 NIAFTE T B2 8%m LTE D O
Z D Ehz/ AT Login.aspl NDZ B 3 E i 205 % #1837 2121 IRDIEHR R B
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V=LA A R
B8 IF R 7 4K

#EHLET.
[STATUSCODE]302 AND [ALL]Login.asp

o (a)A7T—XAa— ’AI200]. »Dllogged out] &7z [session expired] & JiE B A4
L DEIMIZE FN T3, 12l (b) A7 —KA3—R302] 22D B D ETHIZ/SA
[/Login.aspI NDZ M 258 FN TR BILE DL TF N EIH 32121 IXRDIERL R #
fEHLET.

([STATUSCODE]200 AND [BODY]logged\sout OR [BODY]session\sexpired ) OR (
[STATUSCODE]302 AND [ALL]Login.asp)

VE: TH 145 9K 721 TR C13E IK OHT 12 (IC AX—R(ASCII 32) 45 B 2L E 3D D &
To 2BV E FFINAGR >TIER R O— ¥ LR & Sh £,

o UXAL 7 hLocation™ v&XD & Zhizllogin.aspx] BN 3 VKA L 7 ME & 218 3 21
G IKOIEH R AEH L.
[STATUSCODE]302 AND [HEADERS]Location:\slogin.aspx

o A7 —XA{T DReason-Phraseif \24F & O F 1| ([ Please Authenticate | % £) 73 % &4
PGB AR T IROER B #EH LT
[STATUSDESCRIPTION]Please\sAuthenticate
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% 9: Server Analyzer (Fortify
Weblnspect® #4)

Server Analyzerid . — /Nl WHE DY EL TH—RDARNL =T A4V T L AT A /N F—,
Zy®—. ZOf OIF W £ sz L&,

P/ DI T

P—NEI T T B

1.

2.

4.

BE—7" v bk A MTarget Host)] 7 +—)v NiZ. &—7 v M—/SDOURL £ 72 IP7 ML 2%
ANTTL&ES,
A MRAE (=L ENAT— BB E 2 6& . £ld 7 e —N N LTX—7 y
MF— 7 2 AT 235 A . B (EdiY)]> B (Settings)] £ 27Uy LT, Bk &
NEBERENTLET OO, TRRAER E" K OR—=2 18 LT T o 2%
E"AN—U1071 2B ] L TS0,

By #7 DK 4T (Run Analysis)] 71 2> % 7 Vv 7L &7,
# 7 3 % &, Server Analyzerizl 73§71 52 T (Analysis completed) ] D A 7—&X R &, 43 7
P ADIEHDIVA MIER SN ET .

I H OF 4 (Item Details)] <1 > i1 # #5R/x 72wt IHH (Item)] <A > CIH
H#ERL£T.

D Server Analyzer - b
File  Edit Help
Target Host: |http:ffzer0.wehappsecurit}r.cum! | [ Run Analysis & Export
Items Itern Details
=i httpf{zero webappsecurity.c
-l Server Fingerprint The underlying web server of the target/device has been

W Site Analysis Surnmary identified as the following:

-4 Site Analysis Information || Apache 2.2.x, or Apache 1.3.x

¥ Application Technology

g Server Banners

All the underlying web server fingerprints that partially
matched this target/device:

3. Apache 2.2.x

3. Apache 1.3x

2: Apache

11540

11550 Vv
1. 156.0

£ >

Status: Bnalysis completed
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V=LA AN
% 9: Server Analyzer (Fortify Weblnspect® 4 )

=L == S

AX B O)g d

Server AnalyzerDi% & #%48 B ¢ 31214

1. & (Edit)]> B (Settings)] #7Vv/L &7

2. ROLFNAI LRI L £T.
o A NEEE(Host Authentication)] . " 251 7% E" F12Z B L TS0,

o PuFy(Proxy)l. "7 ox ik E" RDA—v [ #Z B LTS,
3. DOK]%z7VvILE7,

AnalyzerD#E B D 7 AR —

M EE R AHTML 7 7 VI T 2 AE— 1 2121

1. P r1(File)]> E7AA— MExport)] Z7Vy7L £7

2. PrANDToAF— MExportFile)] 74> N7 T &7 744 1B 1213 N J1 L
9,

3. Rfr(Save)]z/VvrL &7,

H6H TSR FEan

"WEEER E" T

2L =2 n

"7'aF R E" IR DR—Y
2] 2 2L
R nE X rE

ronlk AY v R
FRRE 30 L e 1 5 (& L BRI OOFE S AR L T 2 s
« H & (Automatic)

VE: HEIM U 28 T8 RE v DI R <A DET . HEHE LT0 25 OFEE A
VyREIRE T 28 AF x> DAT+—v Y AL KIF W - LETS

£4 Y =X MDigest)
HTTPZ 4 (HTTP Basic)
Kerberos

NTLM (NT LanMan)
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VIV A AR
% 9: Server Analyzer (Fortify Weblnspect® 4 )

Ay 2T VR ek
o Al B A% 15 )
E—44 (User name)] 71—V Fic2—#ID%#AN J1 L. PSA7— N(Password)] 71— I

2= DRAT—FEN T LET. N1 3IR%P <fzoiz. PRAT— FORERR (Confirm
Password)] 74—V FIZ S AT7— RF%&4: DIk LA L&

Server AnalyzerC/S 27— NN /7 2> bo—u AR H & 372000 2h 5D 1% 15 3R %1%
T2 PRRT—FAT 74—V FRH 2 74— Al Th 5OR IR #1415 73
(Submit these credentials to forms with password input fields)] Zi# 4R L £ 3.

7'a¥ ik E

COMBE LT 7 A 21cid . BREE(Edit)]> B E (Settings)] 27V v/l &4 . k2. Pe
*3(Proxy)] ZiER L £7.

H 7 4 (7 o ¥ > # %) ) (Direct Connection (proxy
disabled))

7oXH—NEEH L WG A E. COAT Y v IR L&Y,

7'n¥ LR E O H B H (Auto detect proxy settings)
CDATY av %R 3 % &, Server Analyzerid WPAD (Web Proxy Autodiscovery
Protocol) &8 [l L T7 ¥ v HBIER E 77/ V&R DU, 20 &M [l LT7 574 DWeb~7' o
FURRE AT VW ET S

VAT LD7 uF i E 2 H § 5(Use System Proxy
Settings)

O—Lvy b7 X — MER 24 VAR— MBI COAT Y v HIEIR L ET

Firefox7 0¥ 2 #% & #1# H 3 %(Use Firefox proxy settings)
Firefox/ a7 B s H—ER 24> A— 1§ 22k, COATY o IR L £7,
H: 757907 uFx iR E A LTEH, 7o o — A& H CA v E&—2 v NI T 78 A

TEDIRAEIE B DEE Ao Firefox7 20 O &tk € Nl 7 oFx o LR E ST 3
G a3 S Et A
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VIV A AR
% 9: Server Analyzer (Fortify Weblnspect® 4 )

PAC7 7A V&l L T7 v¥ v 5% € 1 %(Configure proxy
using a PAC file)

COA7y av##EIR §2E. URL] 74—)L TR E L7123 AT 12 & 2PAC (Proxy Automatic
Configuration) 7 7 W67 0% La% E Ho— RS 9,

7'o¥ v &8 7R 128k € § B(Explicitly configure proxy)
7aF Y —NEHTA YRy MIT 72 AT B2 COATY 2 FIEIR L, ER sh iz
BMELTOLNA S LET.
1. f—73(Server)] 7+—v Niz7'ax 24— OURLEEIP7 KL A& AN J1 L. &t T

( B— NPort)] 71— Fi2) & — 1 5 (8080% £) &A1 L&

2. 7oF Y= H CTCP r 774wy 80L 3 27 0 haLvd BA7(Type)] %
SOCKS4. SOCKS5. /s tEHE iR L E 4.

3. WALV E 1A &, FREE (Authentication)] VA b s XA 7 HIEIRN L 4.
« H &) (Automatic)

E:HIMHE 28 E $588 A% v DU AR L NEd . 182 LT 35 O
SE AV REISE T BE AF v DA Tr—v AL KR ICH LT,

# A< (Basic)
£ 1Y =R MDigest)

Kerberos

# ¥ — MNegotiate)

NTLM (NT LanMan)

4, 70F Y —NTRRAE PV E 2 53 WS 42— &N AT—FEAN I LET,

5. FFEDIP7 FL AN 7 A M A MW T 78 AT Blepic7mF o H— & 42

WE RO A . Pods #3432 9 244 MBypass Proxy For)] 71— Fiz 7
L AZGURLEAN JJLET. =Y NEX Y] 2556 & Av~EH L &7,

HTTPSH O & 7o+ > %45 & 3 2(Specify Alternative
Proxy for HTTPS)

HTTPSE: 4t 2% U AN 27 0x 24— 105 k. HTTPSHORE 7oxv 2B E T3
(Specify Alternative Proxy for HTTPS)] 7 =v /K v 7 ZA#I& R L, ER shiziEH 2N\ 7
L£9d.
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£ 10: Server Profiler

Server Profiler #ff i L TWeb+ 1 cOH FI 7 A %47 u», Fortify WeblnspectDFF & D&%
EEETH T 2LENDI0EIDEHM LET. ZF 20 2L b 284 . Profilerid
REDVAMIRLET. INADIREEF . ZUTANBZIELIE R T332 TEET,
fz£Z1E . Server Profilerid . A M 2120 HERST 5BV ECTCHBELDD, A ) &t 2—
P ENAT—RIRPIEE SN T W EFHE T30 8N E A TDEEAF v 25i1T
LT3 L <Y DK Wik B 218 20Tk % & Server Profilerd 7" o> 7" MIfE 5T &54T 3 2Hi
B RERERTE T HIENTEET

[A] £k (2 5% % Tl - Fortify Weblnspect 23 7 74 )W R D6 W1 O H AT L&D
IR E SN TWRIEEHNET COT OV AL FIE LGB I —RE 7T T MpsBiR &
N THA7—KA404 Not Found | iR &% \’WebH A NCIX (3L B &4 (IR D NI AT —K R
[200 OK] 2%k St 235G A3 D V& 05, JLE Wk 774 WA DD 648 0 b I A= H
B EN &£9). Profilerid s 2O & HaFiE N E—7 v A MIFESE S To 3 EH I Lt

& ORI IG T & 3 & SicFortify Weblnspecti® & 225 8 § 3 4R L £

Server Profilerid . 771 P} & 2% x> &R § 228, 7707 — =(Application)] #%
ECHMCT 2oL TEET .

Server Profiler®fi H

K D2ODTT DN m%EfE H LT, Server Profiler£#2 &) L £ 7,
v— v &L CDServer Profiler Dt &)
R D A7 7 124¢ >C Server Profiler 4t & L ¥4

1. Fortify Weblnspect® P—i(Tools)] x=2—%21vy2L. ServerProfiler] & L &
£

2. URL] AR vZ7ZAT.URLE#ZEIP7 KL AZANJ] &38R L E T,

3. (A7¥ 2N E S LT B vy A X (Sample Size)] #28 HH L £ 3. K 4
Web# 1 FCIE B 2+ 5 0§ 2720 77400 b vy 8 5 2 28 v 3
Y E B G NHNET

4. Prir(Analyze)] #2770y oL &9,

Profilerid . $£ Z O— B (/2 E B E AR E TH 2L IAT— AV NER LT,

5. IRE#EH T2 . HET2F 29K/ ADF 29085 LET

2—HPAN S HPDE LR COOTE ., BER Sn R 2N 11 LTLLEs0,

7. (A7Y )R LI E &7 7/ WIERAF T 211
a. B DR (Save Settings)] =27 VvrL &7,

b. HEHE D77 VIR 71> P el ] LT, 5% E £Settings7 1L 7 bUD 7 71 )L IR
FLET,

o

Micro Focus Fortify Weblnspect (22.2.0) N—109/379



V—ILHA RN
# 10: Server Profiler

A ¥ ¥ OB 15 K .2Server Profiler ##2 8) ¢ %
A ¥ v DB 4G R (CProfiler #4C §) 3 212lE IRD AT v WHE VW & T,

1.

o &

KONTN D TAF v 2IELLT.,

« Fortify Weblnspect® Bf & X—(Start Page)] . B4 A ¥ v DBH i (Start a
Basic Scan)] z7Vy7L &7,

« P r1(File)]> ¥i¥i(New)]> E: 4 X+ v>/(Basic Scan)] #7 Vv L £7,

o (V= —0D) I (New)] 71 2> TRy 7 X7V REN#27)v LT BER RF v
(Basic Scan)] #iE R L £ 3.

« Fortify Weblnspect® B &f X—(Start Page)] ©. RT Y 2— W SN TAF v D
& # (Manage Scheduled Scans)] #7VUvZ7L. [BIN(Add)] 22Uyl Th o B
7 X% v>/(Basic Scan)] Zi% R L £ .

AF ¥y T4 — RDAT v7 A A% v B )Ty PeZsu(Profie)] 227 Vv oL &

3 ( Profiler %8 8 i1 125 4T ¥ 3(Run Profiler Automatically)] 75% R sh Cw 235 &

R

Profilerid . 2 Z D— B (/3B H AR E THBENIAT— AV NER LFT.

REFEE T2 HIET23F 9/ R v ADF 2y L E TS

2PN BB E LR F I OOTE BER SN EFR 2N I LTI S0,

K A(Next)] #2VvoL &7
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Site Explorer #{fi l 9~ 2 £ 2 ¥ v 45 ] (CR F {7 74 AT &. Fortify Weblnspect Scan
Dashboard & 0 &5 8 & &7 0V AL 54T v, 77— X% ROLR 7> L CREAN #1ERR T &
%7 . Fortify Weblnspect Scan Dashboard Cld i X2 ZEDT &% b, KFE D AF v 7 —X&
ERINDIENTEET, foeZE. A MEZE (Text Search)] ba—#fli | LT, in& T
oD ole T RTDTFAMA=AR Y NERIR TE LT 352, Site Explorer2{f F 4 2 &.
Fortify Weblnspect Scan Dashboard Tld &K 75 T &% W, [N 7749 2(Traffic)] 7 Yy NN @D
HERINCT 7 ATELT S

ScanCentral DAST A & ¥> D3 /8

Fortify ScanCentral DAST 24 . Site ExploreriZ Ul 4 2 X % v 45 B AL B Bt 258 & T
9. 72720, ScanCentral DASTIZIZ 7T ¥ A MR R & N Tt A . COMRE 2 &
%(Z1d . Site Explorer#{fi H s 20 E083HNE T,

Site Explorer D] [}

ZDR— 2DSite ExploreriZid ¥k OB RE 23D D& 4.
o AF y2T —REmt AN A THRIR LT . Fortify Weblnspect Scan Dashboard &[]
CHIETCAF v &7 0747 $ 32 TEEE A

o AFX XY hI74y 7 HIEIRH (BT BR . VKA L2 ML BEUTUBE % &) DA £R IR
L9,

e Web# A FMDAF x> DA ZHR—FL LT, WebH—ERAAF yidHHA— b EH A

AF ¥ XA )V

Site Explorer %2 #] 3~ % &. Fortify Weblnspects: 51 i 7] ft 7% 4 X TD A ¥ v 2% 7] &
n. FXTDOZRF v (ALL SCAN)] X712 AF v>D YA MR/~ sS4 £ 7 . Site Explorers
Fortify Weblnspect &[F] U~ > b2 ® 2355 & . Fortify Weblnspect THL/E ZATH DX+ v
SEUAMIE R SN ET. VA MY OF 2% vk, FRTDAF v (ALL SCAN)] R—v D
AWK IR SN ET

Micro Focus Fortify Weblnspect (22.2.0) N—>111/379



V=V A K
% 11: Site Explorer

2 - o %X
SE ALL SCANS
Q #*
Recently Opened Scans ~
SITE: HTTP://ZERO.WEBAPPSECU CLIENT SIDE - ZERO.WEBAPPSEC! SITE: HTTP://ZERO.WEBAPPSECU
http:ifzeromebappsecurity.com hitpulfzerowebappsecurity.com httplfzerowebappsecurity.com
5 12 5 102 3 1 2 | 10 0 4 0 4
2/16/2018 10:06:29 AM Q0:33:L7 2/13/2018 11:11:45 AM 00:07:55 11/8/2017 9:36:58 AM 00:01:02
Earlier this Week A
SERVER SIDE - ZERO.WEBAPPSEC SITE: HTTP://ZERO.WEBAPPSECU
hrp:fzerowebappsecurity.com http:/fzerawebsppsecuriry.com
0 5 0 6 1 5 0 | 6
2/13/2018 11:23:12 AM 00:03:36 2/13/2018 10:55:38 AM 00:02:29
Last Year ~

Version 18.10.AG.DLI

TRAFFIC MONITOR TO TRAFFIC MONITOR SITE: HTTP://ZERO.WEBAPPSECU

ScanCentral DAST A+ v

[ XTDAF v (ALL SCAN)] 71 AF v> XAV 23K 78 3 %121k« ScanCentral DAST >
BAF v R #X 70— RL, IRWTZh %Site ExploreriZ >R — M 2L E RNH VLT,
ScanCentral DASTTH/E FEATH DAF vV IR R C&EE A

AF v XAV E R s & 21 IR

B AF v ZANWITIE . AF v T 2R O EE R AR R SN ET S

o AF x4
« URL

« AF—&A(%4T T (RUNNING). I INTERRUPTED). /% Il: (STOPPED). 52 T
(COMPLETE). #7=1d 45 # »%.l 2 (REQUIRES CONVERSION))

o i K (Critical). 1 (High). 71 (Medium)DJifi 55 4 D%
o JIE 55 1 O E
o AF¥ vUHB IR Sz IR

o AFx UM (R 70 BLUOR) (RAF v B EHR T LG A EIE LW G500
£7)
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D7V RA LFE T

AF v DI AE | Fortify Weblnspect TR AT SILTE D, bF771v7+¥ vy 27 71 (TSF)IE
X TDRF v 7 — &M & #Fortify Weblnspect T4 % (2 L Tu» 235 A . Site Explorerid A
F VXAV E O UEREVTIVEA LATEF LET. FFA DL T, ["Fortify
WeblnspectiZ & 2Site Explorerf] 7 —2{E il #2129 2" X—Y 1151 2SR L TS

Wy,

AF > BA WD T )W—7H Ty 2
AF ¥V RAIE B SRS SNTcH L o A% v o RFEAT SN EH ICE T/ —710 &
NEdT. 7V—7WIRDEBNTT .

o % ¥ (Most Recent) - iz it F 7n S fz A% v
« 4 H(Today)

o 4 1H %] % (Earlier this Week)

« 4 %] ®(Earlier this Month)

* Jkt H (Last Month)

« 444 »(Earlier this Year)

o IE4E (Last Year)

o ZHL & LU (Older)

AF v ZRAND I N—TDFE I~ EER R
AF vV RANDIN—7"%AE KR ICT BT

o WIVFEELS(7v7yz7o)(A) &2V LET.

AF Y BRAND I IN—T %R R T B

o VER B (K Try 7)) (M) EZYvILET,

AF ¥ DR

AX v B LTAF v 2R TEET. AF v VERR T 3512
1. BZ 74 2(R) 529920 57

MZETXAINRvIARR RN SN T,
2. AFX A HZ DI F T RTEANSTILET,

fe &ZUE . % BT B3http://zero.webappsecurity.com/D X TD A+ v> %45 R T 212
& 7F A MR yI R zero] ENTT L E TS

3. <Enter>+—%f L £,
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Site Explorerts A v> # 7 OV SZALEE L, LRI IR 7 X A MVE N 2AF v DA 2R
w~LETS

MZEDOIYT

MR 74085 2)7 LTI NTDRAF v 5K R T B2

tMRERTA :!‘/m)O)J:%B Whd K]EZYvILES

2 > DN B
Site ExploreriZ 1 > A — &L 2 AF v &, Site ExplorerT s 274y 7€ v a7 74 )W(TSF)
R B SN AF v 2 HIR TEET

Site Explorer T 2 ¥ x> %H| [4 L T ¢ Site ExplorerDSITE 7 71 L i& Hll & &4,
Weblnspect7 —&X—Z%ScanCentral DAST7 —ZX—ZnH5AF v >0 HI [k SN 3288 H
N&+ A . Weblnspect Imports7 (L 7 Vs S| B S 2D TSF 7 7140 EXML 7 74 )L 72

T

AFE v EHI R T BT

o BFRTOAFv+A(ALL SCANS)] 2706 AF v XAV &4 2Uy2 LT, Bl (Delete)]
PRI LT,

CHHH TS FFEn
"AF VAR

"Fortify WeblnspectiZ & 2Site Explorerff] 7 —&{E i #6 & (2§ 2" IR DX—¥

A% v AR R

A% x> A2, Fortify Weblnspectid SQL Express 7 — ZX—A(MDF) 7 71 )V &1E 1% § 35>
Bt /7 DSQL Server7 —&X—Z(MDF) 7 74 Wil A% x> &IB N L 4. 7272L. Site Explorer
Tk 57490129y 2774 WTSEE R DA VT—y 3o %f§ ] L £ . Site ExplorerT
MEAFE ODMDF 2% %> 77 IV ER IR T 3121k 2D 774V 2TSFE A R 200 B »
L MEN I

EE ! ScanCentral DAST 4 Site Explorer EH a1k D d 2 A% v & B AERL L &5
AL LT B D&Y AL 12721 ScanCentral DAST 252 % v X7 o— KL CSite
Explorerizf >R — b3 256 1E. R¥ v> 45 F (Scan Result)] #1#R 20 E 035 )
9,

A R DAL

AF Y EBRLTE, TORAF v I BT SN FEA. KD, B 7 o 22 & >TSQL
F—BR—AMBAF x> T — XMW E St 207 — 20585 LOTSF 7 7/ Wizl N St F5
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TEDAF vld s AF v T —ZR—R2J6 O 3 CTIHRAFE S £ 9,

AR ML SHL 12 AF v AR 3 B B D5 4

B Luyi— 2oDSite Explorer CIE I D A% v S MAME ] TE 2L N 2N H V&
To B LORF o5 R 28 AIA Wi PLAT B LI AF v 28 £ X TODSite
Explorer 2% x> #H AR T 2L B D V& T . CORMAFEAE LI & & AF v 2FH
BT BE UKD B AvE—UBNEIR SN LT,

Ly 3i—2 3> DFortify Weblnspect ©7 —&N—2Z A% —v3 28 B s 1215 & & | Site
ExplorerO 2% +> ] 7 —=ZR—ZARAF =<t H i § 20 E XD NFET . 7T —EN—RAAF—~
W HT S 3 £ Tld . Site Explorerf ICAF v 2 TEEA. CORM HFEE LG
413 . Weblnspect CAF v> 55 &, R SN BRI >THEH 24 3R D 3 A9 —
DERRINET,

A ¥ x> DAL R
LI SN THHE VAT v DR T7—LK AL . REQUIRES CONVERSIONT 4, A% v 545 #
9 B2

o AF v RANEZYILET,
AE 2 RAWIEAT IR A=K IR Sy AF v B AT —RANEK R~ SN F T,

7 7V A B S4 2 o

TSFA—Y aDAF v 7 —RIITE D AF v SN THW EE A . 2D 79, Fortify
Weblnspect Tt D AF v> 7 — Rk LTEBE N ZTH. T IETSF 7 71w LA B &
NEth. 77/ EREIA T2 BEFEDTSF7 70V EHI R L. B SN AF v> 771 )L
EH LOTSF 7 7AW L ET . BEAFEDTSF 774 )WIZIR DT AL 2 b IZH D ET

<directory>:\Users\<username>\AppData\Local\HP\HP WebInspect\ScanData

Fortify Weblnspect(Z & 2Site Explorerf 7 —X
TER 268 323 3

Fortify Weblnspect T, 2% v>FATHR D ~ 774971 v a7 7 (TSF)JE X2 & 22+ %
LT — ROE B R H T EET .

COOMEEE 28 R 2T B2l

1. Fortify Weblnspect §i%E (Edit)]1> 77 V7 —3 223% 72 (Application Settings)] ©
NE IR L7
7' V47— 328K 5€ (Application Settings)] 74> R4 & £
2. f—&~X—R(Database)] #1E I L 7.
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3. Site Explorerﬂi AF v 7 —2%E B ¥ %(Create Scan Data for Site Explorer)]
FrylR v AEHER L ET

4. OK]%7VYvrL &9,

AE v DEATHICCOF 2y R v/ R %A L TH FEET R ORF v F L E L &

Hho CDFzyIR I A% A NI LI TR LIz AF v TDA . Site Explorerf] ODTSF

e 1% 5 A=Y (O & IS

AF v>oDAVR— e 7 AR— |

Fortify Weblnspect# & t*ScanCentral DAST 262 % v> %1 > 7 R— L C. Site ExplorerT
F N T& %7, Site Explorern»: 57 7AVET I AFR— LT DN &L § 328 TCE &,

AF x> T7 74 DNT

Fortify Weblnspectz‘»%l JAR— SNz AF v, Z/zidScanCentral DAST» 6K 7> o—
NS F2AF vl Lscan 7 7AVHL 5K T M & £ 9. Site Explorert» 5L 7 A R— St fz
AF v csite 7 7AWARIR T AT &Z . SITEZ 7/ id 871908 ve av 771 )L
(TSF) e &9 R — T BXMLZ 7/ V& CZIP7T—HA7 774V T

Fortify Weblnspect: 6T 7 2R — SN 12774 VDT 74V SO AT IEIR D &E D TT
%localappdata%\HP\HP WebInspect\Exports]l

7 74 FTlE . ScanCentral DAST A ¥ v &5 B 77/ g Kvvo— FH T SRR E T
e SN tfto—AL vy D7 KRR yn— RSN £9.

SCAN 7 71 )L £ /21X SITE 7 71 )L %3Site ExploreriZ f > — rSh 2 &, TSF 7 74V EXML 7 7
AV S IR DG T icaE—an &9,

%localappdata%\HP\HP WebInspect\Imports

AF x> DAHR— b
Site ExploreriZ A% x> & A > A— 9 212

. Site Explorerf“ﬁ”&ﬁ')‘yﬁbiﬁ“o
KA Z(TASKS)] A= 2—2E 7R SN £ 4.
2. U>A—MIMPORT)]%#27VvsL &7,
B {Open)] 74> FUHBE IR SN 7,
3. .scanZ7 &L site 7 AV ER DU TER LT,
4. B {Open)] #2Vv7L 7.

—

1%localappdata%!d . 8 COAXRL—FT 4> T L AT LD a— AV T 7 Vr—y 3o 7 —KD
B #% LE&d. 12&21EWindows 10 (7 74V bDC: N5A 7 %4E ] ) D15
& . %localappdata% & C:\Users\<username>\AppData\Local T 7 .
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TZAIVDBLLRT A Y R— SN TE D, v Y PR T 23581k A5 v B TUAF
ET BRI 7Oy MR RINET . KOOTNEFEIT L ET,

« B QOPEN)]%2Vy2 L CHEF OSITEZ 7 L %5 & &7,
e H>E—MIMPORT)] 47Uy s LCRELE 77 A LD A > A— hL T

2F ¥ DT AK— b

A¥ v E.site 7 7AIALIR T ICT 7 AR — b 212U

1. Site ExplorerC. T7AR— T 2AF v > DAF x> XAV T EZAR— MEXPORT)] #
VAPVAVF & 2P
B B 24 U TR 17 (Save As)] 74> N oR Sh &1,

2. P74 (Filename)] 74—V AR N 1 L £

3. RFE(Save)]z/VvrL &7,
sitedh IR T A Wi AF yo NI 2 AR— a7,

A R8T 12— AD{E H

PLIF D% bEvZ Tk Site Explorer® 22— A > X7 x— A EZ D W7 IZDWTHLA L &
ERD

A¥ ¥ DRI~

¥ vV ER & ZOAF 2L LO AT R R S, FRTDAF v (ALL SCANS)] &7
CH AN TOH B DT RTOAF v DA ICE N ET. IRDOA A—YIE. [l A T 3R
F D7 74 fea—%5 R LT ET,
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% 11: Site Explorer

ALL SCANS

Site: http:/fzero.webappsecurity.com/

Site Tree . . .
Findings Traffic Text Search e http://zerowebappsecurity.com:80/account/
B http://zerowebappsecurity.com:80 =1 3 ]
EE ‘?cflz ppsecurity. 119 Results Findings Q' £ Vulnerability Description HTTP e
—————————
[ <script>alertC TRACKY;< Severity T CheckID ¥ Name =
g account Critical 5649 Cross-Site Scripting: Reflected
admin ) ling: i
[ backup Critical 5648 Cross-Site Scripting: Reflected aﬂﬂm% E‘gor Emor Handllng. Unhandled Exoeptlon
[ bank Critical 5650 Cross-Site Scripting: Reflected ﬁ:s;g;‘%&g 200
D chibm iz 7 [T el Handllng: iyl Ed Critical database server emror message vulnerabiliies were identified in th
Odb Critical 10834 Privacy Vielation: Social Security in your web i code. U are circums
3 docs High 11293 Cross-Frame Scripting not expoct and does not know how o handle. When successfully exploites
[3 error_log ) 3 using the information recovered from [ ermor 1
|:| errors ngh Ll Expressu)n Language |!’1JE[|IDI'I avenues of affack. Recommendations include designing and adding consis!
[ hibin High 4722 Insecure Transport user input ta your web providing detail to end
tl include High LT22 cure Transpor‘r useful to an attacker from being ms@.
[ manage High 10595 en Misused: Login Description
* E resotirces High 10595 Often Misused: Login
scripts i E
|"_'| ciate High 10512 Web Server Misconﬁguralion: HT The Tostijcommond::use:lav |::nand:]ed e)?:ef.t\or, |zatfzwlule to propel_‘w '
can also be caused by a bug in the web application's database communical
| testing High 1368 Web Server Misconfiguration: Ung unavailable database, or any other reason that would cause the application’s
[ user High 708 Web Server Misconfiguration: Ung the server. The problem is not that web applicaions generate errors. All v
debug.txt . " I point receive an unhandled exception. The problem lies nol in hat these en
D 9 High 709 Web Server Misconfiguration: Ung handling solufion needs to be well-designed, and uniform in how it handles &
[ fag.html § § ! ,
D faq.htmlbak High 2083 Web Server Misconfiguration: Ung specific file. If the request returns an error File not Found, the attacker ca
& fsz.dbacbl( bl High 157 Web Server Misconfiguration: Ung relurns "Permission Denied " the atiacker has a fairly good idea that the sg
B R ways, from determining the operating system to discovering the underlying a
[ forgot-password.htmi Medium 11294 Cross-Frame Scripting
[ forgotten-password-send.html Medium 10044 Cross-Site Scripting: Reflected The error message may also contain the location of the file that contains 1
D index.html Medium 746 Web Server Misconﬁguralion: Dire path as well as give the attacker the Innélinrl nl applicalmrn “include" files or
i a successful attack upon your web application is reconnaissance. Database
[ index.htmlold : ) sful attack b applicati Datab
0 index.old Medium 764 Web Server Misconfiguration: Ung uilized when the attacker is formulating his next method of attack. i may ew
[ loginhtml Medium 10365 Web Server Misconfiguration: Unf
B that this check i rt of unki ication testi hich k
[ manager Low 11279 HTMLS: Overly Permissive CORS @ aware that this ehecl s part of utknawn agelicatin fesing which see
3 R 1 software. Because of this, there are no specific paiches or remediation infor
D online-banking.html Low 11279 HTMLS: Overly Permissive CORS false positive if the page it is flagged on is technical documentation relating t
[ README txt Low 11279 HTMLS: Overly Permissive CORS B
Q searF—r\.htTI N E E . | e

IRODFE PN THBAF ¥>DT 74V b2

HH it B

—DaAVE—FZ Y MIOOLTE B LT 5.

1 YA MU= A b =D " Ik DR— | 25 [])

2 B X CTD A% v>(ALL SCANS)] &7 EB LW T B AF %

DR

3 5 H 2 T8 (Findings)] 27,

BLU ¥ A MEE (Text Search)] &7

4 5 H 2 I8 (Findings)] £ 2—.
B X M# & (Text Search)] t2—. & LU i

Ea—.

[N 274 v2(Traffic)] X7

[ 271 v2(Traffic)]

DYy REa—("7 )y FE2—D AR LA A" A—

1211, T 2% o2 FIH OB R " R—o127]. 1" 15
T4y DR A—1311 BLUT" 7+ 2 MEE Off
"N—2132) %% )

5 [fé 95 % D B (Vulnerability Description)] £7°&
HTTP] &7

6 [ 55 14 O B (Vulnerability Description)] £ 2— &
HTTPIREAN Ea—(TiE Al L2 DA AR A 2" A
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HH i B

1231 M vy 2 O AE" X—2134 ], B LU 5 x—
2D " X—136]1 4% R)

D7)V ZA LN

Fortify Weblnspect THL7E AT H D A ¥ v #2h <& I 7497t v 327 71 W(TSF)E 3
TORAF x> 7T —KMEWM EA ML TG G N IT749 0T =B VTV EA L CTHEF Sh &
T, 2E 40 (2D T . T"Fortify WeblnspectiZ & 3Site Explorerf] 7 —&1{E i 54 %24 2"
A—v 51 eZ LTS,

A b U—0fF

PA MY U= T 70V b Tl AF v IEB SN 2T XTD F 774970y Y)—E2—
My TOVRSN TR WIREE TRIR SN 3. Y IU—IiE FA MR A M DFTXRTOHT
FAL 7 MNID YR MAE ENET. COL2—TW . i L DR R MBI L Th YT T (1L 7
MIERERT Ly & LAV THAE LB R Y& e T& &9, YV —RAx LTUT b 1oE
RAERRT B YA PYU—TYY—RAEER L ET.

VANV R OF | 7

71> 7O B (Window Position)] A= 2—0DA7'> av & ] LT, H4 MY U—%&JE £ R
CT&ET A by IU—2ERRICT DI

1. MOLTFNHEFEIT LT, Par FYOR B (Window Position)] A=2—#F] & £
o YA MYU—D P4¥ FUOR E (Window Position)] 71 2 (=)%2 27 Vv L £,
o YA MNYU—DRA MLN—FL 7Yy L ET

2. PEFER(Hide)] #EIR L7,
YA B Y=L N TR S ET .

=i} . .

= Findings Traffic Text Search

=

Y . - 3

T 119 Results Findings Q
Severity T CheckID ¥ Name ¥ Location=
Critical 5649 Cross-5ite Scripting: Reflected hitp:lzer
Critical 3649 Cross-Site Scripting: Reflected hitpfzer
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HA MY U—DF I~
FERROHA MY IV—2EK IR T BICU:
o IR T LN M/ NFRR SN2 A PV V—DRA ML AA—% 27Uy 7L &7,

2 Site Tree
e & v
T
=
® %E! B http:fzerowebappsecurity.com:80 = dc 5
SN =]
[ <script=alert( TRACK";< T Location=
. g a;cuun’r teflacted hitp:ifzer
admin
] "
[ backup teflected hitp:izer

YA MFDKA N /—N

Fortify WebInspect Cid A% ¥> ik & TE & SN/F ] R A MM Sh &9 . CD7o,
BRAb R A & HE LIz A DY V=N IS A MENDKRR N/ —FRR IR SN BIGE0HNET,
L7ct3oTy BRAN R R bE 7OV KULEE 5 20 B 2 W& RH VET

YA MY V—=D7 A av
WO TIE A MYV—ICRKR SN BTV Em P LT0ET,

742
¥ AW RLTWBRLD

B H—/FK Ak H4 bDY )—HE i O b LN
OB 75 T AL 7MY

O ~x—v 7714V

VY —AD s T 497 DF IR
YAV IV—NDIVY—RAD s 77490 8RINTEETIHH D N F74v 08K IR T BI2U4:

e A MYU—TIHH #ZIERL £,
ZOIHB CHBR T2INTD 7749705 [FZ74v2(Traffic)] 7 Uy FIZER IR S £

FEANICDWTIE L T2 v v DEEAE" X—U134 1 2Z 1R L T2 S0,
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KR NG DA D I~

FA N OEDYVR MR R T B!

o T 75 MDY Y—E2—T, 7HOVEATAa>#&1mE 27Uy oL £,
A M= HA M IPORRRENET . COE2—TlE. Y 7T AL 2 ML T 72 AT
EEth. COE2—HH 1DLL L DOFRA PRI L. FR DERAN CEE . TMER LoK R
hD 7 4L ZALELY N | #2 J8 LT 280,

V=R DR R ISR BT

o LI TANARTA A E IV LET,

IR LR R D740 KL

FAEIN R AL DA LTDIZ A MY V=N O EDHRA N 7OV R C& 9, 3N L
PR ANEZDHTT AL 7 MDA H A MY V=R T~ T B

1, YA MV—ICHARA MG P UDE R SN THRIREE T, Kk T2FA M1, BN L
7,

2. 7OV RT7AavE )L ET,
IR LA A MUY A MY Y=l R SN £7.

3. AN LT, 204 77T 4L 2 VER R LET,

TRTDKA MM DE R
TRTDKR M DRI IR BITIE:

1. 740V A7Aa>& 20y 9,
P A MY Y—1Zy BLET IR R LIABIRFE A DK A MD KA M 12U 0NE R SN &7,

2. IBINFADE KA e 7Vw /LT ENTN ORI R LET,

3. 7R 7AavE 7y oL ET,
TV RILTE S THH WY V=B 2= A MY U—IZRK IR SN, TXTD b F74v703%
RSN FT,

Ty RE2—DAARARX~ AR
TV REa—ICE IR SN BH) DY A XA A EZE GBI, BLOHI R ATEET,
Hl| DY A RAE T

Bl DA R &5 T F 2121

1. $AXERE 3 25 B LOLH O F e a—y v et g L7,
A=V R EDZZ 0, F R LOBE SO MO KEBLEDNET.
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Host T Port ¥ T ,Method T Status
zerowebappsecurity.com 80 fdocs/api/index.html?orgfapache/catalinafwebsocket/V GET 200
zerowebappsecurity.com 80 faccount/ GET 500

2. MOWEFNLEFEITLET,
o MWELRIBICABET I DA 24 £ld LW NIy LET.

o MR AL IV T BE HDOHARIEH N Tht bR )L DT —ZDOME 2 DET .
4V RO R I K R 27— AN—HE N SN B2 ERNHVET .

HI| DA B AL 5

Z )y RCH DNE P 228 § 21214

1. B8 325 HRH Lichr—Y s LT,
R LOY SO 28 KB IcEbNET.

2. 1A 2V oL £,

IR B LOEREBAHICEDLNES,
3. HHIODNAL B £TH 24 2L RI97 LET,

ta___ T Host ____ __ S8 1 tgor‘r T +Path 1
11/28/2017 10:58:00.477 zerowebappsecurity.com 0 fdocsfapi/index.html?org/apache/catalina/websocket;
11/28/2017 10:30:50.352 zerowebappsecurity.com 80 faccount/
7 —RDF| KRB L Bk ODFE A Tad I B B E) L&,

%1 DB N THI Bk
F 7L N TRTDF =28 717 Yy FIZRIR SN 2b U T D V&AL 7Yy FEa—D

2 2y

RE T J VY RERIN T 27T —KF 21BN TEE T, Rox 325 #80 23 HI R 4 3012
&:
1. Z7)yrea—cl 59900 5.
T BE 25 D VA MK R SN ET,
VE: B 4 1k A% v Wi B S 2 AN E R LET,
2. WOEEEERITLES.
o BRWIEBMTAZEINDF 2ol 9w I/AEF NI LET
o RIRMOHIE T BHINDF IR v I AEA 7L ET,

3. FIDVAMINDIEE DLl #2Yys LT YA & L &7
RV D F Sh £
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% 11: Site Explorer

HA C2—DHARTA R

J Uy RLLAN DFFEAl Ea—DL AT 7 hehF—T—v5IER Lz). HTTP]FE4H £ 2—DF R~
S ERREY OB 21203 22N TEFT,

LA 77 DA

B3k (Request) | 54l b2—¢& 5% (Response)] it 4l a—724 & HBIHH 2k LT2DD
FEAN Ea—AE R SN TW B A IE. 2N 504 22—/ B 5200 XB 2T 4 (T
B KFTREEEC)VCHE LT 2208 TEET. LATV METE T 212!

1. 24 ca—ct sy 7.
e Ama— X7,
2. ROLTNMEELT LET,

o FEAN La—ZME(L T )il N2k, #E LA 7V MVertical Layout)] #27 Vv /L &
R

o FEAH La—%EE I XBI12IE. BE VA7V MHorizontal Layout)] # 7V v/ L £

Ho—FT—~vDIH
FIHN MDD AT—F—lE A DN 7 59 RCE BLVE AT EDFF R NCT. 12770, B
DNy 277 RICH SO EDTFAMNEH $2260T&ET #7—T—~v2EET2
Wi
T G * A S
2. OWTN»EET LET,
e WAy T7 57y MICE L LT &DFF A MMl ] 2101k, R 7—=(Light
Theme)] 27Uy /L £9,

o NNyl 5T Yy NICH aff D7+ A befli ¢ 21k, B 7—~(Dark
Theme)] %2 7Vy /7L £9,

HTTP] 2L 4l £ 2— D& /& HIE R R

Ei3k (Request)] &7-ix Ji> % (Response)] ¥ &l La—74 &, HTTPIF A £ 2—0D1D%4T
0112 0( £ AE R T 10T B) LT MO HTTP]ZEM 2O A D& 2K 7 3 52 &h0
T&&9d.

APl Ea— 2 ER IR ICT B

o Al La—DIERIRTAIANA)EZYILET
ERK N OFfAll L 2—FR IR T 212U

o BRTATAN)EL VL ET .
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a—7 47 BE). BEO NyF T

YA MY Y= ZYyRea—, BLUFM Ea—%2T70—T 4> 7 &), 8LV FyF> I LT,
2= AV RT =AU Z HWARTA AT ELT,

A MY Y—D Ta—TF 427 E)

YA M=% T70—T 427 LTCE=RLE DRI D74 P ELTHE) L2, Bl D &7} &7
WU E LI BIEMTEET,

YA MU= E) T 2 IROOBTNEET LET,

o YA YU—DRA MA—%A 2y L. Pua—F 47 (Float)] Zi#iR L £ .

Site Tree
Float

Dock %

= E http:, Dock as Tabbed Document
BB/ tide
(O <script>alerfl TRACK ;<
[3 account

o FAMII=DRA MV A=% TV 7L T LG FZy7 LET .

BT & T N—TWH A MY V—EFEE) I B

o YA MYU—DRA MLA—%L 7Vyo L. BIfF & FF 24 bELT Fy¥ > 7 (Dock as
Tabbed Document)] %i#4R L £7 .
HA by U=, [FZ74v2(Traffic)] 7% F * A M& K (Text Search)] 27 7% £ DR £
TR &N L £,

TV REa2—D7a—7 427

JUyREa—%78—7 427 LT, E=XEDRI D74 F7EL TR TEET,

TV REa—%70—7 427 T 22 IROVLTRnEEITLET,

o FYYRRTDEA MLEA 2Yv2 L. Pu—F1>7(Float)] 23 L £7.

Findings Traffic Text Search
Float

194 Results Dock I})'.I'a:ubed Document Traffic Q #
Mew Horizontal Tab Group

Request Start * New Vertical Tab Group T Port ¥ Path [

11/28/2017 10:29:51.380 AM  zerowebappsecurity.com 80 fresources/js/placeholders.min.js

11/28/2017 10:30:40.790 AM  zerowebappsecurity.com 80 fonline-banking.html

o TVYRKXTDEA MLE IV IZL T LOG T NSy LET,
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% 11: Site Explorer

Al ca—0D7a0—7 47

Al ba—ET7o0—T 427 LT TR L ORI OV 4 FUEL TR B T& &7,
Al E2—%T70—T 427 T B IRDBT N EET LET,

o FEAN X7 D XA MvEA 2Vyo L. Pu—F 4>/ (Float)] ZiER L .

http://zerowebappsecurity.com:80/readme.txt

Float |
Dack ‘8w Tabbed Document
o
REQUEST Q A

GET /readme.txt HTTE/1.1

Referer: http://zero.webappsecurity.com/
Accept: */*

Pragma: no-cache

o FFHl XT DA MVEZVIL T H LOGIC NIy LET S

¥E: B3R (Request)]|#£ 4l 2—¢& |52 (Response) | #E4ll € 2—%Mf 5 1o 7a—F 4> 7
TREETEEFTA. N B2DODE2—Id. 100D HTTP]FEAN ba—&L THERE L. Sl 57
Lic74> RoeELT—&5 W 70—T7 47 L&ET,

X7 D% §f)

A MY Y=, ZVyREa—, FREFFHH Ca—D KT 7 N—THNDRX7TELT Ry 73N TH
PG E . OXTIN—T1CE) TR ET,

o« RTDRA MVEL 2V LT IRDOET N hEET LET.
o M LORTSF ETN—THENR T 2121d. BE X777 V—7 0% HAE B (New Vertical
Tab Group)] #i#ER L £7 .

o LM DETSF &I N—TWX KT ERE T D12k RDEXTT V—71 8 (Move To
Next Tab Group)] %R L £7.

o F DT &7 N—F1 47 %8 T 5id. BT ODXTT v—F K &) (Move To
Previous Tab Group)] Zi# 41 L £,

W: 27O CE247y 20d. E7BIRTIE Ryd > 7 SN TW ARG T & > TR
TNEY,

T4 RTD Ry T
TO0—F AT 74 N5 Ryx v 7 L UNWCHES S5 722808 TC& T,
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% 11: Site Explorer

R TIWN—TNW T4 N7 &% Ny¥x > 7§ 2124

o TU—TAVI TAYRIDRA MUA—EL JYy LT BT & FF 24V RELT Ry 7

(Dock as Tabbed Document)] %1 # L £ 4.
TAY NONE RT T N—TIZ RyF T LET

74 R LOAL B IS FyF v 74 2120

1. 78—F AT 74 FTD XA MUA—F 2V 2LC i LU TIPSy LET,
2. RuX I B AT —ZNERRINTZH6. 70—T AT 74 RUERNyx 74 206 B

WA—YIVEREE) LT,

Findings Traffic Text Search

194 Resulfs

Request St
11/28/2017
REQUEST

1lf28j20176ET fdocs/security-howto.html HTTP/1.1
11/28/2017Referer: http://zero.webappsecurity.com/dacs/
11/28/20177CCePE: 7/

Pragma: no-cache
11/28/2017Accept-Encoding: gzip, deflate

11!,28]2017U55r—»:.gent: Mozilla/5.8 (Windows NT 6.1; WOWE4; rv:38.8) Gecko/:

o.webappsecurity.com
Keep-Alive

Vapriano17 A4 377 A

11/28/2017
11/28/2017, 4
11/28/2017 RESPONSE

11/28/2017HTTP/1.1 268 OK
lleSfQOITDatE: Tue, 28 Nov 2817 20:44:12 GMT

Server: Apache-Coyote/1.1

11/28/2017Rccess-Control-Allow-Origin: * —
Accept-Ranges: bytes

11f28./2017ETag: W T AXO0O0CCO00N0CNNE ™

11/28/2017Last-Modified: Wed, 15 Jun 2016 16:49:46 GM

Content-Type: text/html

11/'28.:’2017“.:[._-;. Lmmmtb.

11/28/2017 Tz AT ZETOWEDEPPSECOTITYaCOTT
11/28/2017 10:52:09.997 AM  zerowebappsecurity.com
11/28/2017 10:51:46.477 AM  zerowebappsecurity.com
11/28/2017 10:57:33.727 AM  zerowebappsecurity.com
11/28/2017 10:35:24.703 AM  zerowebappsecurity.com
11/28/2017 10:30:43.657 AM  zerowebappsecurity.com
11/28/2017 10:31:45.160 AM  zero.webappsecurity.com
11/28/2017 10:56:47.463 AM zerowebappsecurity.com
11/28/2017 10:51:44.327 AM  zerowebappsecurity.com

11/28/2017 10:57:38.600 AM  zerowebappsecurity.com
4

TUOCS RECEASE
fdocs/config/loa
fdocs/configfeng
fdocs/configfexe
fdocs/ssi-howto.
fmanager/html

fdocs/zetup.html
fdocs/funcspecs,
fdocs/RUNNING
fdocs/config/resc

O 00 00 00 ) 0 00 @0 g0 g

3. vUARSIEEEE L E T,
IR UL B4 RIS RyE 7 LT,

Ny 7 B I2DOWT

DA A—JIE SETDOFvF v 7B 4R LTWET,
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% 11: Site Explorer

KOFRIE K FvF IR BEDETO—T AT T4V RO RyF 27§ 2D D0 Tkl
B LTh&Ed,

hr B Fy¥ > 73 35 Bt
Z—4"y b YT O

K="y b TN O g
K—7 y bZYTHN O B
K="y b TN 1 {H

&=y b7 O

A7 a7 D H

WA EoTIE URLY B3R, 3B L EDRTDay 7oy T&&d. &7Da
FIUVEER S 2L B SN X7 Dar Ty aE—0E Loy BCAE L S &9,
VT UVEE R TEBG A . X7 MUVICIEER 74 a (A Fn &9

THH #2121

1. 2724 bR 72> (& 7Vv L E TS
HLOTAY RN &F T, TLDRTZTDAV T YRFH LT A RCR R SN ET . 5T
L4 RuD XA MUk, €lone:<jc DXTD XA b>] £ NET

2. (AT 2NFH L4 FoEXTELTRyF Y7 LET . sfMl DWW T " 7o—7 1>
TORE . BLU Ry " AR—U1241 5F B LT s,

NZ 74y ERR R TH O R

KD hEYZ Tl Site Explorer TDAF v 8571w 7 &b i F TH OEEAE T ¥ 12D TRl
L7,

A% AR i IH OD%T%%'?
A% oI H S 85 M. B 35 TH (Findings)] 87 TR /R T&E &9,

[ i F T (Findings)] 27122\ T

[ 4 = IH (Findings)] #7w2i& [ H 35 15 (Findings)] 7 Vv k& §iE #L (Evidence)] 7 Vv K
NEEN 9. [HEFIH(Findings)] 7 Uy Fizid . A% v> 7 izFortify WeblnspectiZ & 5T
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V=LA AN
% 11: Site Explorer

B S stE AR s S &9, FEHL(Evidence)] 7 Uy NiZik . i 59 £ v s AD R
MR SN ET .

{5t F I8 (Findings)] 7 Vv RN 0% £ v 2k 10O I HIH 4R L 3. el #
HODIaRH A bR YT T 427 (XSSWWE S5 PE AMFEAE T 285 G D NET A, £ vy 2T KY
WETE e ZD+& v 3 CFH L SN E E O AA—y 3 OXSST 8 DIFHL 235 7 Sh &
7.

vE: Site Explorer’?s 2% v> #48# ¢ 3 &, 2D A ¥ v idFortify Weblnspect® 720F
E 25 (7PK) 428 OfF H (Use Seven Pernicious Kingdoms (7PK) Taxonomy)] 7~
Vr—y R ECHER L ET. COT77Vr—y 8% E Tld . s S 591 28 7
FTUOBLIVEE § 210 TOOFFE LR B2 —PERCTCEET. 2OT77Y
r—3 25k E OFEAN I DL T . Fortify Weblnspect™~N L7’ Dl 77" ) —3 a5% 5 © 4
M1 hE w2 & 121 [ Micro Focus Fortify Weblnspect User Guidell % & L T {2 3w,
[ B IH (Findings)] 27 &R O 1> kel T7a—T7 4> 7 LizD. Ry¥ >/ L0 T&&
To Al DWTE . T"7o—T >/ BE) . 8LU FoF /" XN—=U1241 R L TS

Uy,

fil I ] g % 471

fét 14 35 IH (Findings)] 7 Vv Ricid . Web 7' L+ > ZADE 25 v ok s 2% if 99 7« B
TREFEMA—ER RSN ET RN TAERAER C& 7. s OLTE, MM DI
INIEEE" X—=21221 22 R LT 280,

fEH AT RE 2 HIEIRDEBNTT .

« E K& (Severity): i 55 1 Ot 11 2 5F-Aifli (1% (low) > 5 X (critical) £ T).

» F=v7ID (Check ID): 7 & Dfffi 55 14 OF M #F =v 2§ 2. Fortify Weblnspect” o—>"
DT 5 o 128218 F =29 IID 742l T—ERN—AY—/ XD L F— AyL—I LDV T T
AMLET,

o ZHi(Name): 70R4y A FAZVT T4V 7 S S Thanwal 4> 7r— 0% £ R E
Dfifi 55 P 1wxt 4 2Fortify Weblnspect” o—7",

« B P (Location): VY —ANDRE & 2 £/8F5 A— 4,

o RS x—24 (Parameter Name): fifi 55 % /3 54— XD 4 11 -

o R Fx—4{H (Parameter Value): fii 55 %4 /3 5 x— 2| 024 T o -4 .

o CWE: JIfi §5 % «2 [} 3% £} i 511 7zCommon Weakness Enumerationz# 7!l 1 .
o XY yF(Method): B2 (2 ] SL-HTTPEI SR xV w

g 55 1% DR B DK 78

[ i =I5 (Findings)] 7V w B 95 1% (2B 3 25F &l #3878 3 21214
o W EIE(Findings)] 7 VyFCIEH #i&R L &7
16 55 14 DR BH 20 &\ WE 59 1 (B I AR F A SR e F Al La— I Ron S &9, eSO

&t B (Vulnerability Description)] &« Jife 55 £ OME 22, AT\ Bk BB 8 LU B
AR R SN ET.
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&t 25 18 (Findings)] 7 Vv R TOD 7 1)L KAL FR

{5t 3 IH (Findings)] 7 Uy RicR 78 S 31D, L DFI| OF — X% R 8 LU 7 1L UL B
T BIE M € DWebfifi 551 27 0L KL TE £ 9

Weblifi §5 1 % 7 0L UL T § 21214

1. ME 74 2Q) 7)o L &7,
2. P73 WCATEGORY)] VA NC. 71V R%i8 FHl 4 2Webfi §5 74 #1%4R L £ .

Findings Traffic Text Search

10 Results Findings Q &
Seve n
Higt ToWE
High rowe
High Oe
High | & Web Vulnerability roswe
Often Misused: Login

Best Insecure Transport rouwe
Bast Privacy Violation: Autocomplete —
Best FOWE
Best rowWe
Best rowe
Best TowWe

[ 8 # IH (Findings)] 7 Uy 235 87 &4, 3 4R L7-Webfffi 55 PE o — 2 3 28 H IR 720
NE O T,

TOVRDEEAN OO TR TR 7 0L ZULEL" X—21401 %5 B8 LT 2 &S0,

MHFEIHOT I ZAR— b

& 4 3 IH (Findings)] 7 )y 823 8CSV (4> =X V] M) 7 7A ML T — K& T/ AR — hC & &
T JUyRREBIWE ST TIVAR— T BT —ZNRE SN EFT . Ron SN T BY| 21T
JAR— RSN, TIZAR— SN FIE 7 Vy REFE CHF TR S &3, T7AR—Sh
o7 —RiE. ZVy RN DT —REFE CLENY— B LN T7 0L R S 4,

fe eI F—RETIAR— M BHT27 )y NN CE K Bk (Critical)] T 7 1L &4

U G Y— LG4 . CSV 773 B K B 5 B K | OF ) ZTE 7200 48
FEN. T REG Ay — b E T,
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MEHEIEETIAR— N B2

1. #MEIE(Findings)] 7 Vv KTA 220, CSVICT /A HK— MExportto CSV)] #
EIRL T,
B B 24 U TR 17 (Save As)] 74> FuasR R Sh &1,
2. PrA4n4 (Filename)] 74—V RIZ 774V EN JT LT,
3. RFE(Save)]z/VvrL &7,
774 cesvIL IR AT ETIRAF S 7.

Al JL DR IR
Fortify Weblnspect#3ifi 55 £ 245 th U777 V% OFF 4l K8 3 51214
. PR BIE(Findings)] 7 Uy FTIE H #8701 2 Vs L £,
fL#L (Evidence)] 7 Vy RHK IR S IR DGR AF 78 S &9,
» V—RA(Source)-i# R LIk IHOURL %371 L £ 7.
o Bl(Parent)-V—RZ DL 2MOF r—>5—HRKRNLET,

o N A=K (Parameter Attack) -4 % 23501 L. 2 2 2% J 2 /— FO N ic— B K IR
L& (KW 34> 700 ) §E)

Findings Traffic Text Search

1 Results Evidence T
Relation Url
- Source http:fzerowebappsecurity.com:80/
Parent http:ffzerowebappsecurity.com:80/
Farameter Atfack http:fzero.webappsecurity.com:80/

o %5t 7Y I ¥ (Reflected Attack) 7K 4% [ %2 70 AW A NAZ VT T 427 7 &L [ T T 42
O FFPE 757 #3L CRRo 2 sn s & 2@ LT, 2O E E X o—F
N LIzt OB DT T,

R B OFF A DFEAT Ca— RN SN ET . ZIh A, Loy av T & 2/85 4—%
AERTEET. OB TIE. TS5 A—ZD[f 1" *—136 ] 45 1R LT &2 &S0,
Hia 55 M & 7ol BB S 7 3 O i)

fE#L (Evidence)] 7 Vv T [—RA(Source)] £ vy 2> ##E R T2 &, £ vy 2> OffE 55 46
G DER ETAEIS B EE ) OFF A Ea— TR RN S & T,

FE#L (Evidence)] 7 Uy N T PR 54— X ¥ (Parameter Attack)] #1# R + 2 &, B L 7
51t PEsR (REQUEST)] 2441 La—Coh g %5 Sh £ 7.

AN OWTIE " vy 2 DERE" R—2134 1 25 18 LT 2 &,
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CHHHTHSR s

"R AT % ofz S )y FOFRAE" X—2139
W2 7L KL R—30140
"R S e on T X—2143

N7 497 DIR R

T 74 hCIE AF v FICE R SN 23 RTD b 5749008 [Z74v2(Traffic)] 7 Vv B2

RIRSIN AF AV ERD N G749 0B R R TEET . LR B DIV —RAD b7 190 %

RRBITIRRTBIE8TEET. [MF714v(Traffic)] 7 Uy NN D7 —REM R . V— b,

BLOTOV I TEET fFAIICDOTE . T2 &7 0L ZULHE X—21401 #Z B LT
-1

DY)—2AD 5749 7DFR I~
HA MY Y—H DYV —AD 574975 RRNTEEFTIHH D 749 05F 8 T 2120
o A MWY—TIHH ##ER L &7,

ZOIEH CHEBR T3IXRTD b574900 [F574v2(Traffic)] 7 Uy NMICE R S £,

ZIhBy [NF74v2(Traffic)] 7 Uy RT vy av 238 IR LT, ZOE R G & UL H L1z,
IR 52 857490588 R LIz 0. FDNAGA—REFA N DT BENTEET . sfAlIcDOLT
E T oy D OEAE" XR—U134 ). (" 8574907 — 2D FUYLK M XR—2 1371, B &
M85 4—2Dfd " X—136] 25 1 L TS0,

AN IV I
YA MV—TIVY—RZIER T BE CUWIR T TINVDENT VL YR IFTL IV I ST T4y
27 V9RO EAICR I S 9,

::hﬁp:.ﬁf‘mera.webappsecurinr.cam:ECl >] >I'E\EEIUFEEE >5 >|:>am51'rap.min._'|5 x

CNBEDTL RISV IE TLyRIFL VY 2 VA NS TOBERE DYV —AD K574y
IDAR 7OV L TCRR L THWBRZEE R LTOET,

—JDTL yRIZIL Y 2OM DAL B IZYA NSILTOWBERFE DY —AD N 7490 % T 4L R
AL 4 212105

o TLyRISLYYIN DYV —RE Y7L &,

ToeZUE HI DA A= IR 78 S T Bresources 74V ZD T X TD M5 7 47 %R 7N
¥ 3% 45 L. fesources] #27VvoL 9.

RAR L2V — AR B DTL vy R 254 U 212 7% 1, Site ExplorerT 574y 7€ v a8
W SN TR L)Y —RAD N 5749 7DH KR SN ET .
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TV RETEA HI R T B
o TLyRNIZLIYIDRED Kl &7Vl ET S
TVyRIIAVY IHHEIER S NI T749 02 vy DT OV KL Sz e D& T,
CH6HTSR 3w
"ty 2 O E" R—v134
"N T4y IT—RD RYLR T N X—137
"8 F A= RDME " =136
"TEAMEER O

7% A MERR OfEH

I~ X M& & (Text Search)] A7 Cld IGZE DT F A RNy MR R TEET. FFAL
1 & (Text Search)] 272 [+ & M# % (Text Search)] 7 Vv k. [~ 771w 2(Traffic)]
7 Uy k. BIE NZ77+1v2(Related Traffic)] 7 Vv k. 8 &0 Bi# 7+ 2 MRelated Text)] 7
Dy RV &1 &7

Bl W TWBAF v T ¥ R MEE (Text Search)] 27 H] »T7 7t A4 3 &, Site
Exploreril & >sTH R A > 7 w2 AME R S, ¥ X M& & (Text Search)] 7 Vv Fic & 7~
ENEFTMBRAVT v R TFA MR D5l h A b 7F A D XA 7(FE T ALy
AV Mg E) BEUISE OIFFE 24 7% 2 MVE 41 £,

7 ¥ A ME R 5
W ODFIE. F* A MEZE(TextSearch)] 7 Uy N T4 .

# B

#2 A ID(Origin++ ik, 7F A MR DOhofz 8574y ok vy 2 D H OIDT

ID) T EBEIDIEIFED PS5 74978 vy DI RTDTF A NI L—7
4 2354 0. TEFRAMA=Ry bR DB F Tl " 2235 &
AER TF

HF—s3(Server) ik G FIEE LKA MeR— T T

£47(Type) L. aXr b, BT AL, 74— 4. FormAction. HeaderLine.
HeaderValue. StatusCode s ¥ D)tz & D XA 7T 1,

7HEZNText)  HE BT EN2EBEOTFRAITT.
[ % 2 M& & (Text Search)] 7 Vv FTOM &

M &7 0ov ZILPE" X—2140 ) CREBH ST 28 W N 20 7 ov LB 2
T. F# A MEZE (Text Search)] 7 Vv Fizid A7 (Type)] 74— EHAHE S T30
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% 11: Site Explorer

T HRENBAGFEDEATOTFAMIEE C&ET,
A7 (Type)] 74+—v &M H 3 31204

1. MR+ 27 A% PovAFilter)] 74—V PN T LET.
2. BAZ(Type)] Fav 7/ X YR MO NRE T 2T XA MDA T #IER L &7
MR R IEBIR LA TOTFF A MR E SN £

7 A MR TORE OB

b3 A M# % (Text Search)] 7 Vy RTTF A A=Ay hEIEIN 426 BN LGB DT+
A RAZARy bS ¥ A NMTEXT)] 4 Ca—ic R S &4
E: ¥ X MEZ (TextSearch)] 7 Vy FD&Z AT OF IR 7+ A M. 4047 il BR sh &
To TEAMTO R CEIER S (L)MBER SN TH B AL 7F A NDIT B 24017 %
BATBD R ODITAERSLTOALIEERLET. B L TFAME. FFAb
(TEXT)] 34l b 2a—CHR R C& T,
1DDIGEBE L HDTFA ARG NG AHVET. [, 1D2DFF R PR=
Ry M2 DB G TG ERDHVET . 75 A MR Do ol ¥ Dt v 3> DE R
L& UM, ER(REQUEST)] 8 418 Jis % (RESPONSE)] #E 4l E2—IcK 8 S &
ERD
[{ U7 F A MA=ANy bEF Cfth OIS 2R 8 T 2120

1. F*AMEZE(TextSearch)] 7 Uy KN DT> bIEXTIV 7 UvI L ET
[N 5749 2(Traffic)] 7 Uy KA &, & ICZ07 % X FA=Ry MY $1 3T XTD
tyy D VA MIKRIRN SN ET .
2. [FF749X/(Traffic)] 7 Uy KT v av 2N L L7
F 74 hCIE L BR UGEN HTTP]SEAl La— ek S &4
3. (A7v zv) o274 (BROWSER)FfAN Ea—Tt vy v 2R RT3k, PS5O
(BROWSER)] % 2 Vv2L £

vy O FF 71y DRIN

(N7 4y 2(Traffic)] 7 Uy R T vy s> D b S749 08K INTEET,
oy O IE b7y #RIN T 2
o [FZ74v7(Traffic)] 7 Vo RTE vy 2K 70V 7y L ET .

Bl 771 v/ (Related Traffic)] 7 Vy KRR St E 9. #l b7 74002 vy av M A
ARE G A B OVA N2V T, 2R 60 HTTPIFAI Ea—8B LU oy
(Browser) | if4ll La—%K R C&ET,

[F=74v2(Traffic)] 7 Uy RIZJR B1214:

o [F574v/(Traffic)] & H &1 b AA—% 27Uyl &7
[N574v2(Traffic)] 7 Uy FOE R S, $XTD 749 ohK R SN ET.
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AR DL TIE S TR AT 42 o727 )y FOFRAE" X—2139]1 S ] L TS0,

vy D E 7 ¥ 2 MDOFK IR

Bl1E 5741 v7(Related Traffic)] 7 Vv k6. vy s OBIE 75 A MR IR TELT
B 7+ 2 MRelated Text)] 7 Vv Rizid IR Lict vy 2> DG 2 TR D ofz 7 £ A MO
DA MR RN S EF . [IE 7+ X MRelated Text)] 7 Uy R Tld. =2 MIZEIZTF A DX
A7 S &7,
tyy ORI 7 R MRIN T 22
« PB9iE b>71v7(Related Traffic)] 7 Vy T, Ly av X7 27Uy oL &9
[ 3# 7+ 2 MRelated Text)] 7 Vv M3 R S & 3. COZ Uy PR ORI FF+ A b

¥ % (Text Search)] 7 Uy ML T &, Ron SN 37 F A MAEH GZIEIR LItk vy 2>
DELDDAIZENET .

vE: B 7* 2 NRelated Text)] 7 Vv FOZAT OF 7~ 7 F A M 4047 (2 IR S &
T TFAMTOR WA T (L)ARR SN THBGE & 7F A MOITH 24047 %
HATBO R ODIT AR RSN TOLEWIEERLET. BELTFAME. FFAL

(TEXT)] 34l b2a—CHR R CEET.

ITHOFRTOTF R MERR T 22U
o P93 7% % MRelated Text)] 7 Uy N T T 227 Vv/L &
% 2 NTEXT)] 240 La—c52 4 A 7% A MAVE R SN &7
BAiE ~57+1v7(Related Traffic)] 7 Vv FIZR BI2id:
o B#E +>71v/(Related Traffic)] # H & ML AA—% 270y 7L £7 .
B b>7 v/ (Related Traffic)] 7 Uy AR R SN &9,
FEANICDWTIE . TR A 2 o727 Uy ROPEAE" XN—21391 25 R L T2 &80,
CHEH TSR G
"Ry DRR " A= 131
"NZT 49T —RD N KM X—137

RN X (=
A% 42D NS T4 T AR SN T BT — A E 2 L TX €A, #2771, Site

ExplorerT b 574977 — XA LT A¥ v c A LR E 2 & 0 R+ 328
T&&d.

HTTP&: 4l O 7

oy o DER YGE G, HTTP]H4l ba—THR 228N TEET., COL2—Id. IFEAL
D7V RTIRIREN 21 vy DT 740 FEe2—TF . #2770, B OFE4 Ca—HEKx SN T
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IV AR
% 11: Site Explorer

WBEXIZ. ZORDOCE R UGB 2R R T 256 & HTTP]FFAI coa—wd] 08 2 &
ERS

HTTP]Z 4l Ea—Tr vy v 4K /R T 2121

1. ZVyRTEyy v 58I L &7,
2. HTTP]1%7Vvy/L &9,
HTTP]EE4N E2—2300 & IBIR Lz vy av DER UG ZENE R SN F7.

7 ¥ A ~OHT ViR L

B3R (Request) | £ 4 E2— |2 (Response)] i 4l E2—7% EDFEA E2—Tld. 7F A
MIDR OWE K FRAZa— VA= LA WTE 3> TV EER TELR W ENDH N E
7. T ViR L(Word Wrap)]#% & 18 ] LT7* X bEHT DR #1E . K F A Z2o—L/ 13—
KRS €A, Pr ViR L(Word Wrap)] #% & d i 4l La—Z i E TEBLDTH . ¢
NCOFAM Ea—Cx §37 0=\ WEARETEHVEEA. BT DR L(Word Wrap)]#% &
F . 2R E 7 7AOVICEEA C2a—Z QIR TE S R Bl 7707 — av 5B {EXIZZDEE
4 La—D7 74 MIE &2 D& T,

7T ¥R NPT DR T

o FFAl ba—x4 Vvl $1 VIR L(Word Wrap)] iR L £ 7.
W7 FAMTHHT DR S, KPR 7a— A= & NEd.

N—X Y N a— N FEDTF a—
FI7HV T ER USE T TH L F A= by a—F 4 SnTw 4,
FR FEIEZEDTF A MI%3IBR%40L ED/RA—L Y NIy a— N FEHRH 2855 1E. Ch b
DY F %7 3—FLT THFANEART T BIENTELET . BR LI BEDOL T %7
I—NTBL BN Ly DT RTCOB oy v EF 2oy 2DFER 3L L7
I—FENET. INBDOLFENT I— RSN R BB IR 1o 2Dk . AF w2360 LT BfH]
PUTT. AF v 2B CCHER & 7740 NOR R EH S, T X7 I H U/ —
by a— N3N £9,
N— Y hLYa— R F &7 23— T 31214
« JE%Z(RESPONSE)] %7 47214 ER(REQUEST)] 27 T4 2 Vv2L T URLF 2—
F(URL Decode)] #1# R L £ .
N—t Y FZYI— R FEN, AR TOTFAMER SN 7,

P 27+ (Browser)] TO+ v 3> DR IN

274 (Browser) |5t &l La—Tt vy av #RKIN LT A M DEZT M I740 054 L
Jet &R C&£T .

27+ (Browser)] Tt vy 2> #K IR 3 1214:
1. Z7VUyRTroy av 2R LET,
2. P74 (BROWSER)] %#7VUys7L &7,
P'Z 74 (Browser)] #E Al 2—230 & IR Lo vy v WR IR S &7
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VIV HA R
% 11: Site Explorer

&4 23> 7D B

VT UVEIEM(EREBREAA) T BE. I FHBAR—Z, AT v—A—. IAV b BLU
7'y sX Y] Vit 5 IR S, 77V A XDV S NET. LLZOETIE., avF
YYIMANHIZESTRR AW N DI A VET . 1k (Beautify)]#% & &4 H ¢ 0id . JTE4E &
N7 A %R c&&d. [EiL(Beautify)| iR E EFfdll La—T LR E T&2LDTH
D, TRTORFA L2k § 27 0— LA 8 Cldd it A. 1L (Beautify)] 5% €
i 2R E 7 AAIVICEEAN L 2a— T SR AE SN IRl 77 07—y av &0 {E&ICZDEE
M ea—0O7 741 MIE ELTEH s £7,

F s Sn-arr7oysREH 3 21203:

o FEAl ba—TH 2Vvs L. Eik(Beautify)] ZE R L £ .
JE&E S fzay 7 Y DR S, st AR T & DET,

VE: = OFFAMIENTEL VDT, COATY BER RSN L VIEES LHVE
£

CHHHTS M FE

"NTA=RZDfFEH" R

IR F A—ZDff F

NoT74vrt vy s T SN BT A—RD AT LRI BEIMEER R TEET. [V
A— & 4l (Parameters Detail)] Eoa—(2id. o774y 78wy av T s 27 v¥—& 121k
JIVLFHTEIDDL a— REF LT Vo RBRIRN SN EF. [ CATA—80ME F sh T
WBRITNRTD IF 74y 7L I—RERRNTEIELTEET,

INTGA=RIZDNT

INIGA—RZIEIRDOBTNEIRE C&EET,

o IyF—7T—X

o HTTPZE 3K DURLO— B &L TS SN B( 721k 5 DN\ v&IE & 3) 7T ST 5

o Post#xV v &M L TiE{5 S 37 —X(set_<parametername> 7 &)

INTA—REE AN DR IR
Y vy DRSS A—ZDFEA R~ T 312U

1. MOWTN»EFEITLET.

o fLH#L(Evidence)]. [~Z7+1v2(Traffic)]. BiE ~>7+1v7(Related Traffic)]. [
* A M&Z (Text Search)] . £7zi& B i# 7+ 2 NRelated Text)] 7 Yy R T, £ vy 3~
FIER L LT,

o [ FHIH(Findings)] 7 Vy kT vy av &R L. HTTP] 27 %22Vy 7L £,
2. PSS A—ZX(Parameters)] %7 V7L £9 .
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V=LA A R
% 11: Site Explorer

BN Lick vy s TR SN TOARIA—RNBER IR Sz P35 A—X(Parameters)] #F 4l
Ea—5 &£,

H: Al Ea—DLAT77 MR B d P85 4—K(Parameters)] 7 Uy R E L EH A

[~ 274w 2(Traffic)] 7 Uy RAND A5 4—5F1 DIE fn

(N2 74y o(Traffic)] 7 Uy RiZH| 2B N LT, P35 A—K(Parameters)] 7 4l £ a—ic— B (2
SN TVWBNRIA—RERIRNTEET. [FF774v2(Traffic)] 7 Uy Rz 2 607 — &5 %18 i
LTBLE 7—r7o—<7n%ffH LTHwBEEI, £yy v TIREASA—KEBH LT, ©»
DEDE IR H TT7Vr—y aomeal 77 SN TWBhEH ]+ 20 B 03 H 315 612
FRTT,

Jz&21& . JSESSIONID /8 7 A— XD #3578 LT £ v av TO DA & X, £2TZ

O HZE L LT 20 %R T & 3. JSESSIONID /8 5 4—&ZDF| %, 2N AT BE 3
Hset JSESSIONID &— 4 (2B LT AL LTW B ECR AR T ENTEE T,

INT A—=RDF EIB N § B2
1. S5 4—K(Parameters)| £ 4l 7 Vv KT /XS A—KXDAT 545 2 Uv oL 7,
2. FlDOfERL...(Build Columns...)] #1# R L £ .

T IRIR L5 A4—RDF] #ULRTCIE I LIz Cenvd 2355 4+ Bl OFE 1% (Build
Columns)] A7y a3l T& & A

IRGA—=RE DF I, RIA—LE &% 8 T B A/ v ROF|(Z Y § 25 &) edtbic. o714y
J(Traffic)] 7 Vy MIZIB I S &9, J’L%OﬁJ $ B DRF «4/037*‘52’\ Xuﬂ‘( 9t 1) 12

Bl &d. h60F 1L 7 Uy R E A= —‘Cg_%)k_bﬂéhatj_ TV R E A= 2—%
LT Ea—iZH) 2B I LIz 08l LicoT & &3, [0 OIE I/H| " X—21221 %%
B LT IZ3u,

N 74w 7T —RZD KL

[N 2719y 2(Traffic)] &7 ik [F774v2(Traffic)] 7 Vv k. B 571y 7(Related
Traffic)]ﬁ')/l\ B4 B 7+ A MRelated Text)] 7 Vy k3 &L 2§, [FF7497
(Traffic)] 7 Yy RTIEH A bV V=N DYY—AD b 57492 5FK R TE FULK7> LT B
57 1v7(Related Traffic)] 7 Uy NTx v s ORI 1574y 7R IR TELT . T 5,
oy avDILE TR Do ofe7 ¥ A b B 7+ X MRelated Text)] 7 Yy FIZR /R T& &
T

B 57190 LA A
BliE b>71v2(Related Traffic)] 7 Vv MIZIZ IR DI R AR R S &7,

« V—XA(Source) - R L1z VY —ADURLZ# il L &3
o Hi(Parent)-V—ADB M EHDF =—> & —BERRNLET.
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VIV A AR
% 11: Site Explorer

o RFA—RI % (Parameter Attack) -I % 25 5] L. 52 2 252 2 /— RO R ic—E R IR
L& (IR WR T4 0700 LR FE)

Findings Traffic Text Search

l:}hﬂ|:|;.lﬁf'zer1:r.1.l.re|::-a||:||:|securi'r'glr.l:u-m:i?.l] :}' >fan1Tm| x >

> Related Traffic
E Relation Request Start
E  Source 11/28/2017 10:43:54 zerowebappse
= Parent 11/28/2017 10:31:24  zerowebappse
= Parent 11/28/2017 10:30:4C zerowebappse
Parent 11/28/2017 10:29:23 zerowebappse
Parameter Attack 11/28/2017 10:50:25 zerowebappse

o S5 T I 2 (Reflected Attack) —k G5 1] 7 202 A MR L VT T 427 1 & R 5T T 15 5
W33t 12 757 &7 T o1t N SRS 2 23 L& o ZORE S o e
RN LI OB OF TY.

VY —2AD b Z 71497 DRI

A MYV NDV—AD b 774904 R RN TEETIHH D M I7497%K R T 2124

o YA MY—TIHH #EIRL £7.
ZOIEHWCHEBRT2IXRTD N5749008 [F574v2(Traffic)] 7 Vo MR R S &9

oy O E N F 74y DR R
[NZ71v2(Traffic)] 7 Vo R T vy av D 74908 R RN TEEFT,
vy O ST 19 R IR T BICI:
o [FNZ74v7(Traffic)] 7 Vy N T vy a2 &KWV LET .
Bl h>7 1 v/ (Related Traffic)] 7 Vy AR R S &d . Bl bF774v 01 vy avHMfiE A

AR 4G & B OVA N2y /LT 2 sD HTTP]#4l Ea—8 L0 oy
(Browser)] 54l b 2— 4K R T& £ 7.

(274 v 2(Traffic)] 7 Uy MR B1214:
o [FFZ74vo(Traffic)] # H &1 M AA—%227Uy oL &T,
(N> 74y 2(Traffic)] 7 Uy BHRR IR ST, TXTD bS5 749 705FK 8 SN ET,
FEANIC DWW TR T FE A 4 o727 Vo ROEEAE" IR DX—2 1 5 I L TS0,
vy av OB 7% R DK IR

Bl iE 771 v7(Related Traffic)] 7 Yy k6. vy s OB IE 7+ A MR IR TELT
B 7+ 2 MRelated Text)] 7 Vv Fizid iER Lizt vy a> DG % TR D ofe 7 F A +OD
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V=LA AR
% 11: Site Explorer

DA MAE R S ET. Bi#E 7+ 2 NRelated Text)] 7 Uy FClE . = MIT T F A D K
A7 HIR S ET,
by O IE 7% A MR IR T B2
« PBi#E >71v/(Related Traffic)] 7 Vo R T Ly a2 X7 W 7)w oL ET .
Bdi# 7+ 2 MRelated Text)] 7 Uy kAR IR SN &F. COZ Yy PN OEHRIE FF A b
1 % (Text Search)] 7 Uy NIZAL T &, Ron SN 37 F A MAH GIER LItk vy 2>
DELDDAIZENET

¥E: BiE 7+ X MRelated Text)] 7 )y FO& AT DF 7R 7+ A M. 4047 1l fR &h &
T. FHEAMTOT CE IS (L)AER SLTOBE A . 7% A NOIT H 24077 %
BMATBO IR VDT AE IR SN THARWIEER LET. BELTFANE. FFALb
(TEXT)|#f4ll EL2a—CR R TEET
TTHOTXRTOTF R MR R T B2
o PBiiE 7% X MRelated Text)] 7 Vv T T2 27Vv/L &
3 2 NTEXT)] 364N Ca—iC58 4 2 7% A MR TR Sh £
B h>7 v (Related Traffic)] 7 Uy NIZR Bi214:
o [BE +>71v2(Related Traffic)] 5 B &1 bvAA—% 27Uy L &9
B h>7 v/ (Related Traffic)] 7 Uy AR R SN &9,
A OOBTIE S T FE A 4 27 Uy FOEAE" T 122 B L TS0,
CHLEHTHSR LS
"7 E A MRR O " X—2132
15749 /OB R A= 131

B A HL L o7 Uy RO#EEAE

TV RTF—RE RWR 7§ 28, FH XA MU= Wi 257 Voo 234, 7 Uy
N —RDIEE D # FOVE 7 4 B8, T H XA MUA—F 2 2R E TH LWL Vy RA
BHIDZ VY RIZE 2 >THWEET IROW &, FEAE L4 5123007 VyRER LT ET,

Traffic ~
Related Traffic

>
E
5
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VIV H AR
% 11: Site Explorer

HAE L o2 Vy FORIRN &8 T
H A 0DOF O EDZ VNV RER R T BE. ZO7 VR EICE L >THWATRTDZ Yy N
B LEd. /s AR LT RXTOZ )y Ns—EH I L3 TEET,
H 2 ODOH O E D7 Ny RER R T 210
o BINT BT VYRDZA M=%y T,

BRT BTV RO L WCFEAFE R AN T2TXTDT Yy R U T,
BEAE Lol T RNTDZ Yy REH L 21213:
o LU DI VyRDARA MLAA—% 7Yy 7L 7,

f& A 2ot TXTDOZ Vo RHBEH LT,
CHHH TS L
"Z )y RE2—DARARTA R X—3121

MR &7 4L KWL

T Uy RE2—BIPIFEAEDIEZ VY RE2—IZRK R SN BT —XEME TEEd. 7 Vv RIZ
FToR SN 2P| 7T—REY— LD TV Lo e TEET TI/T A7 AF v %
BRLTOUBGEEEITHDAF v TIATT—RER R . 7OV KU BEUNY— T
EET. MR 7TVOIERICDOT . MR 1 DOLT" XN—=21431 25 ] L TS0,

)y R 2—COMK &
TV RICRIRN SN B DT —RE G E | DT —REM R T&EET. 7 Uy IR R Sh
27 —REWMER T 12

1. RET7A2Q) %2097 £,

2. BR#E(Search)] 71—L NI\ S Z(AN—AL L) A T BLUHMR T 2H 2N
L£d.

1

Status='404 Not Found'
ResponseStart>'9/4/2015 9:08:52.242 AM'
Status~'3[0-9][0-9].*"
3. (F7y NVEE OH R E § 21218 <AR—AA—> 4 LT, Jl| OF &4 (AR—R %
L EHE T BIUMRTBEENT LET. WA b2 2R & ANDIR R &L

THOET IR E SNTEBRREM 25 0L a—FEUAE RSN ET . KRR T3
FANZDOWT, COFNE 248 IR L Ed .

B :
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VIV H AR
% 11: Site Explorer

Method=GET Status~'3[0-9][0-9].*"

4. <Enter>x—#%4 45, Qe rvvrL£7.

EMBBREMA LTIV FEMR T2 b T &7 sfl e, MR on
AN—=v1431 2 W LTS,

7V PE2a—TORE
B 3K (Request)] ﬁZ7 ’(5 [B%{(Response)] R7 R EDIE T VY Rea—TT7 —REM R T& %
T K7 THER T 212
1. ZUy RN D7 —KT #E IR L E T,
BN L7 —ROFEAN 23, B3R (Request)] 27 % [Jis 2 (Response)] #7'7% £ DB i
ffFenfe 27 R R SN £,
2. MR T2MEEXTIER 74—V AT L&,

3. A7y VR RFMTCIEHR R 2 42101, RegEX] Fxzv/h v/ AZIER L &
T iFgl OO TR DT R—U143 1 25 18 LT 7 &0,

4. <Enter>F—#%4f L 7.

MZEDIYT
MR #7VT7 T2 MR TAa>D X157yl ET.

J Yy RTDY— |k
7 Uy RN OIE & DF| TV — B2k
e IR HBLEIZYYILET.

7 )y R D 700 KL F
7 Uy RN D1DLL L DOFI 7 0)L KL EE 4 2121

1. HHLDOYFZ2 27Uy L T,
FI R LO TR 7 00 R FIV R IR S E TS
2. Povzdilter)] 74— Mz 74V & AN T LET

TV AR A7 aDIEFE T (5« <v >=+ <=+ 1=y~ =) Tind Tnoting. &721&
Mregex)] DL ML ADR % & 2D ke SCF 5 TR ik S & 3. S FHE S 7 (. )
E 20D FH| DI H 2D TH A T o FANIC DL T TR e Dn T =y
1431 %S ] L TS0,

B

443
'400 Bad Request’
30*
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VIV H AR
% 11: Site Explorer

'9/3/2015 10:53:08.000 AM'..'9/3/2015 10:53:12.089 AM'
in(200,300) notin(400,500)

Wi LuE)HEE FId. HRFER 285 OO CIEEE 7V 2&E [ L WG & »
HOEd,
FEANCOWBTE "7V P O 7 0L ZULEE D)L —)L" | J5F R LT 280,
3. <Enter>—%f L £,
N3N CFEDOTT VY NN OF — KB 70V KL S 9. 70OV XULEE s /-
FHPB LO7Aarvns il o NET,
4. BINOH) 70V KL 4 21203 FH) TAT v71-3%58 ik L &7,

7 )y RN D7 1)L ZYLFE D)L —)1

Ty R D740 KL I IROIV—ILNTE ] St 9.

o T4 IVNREIRE T IV EEDHVEE A FFE DY) T7 OV REHE T 2DT, 74—V K
PR NI S (O

o Povifilter)] 74—V FCEMRIEAE T 2 H C&E7. SFANIC DL T T = i
B &7 v 251" N—2 145 #Z IR L TS0,

o« P Afilter)] 74— RICEF TR 74V FA— FBRE SN WG A 70V &l
field:*string* DK X Dl contains | F) ICA R SN 4. MR 235 T TH En T 3
A 70V AL field: " *string*  ICAE R S E T,

Jz&ZiE . RT—KA(Status)] 51l O 7 1)L XL 41 404 Not FoundidStatus: ' *404*"
Status: '*Not*' Status:'*Found*'ICZ ¥ &, A7—XAHM404]. TNotl. F1:l&

TFoundl 28 &I RTDE v 2R IR SN & T, 70V KL O%E F 2tk 302
Found]. 404 Not Found]. & & UT405 Method Not Allowed | % £ D A 77— X A% E;

Fnxd.

[ 27 —RA(Status) 151 O 7 1)L KL F 4 ' 404 Not Found'(dStatus:'*404 Not
Found*' (22 #& &1, 404 Not Foundl % A TEAT—RRA%HE DT NTD L vy avh

TR IN£9,

o TAHLETZAIVRIZIE EHEL DR R 7OV R ARN—ATX Y] > TIB € C& 7,

o HATERFZ| 74— PO 70 &g B — 5l HAF() & d Z B HAF (" TH R ERDH Y
9,

TANEAIN T E2—D 7))
7y RH D1DLL EOH| TV RENF2Ea—% 27T 2121:

1. 7OV s iB| R Loy & 20970 £7,
MR AAVHH L LOTFeRR S 7.
2. PY7(Clear)] #7Vy/L &7,
HIHN DT —RE 700 ZLHE sz e D&
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V=V HA R
% 11: Site Explorer

3. BHINDH D74V RE VT BI21E . 7OVEULTE SN 125 T2 AT w71 824588 DR L
EQC N

RN ICDHLT

CDREYITE ZVyRBEUXTTOR R (M S 2 OB B R OO TR L &
ER

R 7T YOHE A

MR ITVDFEATE N EXRDEBNTT,

<PropertyName><QOperator><SearchValue>

7 Uy RAER % 335 4 « PropertyNameld #  (% 25 4 © 4. B3R (Request)]
47% i % (Response)] X774 ED 47 T % ¥ %15 17 . PropertyNameld 74— L N/7'm /s
7 1% (TRequest " Response & £) T 7.

7 )y FD1ODF| N 1 %R § 2354 & PropertyName 28 1% L &4 . COXA 7D E D
ERGKDEB VT,

<Operator><SearchValue>

R CIE MR R B (RegExp) i 3 & I 92101 IR DB & L &5
<PropertyName> RegExp('[RegexSearchValue]','|RegexFlags]')

IEH R O H OFFA DWW Tk TE BRI O " A—21461 #Z R L T80,
Bainrxy

Kk LT a8 0O TR 7T — 2B B D4l 42 /7T VERITCEES, Bl n Vel
KDL EDTT,

Method=GET
Scan.CheckId=6

OlvouTube¢H. 2.
AR—AILF R R L F 28 07— RO R

MERTDIVTVVEAR—AL FRRFR L F 08D 25 651 3> 7oy —5 HFF() £
fold ZH G HAF()TH & 9,

Status='404 Not Found'
Path="/signin.html’

XyouTube¢H, 2.
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https://www.youtube.com/watch?v=R09n59YJSbc
https://www.youtube.com/watch?v=R09n59YJSbc
https://www.youtube.com/watch?v=PyyrzqbVErE
https://www.youtube.com/watch?v=PyyrzqbVErE

VIV H AR
% 11: Site Explorer

FJIHFE7ANV EA— Rl A G bE T T& &7
ResponseStart:*'7/8/2015 4:22:'*

BHOR 2 H LIBRER
1O0MBE AR CEROR 25 D208 T53T. FREAR—ZATHEILET,

Path="'/banklogin.asp' Method=GET

YouTube ¢, 2.
A C74— v AEE R R Sh Tw 3l 51 . TORJR & ¥,
Path="/banklogin.asp' Path="'/loginl.asp'

COFE % Tld « Path# /banklogin.asp) Z7zl&/loginl.asp] TH 23X TDL a— R8Ik Sh
£9.

B sn 2 O 74—v Mg  TANDI LT bh 9,
Path="'/banklogin.asp' Path='/loginl.asp' Method=POST

COI% & Tld . Paths3 /banklogin.asp] 7:(& T /login1.asp] T® 9. »>Method 4\ POST |
THZTRNTOL I—RHBIR SN &7

AND/ORMZE D& N DDH| IRk (28 LE T
Method=POST Scan.Engine:Sql* Scan.Engine:Cross*

ZOI & Tl Method T POST1 T4 0. »DScan.Engine DfE D4 88 23 Sqll £ 7214
[Cross| TH BT XTDL a—FHR SN 7.

YouTube¢H, 3.

Null 7 —20# &

Null ()Y NEE OT—REM R T2 =ilHE T &2 L. 20% 122>0—&E 5]
FMEANSILES,

ParameterValue=""

B 52 OFcnull (35) T2 MBS $MTLBF—RETOL LB § 21015 Bl 701 R
(column filter)] 74—V FC=iH 7 2 [ L. 20 12220—H5| A (MeEAN T LET,

OOlouTube¢H. 2.
BE /7 YTOFH 4 OfF H

AN—AEZ LI 4 121 74—V A TR 3256 R 72 VTE 2O AR—RULHI B
LEd. f2&z2E. 7 Uy D Response End] %l 1R 4 2iid . IROFE R 2 H L 7.

ResponseEnd="'7/8/2015 4:22:52 PM'
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https://www.youtube.com/watch?v=r1oojZocMcQ
https://www.youtube.com/watch?v=r1oojZocMcQ
https://www.youtube.com/watch?v=uD0dElCUfc4
https://www.youtube.com/watch?v=uD0dElCUfc4
https://www.youtube.com/watch?v=hnVX6SVDxZI
https://www.youtube.com/watch?v=hnVX6SVDxZI

VIV AA R
% 11: Site Explorer

IEER RSO H

MR NR—VEEN T 27010 ERRREE )AL MR CERKRE 25 92
CENTEET,

Response~'[0-9].*="

OlouTube¢H. 2.
EHREBHRECEEN T2 TEET,

Response RegExp('[@©-9].*="','i")
IEM R Off Fl OFF A i Dw Tl TE R B O " X OX—v 122 | L TS0,

MRBEE T L7 0V A AT

MORIGARREBL 7OV MU &2 FE T LBECOONTHA LT 9.
DO Tff ] st 2PropertyNameld . 7 Vo NER R 725 6 G54 K7 %R T 25 5

E 74—V N7 aR_7 44 T¥. FIWCEHBE 70V 2% v 285 & . Pl 7oL X(column
filter)] 74—V NI 74—V RIZ' 08T 4% &5 2 W T2 S0,

A
¥ o B il
= MR LTS T 28DDA  PropertyName=asdf
R
> MR 3 HAT £ 9K &7 —4&  PropertyName>123
R
>= MEMNME E-EHAM L0k &E0pEE L PropertyName>=123
W — K& R
< MR HAE £72 3 HAF & /N 87 —X&  PropertyName<123
IR
<= MREE £ HAT £ 07 S0p%E L PropertyName<=123

WF—REMR
MR LA E5 LW —RER R

A FA— e LTHR R LF 5
CRE BT 2LDDA ER R (R
TIER LT N F #X [ § )

B L FACAR—REE R v 2
() F EnTw B A B—5 H
Fr&ry —ES A CHA T,
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PropertyName!=asdf

PropertyName:asdf (58 4= — A% &)

PropertyName: *asdf (18 & L F %1 T
Kb BT —REMR)

PropertyName: *asdf* (1 & 3L 77| %
FOT— %M R)
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https://www.youtube.com/watch?v=l_ENxbRGiBY
https://www.youtube.com/watch?v=l_ENxbRGiBY

VIV AA R
% 11: Site Explorer

HH
¥ Pt

T LI QRPN OF7 — X R

T IERURB A LR R T A O
R

1E 2 B O B OFE40 2 DL Tt
ME#HEZH O H" F1ez LTL
12 &0y,

in FEOR CPHH g R EC— 58
DM R (B OME 28R T 2121
Hy=2X ) DD YA FEFRE KT )

youTubecH 3.

notin  #&E 9L TP FN 1M R E LA D4R T
AR (BB DE 2R 43 211k 7
VX ) DD YR AR IR T $)

youTubecH 3.

TE i % 3 OffE H

il

PropertyName:asdf* (# & 3 7% T
U 37 — 2% R)

PropertyName: '7/15/2015 5:00
PM'..'7/15/2015 5:15 PM'

PropertyName~'sea[a-z]ches'

PropertyName in(123,456) 7zl
PropertyName in(abc,def)

Port in(80,443) (41— 2380 7zl
443D FXTD X vy 2 EHR)

Method in(GET) (TGETJ 2V v F%&{f
M3 23XTDL vy s R)

PropertyName notin(123,456) X7zl
PropertyName notin(abc,def)

Port notin(80,443) (A — FH380 X7z
443D F R TD 1 vy 3> %55 41)

Method notin(GET) (TGETJ AV v %
i 329 XTD v a2 &k AM)

FUVRKC)VEE T AER BB CHEH 728 FULEKDEMICH 2 EDH. 450 OIEH K B %
B LTHER Sh &3, SACEM 2 IEF R T (RegEXp)BE L AER § 228 T& &7

MR TEB NI L FH 7 a7 4

EREBREEH LT AR 7492 FH 7087 4Bl X5, &1 HA) %
METEET. S, [F574v2(Traffic)] 7 Yy FEa—0 5% 74 23 % 7V 3

E— B RRNINDZTZA—IVRTRNTIHT g 7.
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https://www.youtube.com/watch?v=zNhSP1Kk8Po
https://www.youtube.com/watch?v=zNhSP1Kk8Po
https://www.youtube.com/watch?v=OBWLO51FyeQ
https://www.youtube.com/watch?v=OBWLO51FyeQ

VIV H AR
% 11: Site Explorer

TERAMRR LTI 7 08T 4

EHREBHAFEH LT 7FAMRR XTI 70745 E TE&ET. 7F A MEER XL T4
7R TFAHIIIRDEDE F £7,
e Server

e Text
e Type

FVR(T)H A 5 Off

FWVET)VEE T 2EH 37256 B NERDEN 8 0E7.
<PropertyName>""'RegexPattern’

—HGI A EE —E A A TEET.

4l

WD 7TV B3R A vX N DRefererizindex.jsp 7 71 IV ME € SILTW 2L v avD YA b
R LET

Request~'Referer:\\s.+/index\\.jsp"

D 7TV 2\ v&Z N DLocationiZindex.php 7 71 )V & fzikindex.html 7 71 L 2348 & S
NTWadtyy avDYA MR LET,

Response~'Location:\\s.+/index\\. (php|html)"

MWD IE. TCross) &721xTSqll Tl 24 HI DEL & T2 ¥ N & o TH B s /2.
index.html 7 71 )V & 7zidindex.php 7 7AW E(EF 2 vo s> D YR bEIR LE T,

Path~'/index\.(html|php)' Scan.Engine~'~(Cross|Sql)"'

RegExpf# 3¢ Of# H
RegExp## 3 i& JavaScriptiZfl TE 0. Ik O X 2 L 7,

<PropertyName> RegExp('RegexPattern') - K 3L 7 &/N L7 #X il L THMER #E AT L &
.a——

<PropertyName> RegExp('RegexPattern','i) - K L 7 &/N L7 #X il LA W TH R 2E
TLET
%l

KDL B3R A XN DRefereriZindex.jsp 7 71 )V € ST 2L v 3D YA b
FRLET

Request RegExp('Referer:\\s.+/index\\.jsp',"'i")
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VIV AA R
% 11: Site Explorer

KD 7T 5 Z N vX N DLocationiZindex.php 7 71 )L & 7zixindex.html 7 71 )L 3 & &
NTW3atyy aDYR MR LET.

Response RegExp('Location:\\s.+/index\\.(php|html)','i")

youTube¢H, 2.

RegExpfi# L i2DWT
K DX T, RegExph L O # OBk 58 B L £ .

Request RegExp('Referer:\\s.+/index\\.jsp',"i")

Response RegExp('Location:\\s.+/index\\.(php|html)',"i")

I I
@ 12
HH B

1 "EOHTTPE R 77— REM K § 20 H, 4L OHTTPIG &
TREMR T 20N EIRE LET (N vAT —RER L
7RO J] & A &T)

2 ROFNTR TIER RIS T & LT RR 31k
RPN E—2ER LET

1E AR B

IER B OAR—AG FIR TR0 —r YA LTE R S &9, IROFR . T
SO FD—# &/~ L. 2O B2 28 LEd. R 72 0SB el T A2
1 > @DRegular Expression Library (http://regexlib.com/Default.aspx)23& D £ 3.

X¥ wiH

\ WO ERER L FEELT—2LET . ME XL FEInJic—FLEd, v—F >
AN AT P — L &Ed.

A AN ERIGAT ORI LET.

WF ALV T 28 BENLFE#EK LET. f2E£218 contentT (L
2 b YN Dlcontent/en & Uf/content/ca Zfk <§ X T &k 4k 3 21214 /content/[*
(en|ca)l.*/* &M H L £4 . \S\D\W S [ L T 2 &0,
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https://www.youtube.com/watch?v=DZdP1RN2GwQ
https://www.youtube.com/watch?v=DZdP1RN2GwQ
http://regexlib.com/Default.aspx

VIV H AR
% 11: Site Explorer

XF B
$ AN EIEITORE I L&Y,

% AT T3 FZ D0 LA FE D18 &8 LEd./zoidlTz) &tlTzoo) &b—F L
7.

+ AT T AL FEOIE ORI E—BL ET . /zoH/iETzoo o —FL L £ 975,
fzjicig—8 LEe A

? AT T3 F 00 £ 1 OB &8 L £4. /a?ve?/idnever] Dlve]
W LET,

AT X7 52 EEO1ICF B L £

| 2O FDVFILTEAMRREA) DM OOR%E/R LET, 2EAIT IRD T
(& 7S AiZfindex.htmlyindex.php 23 FN T2 vy av D YA MR L ET,

Path~'/index\. (html|php)"

i KUF N FEX P LEREA. COXF & RegExpD2F H D5 # ¢t
L&d. f Z2i:

PropertyName RegExp('stuff[abc]', 'i")
N MO7I7 LA G DEBZIENTELT . I 21"

PropertyName RegExp('stuff[abc]', 'mi")

m BT E-FTHRRELET. COXF . RegExpD27 H 05| U ¢ L &
IV AFS

PropertyName RegExp('stuff[abc]', 'm")
N M D757 Ll AL b BIENTEELT . I 213

PropertyName RegExp('stuff[abc]', 'mi')

xyz] XFEvb. FEINH OIEE DI FI—3 L &7, /[[abc)/ikTplainyDlalic—
HLEY.

\b AR—R EOHEER Fic— 8 L £9 . lea*n\b/ix . Tnever early ] Dlerjic— 3K
LEd.

\B  HLEELUAM OBE R 1o L 7. lea*n\B/id Tnever early] Dt Dl ear] &3 L
EQA

\d 1005 L&T. [0-9] L LTT.
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VIV AA R
% 11: Site Explorer

XF wH
\D AU DI Fic—F L&, [0-9] L LTT.
\f A=Y FIC—EHLET,
\n HUATCFICBLETS
\r F )oY VR—2 L F I HLET
\s | AR—R, X7\ A=Y EDF FIC—F LET. [\Wn\Atv] £F LT,
\S FHLFLAIOLF L ET. [*WMn\ntW] EH T
\w TYR—RAAT %% CAEE OBGE LT IC— L EF. [A-Za-2z0-9_] &R LT,
W BT A0 T I L &9 . [*A-Za-20-9_J ¢ LT
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£ 12: SmartUpdate

A &—% v MIEEHE LT 34 > A b—LIE B Tld . SmartUpdatet# fit #3Micro Focus 7 — X
Ly R—HEGE LR &R Sn 787747 2=y 2> M ST F vl B8O
RV —1E W £ L £ 4. SmartUpdate ©ld& . Fortify Weblnspect Dy i /3 — 2> %1 i
LTOBNEIMGIER SN LuA—Y oKXy yo— R g8 215 & B 5 S 4.

77 Vr— av &L E) § 3/-0M1cSmartUpdate #3 1T § % & SiZFortify Weblnspect 23 2
TEE7( WEEdY)] A=2—m5 F7Ur— 25k € (Application Settings)] 1% 1 L.
R~— 7 v77— NSmart Update)] &R L £ 9).

Fortify Weblnspect 2 —# 1 > X7 x— 2 sSmartUpdate # 4> 7 ~> NTHEAIT T2 LLTE
9. CDz»IZiX . Fortify Weblnspect® B 4fi X—(Start Page)] 7> 5 SmartUpdate %
B 48 (Start SmartUpdate)] #i£ iR § 3%,  [P—i(Tools)] x=2—%*5 SmartUpdate] %

IR 4 2h, 23 Y—L3—0 SmartUpdate] KX %20y 7L 7.

A2 RB—Fy MG LT A VA M VIREE DI A & T"SmartUpdate D5 17 (4 7 74
N A—=U1631#Z LTS,

EE! 228754 XA A D4 . Fortify Weblnspect#3ifi ] 4 245 2 @ 7 74
vhSmartUpdate il & > TR - B s 28, oo —ERMFEIE L, 25T

[ A T4 VI AT —RANR IR SN B2 EMH V&9 . Fortify Weblnspect 77V 75— 2> %
RLE) L. — R RE T 2L ERDHNET. DD,

1. & (Edit)]> 7'V — 243 € (Application Settings)] 47/ L £ .
2. Rk 4 ELTHESIT(RunasaSensor)] iR L7
3. [kr4A7—KA(Sensor Status)] =V7D BAH(Start)] R x> &2V s L &7,

SmartUpdate D547 (1 > Z— % v MZH &t L T
254
Weblnspect#3{ > &—3 v MZH% 4t L Tu 335 & (SmartUpdate #5217 § 31214

1. MOLTNHhEFEITLET,
o V—L/A\—T BmartUpdate] #7Vv7L £7.
o« P—(Tools)] x==2—»"5 BmartUpdate] Zi%£ R L £7,

« Fortify Weblnspect® Bf & X—(Start Page)] 75 SmartUpdate DBf 4
(Start SmartUpdate)] #i% R L £ 7.
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V=LA A R
% 12: SmartUpdate

7 w77 — K ] BE 2454 1k BmartUpdater] 74> R &, =Y
(Summary)] &7 HE R S 9. Br~USummary)] X7 IRDTAT LEXT
o— N9 2729 Dt DizfzA 0] e 2 HE DA >3 K3DR R Sh &7,

o Wil F /B IUEH ShicF =y

» Fortify WeblnspectY 7 +7 =7

e SmartUpdateY 7 t7 =7
2. 12U EOXvya— R A7y a0 IG §2F 2y /R v AEF AL ET .
3. (A7 Y 2NHH SN BF v/ OFF Al 23K 78 T 25121

a. PFxy/70s%4H(Check Detail)] 57 % 7Vy/L £9,

T DA NG EH SN BF 2y 7DID T BEPN—Y 3> /R T VR MHFE
NI EY. VA ME {BIN(Added)]. FE ¥ (Updated)]. & &8 Bil Bz (Delete)] T
IV—7% Sh 1.

b. B SN2 EDF vl aF RV —2MER T3, VA NTCEFDF v/ %1% R
LEd.

AT FBRY—D YA MY BiE £ Vi —(Related Policies)] XA > E x &
£,
4 (A7 D)EE £Z F 2RV —OF 4£ R~ T 2100
a. [V —0zE#l (Policy Detail)] 7% 707 L £,
FERMORA N EHOWEEZ TR —PEFIH T EER RSN LT,
H: COVAR MG FH SN 2F zv/ D& 22 3 2R ) —RUIRK R ST &
T, U —0F4H (Policy Detail)] 27121\ 7 v7 7 — M & Tw 31 fig
Y2 D 2ZDM DF Yo —ZE T (R Y —OF L\ F zy OB AT /213 A Y
—HOEE L E)ERIN SN FH A

b. FFE DRV —THEHF INTHBRFzv/5R /RN TBE. VA6 R Y —51# R L
ES 2

B 1# 7 v 7(Related Checks)] X1 . B H s 37 =y /DID. & i« 8LV
A=Y 2 o5 3 UA MYE R SN ET. UA MNE {811 (Added)] . FF 37
(Updated)] . 8 &0 Hil Bk (Delete)] T7v—71% s &4

5. 7977 — b eA YA VT 212id. Bv>o—RDownload)] #7Vvy/L &9,

Fortify Weblnspect =8 i ¢ 912 F v/ 2K 7>
g— K9 3

AF PN EDF /5 EAT TR oY v DOEFH AU E T B N—Y 2D
Fortify Weblnspect 21l Fl L Ty WG & . A% v 71 iZSecureBase D F =y 7 D— #f %5

ITTCELVAREMERADH VE T IR TR OF 2ol LTCT77Vr—y %7 A MBI
& B N—2 2 DFortify Weblnspect 2 ] L T 305 FE203H DT,
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VIV H AR
% 12: SmartUpdate

7 4 — ~
SmartUpdate D5 AT (4 771 V)
#7354 > DWeblnspect®SmartUpdate #E 1T 7 312ld - IRDFNHICHE VL E T,
A7F—y P

1. A= P —REER L ET . ARAXFE— M E 9o, A 754 VFTP
—/SDOURL &7 1 V% 1% 15 8 AR (it St &3 (0 B 235 45). #RAT
DL Tk I'Micro Focus Fortify 72 &4 R — MO B[ L& b (M7
WA= U21])ES R LTS,

2. AV EZ=2y NI T 72X ATEDB VY YTy A T7FAVFTPH— 27 72 AL
ES 2P

3. Fortify Weblnspect® Z X7 1 v/SmartUpdate ZIP 7 7/ )V &KX 7> o—
LEd.

4. Fortify Weblnspect#: 1 > 2 b—v &L T 35> > T ZIP 7 7/ )65
RTCDZ7AIVERRE L &7,

5. Fortify Weblnspect#fd U 9.

6. fig 7R L 7-SecureBase.sdf 7 7 )L & & U'version.txt 7 71 )L %

SecureBase7 — &0 dH BT 4L 7 b icae—L &,

o VAT LAHFIPSIH G LTOA WS 7 7010 OB A&k D &6 9
T,
e C:\ProgramData\HP\HP WebInspect\SecureBase

e C:\ProgrambData\HP\HP WebInspect\Schedule\SecureBase
e C:\Program Files\Fortify\Fortify WebInspect

o VAT LHFIPSH G D & T idik D EB VT,
e C:\ProgrambData\HP\HP WebInspect\FIPS\SecureBase

e C:\ProgramData\HP\HP WebInspect\FIPS\Schedule\SecureBase

e C:\Program Files\Fortify\Fortify WebInspect

B b WindowsTld. 7 74V FTIE SN 6D 74V RIE TR Sh F4
Wo FANKEAT Y 2B LB L7 74V EF LTI S0,
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% 13: SQL Injector (Weblnspect®D 4 )

SQLA >y =7y av dld A E 2T et 030 230 7 2 M (CHIBR LW T o254 7 M
D7 —X%SQL 7T ffi H +8Web 77 V7r—y x> %8 H 4 32F % T 9. SQL Injectorid .
MS-SQL. Oracle. Postgres. MySQL. ¥ $UDB2D7 —&X—A KA 7 %4 F— L. H A
EAESCHEROSEDOY AT AL AT,

ER! COV—id. SQLY— N2 & >TULHE &h 3R] fEE O H ZHTTPEE K #/E Ak L
TEFET22LEN. SQLA >y 27y DI §5tE 27 A ML & 9. Web 77 V75— 3~
Ca—HIRMADF—ZEF ] L CF—ZRN—AL a— FEHEH $ -3 VE R Cx 28584 .
SQL Injectoriz & >THAUM L 3= F2MERL SN B D& T CD & Sl fe %
Bl B4 2720 EH 7T —RZR—AZK LTE TA AT OEOWT IS0 AL b e, 77—
AR—ZAD A—%5 i H T 20 BH F—RZ T Ve ATEL T AN A7 M 2
Dy T —ER—ADT —REFH LIz O8I BR LIz 09 20] GEME 23 b 3 X— 2B A 7 %
HR LTS, SN SDORE HIE LRI ENTEL VI H G EH] 7 —&R—2D 3y
7 7 #HAIAE R LI 92Ty 9 A MR b7 49 0BNE EAEETE & o1 B & &
WT A MEAT oTLIZ S0,

SQLA vy =27y Xkt §BE59 1 27 A Mg B2l

1. 7of s y— el LTO 25 & &fold &7 v Mo NCRREE 20 B 4005 6 1
B (Settings)] 27 % 7 )y L CGEY) 25 £ N J1 L&d . ff 4T iDL T, T'saL
InjectorDi% 2" XN—158] #5 M L T 280,

2. b 71v(File)]> Fr#H (New)] z£R L 7.
- &2l -
[T 37 22 5k (New Request)] 71/ 2> 0 5 2V y oL &5

3. [|r—y =/(Location)] 71— N2, SQLA > 2oy zxt LTSS 2 b
URLZAN 719 2005 0fF 1 £ 97 IR OfF 45 1] L T2 80,

e GET XY v FDIG & (7T VN7 4 —KIFURLIZH A g £7):
http://172.16.61.10/Myweb/MSSQL/Welcome.asp?login=aaa&password=bbb

o POST AV yRDEG & (7T IVRIA—RIE Ay —V R L ICE F1 £9):
http://172.16.61.10:80/Myweb/MSSQL/Welcome.asp

SQL Injector®7 74V MEGET XY v KTH 2728, HE(Raw)] 27 (s BEa—

(View)]> EZ3R D% 7~ (Show Request)] Zi# IR 3 2 £E /x 81 £97) TPOSTE >k %
WETIZUNELDNET ME LIEREIIROL N L DET

POST /Myweb/MSSQL/POST/2.asp HTTP/1.1

User-Agent: Mozilla/4.0 (compatible; MSIE 5.01; Windows NT 5.0)
Host: 172.16.61.10

Content-Length: 22

Content-Type: application/x-www-form-urlencoded
login=qqqg&password=aaa
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VIV AA R
% 13: SQL Injector (WeblnspectD 4)

vE: Fortify Weblnspect23SQL A > ¥ =73 s> Ofifi 5 1% 24k i L7235 & & . Fortify
Weblnspect®+ &7 —y 2> XA VTS Lt vy av 4G 2 Vv o(Elid Y~ XA >
@ [ §5 ¥ (Vulnerabilities)] #7 Cfifi §5 2 URL %4 2 Vv 2)L T ¥ 3= by b A
—a—»5 P—y(Tools)]> BQL Injector] iR T & £ 7,

4. BEfE(Send)] £2YUvsL .

SQLA Y 24y R § 56 RF—AKA(Status)] X7 BALA > 273 R
% #(SQL Injection Confirmed)] £E7r S, &£ F XA D A b Y—(Site Tree)] X
TWT AP E Y V—DR AR N SN ET.

2

File  Edit  ‘iew  Enterprise Server  Help

SAL Injector: SQLInjection_1.sdf = B

Y Mews Qpen Save il SOL Injector Settings ,_‘““Hide Request | Clear Request
p 1] 95 ||= q ]

Location: httpi/fsqli.qa.spidynamics.comiB0fmssql/GET/GET_inurl phpTid=1

] Get Tables Get Colurnns Get Data 4" Pump Data -

Raw | Detals | Hex | = |

- Stop Send

(Select a request action) - Anply

Search Text - 34 [0 RegEx
GET fmssgl/GET/GET_imurl. php?id=1 HTTF/1.1
Tzer—-Agent: Mozillas4.0 (compatible; MSIE 5.01; Windows NT 5.0)
Host: sgli.dqa.spidynamics. com
Site Tree |Data Extraction Set: 4 B Status Details Data Log

Database Detection

EL-‘ sqli.ga.spidynamics. comfmssql/ GE g Status SQL Injection Confirmed.
“{o]| | SQLServer(employee) _

ety F‘arameters(

Posk Parameters(

Data Extraction

Extracting Tables!,

Extracting Columnsi,

D 1oft
) oof0
O onofo
3 nofo
) Dofo

Extracting Rowsl:

£ >

Ready..

W,

5. ¥RTOT—7 6T XRTOF—REH H
VA LEEEER A A DA &

COME T D X7 DFEAN D0 T T"'SQL Injectord 27" X—157 1 4 1 L T2 S

T 3121k F—24 H (Pump Data)] 71 =

FE IROFEEF LT, 77— ] 2RI A T 22886 TE T,

a. F—7)WOE 1 (Get Tables)] #i% R

LEd.

SQL Injector’s, Z—7"y b7 —ZN—AN D FTXTDT7T—7 VDL A #IR L£T .
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V=LA AR
% 13: SQL Injector (Weblnspect® 4)

'Eite Tree [Data Extraction Set-

Ella zqli.qa. spidynarics, comn)mssaqlf GE
E .l___l SOLSery |-'rI|-r|||:|||| HEE::l
----- .Ej sysdiagrams
----- .Ej emploves
< >
b. 7—7 W EAT FAN TWBF 2y /R v/ RAEA > F1E A7 LT 7—7 I ZIE R

LEd.
c. B OELfF(GetColumns)] #27Vy/L &7,
SQL Injectorfﬁ BIR LT WH DIXRTDH DL R 2R L ET .

'SItE Tree Data Extraction SEt.

= IO sqll qa. spldynamlcs u:u:um,l'mssql,l'GE
BN R0 cerver(mployes

EI ¥ sysdlagrams

b L E] version

-[¢|[=] principal_id

- [¢I[=] name

-[¢|[=] diagram_id
-[¢|[Z] definition

EI .Ej employee
-[¢I[=] name

E id

< >

d. #HEAF TN THWBF vl Ry AEF Y A7 LT A 28R L £,
e. F—XOE 18 (GetData)] #7Vv/L £,
6. JIl #EIR L. F—X(Data)] x7%27Uy/ L DB 2R LET
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V=LA AR
% 13: SQL Injector (Weblnspect® 4)

'Site Tree [Data Extraction Set. ' Status [ Details

-1 sol.qa.spidynamics. com/mssglGE Data for Table...[employee_employee]
EI[_] SGLServeriemployes)
ij sysdiagrams hame /
W =] wersion Alan Anyone
principal_id
name Clare Voyant
diagran_id David Donalot
; definition
BE employes Francis Fondue
-~ MIE] name George Theguru
LS ge Theg
Harry Hedunnit
John Doe
< > Kevin Kirk Mudgeon |

¥E: SQL Injectorns7 — &% H T &L WG & 1. ME 58 & 7 —&X—2D 4 H #HL
B9 2282455C, SQLA > Y =7y 3> Offi §5 1 OFF AE AR CEX AR REtE A b D
3. COBEE 2E Fh T Bicik. "SQL InjectorDi% 52" Ik DX— | O #E 5 HE
[l R—204 1 42 1B L T 280,

CHHHTSI FEEn
"SQL Injector® £7™
"SQL Injector D% & " IX DX—Y

SQL Injector® &7

SQLA > v z7y av I § % &, SQL Injectorid X DA > 27 %K m LET .

R XA v
FRARA NG IR DETHRDH VLT,
o £ (Raw)-HTTPE R D7+ A MeF R L ET.

o 4l (Details) -Z R #. xV vy, BERURI, 8EU7'0 harDLs A M T TRR L
F4. BROANVE 74—V FEZOBEBE LB R LET,

o Hex(16# %) - HTTPE K 2161 L X TR R L & T

PR ARA Y ORIR &) 08 2 212id. B3R ORIR (Show Request)]/ B3R DIER R~
(Hide Request)] 7V v/ L &7,

TR #HI B LT7 741 hOhttp://localhost:80/1C B & 2 312id. EXR D27 V7 (Clear
Request)] #7Vy7L £9 .
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VIV AA R
% 13: SQL Injector (WeblnspectD 4)

—_

T —ANX—ANA
ETORA NI IRDEATHDVET,

o ¥4 bV Y—(Site Tree) - URL. 7—ZX—R, 7—7 . 8LV 2K IR LET,

o 7—4i Hi 3% 5 (Data Extraction Settings) -7 — &0l i ¥ (iR S 27 —7u, 5. 8
ST OR KB LR LET. NSO RN E »ofl Hl S &3228, 2Ih FRE] XA
7R/ CTEHETEET,

4o >
H DXL NG IRDEATHDNET .

o RT7—ZXA(Status) -1& Hi 1% e S H A% BE DIEATIR I N—2 KR L& T,

o 5340 (Details) -7 —R&X— 2D R LF N 1] G & I A—ZDFFEAN 2R R~ LET .
o 7—&(Data) - Liz7—7 I SO ot il Shf-7 — 25 R R LET

o nZ/(Log) 1% ¢ 2 % OME T &34 LR 2 AR S &7

SQL Injector®Di% &
SQL InjectorDa% & #28 H 4 5121 IRD L L &7

1. BRE(Edit)]> B (Settings)] Z7Vvy/L £7
2. WOWTNHADKTZER L. L F D7y s> Tt Bl ¢35 Wik € 218 € LT,
o A7y 3(Options)(" {7+ 2(Options)] 27" | 2% &)

o FAEE (Authentication)(" 27 (Authentication)] 27" X—2160%% R)
o 7'mF ¥ (Proxy)(" ['u¥ v (Proxy)] 47" X—160%4% I])
3. OKlz7Uwy7L &9,

br~7"> 2>/(Options)] &7
&4 477 M#P)(Timeout in Seconds)
SQL Injector# & vy 3 48 T § R GZ 45 O [ R B e e L.
IR 88 3E F (Apply State)

T7Vr—y avhit vy av N OIR R 24ERF 3 27012 7yF— URLE & &IA & Fizid
POST7 —2OH 7 218 Fl L T 335 4 . SQL Injectorid 2D )7 X 45 € L. Z1IHE T
B EEE LEHELET .
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# 13: SQL Injector (Weblnspect® & )

7'un¥ v O A (Apply Proxy)

ATy %8R ¥ % &, SQL Injectorls 2—4HEE Lic7 oF ViR B > CTE R %
TELET,

n/5C & (Logging)

D7 CELER T RAANY MEIER L &7

o FIR

o L&

e T o—

o TNNYT Ay—Y

a7 77 wikxmllE 3 T<drives>:\Users\<user
name>\Documents\HP\Tools\SQLInjector\logs!ZfR 17 St &7

B 774 DY EE X YYYY_MM_DD<current-process-id> &0 I ek V&4, ZHf O
B DD id. D& e Riwca s,

o sqli_debug.log: 2D+t v DT /N v7 Avb—YRNE FN FT.
e _errors.log: ZDt vy s> THRAE LIcz5— Rl A 35 & &9

» _RequestsResponses.log: SQL InjectoriZ & >Ti%k %5 SN 2E R UG TXTHY £
nEd,

7 — 44 H (Data Extraction)

SQLA > Y =7y /Zxt LTHESS AURLTT —R&dH § 3 L& IR SN 37— . 4. 8
U DI KB IR LET . N ADfEIE. T —ER—2AX A > D F—44 H 3% & (Data
Extraction Settings)] A7 \C t R /x S &d. N A6DEIE. COXT & 1E FRE
(Settings)] K4 7l #{FH L TEE T& 7,

ey 7 AE 3 3B AL v RO KB 482 L &7,
e 5R /BF ] X— 2D H (Inferential/Time-Based Extraction)

SQL Injectorid . SQLA > ¥ =7 3> OHffg §5 1% A58 ) S 7z 612 2DD5 % 27715 T
F—xEME CEET. TRTOR A HTTPIGZ ON B 2 N2 mF L 2 H LT
EAT SN EFT. COHENERBR LG E 2 B X—203 H EIFiEn 2208 O 1% %
VIR WA ] S BIENTEET. COFHFE TR 7—7 V7 —x5HE 42 b
N\ T —BAR—RY DF L F1Zxt UTERAT R ] 2 W45 OF —ZX—RA 7 T VEIE[E ¢
BET, T —BER—ADLHI #8153 T2 &l & 9. Thid b OFRF[H 23030 2L HE 12 7
BIEMH DI 22— IESQLA > =73 Vi 591 OFF(E i RR 3 2720100 B 4 3T
HefiEecEid,

~27odf# F (Use a Macro)

~/uEEH T35 5. COF IRy R AL BB AR 27 )y LT~ on%
IR LES,
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# 13: SQL Injector (Weblnspect® & )

7 —&XR—R 7 71 )73 X(Database File Path)

COFE AB VE ] 7% A bR v7 A& SQL Injector Y — L 83U F— R ERAFE L, B8 &
NicT —BRX—2AD— R 2 W F 2720IMEK LIcT —EAR—AND NAABEK IR S E T,

2 A (Authentication)] &7
R EE *Y v N(Authentication Method)

HA NCRAL AN E 24 1d. B L(None)] ZiRIR L &4, 2h LoD & & BIE
(Authentication)] VA b2 558 FE AV v REEI L £ 7,

« H & (Automatic)

E: HEMH 2182 728 A% v o OULHE 2 <5 0Ed . 1R LT 27 O EE #
VORERTE T 58 AF v DA Tr—v A KIEWCH ELET.

« HTTP# Z (HTTP Basic)
e NTLM (NT LanMan)
R A & ¥ & 3R (Authentication Credentials)

E—44 (User name)] 71—V Fiz2—#ID%#A /1 L. PSA7—RF(Password)] 71— I
2= DNRRAT—REN S LET N1 3IR%P {Teowic. PRAY— FORERR (Confirm
Password)] 7 +—)L FIZ/SAT7— RE&E DR LA I L&T,

P'e¥ 2 (Proxy)] &7
7'aF o4 — %/ LTSQL Injectoril 7 7 A9 3121k IR D% € 2 L &7,
H B4 (7 o+ &%) (Direct Connection (proxy disabled))
TaF e —NEEH LaWG A, COFT7 Y v ERIRLET.
7'n% Uik € O H 88 H (Auto detect proxy settings)

COA7y av %R 3 % & SQL Injectorid WPAD (Web Proxy Autodiscovery Protocol)
HHLT7ax s AHBRE 771V ER DT, 2N &M L7574 OWeb7 0¥ 23 & %
ITWET.

VAT LD ux vk e & H 3 3(Use System proxy settings)
O—AN ey yhe7 ax s — MER 2 v AR— M B, COATY o HIRIR LT
Firefox7" o L &% & #f# B 4 3(Use Firefox proxy settings)
Firefox/ 67 0% o — \ER 2 >R — T B2 COATY s ZRINL LS.
H: 79790705 R e LTH. 7af s 4—A"EH TV E&—2 v N T 72 A

TEDIRAEIE D DEE Ao Firefox7 20 D4tk € Nl 7 oF o L LI E ST 3
e, 7 aE A S EE A
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# 13: SQL Injector (Weblnspect® & )

PACZ 7 v fE F LT u¥ v 5% 5& ¥ %(Configure a proxy using a PAC file)
CDA7y %R 424 URL] 74—)v BIHE € LIz 7 71 )V D5 T (2 & BPAC (Proxy
Automatic Configuration) 7 7{ v 67 0F L3 € Bo— K3 9,

7'ax > 8 7R B 28k 2 3 3(Explicitly configure proxy)

7aF Y —NEH TV R—A vy MIT 72 AT B2 COATY 2 FIER L, R sh iz
HRMEUTOENN LT

1. f—73(Server)] 74— P 7' aF 49— DOURLEZIXIP7 FL A& J1 L. i C

( B— MPort)] 71— FiZ) R — pE 5 (80804 &) 2N JI L& T,

2. 7aF oy —EEH TTCP F o274y 3 270 havdD BA7(Type)] %
SOCKS4. SOCKS5. /-l fEHEsIEIR L &7,

3. WAL E 2354 &, BBEE(Authentication)] YA b s XA 7 HIEI L £,
« H 8 (Automatic)

FE: HEME 2B E 728 AF v O 268 e 0F 3. 53R LT 357 O
SE AV yREE T B AF v DA Tr—v R K CH ELET,

# 7K (Basic)
£4 Y A MDigest)

Kerberos

%Iy x— MNegotiate)

NTLM (NT LanMan)

4, 7oF Y —NTRAE PV E LG G E W 22— 8 LSAT—FEN I LET.

5. ¥ EDIP7 FLA(NEE 7 A MA M ENWCT 7R AT 217 md o4 —A"&F ] § 2

BE RO L. PudyEnNLART 391 NBypass Proxy For)] 7 +—v Nz 7
FLRETZEURLEAN I LET . 22 MR Y] 256 & v ~&H LT,

HTTPSH DR # 7'u+ > £#5 & ¥ 3(Specify Alternative Proxy for HTTPS)
HTTPSE: 4 22 UA N 27 0% 24+ —n0DH &1k, HTTPSHOREB 7uxs #BE T3

(Specify Alternative Proxy for HTTPS)] 7 = /K v/ A Z# R L, FR s iziEk 2N J)
LEd,
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%)

SWFScanY— i 5/§i fH + 2 &, Adobe Flash7' 5y b 74— A5G LT 3 s =77 ) —
DL F VT AEMELR T 2O BET. COFH N & Y—vik. Flash77 V7r— 3
W AN IFTE DTS 2 E L. 20 A5HI R 7204 [0 8E 3 277 7% 200 i 30 38 T
EBENL&d . MEsME OFF M e DOTIE TR g PE R b R 123 M L TS0,

- 4l &

SWFScanid . ActionScript 2% & '3 (Flash/A\—2 2298 S TUM10) 2 © TR TDON—Y 2> D
Adobe Flash $ & U*ActionScript Z[i H O J5 ¥4 THHR— L &7,

AV &=y &zl > bZ2 v b L OFlashZ 7/ V&R A > N 20, B—Lav Ea—&h5

Flash7 71 )V #o— ¥ % &, SWFScanid . SWF /Y4 ha— %1% 2> /31 )L L. ActionScript

Y—AA—=RELEB L. ART 4w i #FAT LET. ZORIKRONEDL A— AT

&Ed.

o Mgt £5] &L CLIY—R 3— FO

. %%@Hﬂﬁ‘fifﬁ%n%“n%ﬂﬂi?%’&

o MFE KN DIRANSIFARIHARFA

iz Flash77'Vr—y av 2 F 8 T & 4 25 5 (AL DE E 2B INER (4 v h7—F >
7”?0&'. (BN %ﬁll F‘%%‘/Eﬂ?&&‘)éﬁ%ﬁt SN &9,

"Flash 774)1/0363\1% "R DNR—

e 55 1 A5

SWFScanid. X D X4 7DFlasht ¥ 27 i 91 27 X ML £ 7, %ODﬁEO)Hf‘fﬁ PEDF v
21 B % s 201 fF . (SmartUpdate 21 1 L C) SecureBase(ZiE Il 8L £ § .

SWFScaniz & > i S 2ActionScript 3DffE 55 14

Flash QUL | THESE s 1277 07— 3> Cld IR D X4 7 Offs §5 1 55SWFScaniZ & >THE
Han v,

o WATHENWTIOY ST DEE
o BAETHRWTZUr—y 2D
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# 14: SWFScan (Fortify Weblnspect® )

e Adobe R N5 F A RIE R
o 1B RN

KR OF 2y 2D AN C OB TIE . i (Edit)]> & (Settings)] 1% L. Fzv”r
(Checks)] &7 #i#£ R L £ 7,

SWFScan(z & > T i &h 2ActionScript 18 & U2 Dff 55
Flash 8LL N THESE S 1o 77 U —3 3> Tldk « IR D 24 7 ONfs 55 1 #°.SWFScaniZ & > T
Han zd.

o WHEMEDH BIuRYA NRAIVTTF AV

o 2—FARME LT —REZ NN BS54 B AL
o« HETHWT Y FTDERK

o« BETHOLWTTYr—y 20D

o HEB R

KE OF 2y DrEA D0 TiE . BEE(Edit)]> B E (Settings)] ZiE R L. Fxys
(Checks)] 27 %R L £ 7.

Flash 7 71 )V D43 ¥t

Flash7 7{ v &5 ¥1 9 2121& - SWFScan# A &> F7a>y—v &L T, Z7zikFortify
Weblnspect®&i & 2> F—% v heLTEH T& £7,

ALy R7ary—) &L TDOSWFScanDff
A& K7 a>y—)v &L TCSWFScan#1# | L TFlash 7 71 )V &5 #T 9 %1214

1. SWFScan#ii2§j 4 2i2ld. R&— N> BPXTO7'vs/ 541> Fortify Security
Toolkit]> BwfScan] #7Vv7L £9 .

2. 7t 9 BFlash7 71 u(swh #FR € L E T IRDLT N »EEAT L& T,
o PSR Z/EURL(Path or URL)] 2> KK v 7 AT\ Flash7 7/ WA\D 7V A 2% N T &

123847 L. SWFScany—b i —7. B8t £ oo 54,

« P r1(File)]> B {Open)] #2Uvs L. a—#L A RL—Y 7 /31 2 AFlash 7 74
WEIER LT, B {Open)] 27 Vy/L £7,

SWFScanid. IR L7771/ 50— LT, W a> (v L £9,
3. SWFScanv—iA—7., @nalvze » o 5 54
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Fortify Weblnspectl TDSWFScan D1 H

Fortify Weblnspect D4 & 2> K —% > b &L TSWFScan %{#i i L TFlash 7 71 v &5 #r ¢
BT

1. AF oY OEATH FREFEATR I ROLTNLEET LET.
o Jr—y XA > TFlash7 71 (swh xR DI, 774 #4H 7Vy/L T ¥ 7 b
#y b A=2—5 P—(Tools)]> BWFScan] #i%€ R L £7.

= [Z]dy hittp: /A thack, com
=i i

‘;,} (Event) 1: ,onload
D J00crne_airpark2CB0, swf
[#][] 300cme_avalonZCED . sw
[#][ 300cme_haurlyrate, swf
300mm, svif

D ermnailer.php

Farm.htm

][ gallery.htm

D indez, hkm

& lwan 17 awf

o Jfs§5 ¥ (Vulnerabilities)] %7 CFlash®ff 55 1 # K S, i 5 3URL %47 2 Vv 2
L. ¥ 3 by A=a—hn56 P—(Tools)]> BWFScan] #i## L £ .

Risk. Counk Descripkion ~

et 1 [=l Flash¥ars Cross-Site Scripting J Request Forgersy

et 1 Unencrypred Login Form

W 2 =) Suggested Security Controls For Embedding SWF Files in HTML £
hikkps e, 3000, comy auflogo_1 3, swk v

£} vulnerabilities lﬂ Information l Best Practices 1@ Scan Log lﬁ. Server InFnE S

SWFScany—ivat @ L. W a> /&ty —Aa—Fso—FL T,

2. SWFScanv—iA—c., @analze ooy 5 x4

¥E: Fortify Weblnspect CFlash 7 71 )V &53 iT T& &3 . 2D/ 7 74V N E

( R* v>a% % (Scan Settings)]> b7 > 77 514 (Content Analyzers)] ic & 2) T
ZOBERE 2 T 2L ERH VLS. LhL. SWFScan Tl M. Lk . V—A
I— RN SNLTURLOD Z 2 AR — b, BLU 7740 T &l 7l D L AR— DA 5l 3R]
REWCZ& B7cD & DX DBERE Ll 1l 25 ik S & 7. V=R a— N &72ld Z D5 E D
NERE ST TEET(" Y/ —RAa— PO E" R DR—V 1 55 ]).

IHHH TS REn
"SR OHER" IR DR—Y
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"Y—Z3a—FORER" T

n":l % O)ﬁﬁ [EN

e SN -HE 58 1 D YR MASWFScanDAG T ORA VIcEK R SN 7.

YA MA OIEH & 7Yy LTS3 1E B 3 216 ) &R on L e 99 Mk il sanfzev a—iv
(LM OS> TC)R DT L&T.

i ———————
= DWFScan EERNER ~=
Ble Edt  Help
Path or URL: O Dewenboads 3248 pad - & Get | W, Search |5 Settinegs | i Anake

&2 | publlc function handelassPaciet{angD: om. macens.mysd: Fr - Sourte | -] Properter @ Wulns |7 s
43| puble funtion handeEniPadas el :com. macdens. mysg:Pro -
i b Furetior hardeErrorDador e ginim madeva syvigl: Iy T Potential User Account Information Discosure
a» | bl function handlerextacbes()

€5 | puble function handeResponssadoe tlanglom, mackena. ey
o | puble funetion handef el S tFeldacet (ool com. madens.
o b funcoon handefesdtieFeicsfofacke [arpl:com mach
£
€
L}

5| publc function hendeResuitSetasderPaduet s gloom naden
€| publlc funciion handefesuitSeRowPace Harploom madema,
5 | bl fune o handefesutSs tlowaEoPace i pliooos . seck

n | bl Function newPadont])
b Repaiset

& private funcion castbndSe Vel (ar glodbnect, g1 com mads Summﬂr}'

| s Funetion mtflowanalsnt)

€ nternal furanen addCokumn{ar girom macema vl ek A potential information dischonire valnerability was discovered doe to the presence of a keyword that

§ Mt || et e ot sl s bl i e s code Reconmdis e
& PP —— removing this mformation from prodection servers.

5| publlc function ReniSet{arpl:comumadens. mysgt My SaToke

4| publc function et rumColmns() @ int I:'ix

o | puble funetion et tkaen) | cof. madlens. ey MySgToken

| puble function deposel])

2| publkc function firstt]) ; Bookesn

43| puble funciion geiBinary(argl: ™) : fash.utis: Bytedmay Before an application moves into productson, make swe @t is configmed secimely, and that nformation of

| puble furetion geiBlecinardangll:] : Bediean potential valee to an attacker is not being left & your application code. I applcable, remove this information

] b function getiobums() ; Ay ﬁ'mﬂ::pm&rhnnm‘u !

€5 | publc function getDate(argl ™) | Cate

o] puble funetion petiee{aral: ™) ¢ int
e P e T
» publle function getows{sngd Bocleen, srglint, splnt iex  (orvnn = Name Faciage Class =
<2 | publc funciion geiSiringlangd:™] 1 Sing

G
&
i B y
I~ Fyr—- 2 ¢ Dt 1] Fotestial User Accoent 1 commaciemasmysgl HandshakeHandia B
o bl Furetion Lt - Bosiean (Y] Dty Megpaging e fipghstil Lagper
€5 | publc function next() © Bookesn 1] Potestial User Accoont 1 ca 2 flash 1iPiayEvert
€| publle funation previous() : Bookean 1] Dt MEssagng comkongregateasd.dient: AbstracshadowSersie
) i3] pube h:w " 1] Potential User Accoont 1 commaciemamyngl Conpcticn
(5} lulrerabie] Potential User Aot Informaton Dedosre. || W4 PotestalUserAccount ] commaciema.mysgl Hysal
| inbernal statc function Server o tion() L] Fabentsl User Acceent 1 [Glabal] Playeresy
o mterral furction Sertr lnformia bonangl:com. madkema. mysd:: W Potestial User Account ] [Glabal] HySQL
Fl m 3

Y —A I— RO R

FEEDTFANLFEY . &G IBE LIEER KRBT 27 FANLFEI 2R E C& &
T

1. BZEXFF(Search For)] 74—V FiZ. 7F A MCFH - EHRFHR AN S L &
£

2. THFANCFH) Efd IEHL R I ORI F /N7 DX 05— B 2 Bl Fr oA %
BE T 212, KIXCFINICF #X B 3(Match Case)] F v/ v2 2541 L &
¥,

3. XA #EMEB LLCHM T 510l RegEx] 3% IR L&,
4. METHFE O V7 HIERLET .
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ActionScript 27 71 )V D5 5

T XTOY—2R3— (Al Source Code) —i¥f 2> /S f)p & fzy—RAa— R,

¥ € OFf | 2 ) v7(Specific Movie Clip) = VA ;23627 ) v7 %18 L 3.

k5 52 D 71— A(Specific Frame) — 7 V7 7L — A #IE R L &7,

¥ %€ D 7 5 A(Specific Class) — VA 6252 %1E IR L £7 .

5 € D £/ v N(Specific Method) — 7 52 & XV v NEIRAR L £ 7.

ActionScript 37 71 VD5 & -

3 XTODY—2Z3— NAIll Source Code) —i¥i a>/ A )L S fzy—Ra—K,

F5 52 D /8 v —(Specific Package) — YA tm s/ yr —Y #IE R L £ 7,

K5 %€ D 7 5 A(Specific Class) —/ S vy —Y £ 7SRRI L £ 7,

K5 € D £/ v N(Specific Method) —/S w7 —Y . 252, BEU AV vy FEIRIR L £
5. BRZE(Search)] #27VvsL &,

MR 45 R 25 R &5 B (Search Results)] 270 F 7x S, — AR # o Sh £,

SWFScani% 5&

SWFScan# & #1T IZid:

1. SWFScany—iA—. eS8 oL 25

2. SFSEREXTTCHRTEFEITVET, & ZTORTE DFAMICONTIE.IRD NI 525 ]
PNGRAN-10F

o "AS20% 4" T

o "AS3DFR I IR DA—

o "7'm¥ 2 (Proxy)" IR DX—v

e "F zy(Checks)" ~—168
3. DKl#2YvrL &7,
L SN R SN 928, SHhDE->THM §2Ld TELEA. REL TR
Flash 7 70 L 243 B + 2icid ., @anavee w5y oy 200 8 135 0 & 4

AS2 D Ak

ActionScript 2/3 v —Y( A —AARXN=R) G T SR I TEE T DIz FFE D
Nor—o BT e 12 R4k (Enabled)] 7 =y /R v/ R EF AL £

B —CEE D BIESIE. COF 2Ry s A% F 7L ET,
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DA MR AN 218 I 3 212id:

1. EBiNAd)] %27V sL &7

2. E4Mv—v@iE N (Add Exclusion Rule)] 74> 7T, W=V DL ] & Ny —Y %
FLR T RIERI R AEAN I LET,

3. OK]z7Vy7L &9,

BN UV — IR 1213 HI BR TE &2, 7 741 bD L —)L(FlashiZ #E 51 7"5 V)3 25
HT&EEtA

AS3 D5 Hk

ActionScript 3/8 v —Y (A —AAR—ABE LUV IS R) N I TE £ . Z2D1®HIC
B DS — &1 2 A E A U s - 18 2D 4k (Enabled)] & zv 2 E v 2 A& A
izl &Ed,

DT AT —V el VR E DB E & COF v IR/ A4 7 LT,
Nor—PB L7 I7REERAIN VA MBI 3 2120

1. fBiN(Add)] #2VvsL £7.

2. Br4MV—LDIE I (Add Exclusion Rule)] 74> K7 T V=V DL & /Svr—v &/
& 772k §BIEMERIREAN I LET

3. OK]z7VvIL &9,

BN U=V 4R F - HIG T ACELTEETA. T 74V MOIL—ILIE B H CE F¢
Ao

7 1% 2 (Proxy)

MOA7y a2 RN L ET.

o HE B (7 o+ &%) (Direct Connection (proxy disabled)) -7’ % o +—/3 24 ]
LG &g, COA7y v #18R L £ T

o 7'0¥ LR E DH B H (Auto detect proxy settings) - D47 3 FIE R 5 &,
SWFScanY—vid WPAD (Web Proxy Autodiscovery)7' o b v 2l LT7 o+~ H#)
BRE 7AWV ER DU, ZR M LTT7 579 OWeb7 0¥ v ik & 217 LW &1,

e YATLDT7 o¥ VX E #fF FH 7 3(Use System proxy settings) -m— L v v 670
FoH—MER AL VRN B COF T RN L ET

 Firefox7' o#* v &% € £ F§ 4 3(Use Firefox proxy settings) - Firefox» 67 0¥ 34—
IER A A= MBI, COATY v #IER LET,

E: 7 o707 xRN E A LTEH. 7oF s H—N"EH T/ Z—2vMNIT 7t
ACEAMREEEIE HNEF AL Firefox 7o DR E NN 70X o L LJCERE SN T
WBEE. 7ux 3 SN E¢ A
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« PACZ7AV#EMF LT7 u* v &8¢ & ¥ 3(Configure a proxy using a PAC file) - PAC
(Proxy Automatic Configuration) 7 7{ )L 67 0% S E 20— R§ BI2lE . CDOATY 3~
FEIRLEd. 2. URL] 74—V RIC 774V OB T 236 € L £7,

o 7'ux v PR KCER E 3 3(Explicitly configure proxy) -7’ o > H— & i TA > &—
Ay MIT AT B COAT7Y av FIER L, BER SR EUL T OL AT L
EQ A

a. B—s3(Server)] 71—v Fiz7'oF o4 —/SOURL &7z IP7 L 2% N Jj L. %\ T
( f— MPort)] 74— Fi2)£— 1 5 (8080 % £) &N 1 L £ 7.

b. 7'm¥ 4 —EH TTCP r 74y 7% § 27 0 bavd BA7(Type)] %.
SOCKS4. SOCKS5. F/oldtEH#E sl IR L £ 7.

C. FRRENLE 26 &, FBAEE(Authentication)] VA M6 7 HIEIR L &7,
o H 8 (Automatic)

AT HEMR I 25 € 928 AF v DL B HE D& S IR LTH B[]0

EE A YRR E T B8, AF x> DA Tx—v  AE KIE A ELES.

# A (Basic)

£4 Y A MDigest)

Kerberos

23— MNegotiate)

NTLM (NT LanMan)

d. 7oF o4 — TFBAL AW B 43545 . 4 B—¥4 (User name)] & PIAT—F

(Password)] # A\ JJ L £
e. FEEDIPT7 FLA(NER 7 A MA M W T 2 AT 27 ad o —"&fi [l 2

WERE WG E L. Paxy e/ (/8273 541 MBypass Proxy For)] 74— Rz 7
FLZETZEURLEAN T LET . 22 MR Y] 256 & Av~&H L&,

« HTTPSH O E 7' u* > %48 & ¥ 3(Specify Alternative Proxy for HTTPS) - HTTPS
B et AN 37 ox o 5— 0551, HTTPSHORE 7oxv 2B E T3
(Specify Alternative Proxy for HTTPS)] 7 =v /R v/ A% A4 1z L, B3R s et i 2N
SiLEs.

o

[¢]

[¢]

[e]

[e]

7 v 7(Checks)

CDRAIE W av A S fza— RN OFEE O 1t 4 F 073 2B 3 RTH— B

LR SN E7,

F 7D/ — |k

7T 74 NClEL Fzy2D YR ML EKE (Severity)]JlH i v— bai . FE K (Critical)] 725
R2Z 7527 1 A(Best Practice)] N &V — h&N &3 . fFzy244 (Check Name)] T 7L

TRy MEWY— b2 F A LE2Vy L& BN LA OY—NEF #1124 3
i A RB LEe > E 2y L ET,
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F v DF NAE R

774V MCE YA M DF =92l $XTHZH TH Y. 2D &id B Z4k (Enabled)] 51 ©
F Iy IR 9 IANA N 5THBIETH MVET . FryrelEshicszcid. B
(Enabled)] %l O F =y /R w7 AEA L ET
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Fortify Weblnspect® + &4 —3 2> XA V2l 5 . WebH 1 b &7-idWeb+—EADE &
I 12U AR RN S, 2RI A THEFI M A sfc vy v RoR s &d. —J7 .
Traffic Viewer T4 . Fortify Weblnspect23i£ {5 L7z N TOHTTPEL K &, — 3065 5
LB HTTPIS & 4R 8 LCHERR $ 24T & 47

Traffic ViewerD A 4—

LR DA A=V AF v>D 574977 7V 5FRK ~ LT BTraffic Viewerz7~ LTy £
T

2 - o %
TV
Site Tree Y| | 10033 Results Traffic Q & &
Eh=] hﬁp://zero.webappsecur\é’ =
==V Request Start ¥ Host Y Port T Path Y Methc ¥ Status Y:I
€60 4/19/2018 5:15:51.7 zerowebappsecurity.com 80 ! GET 200 0K
[ %2e 4/19/2018 5:15:52.2 zerowebappsecuritycom 80 i HEAD 200 0K
E - 4/19/2018 5:15:52.2 zerowebappsecurifycom 80 ’ GET 200 0K
= : a:m 4/19/2018 5:15:52.2 zerowebappsecuritycom 80 ’ GET 200 0K
[ backup g 4/19/2018 5:15:52.4 zerowebappsecurifycom 80 ! DDDDDD 501 Not Impl
[ .bank 7| 4/19/2018 5:15:52.4 zerowebappsecuritycom 80 I OPTIONS 200 0K
L3 bzr f 4/19/2018 5:15:52.4 zerowebappsecuritycom 80 ’ GET 200 0K
O3 gibin 4/19/2018 5:15: zerowebappsecurity.com 80 1d GET 400 Bad Reqr
[ cobalt
= ‘;‘; = zerowebappsecurity.com 80 I BADMET 501 Not Impl-
[ docs : zerowebappsecurity.com 80 GET 404 Not Four
[ errors 4/19/2018 5:15: zerowebappsecurity.com 80 ’ POST 413 Request
E -git 4/19/2018 5:15:52.7 zerowebappsecurifycom 80 ! GET 413 Request
hg
~

a9 Jﬂ 4/19/2018 5:15:53.C zerowebappsecuritycom 80 [SPIfingerprint&04chk GET 404 Not Four .
»

HTTP -]

REQUEST Q, A RESPONSE Q A~
GET / HTTP/1.1 HTTP/1.1 208 OK ﬁ’
Host: zero.webappsecurity.com Date: Thu, 19 Apr 2018 21:15:44 GMT
User-Agent: Mozilla/5.0 (Windows NT 6.1; WOWS4; rv:30.8) Gecko/20186181 Firefox/3Ser Apache-Coyote/

owz =/ Acc

Ca must lidat .

Con -8

Con

Tra

=

4| | M | |
Viewing traffic file c:\users\| \appdata\local\hp\hp webinspect\logs\b30a504c-f81e-4b60-8fb1-e159649c5ec3\trafficmonitor:tsf

F7y aEE TRV ERD B

Traffic Viewer {8 Fi 3 212id . AF v> %517 9 37ij (Z Traffic Monitor =~ (Traffic Monitor
Logging)] A7y av #HG $h e T 2 END NET . AF v &#EA4T 3 %H0 12 Traffic Monitor
1/ (Traffic Monitor Logging)] ZH #hi2 L& L & 2D AF v 12 B L Tid Traffic Viewerid fii
HT& A, st 4l icD0 T M"Traffic MonitorD 47 26" I DR—2 1 2Z R LTS

LY,

ZaFxH—A
Traffic VieweriZld. 7 A2 b7 F TR E LTEIT CERAH O REE M O7oF v H— g8

IFNTHET, INEFH T 26 757 AHTTPE R 41412 L. WebH— 3085 2% 552
JEL 2 E&DT 574D M5 749758 51 © & £4 . Traffic Viewer7 o 213 7 /3 v/ 42 N &F
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i 4T 212D Y—NTH N, 2—HEH A 2T STX L N6, TNTOER EH—NILE %
H 2208 TC&%7,

1z, COBkRE 2ff A L C. Fortify Weblnspect T{i i © & 2Workflow~ 7 o*°Login~ 7 0%
BT 22E8TELT,

Traffic Monitor O %4t

Fortify Weblnspect Tid . 9 XTD R F v 7213 MEl ¥ DA F v i2x} L CTraffic Monitor 45
MCTEET

TRNTDRAF x5t 4 BTraffic MonitorOfF %4k
7 74 N& 5E TTraffic Monitor 26 %) (29 21214

1. ﬁ%(Edlt)P F 74w bD X% v 5% 5 (Default Scan Settings)] DJE i 7V v 7L &

2. Bﬁ& v E (Scan Settings)] X1 > T, B (General)] #/7VvsL &7,
3. Traffic Monitor® /52 §% %4 %2 3 3(Enable Traffic Monitor Logging)] %% R L
7,

¥E: Traffic Viewerld 8274y 27 7 74 VOl S 4k 29— L &€ A. Traffic
Monitor 7 71 )V %15 5 4. (Encrypt Traffic Monitor File)] 7'y a4 v #3 +5
T49 77 7ANH D BRE [ 2RV TDAMEH 526D T,

4. OK]z7Uv7L &9

il 7 O A* w2125t 3 BTraffic MonitorOF %1t

A% w27 — Fefli ] L CAF v 25 Uh 3 2 £ & Traffic Monitor 2 3 (2 2121 IR
DOFN»EFEITLET.
o AF YA — RO TR ICH B §EE (T 74V b)(Settings (Default))] ZEEH L. "<
TDAF vk 3 2Traffic MonitorOF 246" 1D AT v72-412HE > E 9,
o AF x4 — D FEAN & A v 7% € (Detailed Scan Configuration)] 7 4> K7 T,
Traffic Monitor @ %44 (Enable Traffic Monitor)] #i#R L £ 9.

Traffic Viewer D2 &

Traffic Viewer!d . Fortify Weblnspect &Fortify Weblnspect Enterprise Thl 1y Tl 2 2 F v
O D R w24 (Scan Info)] XA m s TEEd. CONIETY—LERE) T 3L,
N2 74907 AV N S Traffic Viewerhb] & &9 . AF v DI TALY K7 o>
YW ELTL M 749007 aF v D7 —RER R BTV — IV ER (CEHTEET
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BlOLWTWBRAF v s

Fortify Weblnspect &Fortify Weblnspect Enterprise THf 12 Tl 2 2 F > % 5Traffic Viewer
I E) T 2104
o [RF x> (Scan Info)] /% L ¢ Traffic Monitor] %27 Vv 2L .

[

| @ Dashboard | | d: i |
& Traffic Monitor

lattachm %—]
{f False Pos Detailed information about the network traffic associated with the scan |

E: A% v> %47 JAi 12 Traffic Monitor o7 (Traffic Monitor Logging)] 4 (2 L% w»
&. Traffic Viewerld il C& &¥ A

AR N7a>Yy—iL &L T
A&y N7 > DTraffic Viewer £ &) 3 212d . IROWT N HOEAE #5247 L7

« Fortify WeblnspectT P/—iv(Tools)]> Traffic Viewer] D51z 7 Vv 7L 5.

« Fortify Weblnspect Enterprise’® # 2> —)L ¢ P—(Tools)]> Traffic Viewer] DJH
/DA 3 g
N7 49707 0% > DT —ZNE /N SN T WTraffic ViewerSe &) L £ 9.

¥ Windows® R &— ] A= 2—7>&Traffic Viewerz 8 ¢ 326 TC& 7.

A&7 —ADMFE H

DYy Tl B D774V ER Fik. A by U—DfF . 7 Vv Rea—EE 4l
Ea—DAARYARTT i 2= A ZT7—A(UNE K DA AL HE ik, BLUHE R
o—LOfFE OB TCER B L ET,

WE A7 D7 71 )L &f <

Traffic Viewer CIX D XA 7 DEEF D 7 74 IV 5B &, vy s &l NBENTEET .
o NI4Ty a7 7 (. tsf)

o LAYTBEFY LYY 2T 7 (. psF)

e Burp Proxy 7 71 v

e HTTP7—#A7(.har)7 71 v
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E: LA T axs vy a7 71 )(.pst) 2B <&, Traffic ViewernZD 7 7 )V & 7
T4 77 AN s LT,

BEAE D7 74 &BH Acid:

1. B QOPEN)] #2VvsL £+,
B {Open)] &1 7ul/ Ky Ak &£7.
2. FayZ X YR Mpbs, i 77V D XA 7 %RIR L £ T,
3. ANV EILTH &7,
Traffic Viewer Tt v s FE /8 St £ § .

YA M )—DfF A

HA MY Y—=IZIEs T 740 FClE AF v P IR ST RXRTOD NS T7492DY Y—E 2—
DL T RENTOHLRWREETCE RSN ET., VI—ZE. FA MR A M DT RTOHT
FALZNID YA MG FN EF. COP2—Tl I L OKR A MIERIR L THTT 4L 2 MY

FREM L. ZFLRUVTHAETIER GLE MR TELT. A MY V—TIHH 2I& R T3
ECEFDIEH D RS T749 003K R SN 1.

YA MY V—=D7 A av
WO TG A MYV—ICR RSN BTV LT0Ed.

742
¥ AW RLTWBRLD

=] H—/Fh A b A bV V= iE O b L)L
OB 7xvx F 4L 7N

O ~x—v 7714V

VY—2AD 5749 7DER I~
YA MV IV—NDIVY—RAD s 57490 8RINTEETIHH D NF74v 08K IR T BI2U4:

o A MYY—TIEH #IR L 7.
ZOIEH R T2TXTD 574900 V5749 2(Traffic)] 7 Vy RICER SN &9

REMAIZONTIEE " vy O E" R—U179 1 25 18 L TP &S0,
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KR NG DA D I~
FA N OEDYVR MR R T B!

o T 75 MDY Y—E2—T, 7HOVEATAa>#&1mE 27Uy oL £,
A M= HA M IPORRRENET . COE2—TlE. Y 7T AL 2 ML T 72 AT
EEth. COE2—HH 1DLL L DOFRA PRI L. FR DERAN CEE . TMER LoK R
hD 7 4L ZALELY N | #2 J8 LT 280,

V=R DR R ISR BT

o LI T RTAavE Iy ILET,

IR LR R D740 KL

FAEIN R AL DA LTDIZ A MY V=N O EDHRA N 7OV R C& 9, 3N L
TR ANEFDHTT AL 7 N)DA EH A MY UV—IZR RN T BT

1, YA MV—ICHARA MG P UDE R SN THRIREE T, Kk T2FA M1, BN L
7,

2. 7OV RT7AavE )L ET,
IR LA A MUY A MY Y=l R SN £7.

3. AN LT, 204 77T 4L 2 VER R LET,

TRTDK R M DE IR

FTRTOR A M DERIZIR B

1. 740V A7Aa>& 20y 9,
P A MY Y—1Zy BLET IR R LIABIRFE A DK A MD KA M 12U 0NE R SN &7,

2. BIRNFEADEZE RA NIV IL T FNFNDER G LET .

3. 7R 7AavE 7y oL ET,
TOVEILER SN THR WY Y—B 2= A bV U—IZRK IR N, TXTD NS 74v 0%
RENET,

CHHHTB M Fan

"UIEE B DY A RZETE 3T Ofcfeq s BEUREB" X—2177

TV RE2—DHARTAX
JYVyRE2—IlR R SN 2H| O A AR T AL ELE T BN, BLUHIBRATELT .
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G| DA XA T
Gl DY AR ZIE § 1244

1. $ARXEEE T2 EE LOLAR OB R cA—Y Ve8I LET.
A= VAN FE EIZ e 0 Bl L LT S a5 WK B b NET .

Host T Port ¥ T Method T Stafus
zerowebappsecurity.com 80 fdocsfapi/index.html?org/apache/catalinafwebsocket/NV GET 200
zerowebappsecurity.com 80 faccount/ GET 500

2. OWTNU»EET LET,
o VWEARIRIWKBET HDEER 24 13RIV LET,
o MR ALK IV T BE HDOHARIEH N Tt IR )L DT —ZDOMR 2 DET
74 RO REICIKFE A Za— A A—pE I SN B2 EnH DET,
RO A=
Z Ny RTH| DNEF 228 T 4 21

1. BE) 20 RHE LicAhA—YvaeldhLid,
IR H LOYE s /H VKB ILEDVET,
2. 1 29y 7L 29,
IR LOE REPHCEDLNET,
3. HM A B £TH| 24 3 FZ97 LET,

LA eaeddost % tgar’r T +Path 1
11/28/2017 10:58:00.477 zerowebappsecurity.com 0

fdocs/fapi/index.html?org/apache/catalinafwebsocket;
11/28/2017 10:30:50.352 zerowebappsecurity.com 80

faccount/

F—ZDH| KB L. B 0OF A o E A A B E L ET.
HI| DB /8 Bk

T 74 MTClE TRTCODT—LXH| M7V NCR IR SN BZDTTEHNELA. 7Yy FE2—D

HET Ty NIRRT 27X 41BN CEFd. Bon 725 2B 0 238 4 26
&:

1. Zyyrea—cl 2000 £7.
{fi B A fE 25 D YA MR R SN £,
VE: H 44 0E AF oo I SN B AEN R EIR L ET
2. KOBMEEFATLET.
o BMIEMTAZHNDF IRy A %A LET .
o RADAOHIGE T BN DF 2R v/ A%F 1L £7,
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3. IO YA MIDIERE D227Vl T. VA &P L&
RN B Sh &7 .

AL 2—DARRTA R

TV RN DFEA L2a— DL AT T beAF—T—~#IE IR L1z0. HTTP] 4 £ 2—DF R
CERREY OB 272097 520 TEET .

R VAZANOF N

B3k (Request) ] 54l E2—¢& 5% (Response)] it 4l La—724 & HBIHH 2k LT2D0D
FEAN Ea—AE R SN TW B A E. 2N 504 22—/ B 200 XB 2 T 4 (L F)w
B KFTREEEC)VCEHE LT 2208 TEET. LATV METE T 512!

1. i ca—cRrry9rL 7.
R E A= a0 & & T,
2. WOWTNhEFEITLET.
o FRAN La—ZLE(L )it NBIziE. #EL 477 NVertical Layout)] 227V 7L &
ER
o FEAH Ca—%EE I XBI12IE. BE VA7V MHorizontal Layout)] # 7V /L £,

HF—FT—~vDAS

F 740 MDAT—TF—lE A DA77 RCBE SO AT EOFF A NCT, 1277, B
DA77V RCH BT EDTFAMFH 23264 TEET, H5—T—~2EFH T3
Wi

1. a4 ca—cRE )02 5,
2. OWTN»EET LET.

e AW YI7 57y NICE LU fT EDFF 2 M 421013, B 7—=(Light
Theme)] 27Uy /L £9,

o HWwNNyrl 5Ty NICH aff D7+ A befli ¢ 21k, B 7—~(Dark
Theme)] 2 7Vv /7L £7,

HTTP] 2t 4l £ 2— D& /& HHE R R

Ei3k (Request)] &7-ix > % (Response) ] if &l La—74 &, HTTPIF A £ 2—0D1D%4T
0112 0( £ AE T T 0T B) LT MO HTTP]ZEM 2O A D& 4K 7 3 22 &h0
T&&9d.

PR Ea—EIER R T BT
o Al La—DIERRTAINA)EIVILET
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RN OFFMl L2a— %K IR T 2121
o BRTATANV)ESYILET.

UIE R O A R 1 Dicick . 8 LUR B

P A PV Y=0F =KD Yy FEa—7% EFE D2—F (> 27— A(UN)EZ 12 OL T, 4
AREEE L0, FR R 0200 LR R(EB) L2 220 BE TF

HR DYy A AL H

EROYARXEET § 2208 KOOI NHOEE 24T LT

o JUyRE2a—%EIKFDT—RL AT M >TOBRUIER DG &L T 0icick
(Collapse)] 7K F "\—% FZv7 LT, BEERKOIR 2L S0kl &7,

Collapse = *

o YA U—LREFEMEDT—RLATT7 ML >THBUIE X DL & k. P orzris
(Collapse)] f: H N\ —&/zid A 70—/ 3\—% FZ97 LT S2IVONR #2000
ES AN

]
=R
oy
3
1

iz =

BER O 0zl
BR 2P ook
o {7 Wizt=#4(Collapse)] 7V vrL &7 .

TR D B

EREFREM T2
« BB (Expand)] Z7VUvys/L &7,

H &) 2 70— Dff H

HE] AZn— L aG 1L T0waEE. . Lueyy avpiEIN &N 38574927 Vy RH |
A7)V BT D NS749 0ty R EN FT. HEI A 70— iR it 1
EETTOAF vV EFHE LTV REXICDATH SN 7.
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HE) 27— LOfF 2h it
HE) 2 7o—v 80 3123 21Ud:
o 22—y 7A4 3@ E )L ET,

H &) A7 a— L O

[NZ74vo(Traffic)] 7 Uy R T vy av S X270, HE) A7o— )& —IRfF 1k T& &
T HE) A Z7o—L 22T B2

e 22o—noyr7Aa @) Es)y L ET.

E: 7T 47 AF o> IEOODTEHE A /o— v 2HH T& 7.

NS5 74y 7 DERAE

Dty aTlE N4 78RR T2, oy s RS A—REEAE T 2071, b5
TA9IT—ROM R E7OVAD T ERER 2 H 25k 450 ] LET.

NS T4 DR R

T 74 FClE AF v IER SNITRXTD bF74920 [N 7749 2(Traffic)] 7 Uy RiZ

TR SN AXF vV B D ST 8RR CEET . FEL B ED VY —AD N 57490 %

BIRBEIVRRTBIELTEET. [FF7190(Traffic)] 7 Uy PN OF — K& E . V— b,
BIOT7 OV KL CEET FFAIICDOTIE . T2 E7 0L R X—o183 1 25 R LT
-1

VY —AD s 5T 497 DF IR
AV IV—HDIVY—AD s 77490 8RIRNTEETIHH D N FT74v 08K IR T BI2Ud:
o YA MY—TIHH 2N L £7.

ZOIEH B T2TXTD 574900 5749 2(Traffic)] 7 Vo MR R S &9
TLy RIS L)Y 2Of8 H

YA MY YV—TYVY)—REZIER T2, CWRTH U TIIWNDENT L YRIZL VIR NTT 4y
27V RO EIBICE R SN T,

::hﬁp:.ﬁf‘aerﬂ.webappsecurinr.cum:EC' >q' >rescuur|:e5 )5 >|:>nc-T51'rap.min._'|5 x ;}

INAEDTVLYRISLVY 2E. T LR IZSLVY 2IZVA RSN TOBERB DY —AD N5 74y
IDAHET OV L TR IR L THARIEEZ R LTWET,
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— DL yNISLN 7O D B ICVA RSN TOBEEE DY —AD N7 490 % 7 4L R
AVER 3 21214
o TLyRISLYY IR DYV —RE 7YoL T,

fe &ZUE S BT DA A=K 78 S T Bresources 7AW D$TXTD b7 4w 0 53R 78
23541k, fesources] #7Vv/L £,

IR LIV —ADBRIBDTL YR IIAV 2280, v T7497% vy a8 i S T, i
IRLIVY—AD RS T7497DA DR RN SN ET,

TV RESEA Y B T B

o TLyRIFZLYYIDRIED K] &227VvIL EF,
TVLyRISAVY INHIE S, b T74v 08 v a7 OV S e NET .

CHHHTHR Ean
"tyy aOEE T
"NZT 49T —RD N KM X—3182

Yy 2D AE

AF vV DIITA9IT7AIWVICERIN SN TVWBT —REE T §23LHITEEE A 12171,
Traffic ViewerT + 574977 —R5F & L T AF ¥ S X2 8 DWTOHEE 215 ©
BHETEET, 128218 HTTP Editor 24 ] L CE R 25 1%{5 LIz, 7909 T v 3
VERRNLIZDT BIENTEET,

HTTP#E & DK 7R

oy avDER UGE G, HTTP]ZHAl ba—THR 22N TEET. COL2—k. IFEAL
DZ Yy RTIEIR SN 2L vy DT 74 Fea—TF . 1217 JI ORI La—hE R Sh T
WBEXIZ, TR D OICE R UGB 2R 3356 & HTTPIEEA ca—icY) v 2 &
T. HTTP]Ef4l ba—Tt vy av 2R R T 3120

1. 7VyRCryy av#iER LET.
2. HTTP]Z7UvsL %9,
HTTP]F 4 ba—03B &, IEIR Lict vy 2 DTSR UG & R R S &

7 ¥ A2 MDY ik L

B 5K (Request) [ 74l £ 2—% Jis %5 (Response) | #f4ll E2a—2% EDFEAN E2—Tld. 7+ A
MI DR OE KFRIZo— A= H LAOTIE av 7o VR TELOWIERH VL
1. Pr 0k L(Word Wrap)] ik i€ #ffi ] LT7 %+ R b&dr DR €L, /K F A Z7o—u 3 —ik
KRx S EtA. P ViR L(Word Wrap)] ik & 7l La— T LIER € TEZLDTH Y, ¢
NTOFEL La—Zxf § 27 0— VAR E TEHVEEA. P VR L(Word Wrap)] &% &
N 2R E 7 7AOWVICEE A € 2= LR AT St IRl 770 — v B (L& ICZDFF
4 C2a—DF 74 ME &2 VET,
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7 F A NPT DR $I2I:
o FEAl ba—%&A 27Uyl HT DR L(Word Wrap)] iR L 9,
R OTFAMTHI DR S, KPR 7a— =0 k&7,

N—t Y N I— N EZEDF a—F
FI7HV T ER USE T TH L F A — > by a—F 4 SN Tw 9,
FSR FREIBEE DT F A MI%3BR%40G ED/NA—L Y NIy a— N ENH BIGEE. I b
DUF %7 3—RLT TFA M ARLT T BIENTEET . BR FLIEIGE DL T 57
I— R BRE BN LIy 2DITXRTOH vy s ¢ T vy 2 DFER FE)0E L7
I—FENET. NSO FENT I— RSN DR BB IR 12 2DIE . AF w2235 LT BfH
PUTT. AF 2 CTHER L 77400 NOER R Sh. T X FEH P A—
Ly bhbya—rRIn 7,
N—t Yy Ny a— N F %27 23— NT 312i:
« 5% (RESPONSE)] 24747214 EXR(REQUEST)] %7 ¢4i 7»7LC URLF 2—
MURL Decode)] #31%4R L £ .
N—L Y FZY =N FEP AR TOTFAMER SN 7,

R O %
HTTP Editor 2 /] L TE K 21815 T& &¢ . 2R £fIE 15 ¥ 2104

1. 7V Ty av IR L CER UG EHE ER R LET.

2. HTTP]#al ba—Bl v Tuhawigaid. HTTPI 220y 2L 4.

3. ER(REQUEST)]#4ll t2—%4 27Vy2L T HTTP Editor¢& 4~ (View in HTTP
Editor)] #i#R L £ 7.

R 1kt LCHTTP Editor23bi & £ 3. HTTP Editordfif £ i DLW TEE L A& HTTP
Editor® 4> 74 >~ v 7 £ 71214 [ Micro Focus Fortify Weblnspect Tools Guidell %2 &
LTS,

P 27+ (Browser)] TOx v 3> DR IR
774 (Browsen) i Al La—Tt vy av 2R R LT A M DECT b I7190hnFE A L
fen R T&Ed. P77 (Browser)] Tt vy s 2K N 3 31214:
1. 7VyRTeyy av B R LET,
2. 7’574 (BROWSER)] 4 /VUv7L &7,
P'Z 74 (Browser)] #E 4l L 2—2300 &L BN Lz vy v R IR S &7

E& a>7>vORE B

VTV ELHR (SR EA) T 28, 3= R A=A, AT v—F—, IAV N BLY
Z'ay X U] 05 IR S 77OV AR S 0ET . LL SO L Tl 3V 7
SYMARIIC EoTH AN bDIC L ET. Bk (Beautify)] 58 5 21 F 7418 JE4E &
N7 AR T& &Y. Bl (Beautify)] ik & GFHA Ea— LR E TEBHDTH
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D, TNTOREAH a2 387 m—/ L ARGE T H V&t Ao B (Beautify)] & €
& 2= E 7 7AIVICEEAN C 2a—Z IR A S IR Bl 77V —y a5 L X2 ZDEE
Mea—07 75V MIME ELTEH sh 9.

Fagsnt-arrovaEH 1 212:

o FEAl ba—TH 2VvsL. 4k (Beautify)] 2R L £4 .
4G snfzar 7oy s, st AT g nEd.

E: —HOFFAMIENTELVLDT, COFTY R RSN AEVIEES LHNZ
7,

CHHH TS FFEn

"N A—ZDfE "R

IS A= D F

NoT74v0 vy aTEH SN B3R5 A—RDRAT 41l BLUMEEERTELET. [¥F
A—Z5F 4l (Parameters Detail)] E2—i2id. bF71v 2 vy s> T S 27 vF— &2l
STV FHTE1DDL a— REF LTV RBR IR SN ET. A CATA—20ME ] sh T
WBTRTD IS T7497L a—FERRNTBIELTEES. P85 A—K(Parameters)] #E 4l
Ea—i2id [FF71v(Traffic)] 7 Vv k& BIE 274 v2(Related Traffic)] 7 Yy 67 7+
ATE&ET,

INTA—=RIZDNT

NI A=RZUE IR DTN ERE TEET S

o JVyF—T—X

o HTTPZE K DURLOD—#f &L TIEAE SN B( /23 7 DN vRE £ 3) 72 UL F 4|
e Post xV vy & H LTIk {5 &h 27 —X(set_<parametername> 7 &)

ST AL Al DR OR

Ty v DAFTA— KD 23RN T B

1. [FZ74v2(Traffic)] 7 Vv N &7zl B b7 1y 2(Related Traffic)] 7 Uy KT v a3~
FERL£T.

2. P A—ZX(PARAMETERS)] #7Vy/7L &7,

BIR Lict vy s TR S TO BN T A—RPBR IR Sz P8 T A—X(Parameters)] i+ 4l

Ea—20 &£

A Ea—DLA 7Y MNEE & P8 A—X(Parameters)] 7 Vy NICIE S 2 L EH A

Micro Focus Fortify Weblnspect (22.2.0) N—181/379



IV AR
# 15: Traffic Viewer

[N 2749 2(Traffic)] 7 Uy KAND /8 Z A— K51 DI I

(N2 74y o(Traffic)] 7 Uy RIZH| 2B N LT, p¥F5 A—K(Parameters)] 7 4l & a—i2— B (2
SNTWBRIA—RERINTEET. [FF74v2(Traffic)] 7 Uy RiZ 2 607 —X51] %38 N
LTBLE 7—2070— 204 LTWREEIZ, Lyy s TIREE RS A—REB I LT, »
DEDE I T Vr—y 06l 77 NS TOL A0 EH [ 4 200 5 1 d 215 45 12
| T4,

fz &7 JSESSIONID /N 74— XD #FK 78 LTHK £ vy s TOZDME 25 X, £¥2TZ

DE N LT 2035 T& £9 . JSESSIONID /8 54— D% %, 20T HE 3

%set JSESSIONIDE— 45 B M L T EAEH LTV BECRER T IENTE LT,

INFA—ZDH| ZIB N B2l
1. P¥Fx—X(Parameters)] ¥4l 7 Vy N T. N T A—RDIT 24 7 Uv 7L &T,
2. Pl OfERK...(Build Columns...)] #i#4R L 7.

VEDIEIR LI/ ST A—RDF #DARTIIE N LIz C&h3d 235 6« Bl OFE A (Build
Columns)] # 7'y a3l C& £E A

INSA—REL DR DS, /8T A—KME 5% E T AV v ROF (3224 235 &)k, 574y
J(Traffic)] 7 Vy MIZIB I SN &9 . T 6DF) 1k BLAE D AF x> DT —RXN—RIZK &t 1] (2
EBMESN Ed. N eDFZIE 7 Vy R E A=2—ICbIB N SN ET. 7 VY R E A=2—%
@ﬁﬁ LT, Ba—WH 2B L2Vl BR LT & &4, M8 O n/Hl " ~—175]1 %5
fa LT Zan,

NZT 4T —RD KWK
PA MV Y—HN DV —AD bF7 497 %K IR L. RULVEKT VLT vy s> O b S7490%
[N 2719 0(Traffic)] 7 Vy Nea—IlR /R T&EE T

V) —AD b 57497 DE I~
YA MYYV=N DYV —RAD b 7749 05K N TEETHH D MF749 05K /R T 212U
o A MNY—TIHH #IEIR L E7.

ZOIEH CHBR TBIXTD b5714905 [FF74v2(Traffic)] 7 Vy RICER IR S &,

oy DB E N7y IDFR N

(N2 719 2(Traffic)] 7 Vy R T vy av D 57490 8R N TEEFT,

vy O N7y ER IR T B
o [FZ74v)(Traffic)] 7 Vy N T vy a7V 7Yy L ET,

Bl 77 1v7(Related Traffic)] 7 Vy KRR S E 3. #l b7 74902 v av T H

A i &l O YR MYy s LTy 2h 60 HTTP]Z 4l Ea—B s ooy
(Browser) ] 54l b 2— 5K /R T&F T
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[r=74v2(Traffic)] 7 Uy RIZJR B1214:
o [FFT74v)(Traffic)] T EH &1 ML AA—%227Uy oL ET,
N5 74y 2(Traffic)] 7 Uy FAR IR S, TRXTD bS5 749 705FK I SN ET,
FEAI OB TIE T FE A 4 o727 Vo FOEAE" T 122 B LT S0,

HAE K o127 Uy FOFE:AE

Yy RTF—RE RYLET VG 28, TR XA MUA—Mf Wi 24 7 Uy B & &3, 7 Uy
R —RXDEF O 2 FULE T 38, FH XA bDUA—RH 2 2RE TH LWL Uy R
B OZ VY RIZE £ ->TOWEE T IROH| X fEAE % -71232007 Yy FaER LT &7,

Traffic ~
Related Traffic ~

>
£
2
g

W TXRTO77Vr—y 22, FIR T 7 VPRI RTE N 2D TEHNER A

A % o7 Vy RDR IR £ T

HADOF O EDT )V RER IR T BIE ZOT VR EICE £ >TWBTNTDT Uy NE
M UEd. Foo AR LT RXTOZ Yy s —FH I Ll TEET.

B2 0DOF O E D7 Vo RER N T 21205
o RINT BT VYRDRA b AA—% 27V £,
RBRT27V9 RO I AEROSNIZTNTOZ VA LT,
FEAE 20512 RXTDFZ Vo FER U 21214:
o KEIDTVyRD XA ML AA—% 2y £7,
FEAE o2 TXTDZ Yy R LT,
CHHH T P EN
")y R 2a—DHRARA X" XN—174

MR &7 0L KL T

Ty REa—&E EAEDIE T Ny RE2—ICR IR SN BT — Rk LT R 21T D ENTE &
T TUyRICR RN SN B TY— TV RINR 24T DV TEET. TI7T AT AF v %
BRLTOWBGEE.EITTORAFDIATT—RERE LI20, 7OV KU Li20, #
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DIATTF—RCY— M JoDTBIENTEET. MR 72V R O DL TiE. T
ZHIEONT"R—U186 45 HE LT 2 &0y,

)y R 2—TOM &

7Yy RIZE R Sh 51%0)7#%1 i%ﬁiﬁzﬁu DF—REMECEEST., 7 Uy NICER SN
TV BT =R LTHR R 21T O

1. BB T743Q@Q) 229970 £,

2. BZE(Search)] 74—V FIZ . FI G (ARN—AL L)W TEE T BIUBMR I 3MHEN T
LFd.

-

Status='404 Not Found'
ResponseStart>'9/4/2015 9:08:52.242 AM'
Status~'3[0-9][0-9].*"

3. (A7Y 2NEE DFN K L TR R 24T Il AR—ANA—%H LT, IR DFI| 4 (AX—
A LTEHE T BIUBR T2 2N LET BEH DF) 1) § 2% (£ ANDF %
LT DN ET. FH WK LTI E SN B &M 55 0L 3—PDA DK IR SN &
T BT BEAICONT COFE 248 R L&+

B -
Method=GET Status~'3[0-9][0-9].*"'
4. <Enter>*—%#f ¥4, Qe yysL &7,

FHREBERAFEH LTI VYRN TRV ER R TB2E6TEELT. sl icO0LTE M5
Z AR ONT" R—U1861 45 B LT 2 &0,

7V PE2a—TORE

B 3K (Request)] ﬂ7&5 [B%{(Response)] R7 R EDIE TV Rea—TT7 —REM R T& %
T K7 TR T 212

1. 7V RN O7 —T 2I# IR/ L 7.

AR L7e7 —ROFE4 23, B3R (Request)] 2750 i & (Response)] 277 £ DR
fPirenf-27ckKnr s 3.

2. MRITHMEXTHE 74—V AN LET,

3. (7r7°~‘/a‘/ﬁﬁ%‘imfﬁkfﬁiﬁi@ﬁ%@ﬁﬁa“z) & RegEX] F zy/h v/ A%ZIER L &£
T A OB T "R e OnT" RN—21861 4 ] L T 2 &0,

4. <Enter>F—%4 L 7.

MZEDIYT
MR #7VT7 T 2E MR TAa>D k15 27VyrLET.

Micro Focus Fortify Weblnspect (22.2.0) N—184/379



=LA R
# 15: Traffic Viewer

7Yy R TCDY—h
7 Uy RN OAFE & DF| TY— b BI2Id:
e FIHHBLESZYYILET .

7 Uy RN D 7 1)L ZAL F
7 )y RH O1DLL D) T 701 ZALE 5 1214

1. WRBLOYFE 7Yy /L ET.
IR LOTICTZOVRRFIHNERR SN ET,
2. Paovx(ilter)] 74— BIC7av &R EN ST LET .
TV AR L A7 D F (5~ <s >=+ <=+ =~y =), Tinl. Tnotinl. &7zl
Mregex] DWT N DL & 2D& Wkt SCFH CRER s 3. SEPHEE 7 (..)
220D F 5| D12 H B2DTHI A TF o FEAN DO T TR e H>0n T o
N—=V | %S L TS0,
1 :
443
'400 Bad Request'
30*
'9/3/2015 10:53:08.000 AM'..'9/3/2015 10:53:12.089 AM'
in(200,300) notin(400,500)
%: FLOEHEA T HRRHER 25 OO CE#EC 70V 2B A L v & 2
NEd,

AN OWTE "7V RN O 7L ZULEE D)L —)L" | J5F B LT 2 &0,

3. <Enter>—%4f L £

AT SN FREEDOOTT VRN DT —KR 7 OL KL S &4, 70OV KL sz
IR LOT7AarnricZEbnES,

4. BN OH) T7 4L R 4 2121 20 6DH| T AT v 715063 %548 ik L7,

TV RN D7 0L ZILER D )—)u

Z Uy RN D740 ZALFR Z1E . IR D)v—)L A5 F S 97,

o 4R EIRE TAILEEHVECA. FFE DI TT I EREHRE T 2DT, 74—V K
LG BRI 2R 2 S &9,

o Povidilter)] 74— FCEMRRER T 2@ H c& 3. sfdlcovTig, M s
N—v18814Z M L T aW,

o« v A(filter)] 74— NIZEF T R 74V RA—RBIRE S Wi & 70V X
field:*string*DJE I, Dl contains ] FJ IC 25 S & 4. MR 25 S CH sh T 3
WA 70OV AL field: “Fstring* (B SN £ T,
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fz&ziEs R7T—ZXX(Status)] 51l D 7 1)L KL F 51404 Not Foundid Status:'*404*"
Status:'*Not*' Status:'*Found*'IZE 8 S, A7—XAHM404]). INoty. F7/21%
[Found] #&5 &9 XTDL vy av DR R SN ET. 70OVERE 121k, 1302 Found] .
[404 Not Found]. & & UfT405 Method Not Allowed | % ED AT —XAWE & 3%
2o &7,

[ 27 —Z&Z(Status) 15| D 7 1)v XL 7 %] *404 Not Found'ldStatus:'*404 Not
Found* ' IZZ8 # S#1. [404 Not Found | # & ATE AT —RRAZRF DT RXTD L v avH
RSN £,

o THOVRTA—IL NG B DM R 740V REARX—ATX Y] > TR E T& &7,

o HA SR O74—0 RO 7 0u 1 B— 5] F 7 () & F=id — 5 5] F 25 (") Tl £ B 23
HOET.

TOVRIN T2 Ea—D 77T
Uy RH D1DLL E DR T RSN tzea—% 2773 B2l

1. Zov L szl R Loy 2 2Yy oL T,
MR AFVFH R H LO T ICR R S &,
2. PY7(Clear)] #7Vy/L &7,
HIH DF —Ri& 7400 ZULH S e DET .

3. BINOH D74V 2E V7T BI20E 7OVERULTR SN 1251 Tz AT w71 82 %4 DR L
QR

R DT

CDMEYITE 7Yy FE SO X7 TOM R AE H Sh 250 DR i E ZR (2 OW Tl L &
ER

VEOF: V.75 ¢

BR 7TVOFEAL N GIRDEB VT,

<PropertyName><QOperator><SearchValue>

7 )y MK CHR T 3354 . PropertyNameld iR (o5 ® 3% 4 T4 . B3R (Request)]
7% [t % (Response)] X77% £D X7 CTHi R 3 %35 &  PropertyNameld 7 +—)v K/=7'a /3
7 14 (T Request] > Response | % £) T3 .

7 Uy RD1ODF| N 218K ¢ 2354 14 PropertyName 2518 L& 4. COXL7TDRE D
R EKDEBNTT,

<QOperator><SearchValue>
R CIE K 3R Bl (RegExp) i S & ] 37 210k RO & L &9,
<PropertyName> RegExp('[RegexSearchValue]','[RegexFlags]')
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1R RO O icOn T T IE B R B off " X—2190] 22 B L T80,
Bainorxy

KPR L a8 0O FH 7 — 0B OBA 4 /T VEHEIT CEES. Al 7 )8
DL I DT,

Method=GET

Scan.CheckId=6

lYouTube ¢R. 3.

AR—RAILF £ R L F %8 07 —2OW R

MRS DAV TVVEAR—AL LR LT 0 d 25 A& av 7Y —5 () &
feld ZH G HAF ()T & 29,

Status='404 Not Found'

Path="'/signin.html’

OlvouTube TH. 2.

SIRFT 274V A= FEHART OEBIENTEET
ResponseStart:*'7/8/2015 4:22:'*

BEHORK EH LIBRR

1O R AR CEROR 25 D208 TEET. ZNEFNORIE AR—ATX Y] V&
T,

Path="'/banklogin.asp' Method=GET

OlvouTube TH. 2.

[ 71— PSR E R R Sh w258 1. TORIRa VEd.
Path="'/banklogin.asp' Path='/loginl.asp'

COFE % Tld « Path# [ /banklogin.asp) Z7zl&[/loginl.asp] TH 23X TD L a— R8I Sh
EQ A

B & 2 O 74— Mg TAND I LT b £9.
Path="'/banklogin.asp' Path="/loginl.asp' Method=POST

CO: & Tl « Pathzil /banklogin.aspl & 7zi4& [ /logini.aspl T& 9. #>DMethod %3 POST |
THDHTXNTOL I—FHBIR IN F7,

AND/ORMZ D& N DODF| IRk 12xn LE T
Method=POST Scan.Engine:Sql* Scan.Engine:Cross*

CODIE 2 Tld  Method 3T POST] TH 0. »DScan.Engine D D4t 88 431 Sqll & 7214
[Cross] THBTXTDL I— PR SN EF.

OlYouTube ¢, 2.
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https://www.youtube.com/watch?v=R09n59YJSbc
https://www.youtube.com/watch?v=R09n59YJSbc
https://www.youtube.com/watch?v=PyyrzqbVErE
https://www.youtube.com/watch?v=PyyrzqbVErE
https://www.youtube.com/watch?v=r1oojZocMcQ
https://www.youtube.com/watch?v=r1oojZocMcQ
https://www.youtube.com/watch?v=uD0dElCUfc4
https://www.youtube.com/watch?v=uD0dElCUfc4
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Null7— &0k &

Null ()Y NES T —REM R T2 =mE T 2 L. 201 122>0— & 5] [
FMENLES.

ParameterValue=""

g OFznull () T2 bIDE gNTW 27T —RE7 OV XL § 51218 Pl 70L&
(column filter)] 74—V FC=iEH T 2 [ L. 20 1222o0—H5 A (MEAN T LET.

OlyouTube ¢H. 2.
KR /YT 4 OfF A

AR—AEE LY 4 E12ld 74—V P TR 3256 R 72U TIE 2D AX—RIEHI B
LE&d. 1z&z2E. 7Yy D Response End] %l 1 R 4 2i2id . IROFE R 2 H L £,

ResponseEnd="'7/8/2015 4:22:52 PM'
EHRRFEOEH

NA—VERR T 20 ERRIEF T () e LTEHR BRI &M R T H2IENT
&E9.

Response~'[0-9].*="

OlvouTube TH. 2.

IEMBRRB L EN T 628 TEET

Response RegExp('[0-9].*=","'1i")

IE 3 R B O F OFF A Dw» Tl TIE R R B O A" X—21901 22 8 L TS0,

AT

KORTEHRREBLIO 7R H C& B F A ODWTHB LT ET. 6D
H| ¢ff ]l ST 2PropertyNameld . 7 Vv KRR 21T 5 & 130 & « K7 TR %17 9
B E 74— N7 aiT 44 2 xEd. HCHE 7OV EEE A 72858 3. Bl 700K
(column filter)] 7 1—v RIZ 74—V N7 08T 144 5 7% LT 280,

HE
¥ B i
= MBS FICRE T 250DDA  PropertyName=asdf
R
> MR 3 HAT £ 9K &7 —4&  PropertyName>123
R

>= MEMNME E-EHAM L0k &E0pEE L PropertyName>=123
W —RER R
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https://www.youtube.com/watch?v=hnVX6SVDxZI
https://www.youtube.com/watch?v=hnVX6SVDxZI
https://www.youtube.com/watch?v=l_ENxbRGiBY
https://www.youtube.com/watch?v=l_ENxbRGiBY
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HH

notin

Bt B

MRBE 2 HAT & 0/ Sh7—2&
R

MR BE &2 H AT & /N SHHEE L
WT—REM R

MR LT 5 LSBT —REM R

AW RA—NEEH L TR CFEF
LR T ELDDE ER R (R E
TIE R LT N LT %2 X[ 7 2)

W LR AR—REL R v 2
() E FhTwag &, H—5
TF &g —EG A CTHOUE LS
NEd.

T LI OF PN OF7 — X R

1EH R B 28 ] LR 307 41 O
R

EH KB O B ORE4H 12 DTl
MEBRRHOFEH" R OX—Y %25
HE LT a0,

FEOR CPHH g R EC— T3
DM R (B OME 28R T 2121
Hy=2X ) DD YA R EFRE KT ©)

youTubecH 3.

FEIN TP EN 7 R LI D TR
R (E L DE 2R AN 3 2iid. 7
VXY DD VR b EFE YL T &)

youTubecH 3.

Micro Focus Fortify Weblnspect (22.2.0)

il

PropertyName<123

PropertyName<=123

PropertyName!=asdf

PropertyName:asdf (58 4 — B M R)

PropertyName: *asdf (# & X F % T
BT — 2% R)

PropertyName: *asdf* (}& & X 7 ¥l %
H LT —REMR)

PropertyName:asdf* (# & 3 7% T
i £ 7 —REMR)

PropertyName: '7/15/2015 5:00
PM'..'7/15/2015 5:15 PM'

PropertyName~'sea[a-z]ches'

PropertyName in(123,456) 7zl
PropertyName in(abc,def)

Port in(80,443) (41— 2380 £ 7zl
443D FTXTD X vy R R)

Method in(GET) (TGETJ £V v F%&{f
M3 23XTDL vy v R)

PropertyName notin(123,456) X7zl
PropertyName notin(abc,def)

Port notin(80,443) (A — FH380 X7z
443D F R TD 1 vy 2> %55 41)

Method notin(GET) (TGETJ AV v %
i 329 XTD v a2 kA1)
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https://www.youtube.com/watch?v=zNhSP1Kk8Po
https://www.youtube.com/watch?v=zNhSP1Kk8Po
https://www.youtube.com/watch?v=OBWLO51FyeQ
https://www.youtube.com/watch?v=OBWLO51FyeQ

VIV AA R
# 15: Traffic Viewer

I 3R B AL

FVAC)VEA T2 ERBERCHER T28 FLXDLEMICH 200, £l OIE H R H %
R LTHRER S &d. SHEME 2 IEH R L (RegEXp)FE L #1ERL 32288 CT& T,
MR CEB N7y F A 7 a7+

IERRAAZEH LT ATE O 74973 F 5 7 a7 4(8UE S SCF5 . e HAT) %
METEET. ChClE. [FF74v2(Traffic)] 7 Yy Fea—0 5 74 a3 % 279977 3
E- TR IR SN BT AN FERTHE £n £

FIVR(T)EE T Off

FURCVEE T2 32856 BERERD L% 0ET,
<PropertyName>""RegexPattern’

—H A EE - EHE AT TEET.

i

D7V ER A vX N DRefererizindex.jsp 7 71 VMg € SILTW 2L v avD YA b
2R LET.

Request~'Referer:\\s.+/index\\.jsp'

WD 7TV 5 Z N\ v&Z N DLocationiZindex.php 7 71 )V & fzikindex.html 7 71 L 238 & S
NTHWadtyy aOVA MR LET,

Response~'Location:\\s.+/index\\. (php|html)"

WD)k, TCross] £7214TSqll T & 2L 0 DA ool & >THE shfz,
index.html 7 71 v £ 7zidindex.php 7 7AW EEF 22 vo s> D YA bEIR L E T,

Path~'/index\.(html|php)"' Scan.Engine~'~(Cross|Sql)"'

RegExpi# 3 D1 A

RegExpf# 3 i& JavaScripti2fil TE 0. X DR 2 H L &7,

;_PropertyName> RegExp('RegexPattern’) - K L 7 &/N L7 #X il LTHUR #E 4T L &
<PropertyName> RegExp('RegexPattern',' /) - K L 7 &/N T #X 7 L&A WTHR R 2%
TLET

%l

D 7TV B3R AN vX N DRefererizindex.jsp 7 7/ VTR € S T 2t v 2D YA b
R LET,

Request RegExp('Referer:\\s.+/index\\.jsp',"'i")
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KD 7T 5 Z N vX N DLocationiZindex.php 7 71 )L & 7zixindex.html 7 71 )L 3 & &
NTW3atyy aDYR MR LET.

Response RegExp('Location:\\s.+/index\\.(php|html)','i")
OlYouTube TH. 2.

RegExp## (2D T
K DY T RegExpi 3L D& DK 250 B L £,

Request RegExp('Referer:\\s.+/index\\.jsp',"1i")

Response RegExp('Location:\\s.+/index\\.(php|html)','i")

I I
@ 2]
WH B

EDHTTPE R 77— X4 R 4 3D H £ OHTTPIL &
TFT—REMR T B0 E LET(NVET —RER L
T — XD 5 #E A &T)

2 WROR R TIER BB CF 2 H LT MR 7 31
BEBRAR—EEHLET

—

1R R B

EMBRHONAZ— AL R LT —r VA& LR St &4, IROF 2. 2h
SO T D—iB &R Ly 2O R 2 2x LEd. #HER T 2O ML LT A>T
4 > @DRegular Expression Library (http://regexlib.com/Default.aspx)23& D £ 3.

X¥ B

\ WOLFEEHR L F L T~—2LET . E L FETnJjic—HLET. >—4 >
AN/ AT CFIC— L &7

" AT EF3AT DB — B L &7

WF AL T 88 HE X T &R LET. 2EAIL content7 (L
2 MY D/content/en® & Uf/content/ca #fx <§ X T %[ 4h 4 2i2id . /content/[*
(en|ca)l.*/*EEFH L 4. \S\D\WELEE L TS0,
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https://www.youtube.com/watch?v=DZdP1RN2GwQ
https://www.youtube.com/watch?v=DZdP1RN2GwQ
http://regexlib.com/Default.aspx

=)L H AR
# 15: Traffic Viewer

XF B
$ AN EIEITORE I L&Y,

% AT T3 FZ D0 LA FE D18 &8 LEd./zoidlTz) &tlTzoo) &b—F L
7.

+ AT T AL FEOIE ORI E—BL ET . /zoH/iETzoo o —FL L £ 975,
fzjicig—8 LEe A

? AT T3 F 00 £ 1 OB &8 L £4. /a?ve?/idnever] Dlve]
W LET,

AT X7 52 EEO1ICF B L £

| 2O FDVFILTEAMRREA) DM OOR%E/R LET, 2EAIT IRD T
(& 7S AiZfindex.htmlyindex.php 23 FN T2 vy av D YA MR L ET,

Path~'/index\. (html|php)"

i KUF N FEX P LEREA. COXF & RegExpD2F H D5 # ¢t
L&d. f Z2i:

PropertyName RegExp('stuff[abc]', 'i")
N MO7I7 LA G DEBZIENTELT . I 21"

PropertyName RegExp('stuff[abc]', 'mi")

m BT E-FTHRRELET. COXF . RegExpD27 H 05| U ¢ L &
IV AFS

PropertyName RegExp('stuff[abc]', 'm")
N M D757 Ll AL b BIENTEELT . I 213

PropertyName RegExp('stuff[abc]', 'mi')

xyz] XFEvb. FEINH OIEE DI FI—3 L &7, /[[abc)/ikTplainyDlalic—
HLEY.

\b AR—R EOHEER Fic— 8 L £9 . lea*n\b/ix . Tnever early ] Dlerjic— 3K
LEd.

\B  HLEELUAM OBE R 1o L 7. lea*n\B/id Tnever early] Dt Dl ear] &3 L
EQA

\d 1005 L&T. [0-9] L LTT.
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XF wH
\D AU DI Fic—F L&, [0-9] L LTT.
\f A=Y FIC—EHLET,
\n HUATCFICBLETS
\r F )oY VR—2 L F I HLET
\s | AR—R, X7\ A=Y EDF FIC—F LET. [\Wn\Atv] £F LT,
\S FHLFLAIOLF L ET. [*WMn\ntW] EH T
\w TYR—RAAT %% CAEE OBGE LT IC— L EF. [A-Za-2z0-9_] &R LT,
W BT A0 T I L &9 . [*A-Za-20-9_J ¢ LT

Traffic Viewer7 o= >

DXy avCld. 7axvEa— et T2 E Lo ax s 7oAV EER T 207
12 | Traffic ViewerO 7' o L 5% & 217 I E i L £

Traffic Viewer7' o= > D1 H

7'mn¥ v E®— FOTraffic Viewer2 i LCH LW ox s 77 AV EERR C& F4., 2O 771
WIE 87490774~ 70él TIRAE TEET . 12621 Weby A Do/ A > 7 uk A%
L. F v Fvan T —REal (v~ rnbl TR TE T,

7'n¥ v E— FOB 14

7 uF v E— NERIE T 213 IROWT R HAOEAE 2347 L&

s HlOTWBRF xI MBI T4vIT —RERR LT 2L BB (NEW)] 2270071 &
ERS

e [P/—(Tools)] A=a2—( %7z Fortify Weblnspect Enterprise D V—)L & v ) %> 5Traffic
ViewerZ# &) L7248 . LRT WSt SN fe7 ux sy 7/ VR R T 2856 13 B <

(OPEN)] %2y 2L, i Lo s 70 L &E K T 285 & 1d BFE(NEW)] 220920
ES

T4y RO EEc T ex o Y—ILOR KX BRI SN ET .
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LT oxs 7714 L OFE K
Loz oxs 7oV aEKR T 21

FHRNEW)] 227097 &9,

T4 ROD LI T aF Y —ILDR KX BPER IR SN ET .

2. 7TuX 7 ANVDREE EH G T 501, BR(START) ] #2Vv oL &7,

3. BER(BROWSE)]#/VysL %7,
v—L»3TruClient #Firefox7 74 il 8 L £

4. 7STF T, 7aF T ANVTR IO A FDOE > $THEI L £ 1.
Traffic ViewerD 7 Uy Rz, 7aF & H D b7 49 70BN D& T,

5. #& 7T L7zs EIE(STOP)] #7Vv oL £

6. IKDWTNMEFEITLET.

o TOXLTANENTITAvITAN(tsf) ELTIRAE T B121E R (SAVE)] 27y
7L ET,

o 7OF 2 T77{)E~0(.webmacro) ELTIRAFE 372121 TRFE(SAVE)] Fovr Ko
A=a—%27Uys L. FZaélT(as Macro)] ## R L £ .

—

7'ax T YRAF DK E
7TuFx YRS TSI hSOEEEEG F VAT 2e—WHTTPZ o v 4—NT4, 7
OF 2 VRS OB EGRE NV T VLT EBE7 )y LTRIERLT 72 AL ET
7 oF VRS EHRE T BT
o« B (GENERAL)] =VU7T7u*> YA+D p—#VIP7 FL A(Local IP Address)] &
B—MPort)] &= 2N JLET.
E: 7 740 bTIE. 7'a¥ vidlocalhost (IP7 L 2127.0.0.1) &R — 8080 2fF F L £ 9
Dy INEDLE S CTEE TEET,

E 4> DA A b OWeb Proxy Zll Ok A STl H 32 & A E T 312 o—AVIP 7 FL
ADEEREF T BULERDHVET . 7 74V MDT7 FLATH 5127.0.0. 11 #hE8 AR b T
R TEEHA. COBET—VAT—y 2OHREDIP7 L A H I, YE— MR
F—y R TEDT—IAT—y 47 ax LT T& 7.

7'aF s WWeb7 574 Dij 7 TE CIP7 FL RER— bl ] T 20 ERH VLS. 7 oFs
ET—RNT P77 (Browse)] R X2 3 2&. 6D E A7 ZU4 I H B 1 128 &
n £ . Traffic ViewerD4 i T7' 704 £ ) 3 285 & . CORKE T Sh &2 A,
7'n¥ > D E

TRFVREE TV ViR E AT W ETEE VL TR E LT 7L ALET .
7'aF AR E T BT
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1. PeF(PROXY)] /s oo TA7 Y av BN L ET IROR T A7y 242 D0 T
AL Ed.

A7y av A

HEES(Zoxy ZoFod—n#iiH Lavg &, 047y av£#E R L £
{8 %1 ) (Direct T

Connection (proxy

disabled))

7ox ik EDH  WPAD (Web Proxy Autodiscovery) 7' o b 2 il L T7' o ¥
B 1% (Auto SHBIRRE 77V EE L. 757 OWeb 7 m ¥ Lk E 24T O
detect proxy 9.

settings)

SATADTOFY p—veyyhsTaF g — MER E/ VRN LT
wKEEH T3

(Use System

proxy settings)

Firefox7'o¥ v  Firefox» a7 oF o9 — \ER 24> F— ML T,
EEEH T 2(Use w: 7oovrosor o lE AHH LT H, 7o s — 4k

Firefox proxy DAY E—% v b7 S e APMREE SN 2D Tl b D&+

settings) Ao Firefox7' o4 O G ik & Profs—&fH La
W] IR E SN TV ARG A&, 7ax s — N3 FH sn £+
Ao

PAC7 7% PACZ 74 )WURL(PAC File URL)] 74— NCH5 & L7135 Fr
LT7o* v 4% E 12d 3PAC (Proxy Automatic Configuration) 7 7/ )L 467 1%

4 %(Configure VIR E #O0— L&,

proxy using a PAC

file)

TuX R E FH ToF AR T LN Ok AL L 29
AT S a. 7uF P — AR H § BTCP 574y /8L I § 2720
(Explicitly 7’0 ha)L D XA 7(Socks4d. Socks5. &3 HEHE) &, KA
configure proxy 7(Type)] VA oS 4R L £ .

settings)

b. FRAE v E %2545 k. §BEE X1 7(Authentication
Type)] VA M SR DWTNHD XA 7 EER L &
° H Efj(Automatic)
o #: A (Basic)
o X4 ¥ xR NDigest)
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F7Y av 25 BH

o Kerberos
o %Iy x— MNegotiate)
°© NTLM (NT LAN Manager)

c. fr—/3(Server)] 74—v NiZ7 vF >4 — DURL £ 721 1P
7 RLAEN S L. G v T( ’— MPort)] 74—v Bi2)&— k
%5 (80804 E)EN I L&Y,

d. 7oF o —\PRAE #E K 323551k, B—% 4 (User
Name)] 7 1+—v k& pPSA7— N(Password)] 7 +—u NIZE&
HEIRENTILET.

e. FFEDIP7 FLA(NI 7T A MA MW T 72 RT B/
7 OFRIH—NEEH T AL ERLOESE. Poxy
#/3{3A7 3% 1 MBypass Proxy For)] 71— FiZ 7 FL
AEIGURLEAN ] LET. =2 NEX Y] 256 E. v~
HEHA L&,

2. IRFE(SAVE)] 5#2YyrLE7.

7947 > Nk ] & Ok E
254 7> baE & D% 52 (& Traffic ViewerO 7 oF Vik € CIT W ET. BE 2V /L TR E
W7 72 AL &7
747> MEE FF L M 9 25E B E 248 E 21
1. 247> MW & (CLIENT CERTIFICATES)] = U7 T o4 7> MEHE #83«
7 3(Enable Client Certificates)] #i% 4R L £ ¥ .
2. #4235 E 0 FEBHF R b7 (Certificate Store)] ZiE R L £ . 47> =3I D
tBNTT.
e [—7v = (Local Machine)]-a> Ea—ZDa—#uild ). 2> E2—KE DX
TOZ—H X LT a— L sE Bl #E 2 b+ 7.
o PlfE ®D2—¥(CurrentUser)]-a2> Ea— XL OWED2— 7 A7 MO O—A)LiZ
HEALHE AT,
Ll 7 72 24— NCAC) V=X ] S Zak Ml & & 2 — AL & TH 0.
BifE O 22—+ (Current User) ] IfR & S £ 7.
3. MOOVENEFETLLT.
o TENIT~A1)GEAF A M7 ARE B F IR T 2121 FeyZ/ Ko IR s [
A(My)] ZIER L 7.
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o [EHH SNV — NIEW]E RN T 2121E. Foy7L 7> YA bC [L— MRoot)] %i%k
WLEd,
4. Web+ 1 NI LIl 7 74 2 H#— NCAC) Y—K %46 Fil L £ 4 5?
e NETWVWDIGAH G IRDFHZFEAT LET,
i. §E B F (Certificate)] YA b5, [(SmartCard) ] &0 57°L 747 255t W f23E B
FEERLET
R U/ B &l 4 215 3 EPIN74—L B2 BiE B # 1% #% (Certificate
Information)] T V72K /R S &7,
ii. PINAS B 2035 4 13, PIN] 74— FIZCACOPINZA /1 L 7.
ii. FAMTest)]%227VvrL &7,
IELOPINEAN ) LIG & 1 I Av—Y DR R S &7,
e Tz DI 4& 1x. HEB & (Certificate)] VA b aaf & #IBIR L 4.
AR U733 R 3 A1 4 BE W] & (Certificate)] YA MO R 10K R Sh &7,

5. BRFE(SAVE)] 5#2VUvrLE7.

7 o VR A DR E

A A=Y 774 WPPDF 2 EDFFE D XA T D774 N 570X 7 —REH B2 WiG & 2 H
NET. TN BIEFLER DR R M AIRIN T B2IENTELT . TN D771 IV RN THIE. Ay
=Y ORI AN 2 L ONHL DR Hi T HTTPE SR /)5 2 DT ENvRICE T 52 ¢
NTEET. T 5D 7 71 LIk Traffic ViewerD 7 o 23 2 TR 4N L ET.BE 27Uy L TR
XTI ALET,

T 7AW RAT RN T BT
1. 8k L4\ (DONOTRECORD)] V7 CIEH KB 2L H L7 axs 771 LD
F T F SR T BT AANILTR T EN ST LET S
i :
*\.jpg$,.*\.png$,.*\.omp$
FEATC DL TE TMIEHLR DL O " X—2190] 2 L T 280,
2. BRFE(SAVE)] #2VyrLE7.

R & LVE ] ORRE

MERBLIVCEBRTIE, 70X 28 H LTRIE T 3HTTP Xvt—Y N O 7 F 2 MMl O
REBRDIEOON—IVEER TCEET, COBEE G B DY I2L—y 2 5[ F)12AT
I DIEHF TR eV — AR LT, R SN 2HBRERDEBVTT,

o I—HHRRNAT— R EDE T —XD~R Y
o FERADZyF—DIEN
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o AcCeptE R N X 74—V REZEH LT BB CHFR SN B AT 47 XA 7 %IB N 7213 Hl
bk 9%

o BIRURINDER #/70AH9 A MRV T4V N BIETR T3

M2 B S UE B O (L Traffic ViewerD 7 o X L3 E TIF WET.BE 22Uy L TR E W
772 AL ET .

7 ¥ X MO R LH
BERFLEIGEDTFAMNERR LTCHE &R 2 3120

1. Bin(ADD)] %2 VvsL 9.
F 74 DTy FUNBF BN SN T,
2. zOx> MO BRIGHT(Search On)] %l X7 7V /L &9,

3. FOvwZ R R #7V9 /L C R T2 A=V U7 5B IR LET. A7 a3 IR
DEBNTT,

« RequestFull -E 3R Ayt —Y &k TRE LB 2T VW ET

o RequestHeader -Z 3k N & D 23 TR LB R 21T L T,

« RequestBody -Z 3K A L O 72U TR EE IR AT W &7

o ResponseFull -J5 & Ay —V K TR EBER T VW ET,

« ResponseHeader -Ji; & N\ v DH 21 TR EB IR 21T W E T

» ResponseBody -jt; & A X O U TH R LB R 217 W& T,
WO IGE Ave—YDE Iy R LTHWET,
RESPOMNSE

HTTP/1.1 382 Object moved

Date: Wed, @8 Jul 2815 2@:22:30 GMT
server: Microsoft-IIS/6.9
¥-Powered-By: ASP.NET

Location: banklogin.asp
Content-Length: 134

Content-Type: text/html
Cache-control: private

¢<head»<title>»0bject moved</titler</head>
<body»<hl>»0bject Moved</hl»*This object may be found <& HREF="banklogin.asp">here
IHEH #H

1 YN e

2 IBEAX
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4. BEXFEFor)]F i MR T 27— Xk 7 —2ERTIEHRRI)EAN 1L &

ER

5. B#7—4Replace With)] 5] 12, B Dmofc7 —R%&8 &M 2 27— X&N 1L &T.

E: BEXNZ(For)]sl % E#7—(Replace With)] 51l TIF # K Bl #16 F] 2
Zix. Regex] Fzy/A v/ AFBINL & T "LV— L TOIERRTOMAH" T 1%

ZHE LT s,

6. MEL—ILEFBEIMTIERT22E. A7 v71-5%42 ik L.

7. RHE(SAVE)] #27VysL &7

WL TODIE FL 3R B OfF

ER!
TW&ET,

DXy d . IE R BN SCOME 25 28 D L gl 2—5 DA x4 &L

E#a—riE. BREXR(For)]5 & B #(Replace With)] 51| D] 77 TIF # % Bi 28 H
LT R CERDOL—IVER E TEET. f2eZIE . 1IE#H £ B 218 ] L CResponseBody T
(<return>) ([*<]+) (</return>) 21 R L TH Do ol 7 — R %$1< | [CDATA[$2]]>$3 10 B &
AL —IEH T 2E COMBIL—IIZED, LR IR T2 E AN A0 22827k

NE9.

This Response Value...

Is Replaced With this Value...

HITE/1.1 200 OK

Date: Fri, 31 Jul 2015 14:FZ:40 GMT
Server: Rpache/2_0.63 (Win32) DAV/2 mod suth sspifl.0.&
PHR/S5.2.5 mod =s1/2 0.63 OpenSSL/0.5.7Tm
H-Frame—Options: SEMEORTCGIN
H-Powered-By: PHE/S5.Z.5

H-Token: CH455E5478

Content-Length: 207

Esep—Rlive: timsout=15, max=5H
Connection: Hesp-Rliwve

Content-Type: application/xml

<?7zml wversion="1.0" encoding="UTF-8"7>
<Data xmlns="http://scanms/sexvi(l">
<Body>
<testResponser

<resultrrecurn</result>
<return*2ZZIZ</return
< /testhesponse>
</Body>
</Data>

HITES1.1 200 O

Date: Fri, 31 Jul Z015 14:2Z:40 GMT
Server: RApeche/2Z.0.63 (Win32) DAV/2Z mod suth sspi/l.0.4
PHR/5.2.5 mod_=s1/2.0.63 OpenSSL/0.5. Tm
H-Frame—Options: SAMECRIGIN
H-Powered-Ey: PHE/S5.Z.5

H-Token: CH4S5e5473

Content-Length: 207

Eeep—Alive: timecut=15, max=58
Connection: Hesp-Rlive

Content-Type: application/xml

«<?xml version="1.0" encoding="UTF-B"7>
<Data xmlns="http://scamme/servi0l">
<Body>
<testBesponse>
<resultrreturn</result>
<return><! [CORATA[Z222]] ></ return>
</testResponses>
</ Body>
</Data>

FEA I DOWL T TR R B Ol " X—21901 25 18 L T2 S0,

L—)L DiiE

FRNIGBENLV—IVERR SN TOHBEF CIEREH SN 4. 128218, H2L—n
HTTPS #SSLIZZE L. 2018 124% OL—IVSSLASECURE IS T 4 235 4 14 45 B 1Y

WCHTTPSH/ASECUREICE F S £77,
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V=L DA B

W—IVER BT BT

1. At 2Lr—1D BER(Enabled)] 7 =v /R v/ A% 4 L&Y
2. {R7E(SAVE)] &2VvrL &7,

=L D HE Ak,

NIV [ ] e ) R Y N F o

1. 5T 20— D BR(Enabled)] 7 =v /R v/ A% 471 L £9,
2. RFE(SAVE)] £ 27YvsL £ .

=V DH fk

WV EHI B 9 2120

1. IR 20— 58 IR L ET.
2. BIB(REMOVE)] %#2VysL 7.
3. BFE(SAVE)] 52Uy rL 7.

JL—IL D £E

IV EHR R I B

1. BEIG P (Search On)]%1. BREXNFK(For)]4l. £72id BE#7—X(Replace
With)] 51 D> bUx 2 Y950 £5.

2. TREEHELET,

3. BFE(SAVE)] %2y rL 7.
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Web Discovery #ffi Fl 3 2 &, T2 &—7 A XEBE N CH O THL 23T NTDKRA MR T
FES

- 4l &

Web Discoveryld (1§ 7€ SN 7zIP7 KL A ER— FDFEIFH N D) F R CDA—T7 VR — M7y
PEIEE L UGB N E OB R EM R LA R 28R L &3 . Web
Discovery(Z i . Web Server £SSL Web Server &£ 55 | € 5§ SN 12200 /37 v bV &
TWET, SR ADM 712 IROHTTPE K 238 g T &9,

GET/HTTP/1.0

Web Discoveryld . HTTPJG & 2 X T A THTTPI #88 K L. 2O F 4 AR, O 3
&L ZDIP7 FL AL £— 5. 8 LU TWebServer] £y 97 ¥ A baE IR L. 612201
Zy F—ANDZH EN—Y BT EHIR T 25 AR A ShIE R R R 045 R 2%
ALET.

M SNz —SDYVA M TF AN AAIWARFE CE LT,
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Web Discovery V—v DA 4—

WDA A—2E ., H4 bOMH D72 DIP 7 ML A8 P AN 1) Sh 72Web Discovery V—L %
ALTHET,

File  Edit  Scan  Enterprise Server  Help

B Start ] Pause Stop @A Settings

Search Addresses

IPY4/IPYE Addresses (or ranges) Ports {or ranges)

|1:-'2.15.10.0-1?2.15.10.29I | 80,443
Example: 192,163.0.1-192,165.0,12;172.16,10.20; 2001:0db3::1425:57ab  Example: 80-100;443

Total IP addresses specified: 30 Total ports specified: 2

Discovered End Points

Selection IPAddress Port Identification

B A O H

Web Discovery #3217 L TH A1 btk th 3 21214

1. [PVA4/IPV6 7 FL A( % 7zis %1 [ ) (IPV4/IPV6 Addresses (or ranges))] £ v7 &2, 12
LLEDIP7 FLA(&72IEIPT KL ZDF FH) 2N 1 L& d .

e WH DT FLAEX Y] 2121k, 3gav s L7,
#51:172.16.10.3;172.16.10.44;188.23.102.5

o HIHH DBHIGIP7 FL A TIPT FL AZX Y] B12ld Ky a&fzlg A7 & L
9,

f1:10.2.1.70-10.2.1.90
HIIPVE T FL AGFE IR CHl O B A H D& 3. B 218
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o O

o http://[::11D3% & -
Fortify Weblnspectid l'localhost] # 2+ v> L £ 7.

* http:/[fe80::20c:29ff:fe32:bae1]/subfolder/ D% & :
Fortify Weblnspectid . 1§ & S 727 L AD K R hD R F > %[ subfolder] 7 1L
7 b eI L ET .

* http:/[fe80::20c:29ff:fe32:bae1]:8080/subfolder/ D5 4 :

Fortify Weblnspectid . £— N080TH 1T St T 34—/ XD AF v %
I'subfolder] 2> 5B 45 L &9,

R — N & 7zi % 8 )(Ports (or ranges))] K v 7 A2, A¥ x> 2A— &N LET.
s WEBOR— X Y] 212id. £3Iaov A LET.
11 : 80;8080;443

o HIPHODBAMf R— b T A— b2X Y] 212k Ky adicld A7 & LET.
f1: 80-8080.
Web Discovery Dik & #48 ¥ 3 2121 R E (Settings)] #2707l &7 . sf 4 D0
TlE. T3 5E (Settings)" X DXA— | £F B LT &0,
B #E(Start)] # 27Uy L TR 7' o 225 4 L& 7
R0 B stfoz> PR 1 > NDiscovered EndPoints)] T V7R /R SIL & T
[P7 FLA(IP Address)] 5 DT> NU%E 7Yy s LT, 204 A (779 TRR LET.
i 5 (Identification) 15 O > pUE 7 Vv 2L T, e vy a7 037 4(Session
Properties)] 74> NV &5 & A OE R & 2R L &7,

& oA NORE AT

M SNz — D YR MR AE T 3120

1.

2.

P 71 v(File)]> 7 AR — MExport)] % 7Vv /L £7
T —RE.CSVZ7AIVICTZIAR— N B &, ZHL6DIP T NL A7 74 hDFortify
Software Security Center 77 V7 — 3> NE T, L 6D 77V r— av ERf i 7 —
K&\ Excel T4 5 T & £9. 20D1% . Fortify Weblnspect Enterprise TFortify Software
Security CenteriZ 2L 5D 77 V77— av %A R — b C& &7 . 5F 4l (C DL T | Fortify
Weblnspect Enterprise DA > 54 >N L7 %5 Jf L T {280,

BREED T 7 ANWIEIR 74> FYEMH LT 77 0OVICK T 247 O TR L &7

IHL5HTHR Faw

"5% 5 (Settings)" X DX—
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2
34

iE (Settings)

Web Discovery Y—L D% & 425 B 4 31214

N —

w

B

7.

fR 4 (Edit)]> B (Settings)] #7Vv/L &9,
P'o ba DR (Select Protocols)] 7 )v—7"C. 7’0o haw g OB O F =y /K v/ R %
Iy EE AL EE T2 7y hERIRL & T
B/ 8% (Logging)] 7/ )v—7"C. oZitit ¢ 2E R ZRN L7,
o F—7vR— % n/it#R(Log Open Ports): + X b T Y &0 748 F AT BE 22 4
TOA—7vR— 207508k LET. Web— N\ ER DA 207 771V IRAF L &
ER

o —ERA%#u/EL 8% (Log Services): 1 Hi H (i i S fzF R TCDY—LRE 7 IZED
ELET,

o Web#—/\% /50 8% (Log Web Servers): i jill St 7-WebH— &0/ (Zit #% L &
ER

7 DRC#R 56 (Log To)] & v/ A7 7/ VDG it & N )13 %0 BIKFL 'S ARV & 2
Vo7 LTIRED 7 7AWIEBIR 74> R H LT, o/ 2> MERLE T 27 71V &8 €
L£d.

B4 277 17 4(Connectivity)] 7 )V —7"T. IRD XA L7 7 NIV &k @ LE T
o &t 21 4 77 MConnection Time Out): IP 7 FL 2551 3R AR S 4 Wi & 12,

Web Discovery 7 i — hAF v #1513 2 £ TR 1 215 [ .

o %15 24 477 MSend Time Out): Avt—YikfE #UE— NPT FRA > Mizxt L
TIT HEEW IEENR I/ SRy y M E SN 4., T8 E SN N weIP=>
R A > MSE(E A7 v MERAEHR LW &, Vry M Lo, 201y FHA
Y MOMH Tl — AR Sh Et A

o 218 21 477 MReceive Time Out): VE— NPT KA > MZ Avbt—Y #1E(E T
BEXIZIEBN RGN S Ay NSO E SN 7. 1558 Sh IR [H 9 1cWeb
Discovery YV —IVNE(E A7 v b &% 5 La W& Vry M Cen., 20> PR
1> MO H TlEH— AR Y Sh FH A

V47 v MSockets)] K v/ A% H LT A—7"> V7 v bOF £ L &5, A—7> Y

Ty NDEI ML VI E. AF v>EIEICE DET . 12720, T— DL EWHE % 2 28

FRE TR R R AE T A R AD VLT,

OK] #2Vy 7L CTHE#H LIz 3R 20# 77 L. Web Discovery] 71> IR DE7,

(R AR—MNEELG D DL T AT ADZL AT TH D Y—EAB A v NT7— 214t T 5
FAY b ¥—ERIG[H] 7—F 7 7F v Tl 10D F v b7— %t 5H 12200 T R A > b3
R L. — B — AR 3 20 fh 7 Ny —e 2% + 2] &% 3. Webs—EAT
d. T PR A > MIURITHE € sh 3)
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IH5H TS JZan
"Web#f i " X —2201
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=17:Web 74— L 17 14X

X EAEDWeb 77 V7 — 242iE AN JJ 3> bo—(TF A MR v I AL KXY, RayZ Koy
VA Mg OIS FNT 74— LD VET . 2—FEBEH AN 3> ro— V2B H(T7F A M
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9. 1220 R (Edit)] x=2—»5 R E (Settings)] #E IR LT, I DIP7 FL A &K—
NEfRIE T BIENTELT,
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1. Z+—AMMEDO VA MER T 3121k Prfv(File)] x=2—»5 HiFH (New)] i L £
F(Efeld Y= A—0 Bl (New)] 74 a>% 27090 £9).

2. BEAEDYVA M 74— LMl #B N 2i2ik. P rAv(File)] »=2—»5 B {Open)] %
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4, Tr—LEERSEIEE LESEEHE .
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B714Y]. BfE]. BolaLorxr%ss

5. ZOMDR—VUBE L TT7+— L5185 LET. INE, LEBLERDHZTRTD YV

VT 2ETHIT ET,

¥ Untitled® - Web Form Editor

CBEX

File Edit View Help

Smart Credential Username
Smart Credential Password

Mark As Interactive Input

X Delete

A"
MName Type Walue Length | Smart Cred. | Match Type | Allow Hidden Submission | Form
http-//mail .alltel .net:80/servlet/Login
PASSWORD password \Whackadoao Mone Exact False loginForm
USERMAME et dthackery@alltel net MNone Exact False loginFom
jeCapable hidden 1 Maone Exact True loginForm
LOCALE hidden en_lU5_base Maone Exact Trus loginForm
WARIANT hidden consumer MNare Exact True loginFom
http-//search.windstream net -80/_1_2B3G TRCO3FVKEDC__ wind main/search/redir htm
F — Mane Exact Falze idxSearch
g Add Global Farm Input 0 Nore Exact Trus ideSeanch
r Make Global PR4FSREESF40F1230 O None Exact True idxSearch
r_| Modify Maone Exact True idxSearch
r] Nore Exact Trus ideSeanch
Unselect
Select

Browser's Proxy Address: 127.0.0,1:1147

f2eZiE. ERL D VA MDELIE D2OD LY ME IROHTML 757 AY bh&f3 126 DT

ER

<form name="loginForm" action="/servlet/Login" method="POST">

<input type="password" size="16" name='

"PASSWORD" >

<input type="text" size="16" name="USERNAME" value="">

<input type="SUBMIT" value="Submit"></form>

2 H S DL ERAT—REN I LE LT
6. BE G LT T MEA UL, 3 Ay MR 7 T v7) A =2a—%F H L TIEH

RETETCEET.

o TV INVEHE T Bk BE(Modify)] 2R L&,

o IV NIEBINY BIE. P a—rvZr—AN ] O I (Add Global Form Input)]
FIEIRLET. Jo— vy MUK K OURLICBH A S st T AL hYT

R

o TV NUEERANT B, IR (Unselect)] Zi R L&, Cnicdn, 20>
MOIEALEL X R s SRR Ah S & F. 12720 774 Bl BB S &€ Ao
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o TV IUEHIK I 21k, BEIEX(Delete)] #iE R L £7 .

o TVNEAT—MEIER ELTRE T80k, Rv— MEEBIR 2—4 (Smart
Credential Username)] &£7/:l& R~— p& & 1E ] /S 27— F(Smart Credential
Password)] #3i#4R L £ 3. sE 40 OLTiE . " Av— FE R 1H " ~—v2171 %%
HE LT IZS0,

o AF yF TORF v G —HEEIE L. 2= 12Dy NIDE DN 1 23R 9
274 RUERRT 22 REEHEAN I &L Tv—2(Mark As Interactive Input)]
FIERLET,

AF v} DAT7Y 3> Web7+—LMEH DN 7 #23K 3 (Prompt For Web Form
Values)] 23R s T 3354« A% vFH I EHTTP 74— 4 &/zidJavaScript 74— 4 %
Bl 428 AF v e EIE LT, 2= B 75— LN DN J) 2> bo—LOfE %
NN T 200740 PR RLET. L. AF v+ DAT7Y 3 RIS ENTTD
& % 3R 4 2(Only Prompt Tagged Inputs)] #3A] B (218 I S T 335 & 1 57 E
DA F1av be—uiz 58NS &L T>—2(Mark As Interactive Input)] 35 &
ENTHRWLIR D, 2F v ld 2—HF AN DD Z 1E 247 W EFEA(F2E L, /SR
7RO E G &ET. NAT— RO G AF v F I E R fF IR LT &3k
» £7).

7. P 71(File)] »=2—»5. fRFF(Save)] £/2id& BT 2} F TR FE(Save As)] #i%
RLET.

Web7+— L DfE & F 8 CIEIN 723K E ¥ 2

Web 7+— DIl 21BN &7 28 B 9 5121

1. OWTNEERITLET,
o Web7+— L DM #18 Il 4 3121k« Web Form EditordfE 2 = V7N OfF = O fif %
FH IVl v a— Ay MR o7 7 v7) A=a—ms6 Pa—s v 7x—5N 11 DE M
(Add Global Form Input)] Zi#&# L £ ¥,
e Web74—2LDME 228 8 § 2121 T bIEL 7YoL ¥ 3= by MR w77 v7) A
—a—p5 B (Modify)] 23R L 4.
E—+5E A\ ) D& jn (Add User-Defined Input)] 7 4> N7 &7218 [\ J) D25
(Modify Input)] 74> RURE IR SN £7.
2. BET(Name)] A v/ AT AN EXOLRIEME 2N J1(FREETE)L LT,
3. [ &Length)] R yZ7 Rz IRDWEFLENTILET,
o« vARJEME TR e 4 BE

o Yr(HAXEIE#EE LEOANTTER DG E).

Micro Focus Fortify Weblnspect (22.2.0) N—208/379



V=LA A R
#17:Web 74— L T7 4K

Tz 28 IROHTML 7 57 A bDTF — 2% (5 § 285 6 . ..
<INPUT TYPE="password" NAME="accessID" MAXLENGTH="6">

... B R (Name)] izaccessID#45 € LTCOL R DT> FEER L. E &(Length)]
WCHART6l 248 E T 2L EBHVET.
4. fE(Value)l A v7 Az N E R CHIEAT 27 — XA AT— e E)EN T Li@“
5. = (Match)] VA &I LT, 2O pUAERE DN F1 3> bo—)L D% 5 12l
LTWEdhEAF v 388 2% MR EABEE LET. A7 3R DEE V)m“o
o B{% (Exact)-\J] 3> buo— VDA FIEYEL. SO bNCE] 0 Ton 24T &
TR LTORLERDNET.

o IR TIf % 3(Starts with) -\ /7 2> rp— L DL BT JEPE . COx> picE 024 T
NIZRT TR £-oCOR BB ERHVET,

« & ©(Contains) -\ Jj 2> ro—VOL HIEPE . SO MIZE] Y Ton f24 i
BT ENTOILERDH VLT,

6. 7l 5=id. 774 7Y b —/ O] TR S 21E R B F EHTTPO X7 — hL A&
WHEE DIk bl TL E D) &R A7 T 572012, type= "hldden"’&f'aﬁﬁ LieANJ1ar
bo—v&HH 22805 0ET . Web Form EditoriddE R m D 2> bu—LOJE M %
UL LTRAR LETH, AF 513 BERRIE(E %7 7 (Allow Hidden Submission)]
PR SN T wé ERRDaY ho—VOE 245 LEE A

7. 1BiN(Add)] #7216 BEXE (Modify)] 22 )vsL £9.
8 MEIWIL LT MEA ZVvI L. ¥ = My NHR V77 v7) A= 2—%E ] L TB I
DM EE| VM CHIENTEET .
o TV NVERRANT Bk, BN (Unselect)] 2R L £4. Tz &0, %1/7
S INF ALY ZOZY PNEALE S R ofR A S & T 1220 T v s
Hil B S &4 A

o IV RNVETITATIZT BT %ﬁi(Select)] FIBEIRLEST., INWCED, Fryrv—
It & ZDTY PUBSLEE X R EL TR E S E .

o TV IUEHIKR T 2CiE. BEIBX(Delete)] #i# 4R L £7 .

o IVNYEAY—MEIER ELTHRE 7211k, Rv— MR B IR 2—4 (Smart
Credential Username)] #7:id R~—FMEIBR S A7— l~“(Smart Credential
Password)] #3i#4R L £ 3. sE 4l oL TiE . MM Av— ME B IH " ~—v2171 %%
HE LT IZa0,

o KEEBIN J1 £LT~v—2(Mark As Interactive Input)] #1Z R 3 &, AF vF 23R
Fyre—HFIE L. 2Oy NIDIE DN SJ #R 274> RURR IR SN ET(A
F ATy 2N RF 2 ICWeb 74— AH O 77 #E 3R 3 3(Prompt For Web
Form Values During Scan)] 8 $ O gZ7f} EN 7 D& #E K 3 3(Only Prompt
Tagged Inputs)] Ok & 237 £ 2555 ).

% WEER N J1 £LTw—2(Mark As Interactive Input)] 2 ] L TS 27— K
CRTEMNTZLBEEHVEE A
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774D A R — b

DA D /3= 2 DFortify WeblnspectH (5% 5t 8 S UME I S fe 7 74 v &4 >R — LT
I {E ODWeb Form Editor Tfff FH T& 27 7/ WA T & &7

1. PrAuFile)] A=2—n5 K> &— NImport)] ZiEHR L £,
Web 7 +— 448 D%2 # (Convert Web Form Values)] 7 4> FURFER /R S £ 7,

2. HYR—pT 3771V D (Select File To Import)] D icH 25 R K> e %7
VoL &7,

3. D77 WIEIR 71> MY EfF L T. Web Form Editor® Pl §f D /3—2 2> TfE %,
SNIXMLZ 7AWV ER L &7

4. B—4 v b7 71 )VOEIR (Select Target File)] Dt icd 2 R x> 27 Yw /L &
_g—-

5. BEDT7 7 WER 74> PO H LT BRIZE D77 VD7 713 85 #15 E
3

OK]#27Vv7L &9

o

My M AZ2—

Web Form EditorDfE 2 T U7 %545 2V 0§ 38R I8 SN BR v7 7 w7 A= 2—ms6ld LLR
Davy e T&Ed.

avwy N o B

Za—/O0 74— A B—45E & A\ JJ Di Il (Add User-Defined Input)] 71> N7 %%

ANSTDEMADD  RLET. 2—FE D74 FYTAN S 3> be— V0L R, & &,

Global Form Input) & & U'fifl £45 5& T & & AN DL T T"Web 74— L OfE 2 7
) CIENN 228 T 4 2" X—2208] #5 I L T2 a0,

Ja— e 3 BIR Lz YRR E OURLOB AT 2R L& 4. ch 247 D

(Make Global) & AF ¥ FE Oy NIOZRTE M 24 DA J) 3 be— L ER
HLice&iz, 20 ay bo—vo AT iR % B 23515 72 £ 912
ZNES.

25§ (Modify) IV MNOLRT R Sl BIO B (70BN 2 FH T &
ER

I R R Ty M ES s e F 2y R v REF AL ET . 2D MY

(Unselect) G SN &R A. ¥y NI LEZOR—V UK R L

TH. TV MIBYRA MBI SN B3I HNEL A
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=17:Web 74— 4 T7 41X

aer R i B
12 4R (Select) T MBI e e F v Ry REA LT IRIE SN B Y

AMIZFDIZY PUBE EN B LN 7.

Av— MEHIEIR 22—y NEAv— MEKIE R 22— 4 LTI LTw» 215
2—44 (Smart 4 . Web Form Editorid z—% 2N J LI ZDME 2R F LEEA. A

Credential Foofld. COTY MBS U N T BER 25 ARR—V %
Username) A% v 4 BE. [REL(Authentication)] DA 7'y av T & Sh 1z

2L (2L R E ShTuz LA . T 5
[FormFillText]) #fC AN L &9 .

Av— MEKER 2By PVERAT— MR IE IR A AT7—FEL TR E LT 28

SNA7—NSmart & . Web Form Editorid =z—# 2N /1 LIz 20D #1377 L&t A A

Credential Forld. Oy MICHEfT U N B R &H ALN—Y %

Password) A¥ vrd &, FEE (Authentication)] D47y 3> T € S 28
AT—RNUARAT— R E SN Th WG H I L TF )
[FormFillTextl) #fX A L &7

xpEE M N 77 £LT  Fortify Weblnspect®i5; & D4 : Fortify Weblnspect® A7y 3> R

~—2(Mark As * ¥>H ZWeb 71— LE D /7 #E K ¥ (Prompt For Web

Interactive Input)  Form Values During Scan)] 8 &' BZ4F EAN T DA 2ER T3
(Only Prompt Tagged Inputs)] D J5 733% & 1L T 335 512
2—HFNNHPBE LT MIELTIDIY MERXIFIFLET.
Fortify Weblnspectid CO > MBI A (F s o N FT B HK 25
AER—VERF x> F 58 2= BRIODANJMEAENT] T 24£TA
FrE—RFIE LET. SN BAHEOEE2LE T 27— LT
ERFCAER T3 2O LT L 2 A7 A(F 5 HNEE
LCWaE TZ2OF LTI SN THLET 14 EDRSE IR
T)%, CAPTCHA (J& & 23> ¥ 2—RI2 & o THE B S 22 b C 40
B BLHD—FEDF vL v OIL ARV AT RDTFA NG END V&
ER

Hl & (Delete) BN SN PR VR M SRR LET . 2Oy PSR S &
Yho IZEL. COZY AR LEX—V R ERIRT 2L 20T
> MDA MBI S £9,

Web7+—AL 77 A IVEHFH LIz A% v

T 7 FDAF v ik 5 TWeb7+—4 771V &fa € L1356« A¥ v+ idWebH A bDFF
i 2B 45 T2 X CEB R HEIRCZO 77V EIRIR L ET. 12770, ZOIEIRN N A&
TEDAF v K LTHI D7 7AW EIRIR 22T, FEETBZIENTEET.
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YERR LIEWeb 74— LfHED VA MfFEH LTHA bEAF ¥ T 2E IROFNE R W ET,

1. Fortify Weblnspect® ﬁ%(Edlt)] A=2—%27Vy 7 LT F 74V MDAF v 58 B
(Default Scan Settings)]i£ i L £ 3. F 74/ bk & (Default Settings)] 7 4> K74
b &7

2. R¥F % a% E(Scan Settings)] t 73 2T ik (Method)] ##ER L £

3. [R* x> E)fE(Scan Behavior)] 7 )V —7C¢ WebiRZ& K ODWeb7+—ALDHEBIN S
(Auto-fill Web Forms During Crawl)] #1##1 L £ ¢ .

4. DLRTWCECER L7 7V AR T 2120
a. ZHR AR 27V 7L ET,

b. HEXE D77 )VIBIR 74> FA [ LT i 4 2Web 74— 4l 25 A2 7714V
#IEF L. B {Open)] Z7VvoL &7
C. (A7Y2)ITYNVEL ZYy /L TAVTHFRA M= 2a—ho4 7y s FIEIR T 2241
FONBEMETEET,
5. Web7+— A DM 50 8% § 2121
a. ¥ LuWeb 74— A1 D1E pi (Create New Web Form Values)] tal 5 2vo2L &
ER
b. P7AMFile)] *=2—%2Yv2L. FH(New)] #ER L &7,
c. V'ov¥oi2E)(Launch Browser)] #27Vv /L &7,
EAIZOWTIE S ["Web 74— A DL " X—2206]1 2F 1R LT 2 &0,
6. IR L2771V DOWeb 74— LMl 4 5 + 21214
a. Bi7E DWeb 7+— AfE O%i £ (Edit Current Web Form Values)] 215 21,21
9.
b. FEAH IO T T"Web 74— 44 Oit " X—2206 1 %5 8 LT &0,

Qo

Web7+— AL VA RN 7Y bo—D~<yF 7

Web 77 V7r— 3> #Web#R & L TWeb 7 +— A Dff %1% {5 4 % £&. Micro Focus A ¥ v
IEWeb 74— LHD 774 NVD Ty bIES T LT B 215 E TREBEIDHE LET. S
LTOWREHE T 20000 va HEREOE OGEDLHICIR DR IR LET.

Web 7+— A D~ wF > 7 D)—)L

{1 bRy 2l ax B
R—V[lEH 7+—54 BE—B BT Web# & L7:WebX—> T i L72EE &
DfE (Name)] 52—  OWebX—Y  Web7+—24% . 8L ME D
. E 3(Length)] £ 3. ZAF v H ICER sz
M58 4 — 3 webformvalues.xmly D1OD L 2— FE5E

L THL 3,
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#17:Web 74— L T7 4K

(-1 A% it B

W —2 fail Web# % L -WebX— Tt L7-4f &

(Name)] DA —E  ODWebX—> & LUWeb 74— 4% 25, &

L. E (Length)]  #* v 1iE R Sh fzwebformvalues.xml

&7V A= FEST ND1DDLI—FEe—HLTHW3, 20D

AJ Zr—AMECEEAT s TR TV R
Rld. ED &% 74—V EAN TR ANDIEAS
O G $ B(7A)V RA— R T74—)L R —

).
Ja— ) 7r— L0 RE—I KA Webix & L7-WebX—> T ! L 72Web
fil (Name)] e 4 — 74— L% BLUMHE DR SH. AF v M1
M. [ S(Length)] IR sh 7zwebformvalues.xml © 7 o—
e 4 — B 7OWWeb 74— LB £ 7 32 H B1D0D L

a—RFE—FLTWL 3,

WA —B1 Bl WebiE &R LiWebX— T i L7-Web

(Name)] & 54— 74— %0, A¥ v ICER sz

#. [E S(Length)] webformvalues.xmly ® 7 o—/ U & 7

7V RA— &G B 75— L4 B LT

Af 2. 2D 75— LME BT F N TH 3
4= MR ED &% 74— RN T E
NOEAF ORI T (7 AV RA— R 74—
W NR— ).

Wy —;2 71— 771V H OWeb 74— L4 A5, F D o7

N2 DEED BRI 74— M S e— 8L Tw3, 20

(Name)] Ofid TH Web 74— LB I g TH 3T XTDX

n. E &(Length)] 7 #AWebX—y 74— )L N4 DI TEA ) &

54— — 3 L. WebiE & L1-WebX— TR L
74— FE A, A% v IR IR sz
webformvalues.xmly @7 o—/\)LWeb
Tr—LME LIy W HBL A RE—F L
TWh 5,

B4 —H3 71— Tr{ILN OWeb 74— L4l 23, /Db ofz
N DI TRER 43 8 74—V RE S HJe—F LT 3., 20
I AT (Name)] D Web 74— AME I8 N TH 2T RTDYL

Thn. ES T, WebX— 74— N4 DA TE S 47
(Length) ]l 7AW b &=L TW3, ZOL a—FD 74—V FE
H— NEFFA] X AT E D 74—V MR ADEAF () i 3

B(74) FH— 74— MR — ).
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=17:Web 74— 4 T7 41X

(-1 A%

Wa—B4 Bl
(Name)] OfE 3
T4V R ICE &
n. E &(Length)]
& 584 — 3

Wo—2,5 Bl
(Name)] D& A
T4V R TE
. [ &(Length)]
& 7AW RA— K&
il

— L T4 R L 584

W EHE 7 1 12 ¥ Web

T —ME E—EL
AR

750 ME & L
AT 74V ME H
FBEINTHLRWL

e

Web 74— LfE D7 7

i B

774 )V OWeb 7 +— L4 7. |/ Dby ofz
T4 R SR HIC— LT3, 20
Web 7+— LMl I8 N TH 23T XTDYL
TR, WebX—Y 74— )L M D—Ff &—
FH L. WebiEZE Liz-Web_X—y T L1z
T4 MR AF v IER SNz
webformvalues.xmly @7 o— )L Web
Tr—LMEL 7Y W HBL A RE—F L
TWh 3,

7 74 IV OWeb 7 +— LMl A3 F Dhvofz
T4V R SR RIC— B LTw3, 2O
Web 74— LB I EN T 33X TOL
T, WebX—Y 74—)L 44 O— i &—
LT3, ZOL I— RO 74—l FE I£.
BB D 74— MR ADEAS (R IS 4 3(7
AW FA—= R 74— FR— ).

Web 74— LMl ED—F 234 o 5 5E Sh
Je7 74V ME( F 74V MDefault)] ) #%i%
& &h 2.,

Web 7 +—24fH O—F ik % {\ Web 74— A
D7 7ANET 74 ME D W, TR Dps
N &+ A(not found) ] 7% 5 S 5.

TSI Z—5 y N\WebH A bER DI 0T 237775 & LN O E 2 LTIR € 3220
T&FT. NSO EIWT 78 AT 212k, EREE(Edit)]> B E (Settings)]> B

(General)] ##E R L £ 7.
iR E Wt B

7'a¥ YA+
(Proxy Listener)

Web Form Editorid . 777+ £2—% v \Web# 4 N OHTTP +>
T49 A § 27 0x ELTHERE LET . 7 74V bTUEE. B—2

WIP7 FL 2127001 HFEH T RE A R— 2 H L &4, #2720,
2—HE N Oa—MUPT7 FLRAER— IR E T AENTEET,
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#17:Web 74— L T7 4K

W RE bt B

T s T aR— bada E 3 20] BEME 20l 8 3 2120 .
R— rD B Bh &l v24 T(Automatically Assign Port)] i R L &
ES

P aHTTPRIT 13 EA EOWebR—21i2id, i ¢ 330 F £ v b7 504125 64 2

(Advanced HTTP ¥ »& N T & 3. ZOFE R I&. HTML F¥ 2 x> hOHEAD & 7

Parsing) > 3> DContent-Type)is & N\ & ( &1z HTTP-EQUIVE 1% #%F D
METARZ) &M L TiT b &9 LF 2y beT7F U AL TG
WA—Y ] 1cZWeb Form Editor ¢ | ¥ X& X F v, BE S
h 3l L= ¢ v b] => a— F(Assumed 'charset' Encoding)] VA +
THRET&EET.

—%‘)‘L . ° ~
EX Bl 7 aF Y
7'onF o H—3 %4 L TWeb Form Editoric 7 72 23 212i&. LR DR E 2 LEd. C

NAORFEWT 72 A3 2121k A (Edit)]> BRE (Settings)]> P'u¥3(Proxy)] %
RLET.

B R B

HEES(Toxy Toxey—sffiHLa0G G, COF7y a2 E R L &7
% 1) (Direct

Connection (proxy

disabled))

7'oX Uik E OHH)  WPAD (Web Proxy Autodiscovery Protocol) 7 o kv 2 F L T
5 H (Auto detect 7a¥ HBEIRE 77V ER DT 757 OWeb7 0¥ L3 E %
proxy settings) 1Tk COAT' Y v RN L ET,

Firefox7' o v i% € Firefox» o7 oF o 4— MR 24 >R — b 212k COATY 2~
#f# F 3 3(Use FIERLET.

Firefox proxy

settings)

AT LADTOFY oAy rme7ax—A\ER 2 R— N B, COF
W E M H T3 7y avEEIR L ET,

(Use System proxy

settings)

PAC77{iw%ffiH  PAC (Proxy Automatic Configuration) 7 7{ )V 267 0% 2 5% € %
LT7oFs &R E o= FF32d. COATY v &8I L LS. Wi URL]I KR v2 R
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W RE i B

9 %(Configure a T77AVDE T8 E LET.
proxy using a PAC
file)

TaF EHRMIE TeF =B H TA Y R— Ay MIT 72 AT BTG COAT
WX E 9 B(Explicitly > s> #IER L, BER SOIAFEREU T OLNAN T LETS
configure proxy)
1. B—3(Server)] £ 7Rz 7 o v 4 —XOURL £ 721£IP 7
LAEN ST L. BT R— MPort) & v/ R ich— &5 (o &
Z1& 8080)FAN J1 L &7,
2. 7 aF A —nEEH OTCP F 774y /DI E Dfz» D7'm f v
%. SOCKS4. SOCKS5. F/:dEHE D naiR L L7,
3. WAL E 2354 . EREE (Authentication)] VA b5 KA
TEIERLET.

B Bl (Automatic)

YE: B 28 E 728, A% v OB A2 < D
F9. IR LTO R0 ORFE AV vy RETRE 58 A
F o DR 74— R KB cH ELET,

# A (Basic)
£4 Y =X MDigest)

Kerberos

4T v x— MNegotiate)

NT LAN Manager (NTLM)

4. 7'aF Y —/NTRAE AW B 215G & Bk 2 —v 8 e
AT—FENTILET,

5 FFEDIP7 FLA(WH 7 A MA M OV T 72 AT B1-0127
DX Y —NEEH T 20 ERALOESIE. Pa¥kresg
NAF %44 MBypass Proxy For)] K v 7227 FL X /214
URLZA I LET. = M Av~TX Y DT,

HTTPSH O E 7" HTTPSHE 4t 2% AN 37 n¥ >4 — 105 &. HTTPSH O
n¥ ERE TS KRB 7' ¥ %3 & T 3(Specify Alternative Proxy for

(Specify Alternative  HTTPS)] Z1Z R L. E R st -5 2N 1 L&,

Proxy for HTTPS)
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V=IVAA R
%= 17: Web 74— L4 7 4 &

v i 1 3R

Web 74— LMl #5083k LT B E&IE . 22— X ATV— DN 1 53R 20/ F > 75— L4

MERSINBIENEILADNET . B D2—HH ENAT—FELE 2 H TEETH. 20D
F2E s T7AIVERTE T BRI, 22— X AT7—FD Y MET ZA~v— MK TE R 1 &L
THTETIVLERHNET ., EEDNARAT— N2 —F L IRAF SN E¢ A,

AF v FiE, COTY MBS AN ST 32 ha— L ES ARR—V 5 RAF v T 3¢,
Bl @ B AE (Authentication)] A7y av TR E SN TW BN AT7—FEAAN L ET. COAT
VIl EF VT ARV E EL AV D 2—H 4 ERXAT—RBEE SN Ed ., 22—
& E1E A AT RBRE SN THR LIS . AF v Hd X FE A TFormFillText] #1515 L £
T
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Web Fuzzery— V& § 2 &, IRICE T 2& 5% — & 20 275 ADWeb 77 )5 — 3+
F 2T AT It LTy WOMDHEE 7 A MEITTEET,

e SQLA Yz 3~

s LFHDTr—~vh

o JORYA NARZVT T AVT

o /NRA NI/ —H )L

o W AT

o Ny 77D —/N\—T710—

o 7oL DFE B B v B[ E

777 el

(7702713 HEI Y 7 727 T A MW CL 7705 —> 2D 8ES £ VT FV AL %
Frldy—r vy o 7T —REE R LTEE Ly v F 297 4D 5518 28 ez L& Hel £
To 12E2E N7 7DA—N—To0— 4R T E . TAMIYF L IESE LA ADT —X
EER L. 2N 27705 —y av Ty MIEAY MO1DIIEE LT 77 Ur—y O E )5
EEHEHTEET.

Web Fuzzer~® 7 7+t A

Web Fuzzer—ViZ7 72 A4 3IE. IROWTNhEEITLET.

 Fortify Weblnspect”—iv/Y\—T. P/—i(Tools)]> Web Fuzzer] #7Vv/L £7 .

e ¥ 2UTaY—VE v EHH LT, B (Start)]> Fortify]> Web Fuzzer] #2Vv7L
¥9,

Fuzzer X=a2—12DOWC

D RNEYITIE. Web Fuzzer A= 2a—N"—D S &4 47 DWW BH L £7,

P 71 V(File)] A=z2—

WOFIE. Pr1V(File)] A=a—A7> 2D 8] T,
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A7y av 2% BH

A H—b PLAT AR AF LIzt v s> % fe vy a>/(Sessions)] = U721 > A— L
(Import) £9.

ITJRAKR— | fe v> a>(Sessions)] V7D vy 2 EF 7 7AW T I AR — ML E T,
(Export)

vy avDrY  kyrarba—YRALEIVTLET.

7(Clear

Sessions)

#& 7 (Exit) T7Vr—y v EH L&Y,

I 4 (Edit)] A= 2—
WOFEE. FEED)] A=2—A7> 2 OH I TF.
F7y 3> % BH
Y—3(Server) X—7 v M —/3%fEE L. WAERRE #IEIR TEE T

7% 5E (Settings) — MRk E . ToF K E . Vv NRE . BLUT O FVER E £15 E
T&E7,

[z v 2>(Session)] A=z2—
R DF L. v 2/(Session)] A=2—A47"> av OB T3,

ATy av i B

A¥H—b PLRT DR AF LTzt v 23 EN TO XML 7/ L&A Y A— L &
(Import) K

TJRAKR— b oy 2 EXMLZ 7AW T 7 AR — L E T

(Export)

fER(Create)  Session Editor# [ &, R #E ik 3 27-0 OffiE b s 77 o—F
AL E T

A OfER(Raw Raw Editor#ff &, fE#EZR 245 & 7
Create)

# £8 (Edit) vy OB (A ] T & £4. Session Editor 25 & 7.
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F7Y 3> % B

£ omERaw b vy 2 DIRRIZ EH T& £9 . Raw Editor 25 & £ ¢,
Edit)

P v X(Filters)] A=a2—
KOERIE. PovAFilters)] A=2—47"> > Dl B T3

A7y av % BH
%%(Edit) P1v X(Filters)] X4 707 %5 &, fa € LI & D& 2R 3 31E
BRI EER TEET,
B3k vy TV REE LT,
(Enable)
Web Fuzzer®Dfg H
R DF L. Web Fuzzer®fifi b5 #2585 LT 25,
RART—Y
1. P ER AR T LET BEACOLTR " — D E" R DR— | %
ZH LT 0,
2. HEEIT WET A OWLTIE . ["Fuzzeri¥ 2" ~—22301 %45 LK
1780,
3. KOO TNHEFEITLET,

o Ly EEMLET,
o UHTWCIRAE LIz vy av AV R— L (R E LG E)mMELET.

FEAN Iz DV TS T"Session Editordf# 1" Ik @ X—2 | -4 "Raw Editor
D" ~—v226] #Z I L TH S,

4 B #6 (Start)] 2 Vv oL £ 4.

fz v 2/(Sessions)] TV VNIl & oTHE AL ST 1285 £ v 3(FE K
LBV BRI ET,

5. 4R ETER 4320, Ry 3/(Sessions)] YA MDY NE 7Yy L
ER
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AF—Y

AR LIzt vy s OHTTPE R 28 BER (Request)] T V7 ICK IR S &7
=N E L. P97y e2—(Browser View)] 27 B O % (Raw
Response)] £7 O] J7 (2R 7/~ St 5.

6. FESE LR 24 4E 2121k e vy 3/(Sessions)] VA hCr vy 3%
EIR L. Ryy a/(Session)] A=2—%7Vy7LT. #E(Edit)] £/-1&

H 4L (Raw Edit) ] DB 60 51K L £,
FEAH DL TIE . T"Session Editordf# 1" T 1 &7z T"Raw Editord{# "
N—v2261#Z LT S0,
P/ NDEK E

pr—/ D% 52 (Server Configuration)] X1 72/ #{f i L T. &—% v M\Web+ 1 t %3 7
L. IBAERRE #IT LW E T

H—/\BRIE #AT Ol

1. & (Edit)] #27Vy20L. fr—/3(Server)] ZIER L £ .
fr—/ 5% 52 (Server Configuration)] &4 7o/ 76 & £ 4.

v A 12 /IP (Host Name/IP)] £ v 2 212, Web# A rD5E 215 6 B 44 >4 (FQDN) &
FEIP7 RLAEN T LET S

3. f— NPort)] £ vs Rz, — D F— IS AN LET.
4. +—s HSecure Sockets Layer7' o b L&l LT 3354 & BSL] Fzv/R v/ R
EAACLET,

5. BAE BV E IG5 H & BAT(Type)] VA s XY vy REIEIN L. %Y § 2R v/ AW
2—HYZ ERAT—REANTJLET,
OKlz27Uy7L &9,

N

o

Session Editor®/# F

Session Editor &1# i} L T, HTTPEE 3K #/E i L7z 0. HTTPE R OfF g D 7y av 48 1
L7zOLET. 7F AR Y2 RIZTF A MDA &2 085 OfF 3 217 >CT. HTTPE & LB &)
ZBIENTEET . FLE VAL —REFHAN LT ER SN T — RS ALER OE R %
e c&£7.
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v vy 2 DVE Rk
oy av EER T 312

+ [k vy 3x/(Session)]> {E Rk (Create)] ZiE R L £
Session Editor23 b & & 9. "t v 2O E" N ICEA £7,

S A EVAD) T
Yy v EHE T 52
1. R v 3/(Sessions)] VA T, € vy av5iER L 7.

2. R v 3/(Session)]> f&E(Edit)] ZiZR L .
Session Editor3f & &4 . "t v 2D E" FlciEA 9,

t vy a3 DER E
Session Editor Tt v s> &5 8 T 31214
1. Z7%70y 7L 9.
2. H RTOFHANOWTIE RO 7y 3w &5 M L TS0,
e " [¥V v (Method)] £7" K DX—
o " P3A(Path)] &7 K DR—Y
o " T Y(Query)] Z7" K DX—Y
o " P3— 3/(Version)] &7 X\—224
o " INvX(Headers)] &7" ~\—224
« " P v*—(Cookies)] 47" X—225
e " POST7 —X(Post Data)] £7" ~\—225
3. KON H»EFEITLET.
o THEFAMIVIAIRIN SN BT —REHE L FT,

o P xAL—R%EEH ¥ 3(Use Generator)] 7 v/ v/ AEIER L. PzrLr—K] %
UL Ty YadL—XEH AN LET. sl 2D TEL T"Fuzzery =4 L — &2 D

T"N—v2271%5 B L TS0,
4. O YVTELE T 212 MOKXTE Y9I EF .

5. BET2IU74RELILET. DKl 22Uy oL &4,
6. Web Fuzzer] V4> FVIZJR ofz 6. B#G(Start)] 227V oL &9,
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[¥ v N(Method)] &7

F 74 FCGET AV yRDMEE SN THET MHERZ DT FAME &R 2 200, A/ yRY =2
L—REfENT&ET,

P Z(Path)] %7
NACHE 4 2R D3ODDEE 5770/ &7,
o 771 IVD% i

o 7ANILIRT
o TALZMILNVEIRE T 330 F (B H & AT vy af)

NEDERXRLZERBRDTFAMEBE &R 220, VAL —REffANTELT,

P —Y(Query)] &7

—HOHTTPE R 121d 2 VXL FH 35 & 3. &% /35 4—&i% . parameter=value &> 9
R T 7o Y NR)TX Y DET. UY—Rik X ) 05t 5 307 (B LR 75 T
DN T7Vr—y 2T O F 2 T& &) E-oT o Un o il St 3. il 2
i

http://www.website.com/category.cfm?model ID=0&category ID=12

ST VST A AR T B

BmAdd)] 270y £9,
name=valueB YA MR RN SN ET. INEVER T 272U FH 2R L FET,
2. BEEi(Name)] 27 %2VyoL £,

Mname] £V IH AT DTG A—REMRE T 2. DNy AL —R&H ] T&ET( P
A L—x%# F 3 3(Use Generator)] 7 =y /H v A& IR LT, PzrL—%K
(Generator)] =7Vl £79).

3. fE(Value)l x7%27Vv/L &9,

B Dlvaluel 8 E T 20 b CY AL —R&ffH C&Ed( P orL—R%&E
H 3 3(Use Generator)] 7 =v 7K v/ 2%EIR LT, P =2 L—X(Generator)] 7 v
sLET).

4. P/SL—ZX(Separator)] x7 %27V L &Y.
2o 0 &0 B4 230 F (B HE EFE S T)EMmME 720, DNy 24 L—R&{f
HT&&d( PAL—K%MH 3 3(Use Generator)] 7 =/ v/ 2R LT, P=x
# L—ZX(Generator)] = 7Vv 7L £9).

5. PA—<vyMFormat)] X7 %/7VUy/L £7,
HAEROERR SN 248 LIz, R OB F AN LI0T 30T E
9.

—
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6. BEHET LE D+ /SL—Z(Name Value Separator)] = V7 C. /35 A— X%y B 4 230 T
(B T\ R ERE T 20 ROy AL —XE2 [ H T&FF( P AL —K%
fE Fl 3 3(Use Generator)] 7 v/ v/ A %1€ R LT P =k L—X(Generator)] %=~
V7L 7).

7. DR A—=REBIN T 512, BIMALD)] 227Uy 7 LT A7 v72-6 %4 ViR L7,

PX— ax/(Version)] &7

W= L BOR DR AE ] ¢ 2HTTPA—Y 3o 24— NR LES. A 3 a3—Y av
£.0.9.1.0. BE1ATT . A= a1E R IETHTTP/version] D K iHE L & 4. 2
Es ATvy 2(1)TXY) s 124 5 S DX 7T . §'ubau(Protocol)]. fe/iL—x%
(Separator)] . B £V p3— 3/(Version)] P3O0t /3 2§ X T 770>/ C& &9 . JE
JP AL L), MR AL FEMALLOLT B ET779 7 TEET.

P\ vX(Headers)] &7
NI =N & 77V — av B R 2ALEE 5 2D14% 5. D 7947 > M2 & oT
FAT SNIEEARBE M AT anTo &9, — K &\ vXid . HostéUser-Agent T3, % v
Kt Tname: value | L 2 LTE R SN £7. COLFT L OREE 5. 77027 D4
DD E| T8 TEET,

Ny R 3 B

Bin(Add)] 2 2VvoL £7
name:valueZN YA MIER /R SN &F . NIEER T 23N vXeR L &7,
Bl (Name)] 27 % 7 Uy L &7,
[name] WG BT DT A—REGRE T2 KDY AL —RE[FH T&E9( P=
A L—2%fF B 3 3(Use Generator)] 7 =y /4 v/ 2 4i& R LT, P zhL—2&
(Generator)] 7y 7L £7).
3. fE(Value)] 27 %7 UvrL &7,
Mvaluel 7 A MEHREE 230 DNV AL —REHH TE& &3 ( P oA L —R%EfE
H 9 3(Use Generator)] 7 =v 7K v/ 2%#EIR L. P =2 L—Z&(Generator)] 7 v
L ET).
4. P/Sv—ZX(Separator)] x7 =7Vl E7 .
E»SZ R 20 BT 2L FEE X 30 EHE T2 Kby =oAL —X&{H T
EF¥( PAL—K%&EH ¥+ 3(Use Generator)] 7 =y /R v/ AFIER LT, Pz
L—&(Generator)] # 7V L £79).
5. Pr—~vyMFormat)] X7 % 7Uy/L £7,
NYRBERNR RN SN BEF 28 LIz, BROM ICLF &2 AN LIZ0T 32ENTE
£9,
6. IZHT LE Dt/3L—%(Name Value Separator)] =V 7 T. N\ vX %% B 3 230 7 %4
20 by sh L —2&ifl C&&9( PoaL—2%MH 7 3(Use

—

N
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Generator)] 7 =v /K v/ 2A#iE IR L T P =k L—&(Generator)] # 7V 7L 7).
7. MONyXEFEBEMN T 2. BIMAD)] 22Vy2L T AT v72-6%48 R L &7

P v+ —(Cookies)] &7

IyF—ld, 2= LIRTE %Eﬂ?‘%ﬁ’&bk77 Nr—y AL ST S /87 4A— X%
RN L NVETT o 79F—ERDEAEKRDEBNTT .

Cookie: name=value;name=value
B RSGA=RE RN T 70 27 TEBLH LH DT T,
Iox—EERN T 212l

1. P v*—(Cookie)] VA +T. {BMN(Add)] 7Yyl &7
P v¥ —(Cookie)] VA hMZCookie: R /N SN &T o CNIEIER T2 79vF—2K L ET
U v¥%—0D3E 4l (Cookie Detail)] VA t¢. BM(Add)]1 227 Vy/L £9,
name=value?® P v¥—®D&¥ 4 (Cookie Detail)] YA MIK R S &7

3. P y¥—DF 4l (Cookie Detail)] VA D45 il icd 3 P y+—4 (Cookie Name)] x7'%
VAP VAVE &2

CHTERAE T 2 MDY kL —REM l T ¥ ( P L—&&fEH ¥ 3(Use
Generator)] 7 =y /R v/ AFIER LT, P =xL—XK(Generator)] 47 Vy/L £7).

4. & (Value)l x7'%27VvrL &7,

Mvaluel 7 A MEHREE 230 DNV AL —REHH TE& &3 ( P oA L —R%EfE
H 9 3(Use Generator)] 7 =v 7K v/ 2%#EIR L. P =2 L—ZX(Generator)] 7 v
sLET).

5. R/Sv—ZX(Separator)] X7 %7V L £9
E»2 0 #0732 FEE EE ST T)EME T2 by o4 L —K%E(f
tc&zd( P L—2%MH +3(Use Generator)] 7 v/ Hh v/ AR RN LT, P
A L—A&(Generator)] #7 V7L £79).

6. Pr—~vyMFormat)] X7 %7Uy/L %7,
NYRBERNDR RN SN BEF 28 LIz BROM L F &2 AN LIZ0T 32ENTE
9.

7. I&HT LE D€ /3L—%(Name Value Separator)] = V7 T. N\ vX %5 B 9 230 7 %4
20 by sh L —2&ifl C&&9( PoaL—2%MH 7 3(Use
Generator)] 7 v 7 v/ 2A#iE IR L T P = L—ZX(Generator)] 27V v/ L 7).

8. HDIyF—%BIMT G AT v/ 1T R LET .

N

POST7—X(Post Data)] &7

21 )iz Request-URNZIE I T & 2Dwxf L. POSTF —&id E 3k O 18 Wi & £7,
R IGURIZZ DL TE 0. 1F A EDI & POST AV v NCfE ] &0 ¥ 3. POSTF —%%
23546 B3R ik POST7 — XD+ 1 X %7~ 3 Content-Length~\ X 723& £ Tu»
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2E DD NET . POSTF —X#21J T/ < Content-Lengthfd £ 77> > 7 LT, r—3N &7zld
T7Vr—y aPNED & UAHIE LI 207 A M CE&ET,

HTTPE R Ao —V (770273 286 77 05—y aVIREE D200 4 J& (—7'1 b
DVDELE EWeb 77 Vr—y W E LY.

POST7 —&&1E i 3 31214

BinAdd)] #7207
name=valueZS YA MIR N SN 9. CNIETEKR 7 2POSTT —X%%k L &7,

B Hi(Name)] 272 7 Uy L &,
[name] EW LRI D AT A—REHE T 2. Kby AL — k&G H TEE9( P=x
AL—2&%fF B ¥ 3(Use Generator)] 7 =y v/ ZA%i& R LT, P xhL—&
(Generator)] 7yl &7).
3. [E(Value)] X757y oL £5.

Mvaluel] 7 A MESRE T 20 OV 22 L —R5MI ] C&£9( P xhL—&%#
H 7 3(Use Generator)] 7 =v 7K v/ 2%#EIR L. P =2 L—Z&(Generator)] 7 v
oL £T).

4. p/SvL—ZX(Separator)] x7 =7Vl £7 .
ENSZE Z0BE T 2L (B & a0 )E8mE T2 by 232 L —x&{f ¢
EF9( PAL—R%EEH +3(Use Generator)] 7 =y /R v/ AFIER LT, Pz
L—AX(Generator)] = 7Yy /7L £7).

5. Pr—~vyMFormat)] X7 %27Vy/L £7.

NYRBERDBRIN SN BIET 4 E L) RO L F 2N LIE0T e TE
9,

6. PET LE D+t /SL—%(Name Value Separator)] =7 T. N\ v& %5 B ¢ 230 F %4
20 by 2L —x&ffl C&&9( Porr—2%MH 7 3(Use
Generator)] 7 =78 v/ A#IEIR LT P =2 L —X(Generator)] 27V 7L £7).

7. B OPOSTF —&E &K #B N 4 212k BM(AAD)] 22 Vy7 LT AT v72-6&4% ViR
L£d.

—

N

Raw Editor D1 H

Raw Editor 18 | L ¢, HTTPEL kK Ave—Y 2/E L £

ZROOT N O 2L E T 210 Y—LD7 * A Ml e £ 1 4 20, ¥ 21
L—RERALET .

VAL —REFHN T B
1. KOLFRAEET LET.
o BRHNDIERZDGATCA—YIVERF LELT.
o BIRDIERE O 2R N L ET
2. H7Uy/LT, v by A=a—ms P il —X(Generator)] € R L £ 3.

Micro Focus Fortify Weblnspect (22.2.0) N—3226/379



V=L HA RN
= 18: Web Fuzzer

P =4 L —&(Generators)] X4 707 6] & £ 7,

3. P zkL—&Generators)| X170/ T, ¥ xx L—&%i%E L. & E(Configure)] #
VD VAVE & I
W~7'> 22(Options)] X4 7 a7 36 & £ 7,
4. R7v 3/(Options)] XA 70/ C. & EHRENTI L. OK]Z22VvrL &7,
5. PxzxL—Z&(Generators)] 1 7r7T. DKl %Z27VysL &7,
6. TER Licy s L—&i& . #—Y WAL B (E720d A7 971 T TR LIAE = OEf /7 12

BERAOMAN SN ET,

R OBIAE £7203 ¥ 23 L— RO A\ (7213 2O J7 ) 54T o1 T OK] £ 2Vv 2L,
Web Fuzzer] 74> PR V& d . k1. BME(Stat)] 2 27Vv oL &4

Fuzzery =4 L —&XIZDOWT

AL —REMFH T RE TV I T A vy s OIE AR L B ET . IRDFE I
Web FuzzerCffi FH T& 23 24 L—RIZOWLWTER LTWL 9,

YR L—& B

ASCI HR a2, 155 L8 P OASCISC 7 2108 A L &9,
PRGN F e T LT BEU— B O F 2L —7 ¢ 3R B 2 E L
7,

pas PEE LT E R L S ER 2O F M EN L&Y,
BNSC TR ER KT BEUBE Y R E LE TS

/N T8 LI#T P ) /N 2% R N L &7

B /M (Minimum)] & &KX (Maximum)] O%(. B4 (Increment)] .
BLIUO—H O AN —7F 2RI R E L&Y,

GUID £ 55k 12 & 4 % Globally Unique Identifier (128 & v D% il ) %4
ANL&ET,

TROH #rE LET.
HTTP XYyl %V yNGET. POST. PUT% &) # B R iHfi AN L &9,

7’8 b D A=Y 22409, 1.0, 1.1, LB IR 2R E L LT
HE R LB A OB 2% BRI L &S,

B /M (Minimum)] & &KX (Maximum)] O%(. B4 (Increment)] .
BLIUO—H O 2V —7F 2RI R E L&Y
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YR L—X& B
SQLA> Y x/ IBELLETFANZALLELFEH EHFANLET. EROH L. 774

¥ av W DB TEB I E>TIR E0FF . BEIK N Dcharacters 3 XTHHE A
SN Ed.
7 74V bD 7 74 )L(sqlinjections. . txt)iZid IR D2 DD T MURE &
nEd,
'"'or 1=1
"or like '%

T¥Ab BELLETEFAMNAIDODER IFHEANLET,

WordList)—% $8E LIrT7FANTZ AN EH AN LET. BER O I, 774
IWHN DB TERICE>TIR E0NET. BIE N DT X TOXLF N Sh

9.
XSSA>Y s JHELETFANZANDLSLFH TN L&T. R OH L. 774
vav VN DBUE B & oTIR E0ET . Vg N DT X TOILF A3 A Sh
9.
7 74 bD 7 71 )V(xssinjections. txt) i IRD T PUBE Fh &
ER

<script>alert('test')</script>

7 4V ZADEEAE

TOVRE LHI . BEUL— TR SN FT. T— g, Y — B D E Dt
IV TRERTBTHFAMNER TBEMRMEH T, 2l uE AL lerror] &5

HEE NS ENTHT, OB E D AT—KA 32— FELT500-599 15 E S T 254 120
ERIRNTBEIROL—IVEFH LT,

[STATUSCODE ]5\d\d AND [BODY]\serror\s
RORFLIEEEH LG IGEDE 7y av 2B E L LT,
[HEADERS ]

[STATUSLINE]

[ STATUSCODE ]

[STATUSDESCRIPTION]

[ALL]

[ SETCOOKIES]

[BODY]
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POV A(Filters)] X4 7 a7 D7 7€ A

P oV X(Filters)] K4 707127 72 A9 51214

« PovA(Filters)]> §i4E(Edit)] 212 L 4.
P 1L &(Filters)] K4 7027 7\ & £4.

7 )V ZOVE 1%
TV REVE R 5121

1. PavA(Filters)] X4 7u7 <. BI(Add)] %227V vy7L £9,

v—uiZ & 5Tl Default Rule] &4 5% B DL—)L HME [ S £ 37
2. B Er(Name)]. §%8H (Description)]. 8 &8 p—(Rule)] 2 H L £ 4.
3. A Apply)l £27Vy/LT. 74V &&RIELET.

7 0L XD

TV REGREE T B

1. PavAFilters)] 4 7ur/ . PavA(Filters)] YA a7 0L &R L &4 .
2. B Ei(Name)]. #i8H (Description)]. £7zi& Jv—iv(Rule)] 255 L £ 7,
3. WHApplY)1 #7Vys LT ZBHEERFLET.

7 4L ZDfF H
vy T T7OVRENH § 2121d:

1. PavA(Filters)] X4 7u2/ T, PavA(Filters)] UA b6 7 0L REIER L L9,
2. EBE#ik(Enable)] 7 =y /R v/ AFIER L L7,

BE! BFEOL—IVEEITEIEDIEMNI. — B 2 L—L O H ¢ G 3T 3
DERDVES. Z0H1d. PovA(Filter)]> ¥ %4k (Enable)] iR L £4 .

7 4L ZDH [
74V REH| B 121

1. P1avAFilters)] X1 7u2/ T, PavA(Filters)] VA bMpos7 oL Z&1E IR L 7.
2. HiBk(Delete)] #2VvoL 4.
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Fuzzer:k &

% 7€ (Settings)] &1 7 u2 TWeb Fuzzers% € 1T ICENTEE T .
Web Fuzzeri% & #17 JiZid:
1. fE(Edit)] #27VvoL. B E(Settings)] ZiE R L £ 7,
% 7€ (Settings) 1 &1 707 35 & &9,
2. WOWTNhEFEITLET.
o T NT— K E #AT NZid L K OXA>T M (General)] ZIEIR L 5. f#

AT BE %k €

OFFICOB T T B E" T 1EZ R LTI S0,

o 70X VEEE BT OIE L DRA VT FaF v (Proxy)] RN L4, 18 H A AE
BRGE ORFAN DWW, T o i e D=2 1 2B IR L TS0,

3. #& T Lizs,

— MR E

OKlz7Uv7L &9,

WOFE, — R ECOOTHIA LT ET.

B R

7V ROE Fik
(Enable Filters)

HE8j A 70— Ea—

(Auto Scroll View)

Y=y MERR
(Show ToolTips)

B K V7 v M (Max
Sockets)

A LT T NP
(Timeout/Seconds)
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2—H A > X7 2—A(UI)DF € DB R ICY VAR Y RESG b
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HT 27y DR K &IBE LET.
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W RE i B

Content-Length®58  Web Fuzzeris . % % (25 UTE =k DContent-Length D1 % H
#l (Enforce Content- EHJ Wil L& ¥ . COATY avH %2 ¥ % & Content-

Length) Length\v&X% 770> 7 TC&FH Ao
Host\ »X' D3 F Web Fuzzerid . 3 XTODE K (CHost\ vX & 8 &3 . ZORE
(Enforce Host e 2 %N T 28 HostN &k E 770 v 7 C&ER A
Header)
7'a¥ ik E
WOFIE. 70X BB OOTHI LTHET,
iR B B
HEEGO e 7ofey—#HifLawGaE. o477y av &R LET.
. %))
(Direct
Connection
(proxy
disabled))
ZoX R ED  WPAD (Web Proxy Autodiscovery) 7o b v il LT7 ¥ v H &)
H By RE T AVER Ly 757 OWeb7 o ¥ ViR E #1T VW ET .
(Auto detect

proxy settings)

YATADZ R vy sy ad s — MR VR L ET,
* VR E &ff

Fi ¥ 3(Use

System Proxy

Settings)

Firefox7’ 0¥ Firefoxh 67 nd v H— ME#H 21 > R— LT
REEEH T

%(Use Firefox

proxy settings)

PACZ 71/ v % URL] & vZ7 A T#5 % L7125 fr 12 & 2PAC (Proxy Automatic
R LT7’'v+ Configuration) 7 7{ W67 0% ik € #o— L &7,
VERET D

(Configure a

proxy using a
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X SE B
PAC file)

77Xy ERR  ERINIBHREANN T EILEoC ToFvERE LET. [T
MR TE FoOmE" FIES LTRSS,

(Explicitly

configure

proxy)

HTTPSH Off HTTPSE: & % UAN 27 0 v H— RO & . CO47'y 2 %1%
Brokveft RL ERSNBWRAENN L7 oF v & ELET. "I 0s 0
& T 3(Specify " F1EB LTS,

Alternative
Proxy for
HTTPS)
7% > DK E

70FVERE T B

1. Br—/3(Servern)] £ v7 A7 mF v —/3XDURL&/2IXIP7 FL AZANJ) L. &> T
( BB—MPort)] A v7 AiZ) R — M 5 (80804 £) AN JJ LT .

2. BAZ(Type)] VA b6, 7ok o 4r— & H OTCP M5 74y 2403 3 270 bajv
(SOCKS4. SOCKS5. &7zl 1 # ) I8 40 L £ 4.

3. WAL E 2354 &, FBEE(Authentication)] YA b s XA 7 HIEI L £,
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FE: HEME 2B E 728 AF v  OUE 268 2 0F 3. 89R LT 357 O
SE AV yREE T B AF v DA Tr—v R K WCH ELET,

# 7 (Basic)

A4 A MDigest)

Kerberos

% Iv x— MNegotiate)

NT LAN Manager (NTLM)

4, 7ox Y —NTRAE PV E LG G E W 22— 8 ESAT—FEN I LET.
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TO% . CORLEREHH LTAF v 24 3 2 & 2. Fortify A% v F IR /R T& & T, 7—
ry7a—~rnld, al AV A7 y7 (W B G L) &4 b L OFF € OURLOFL % T .

T 2% vr ] &0 O EE & LIE LIET Fortify Weblnspect 8 & UFortify Weblnspect
Enterprise ] DX b Dz H & & 315 3k 25M) 77 O i 1234 Tl £ 25 A ).

IE7 7 /v

7 74 b T £ vy 2 X—ZDWeb Macro Recorderid . Internet Explorer7 27+ 7 7./
P(ET2/uy PR L) e H L Cerngrtix 8 LUH A L LT

/A >v~orn

o/ A4 >~rold. Weby A FE/2idWeb 77V r—y X7 72 AL TRy A > 2l B
BT ITACTADRLER TT o WH L 22— ERNAT—RFEAN T L. [a7 A ]%0[0l 4 %
EDRR &IV ILET AX vV &€ 256 lE E. LT sk Licn/ /v~ 7o
FIRE T 20, $REAF > CEH T2 A T LurZfr~rn%itiE LT,
T7Vr—y avipsnl 7 LI B AR v R TR T T8N e, vl v
szl vl 77 S Lic CEEIITE R T as 7o MR D 4 81 DFR E T B
BIHVET AF oI AF v E SESELBH TR/ 7N 2G5 08H0FT. IR
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o X=X yhHA MIEoTH S SN B H Ol 77k
o BALT TN EDR—47 A D TF—IRFE
o WEN e NFTA—REED~V/OE kD TS—
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/A y~raD— el Tal/ 77 M EIBE T2 AF v T Lawal 77 b5
FELGEC. 2T ELFH Co/ AV LHIMENE L NET AF vF k. &
A NEAF v T BE I, Z—7 v b A FNOZIGE 20T LTIREZ2H M LET. AF v
. gl 77 LA LG &l nwDOTe. n/fr~rueEfTLTu/(>LE L. a2/ 7
7N L S sy A FOWebIR R /3B E2H B LET.

n/ A v ruEitit T A B D AT v EL Ty £ vy 3 R—ADLogin Macro Recorder(d
EELT A LCTTHBIR o 77 MG 2 L. 2hvzn/ (>~ omidg e L
SO A ET. FEAEDE . FEITul/ 7o MM 2 E T2 EEHNEEA. 1217
L. ol 7o b 2B ElcdmETEEFT.

J—r70—~</7n0

v—s7n—<sald, ul A VAT v (L BIE L) & A P ECTFE TR EN T 25 E D

URL®DEL $% T 9 . Fortify Weblnspect & 7zi& Fortify Weblnspect Enterpriseld . 7—27 70—

v /OZRLER SNLTURLD A B L B A ik il St e A "= Ur 225 L E ¥ A

SO D~snlt. 7705 —y O E O 7 7y AE B 24 Ta-00h & & 4

SN ET. vIOREE T O RO H Tld. 0l A >~ 2o DR AN A2 IZIRDEB T

E

o T—y7O—~x/llld. LB IR E) LI € ODURLDA NS g &d. 77—
7o—v ol BAEKCZEN sOURLICDA 7 72 AL 7.

o U—yTa—~xraTEnl 7 NMEM DI A TIE L WD T, £ vy 3 X—ZADWorkflow
Macro Recorder® 22— 4 > X7 =— ATl V—/r7u—~/u%itit ¢ 3 e/ 77 b
M BERE DBR AN S £

YE: Weby A NCREEEPVE LGS E. al AV ATy 7 57— 70—~ /70llit i L
WTLLESH A b, flonZ A r~ro%it st L TWeby A Mool A > LTS,

vy 3 X—ADWeb Macro Recorder~D 7 7+
A

DL N O TlE. £ vy 3 X—Z2ADWeb Macro Recorder it &) ¢ 2 3 £ X £ 4 )5 1 12D
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o/ A>~rn

Fortify Weblnspect & 7-(& Fortify Weblnspect Enterprise Tid+ £ vy 2> X—Z2DH Lo/
Av~rasilit 528t LMK AL vy R—ADWAF Dl (v~ /uEi# R (B
SUATY > CHRE)T BIELTELT . IRD & ANAT L ET

* Internet Explorerz L > X V> T2 ELTHA M EAF w2 2K E T 25 65 1d. &—
TybrA hcalfv~ranhEThbIlER E L. fER(Create)] #27 V2L TH L
WOZ A~ AR T B BEEO RS A v~ ERIR (B LUAT Y 2 CHAE) L £
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EE

« Internet Explorer# L > X))/ x> L Tf B L C. Fortify Weblnspect D& A& 2+ +

>~ ¥ 1z13 Fortify Weblnspect Enterprise DWeb+ A F A% x> ik € § 235 & A7 v727T
fr4 B EE (Site Authentication)] ZIZ R L T Lo/ A >~ 7o %it #t ¢ %5 BEAF D
DA v s ERR (B L UAT Y 2 CHAE) LT,

» Fortify Weblnspect—/3—T. P/—iv(Tools)]> [ogin Macro Recorder]> v 3
> RX—ZA(Session-based)] # 7 V27 L T. Login Macro Recorderz A &> N7 a>E—NT
EITL Lol fr~razilst 320 A0/ (v~ ra%f &&9(B8 L0047
v arCTHELET),
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Login Macro Recorder]> R v a>X—X(Session-based)] = 7YV »7L C. Login
Macro Recorders A &> N7 0> E—RTH & #r Lo/ v~roait it ¢ 25, BEAFOD
/A~ ruE K ET(BLUAT Y 2 THELES).
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(€ v =>)(Login Macro Recorder (Session))] % 2~ v~ L T. Login Macro Recorder %
AR K7y E—RTEAT L. Lol fr~rn%&itif 50, BfF O/ (>~ ro%
B3 T(BLU0ATY 2 THE L 2T,

o Windows T 727’ 0—57T. t v 3> X—AMDLogin Macro Recorder #{# Ji] L Tit #% St
PEEfFDOasAy~railB8) L. K770y LTH &3 . £ vy 3 X—Z0DLogin
Macro Recorderm» 2 &> K7 o> E— R TH & &7

J—/770—~</7n0

Fortify Weblnspect & 714 Fortify Weblnspect Enterprise Tld « #f L 7—27 70—~/ n%id
BT ALLELENF AL OV—r7a—< /iR IR (B LAY s CHRE)T B2
EVTEETRDENAT W E T,

o InternetExplorerzL > XV /7 1o ELTHA M EAF v 28R E 7258513, R
¥ x> &4{7(Scan Type)] # P—277o—(Workflows)] icifE L. 20% . P—2770—
(Workflows)]> 1. 7—277u0—Z7 v OE M Hr LLy—r7n—~/700it k. Zfzid
M D7—r7n0—~ 7004 R— ML ATy av THi B 21T W T,

* Internet Explorer# L > &)/ x> &L Tff ] L CFortify Weblnspect D3t A& 2% >
ERE T BG A AT v71T P—2 70— E &l 2+ v>/(Workflow-Driven Scan)] %
EIR L. L8 (Record)] 721 ¥ (Manage)] #27Vy/L T Lwy—2r7n—< /0%
ALER T 2 BEF DU —r7o—~ /0B IR(BLIAT7Y 2 THRE)L LT,

» Fortify Weblnspect—v/3—T. P/—iv(Tools)]> Workflow Macro Recorder]> fz v
¥ avRX—X(Session-based)] # 7 V7L T. Workflow Macro Recorderz A %> N7 >
E-FCEAT L. FT L y—r7n—~vrusilik 3 50 MFEDOV—/7o—~v o4l & &
T(BLOATY 2 TCHRELET).

« Fortify Weblnspect Enterprise D& # 2> —)L D V—3\—T, P—i(Tools)]>

Workflow Macro Recorder]> [z v 2> X—X(Session-based)] # 7 Vv 7L C.
Workflow Macro Recorder# 2 &> 7> E— NCH &, #f LLWy— 2 70—~ /040 i
T2, BFO7—r70—~rusf EET(BLU0AT7Y 2 THELET).

o ¥ YT ay—F v & LT, B (Start)]> Fortify]> Workflow Macro

Recorder(+t v =>/)(Workflow Macro Recorder (Session))] % 2V~ L T. Workflow

Micro Focus Fortify Weblnspect (22.2.0) N—235/379



Y=IVH AN
= 19: £ vy 3 RX—2DWeb Macro Recorder

Macro Recorder# A &> R7 0 E— RCEAIT L. Fi LLwy—2 70—~ 70450 8¢ 3 30
B Ov—r7n—~ /0% & & (B LU0A7Y 2> THELET).

vy 3 X—ADWeb Macro Recorder 1 > X
T1— A DOWNWT

D MEYITIE, £ vy 3 X—2DWeb Macro Recorder® 22— A > X7 z— A2 D T B
LEd.

(7]
€ >|[C[x >
@ Record 3 Delete Highlighted O (CAPTCHA)
Run Method  Status URL

X DF TlE. vy 3 X—ZADWeb Macro Recorder® 2—# A > &7 z—ZAD 2> K—% > b
WOWTEBH L Zd.

HEH ##
1 VAN FEANICOW T T N R DR = 1 S IR LTS S0,
2 AT w7 %I otz WA K ARt 3 238 B YR /R /3 —,
3 K7 yb¥A A,
4 B ARA v G OB T T I A" R OR—Y [ #Z ] LTI S0,
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=) /N—
VAN —E IR DR Tl ¢ 247> ao & gncniEd,

A7y av 4 BH
3 # (New) rlo~srosfERLEd.
b {Open) R CRER S e~ rnE OT(E A R— L) A ki

ELET RDT7ANEATEH AR TEET
e Web~ 7 o(*.webmacro)

» Burp Proxy (*.*)

e HTTP7—#17(HAR)Z 71 )L(*.har)

RA7/ BREMOTwav /7o 7E LET.

ZHTEA T

TR A7

(Save/Save

As)

al7v Nk (el Ar~oaDR)al 7o Nk T a8k & &7 FEATIC DL T
(Logout E Mol 77 MR 27 42 R—=22411 2 R L T80,
Conditions)

AT ' oo+ 5% %€ (Browser Settings)] X1 7 a7 #] & £ 7. fFATIcDO0LT
(Browser G T 7 I e =242 %5 R LT IS0,

Settings)
55 Bt A >

BT ANA NG KRR A= 0, Z IR DR THY T 2R K EF 290K v I AHK IR Sh
9.

REAF zv7

RyI R i B

SRR E#H JVv/LCHEPFRR Lic, — OER(UT)#HE LET. EAT

4 (Play (Run)] 51l OB IE A+ (F sl F 2o 7R w7 AHUER ST 2354 . o

Highlighted) HAERSNEEREHBELET. ETRUN)] DM DF zvihR vo
LR LEE A
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AR F 297
B yI A

(Play All)

1% 11 (Stop)

n7 77k
(Logout)

o J1 KR & H
4 (Delete
Highlighted)

4 XTHI B
(Delete All)

n/4>07ay
7" b
(CAPTCHA)
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login
(CAPTCHA))

B
7.

AT 2 TRNTODRTF 7B/ OIRIE SN T4, v/
2P T 27200 AT (Run)] Bl CIEIR LIz AT w7 U HFEAT &
nEd,

B R CHE A (Play All)] £ 2> % 7Yy 2 Uikcds © B A i il T & &
T HAAEDERNTE T 2L EEPIELET,

(7—2 70— /0CIERRENEXA YA H6/ 77 L ET. 0
77 MLIGE S B SN BB G DEE R IS LTHA MAED & A
ST 20 EHITEET,
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AN LEOBAR CHoT. I Ea—RTCER LELDTE AW EE
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A TR SNEEBEDAT— R A, AT—ZANT 8 LAl &5 7% 215

G HAERCERENET,

5k OURL.

KOF TP T 27BN THET,

o B
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-

tLék (Record)] 27Uy oL &7,

7 KL AZ74—)L RIZ&—4% v MBURLEAN /1 LT ? 2 2Uv2L &7,
77 Vr—y a4 LET.
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6. v uIE LEAE Sl EisE LET.
o 77—l SN TVAT TV —y DK I CIE T (2T 22 AL A i
Fuw(Yes)] #27VyrLEd. v7ah5E | LET.
o U— 70—l SN TV BAT 7V —y DK CIEH T 722 AL & hyoizty
Hlik. PWER(No)] #27VUvsL &4 . YERL(Create)] #27Vy/ L T Lyvv /2ol
G20 " 70D 7 1\ /" X—U244 1 5 18 LT {2 &0,

R~ 27048 L1235 4 (3 . Workflow Macro Recorder 28] U2 & &2, 24T 9 201
WA AR T 24 AR DB AvE—U R R SN T,

a7 77 NS T 4R

0l 7 N T AREM LT, us A v~ oaDal 7 MR AER i mE T & &
T MELORE L2077 M ETRE T 20T B T, I DKM DL s
Tili 72 3L 1235 4 < Fortify Weblnspect & 7214 Fortify Weblnspect Enterpriseld o7 1 >~/
EPOH LTH o/ 4>l Bl LG oA v 2F B LET. $XTO/ 77 M
DEEHE LML Z=7 vy A MDAF x> ical 77 hS 27— AT X T DO THN—TF
BLERDH VLT,

t v avR—Z0DLogin Macro Recorder”3H S i1 ic 0/ 77 MM 2 ¢ 2 2 &) ¢

28 0777 MEMFEIROWT N OB I/ Sh &7,

« HEJUKAL b 2—7 v A M3302 VKA L 7 hCIGE T 22 ED L vy 2 R—RD
Login Macro RecorderiZ & >TH !} S 7235 & 12 SO D ns 77 Met AME R &n
9. EH KRB (regex)DIE R & VEd.

o BB, 5—5 v A MS302UKA L 2 RELAR (B 200) TR 2 § 3 2 emdE vy 2 R—AD
Login Macro RecorderiZ & >TH H} S 735 & 10, COFEE D ur 77 ’ME A AME R Sh
9,
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Y= A A K
#19: £ v¥ 3> XR—ZDWeb Macro Recorder

a7 7 hMEA DB N
FlLwolZ 7w b BN+ 312i:

1. VY= /A\—0 B 77 bk (Logout Conditions)] R &> %27V /L £,
2. [|BZ 77 bk (Logout Conditions)] XA > T, # £ 27Uy 7L &7,
Lol 7y MBI Sh T,

3. P'u/i7 «(Properties)] XA > T, 2O/ 77 Mk OOZ 7Y bl 4 BIE R B
(regex) Z1E % L £ 9,

EHRER LG LFINDLy R T AE—2TT, ERHERIG., SES0HE T %
fHHLTNSEREZHAS DT R E-T. R DE AR SN £3., FHET 2
B 4 25050 25 D2 — 205, COMRE 2 2L i LT Ea0n,

Regexid . a)fRi# SN IzA—DW T 7L AT 2l Dal A > a2—F OERADIGE & b)
[ U5 SN R —D W T 72 A 212010, nl 4 L To4L0z—F 600 UKW
P4 BRSO ERIE T BN ENDVET . Regex & 5 + 2— K & FE IR O
EBNTY,

a. Web7'ox s V—)L&EE) LT.Web b7 749748k LET. COY—ILDNLT' &
#z1& [ Micro Focus Fortify Weblnspect>—L 771 Kl #Z & L T {230,

b. IEXHICKX—7 v A bal AL, i SN TX—YDURLZaIE—L £

c. /77 LT, aE—LRURLEEH LT, o/ A 8§ IR # S eR—2 77+
AL &7,

d. JEEELE L. 0/ 4 o2 IR T SN X—2 1 7 72 AL O & Ol A 2 5
HRPELET.

e. EMEBR 7 4xy— L5 &3, 2O Y—ILDN)IVT7 & /214 Micro Focus Fortify
Weblnspect Tools Guidel #Z & L T {2 &0,

f. /A TR E SN R—=DW T 7 ALK OS2 OF A 2 5 &R L1z
Regex#12E L 7.

g. u/ 77 Mk 7 44D Regex] 74—V NCIEMI R #a6—L &,
4. OKl %2270yl Cal 7 MR ERIE L. ol 7o M 27 4 %% L&

a7 7w Nk OH R
as 7o M EE R T B

1. |27 77’k (Logout Conditions)] XA > C. B Bg ¢ 207 77 MM 2RI L &1,
2. ®ze7YyoL&Ed.

N — \\é‘)—L A
7 27X jE
Fortify Weblnspect & 7z1& Fortify Weblnspect Enterprise’& # 2>V —)L T, £ v¥ a2 X—2
DWeb Macro Recorder# A X F7a>E— T H 3235 & &, V= 3—0D PIU4ER
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Y= A R
#19: £ v¥ 3> XR—ZDWeb Macro Recorder

%€ (Browser Settings)] K x> %27 Uv27 LT, PoxakE (Proxy Settings)] #7°&¢ By b
7— 788 &k (Network Authentication)] 27K /x L £ 7.

¥: 75U E I v /Il 3R SN EY A

P'o ¥ 2 3% 52 (Proxy Settings)] &7

WOFR T SN THBEAFTY 20T HEEIRNLET.

A7y av 25 BH

B (7 ox 8 3)) TaF i g—AEEH LG E k. S04y 2 FiE
(Direct Connection (proxy RLET.

disabled))

7'nF R E OH B H WPAD (Web Proxy Autodiscovery)7 o + )L #{§i ] LT
(Auto detect proxy settings) 7 oF HEIKE 77V ER DU 777 ODWeb7 o+
SERE AT W COATY o BRI L ET

VAT LDTaF VR E EE o—Aver e aR s — B 2 v A— T B
F 9 %(Use System proxy . COAT7y avFIRIRN L ES.

settings)

Firefox 7’ o v i% € #18 l ¢ Firefox/» 67 0¥ o4 — MG 24 > A— b B121E. 20D
%(Use Firefox proxy F7y o FER L ET

settings)

PAC7 7/ )W el LT7 0¥  URL] K vZ AT & L35 B icd 2PAC (Proxy
ik € #17 HAConfigure Automatic Configuration) 7 7 )V 670 % 2 3% € & 0—
proxy settings usinga PAC N3 32id. COAT7 Y s #BIN L £7

file)

T uX R E FHRIIAT O RO LN BRSO REANTI LT oF L 2R E T
(Explicitly configure proxy Bl COATY o #EIR LT,

settings) . H—s3(Server): 7 0¥ v #—OURL & 2 IP7 KL %
ENIILET,
o F—NPort): £— Mk T £ 1 L &3 (F2 L2018 8080
% E)e

o XA7(Type): 7' > H4— & H OTCP 7714y 0%
W 5 270 ha)L(FE #E . SOCKS4. £ 7214 SOCKSS)
FERLET.

SR 3E (Authentication): F2AF 771k #IZ R L £ 7. 7R5
TIEDFFA DO TE . - DNV T Efold 22— A A
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Y=V H AR
#19: £ v¥ 3> XR—ZDWeb Macro Recorder

A7y av =5t BH
FES L TES0,
o 2—#4 (User Name): =—# % 235 E L 7.
o RARA7—F(Password): S A7—FEIRE L& T,

o Tk ENA/RRT BY A MBypass proxy for): i i
DIP7 FLA(NHB 7 A A M VT 72 AT 2121
TaFsH—NEEH TN ENEOIGE L. 04T
IR LT Ry 2 AT FL R EIGURLEA F7
LEd. =2 MR Y] 256 Av~s i LT,

B v b— 23 5 (Network Authentication)] 27
oy N7— ZFRRE Db B A
1. By b7—7885E (Network Authentication)] #27V v 2L 7.

2. PHE(Method)] VA 2s0F N ADTE IR LET. HIERGIRDEB VT,
« ADFS CBT

H &) (Automatic)
# 7 (Basic)

A4 A MDigest)
Kerberos

%Iy x— MNegotiate)
NT LAN Manager (NTLM)
3. AV NT—IURBAEDa—HZ E/NAT—FEFRE LT,

4. P 347> MEB & (Client Certificate)] 7 v /R v/ A& 4> &I2ld AL & A1
LIAGE G FEHFE AN 74—V PN T LT RE B E 28I L £

~7aDT /Ny

COD MEYI T FE 2 BT (locations)] XA > T~ roaxt il BT /N v/ § IR % A
FYTWOWTEHIA L ET.
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VIV AA R

#=19: ¥ v 3> X—2DWeb Macro Recorder

15 It (Locations)] X4 >~ T DI it D41 LIk BE OF 7R
AL &% SN 1235 P OFE AN LIR BB 23R R 3 2124
1. B FT(locations)] XA >D7—7 )W T, v~ 70 CTo5—0FE LG 28R L.

Run | Method| Expected| Actual URL

] GET
[+] GET
[+] GET
[+] PosT
[+ PoOsT
[+ GET
[+] GET
[+] PosT
[+ GET
[/ GET
[+] GET

200

200

200

200

200

302

200

200

302

200

200

http
200 hitp

http:/f
403

http:/,
302 http:/

http:/f

302 http://
302 http:/f

302 http://

403 [T

http://

:/fzero.webappsecurity.com:80/bank/account-activity.html?acc
:_f'_f@jo.1-.'r:bappse:urity. com:80/resources/js/jguery-ui.min.js
zero.webappsecurity.com:80/bank/account-activity-show-tri
zero.webappsecurity.com: 80,/bank/account-activity-show-tr:
fzero.webappsecurity.com:80/bank/account-activity-show-tri
/zero.webappsecurity.com: 80/bank/redirect.html?url=transfe
zero.webappsecurity.com:80/bank/transfer-funds. htm
zero.webappsecurity.com: 80/bank/transfer-funds-verify.htm
zero.webappsecurity.com:80/bank/redirect.html?url=pay-bil
zero.webappsecurity.com:80/bank/pay-bills.htm

i/ fzero.webappsecurity.com:80/bank/pay-bills-saved-payee.ht

&

-

2. 774V el BEA (Details)] X7 ER 7 — RS E T —AnE R SN & R

*—4(Scheme)] .

iR R MHost)]. 8 &1 R— MPort)] AIE L Ce2fER L&

3. RRE(State)] x7%7Vys LT, v /7uf A REEAE bR M EH 7 L &

o

4. LE S CTORBEHESF 2 LOTEZEMTEET. FIHRGERDEB T

a. BAZ(Type)] Fav7 Ko YA ML 7 HIEBIRLET RATOATY 2 EIRD &
BOTT,
o Regex
o 7xY(Query)
o KA MPost)
o 7vy¥%—(Cookie)
o AAXKXL(Custom)
b. B EI(Name)] 7 r—v R LTk 04 i # N 1 L &7
BmAdd)] 2070 7.

27 v7 (35 ) O 4

1 DD AT w7 121335 i #0248 4 21204

1. £ (locations)| XA > D7 —7 W T, w70 T 5—nFAE LI 2% R L7,
2. BA¥ER #F 4L (Play Highlighted)] % 27Uy 2L 7.
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Y=V H AR
#19: & v 3> X—AMDWeb Macro Recorder

AT DRT v7 (5 B ) D A 143 e

SN AT w7 RGBT E~27aN IR 0. 1B CHUOERCTEE T2, 4 sn &
A,

B Ic~roART v 121335 BT 23123 21214

o B (locations)] XA >D7—7 W T\ ZTDHHT O EAT(RUN)]F| D F =9 oHR v o A% 7Y
7LET.

HATCvI/oRAT 7 2B OE T B

o il (locations)] XA >DF7—7 W T, 2D T ® AT (RUn)]H O F 29K 9o A&+
WL&Ed,

AT 7 (3 BT ) DHI ER
~ b6l BT 2K AZHIBR 3§ 512

1. B i (locations)] RA > D7 —7 W T, v/ TIT5—n3E4E LG it 438K L &7,
2. BAFE R %8I & (Delete Highlighted)] # 2 Vv L £ 9.
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7/

720 vy B E ODWeb~v 7oL
1—X7.1

Fortify Weblnspect. Fortify Weblnspect Enterprise. & U'Fortify ScanCentral DAST 2
. v o/ozy Y T AV EEE LI2DO0Web~v /7oL 3—&X0E N TwEd. 12d s/
Av~2of T, LN Dd 7—r7o0—< 270 TF. CO R¥ 242 FClE 2 6D2D0DY—)L
E RE DR A VB B L= 7ol Dar 7y ER & — R cTWeb~v 7oL
I—KEFIEN £,

HEET vy —12DOn T

Fortify Weblnspectt >+ —Ii& . Fortify Weblnspect 22—+ > X7 =— 2%/ LIzH#E D 2—
YERAE G LCVE—PCAT Y a— W S BR SN AF v AT S 2A M T
FortifyWeblnspect Enterprise & 7z (4 Fortify ScanCentral DAST 2$% %t Sh 7235 & OFortify
Weblnspect 77" V7r— 2>, O NF¥ 24> bD YTV /bsFortlfy Weblnspect\ Fortify
Weblnspect Enterprise. & & U'Fortify ScanCentral DASTZi# ] sh 23 & 1. &>
H—] WO FE I sh &7,

<7D

o/ A ~vrndld.WebH A M7 22 ALTaZ A>T 2EXCHE T 24Xy MNELEETT .
2015, CORE A LT Y —IcAx v 20t T 248/ ks C& ¥4, v7—r 70—
vznold. 44 bL OFFE ODURLDELEF T4 . bl icD0W Tk M/ (v ro" X—v250 &
"— s 7n—vro" N—U251 1 55 M LT E &,

TruClient7 7 /oy —

v o>y 7 AY— i E OWeb~ 2oL 2—XiE. TruClient7 7 /oy —TCREt sn L
foo AR MR—2DKEFE ETruClient 7’ S Hi KT 2 LT~ /onzidgs 8L UOH A L
9,

Web~ 7oL a—x Dl R

Web~ 7oL a—X14 . Flash £ 7214 Silverlight 77 V7 —> 2> OFL &% #0 F— LT EE A

Web~ 7oL a—X¢f# & 3TruClient7 7 /oy —Ii& . Jt % « Micro
FocusLoadRunnerMicro Focus 8 U 7 r—<> At > Z—Tfli ] T 2720125 3 an /-
Ajax TruClient7 7 /oy —#)5H LIz 6D TH. 2 6O G I 7V EE N —2 22D FXT
DHEBE NI AIA A, E1EHR— PSRN TVBEVRICETIEHVEE A
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Y= A R
#20: v /x>y Al OWeb~ 7oL 3—X7.1

~ 7N OCookie ™ »&

v/ /OEBEAE T BE oI, B SN o~ 2 mIcs AN F T BT BEM: D H 3Cookie
Ny EEGFE LEE A

~ 27N OURL

URLD 270N I2H 235 H « AF v € ORI V—IVICB R % < ~ 70D A R g5 5k
W ACIEfE SN 4,

v /Ry TAB B OWebv /oL =KD 7
7 A

X DB ¥% Tl « FortifyWeblnspect. FortifyWeblnspect Enterprise. & & U
FortifyScanCentral DAST C~/7nx> v > 7. 1% Li-Web~v /oL a—X %L H) + 53 &
SERFHECOOTHH LET

FortifyWeblnspect £ /-4 FortifyWeblnspect Enterprise ® o
JAv~rn

Lol A >r~rnEit § 3 %5, FortifyWeblnspect % /(4 FortifyWeblnspect Enterprise
OTruClient” 7 #7 21 Fl L Crtdt SheBE 7 Dol A >~ 2uzk O ik CIEIR 6 &
OA7'y 2o THRETEET.

o Firefox#L >R V> T 2o ELTHA M EAF v &R E T 25 6 1d =7 v A b
coZA o B EHgE L HEBR]IZ 2y LTH LwaZ (>~ oa%il it 3 20
BEfF Do/ Ay~raEZRIRBS A7y v THRELE T,

o Firefox#L >&XV)>7 > > &L T, Fortify Weblnspect & 7-(4 Fortify Weblnspect
Enterprise DWeb+ 1 b A% v ZH AR 2% v /% € T 25 & A7 v72TH 4 MNBILE %1%
RUFTLuaZfry~roziiit 320 BBIFOu/ A r~v /o iR 8 L0477 3 T
LLET.

» FortifyWeblnspectY—)L /3 —T. [V—)]> [/ (A > ~/nL 2—X] > [v /> Y T 1]%
VoL T vl fr=r8L 3—R 5 AXY R7ayE—RCET L. Lo/ fr~ro%
BLER T A BEfFOr Ay~ rnsf  BLUAT Y o THRELLT.

« FortifyWeblnspect Enterprise D& # 2>V — )L —)L/A—T. [Y—]> [TV~ /0L
K] >[v/uz>Y 7412 7Vy /LT ol fr~vrulL 3—Ke AKX K7 o> E— NTH
S HLuolAr~raEitit 50 WGFEOn/ (v~ rnEl { B8LUA7Y 2 Th
LLET.

o F 2T 4Y—F v B LT, [E)] > [Fortify] > [m/ 1>~ /nL 2—X(A X N]%
VoL T vl r~r8L 3—R & AXY R7ayE—RCET L. Lo/ fr~ro%
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Y= A R
#20: v /x>y Al OWeb~ 7oL 3—X7.1

RLEE T A B Da A= uE BEUOATY o TCHRE LET.

e WindowsT 2 A7 0—5TC, v/ux> P 7 A #Hi0oul/ (v~ a—X % H L Cid ¢
SNIHEAORZ Ay~ ol L. &7V 2 )7L T &&3. o/ (> ~vrnL a—X
id. AR R7 0y E—RNCH &£7.

FortifyWeblnspect & 7z (4 FortifyWeblnspect Enterprise ©
7—/770—~v/0

B Lwo—27o—<so%it it 3 29 FortifyWeblnspect £ 721& FortifyWeblnspect
Enterprise DTruClient”" > 7 i1 2 F L CRe#f S 2Bk F D7 — 2 7o—<70&Ik D
HETIEIRBLVUATY 2 CHETE LT,

o Firefox% L > &V 7 200V ELTHA M ERAF vV 588 € § 285 & &\ [7—278—>
NTAF ¥ RATHRT— 70— THZLEHRELET. V7—270—RA7 v OF H
T Lwy—27o—< 700t ik, LGB OY—r7o0—~ /0D YR — B L UAT
VA CHRE ATV ET

 Firefox# L > &> 7 > v &L CFortify Weblnspect T3t & 2% v 25 52 4 235 5 A
7Tv71C[7— 2 70—BRE B A% v 218 L. RCR] 0 [BE]) 27092 T Lw
U—s7n0—~< /0%t T A0 A Ov—r7n—~/nEBRIR B LOATY S THRE L
9,

» FortifyWeblnspectY—)L/A—T. [Y—)V]> [7—77n—~ /0l 2—X] > [v/nT>Yr
7A1%227Vy /LT, V—/r70—</0L 3—K 45 AXY N7y E—FCET L i Lwoy—72
TO0—< /uEitit A0 BEOv—rT7n—~v/ns { BLEUOAT Y v CHRE L ET.

» Weblnspect Enterprise D& # 2>V —)L YV —)L/A—T, [Y—NV]> [V—77u—~ /DL 32—
K> [v/ux>rYFortifylz 7V /LT, V—2r70—~v/0L I—XEAX R7aYyE—R
TH & FrLuwy—2r7o—~ 77 10%iLek 3 20 BEF D 7—27 70—~ 70k . 8+
F7'v v THELET.

o ¥ 2T aY—F v i LT, [&E)] > [Fortify] > [7—/7o—< /oL 2—X(A >
N%Z2Vys LT, 7—/70—~270lL 3—XEAKX R7aYyE—RNTEAT L. i Lbwy—2o7
O—~/o%itit 720 BEDOV—r7u—~ /s B LA T 2 THRELET.

FortifyScanCentral DASTO 7 f >~ 7

Web~ 7oL a—X—)L4#ScanCentral DAST REST APl 2> 7 60— 2> Ea—&IZ
K7va— LB IROFEE Tl 4 r~vral a—K 5 {CenT&E£7.

o [FortifyScanCentral DAST#X i€ DO il ] 74— NTHEHE 2% x> 5558 5E 4 235 & &« [68
ER—vC[vroL a—KEE F.1]182Vv2LET.
EHE! Webv/nolL a—&20—lLa>Ea—RKX7>a— R NB LA VA =L &N T
WEWIEE X Web~v 7oL a—XK%0 {CENTEEFH A
. OZAYvouL I—KEARY N7 OvE—FCEAT T 2121 [BEY] >
[Fortify ScanCentral DAST] > [/ 4 >~ZuLa—X|z 7 Uy L. HiLwa/ (>~ /ro%
LR T A B Dus A v uEl BEUATY o TCHRE LET.
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Y= A R
#20: v /x>y Al OWeb~ 7oL 3—X7.1

Web~ 7oL a—XDX 7> o— RO Al 12 Duw Tk« [Micro Focus ScanCentral DAST D
JRELOMEH 71 NES IR LTS 0,

FortifyScanCentral DASTO V—/ 70—~ /71

Web~ 7oL a—&—)L %#ScanCentral DAST REST APl 2> 7 60— a2y E2—&IZ
A7y a— RN IRDG1ETT— 70—~ /o0l a—X %55 (¢ TEFET,

o [FortifyScanCentral DAST# & O ] 7 4 — K CT7— 27 7o—BK B ] 2+ v > 5% 5E ¢
2GE . [2—7 vy NR—YC[v—27a—~< 7L a—X %8 J.11%2 2y 7.

HE! Webv /oL a—4&po—ALayEa—R KX 7>a— R RBEUPA VA ML EN T
WARWESIZ . Web~v 2ol a—X%B {CeNTEEE A

o U—/7n—</ulL a—KEAXY N7 0ryE—NTCHEAT T30, [BE)] >
[Fortify ScanCentral DAST] > [7—/7u—~/nL a—X|%7)y/L. i LLwy—2r 70—
v /uEiER T A0 BME DO U—rT7u—~ /sl B LUF T o THE L ET

Web~v /oL a—&DK7> a— FOREAN 12 DL T [Micro Focus ScanCentral DAST D
R E LM 71 Nes LTI S0,

/A >~rn

o7/ 4 >v~zald. Weby A bE72lidWeb 77 Vr—y 327 70 ALTal A > § Bz lh B
BT T ACTADREE TT . BH . 22— % &A= AN L. [aF A ][al 4%
EDRRE IV 7L ET . AX vV ERE T D56 B . LET it Licn/ (>~ /o
FIBE T2, FLEAF AT AT Lunl/fr~rusidiE LES,

as 77 kA

=N T TNy heal T LI B AR vV IR TR T T 205 <o
W 0l Ay~ raTiE. ol 7 MAFRA LECEERTE R T/0 2 Leb1oD s 7 MEE
VIEETALERDHNET ., Ax v I, o —RlRDEES 4B Tl 7Y NS 3
A REMERNDHVET,

o X—7 y A MIENE T 2B E Oas T b

o BALT T N EDR—47 A D TF—IRFE

o WEN e NFTA— R ED~V/OE kD TS—

n/{y=/nO—ff el Cal 77 Mk EIRE T 28 A% v T LawaZ 77 b
RAE LS. 2= E L F I Cal/ A LHETWEN L NEFT, Y1 MERAF v
TR, b —ld K 2= v A MO B 2T LTIREEZAM LES. oy —nnl 7
TRLTWBREHIW LI & . /A r~ruExEiT L THE /AL, al 77 MFEAE L
1ol T A MDD ro— L B AEBE L ET.

BHEHOas 77 M EIRE C&ET. S oD%k s g6, ev—dar/ >
~ s AELTH AL Bl LI o xF v 2B LET.
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=LA R
=20 v ouryy Ui E OWeb~ /7oL 0—XK7.1

CHHH TS Ean,
"ot 7o M O " XN—2275

J—770—~<x/70

v—r7n—vrad. A b L T THE) 7 255 & OURLDEL &% T3 . . Fortify
Weblnspect TDH A& 2+ v, F7zidFortify ScanCentral DAST TD A ¥ >, LA AT (5T &
Licy—207a—</a%iE € 3 200 A% x> &[] 3 2l 5 TH LLy—2r 77—~/ n4id
BRLET. Lo —ld. V—2r7n—v /ol ik ScURLDA #8i A L, B A& ki i &
NI ANR—= ) 2FIBOERA. COD~7oid. it VBT 7 Vr—y 2O 2 047
Iy ERENTRGAE M SN &, v /ol 7o A0 Tk, ol (v~
2EDFEAN HIE IR DEBVTT,

o U—r7O—</rmllE, BT 2= ) LIk E ODURLDA NS Fh &3, 7—7
7o—vrold. BAER ICZEN AOURLICDA T 72 AL £1°.

e V—rT7u—~/rnldul 77U Nk ERE LLLVLDT,
¥E: WebH A MCRRGE B B 5 H i a/ AV AT v7 27— 70—~ /ol #% L

WTLLESH A b, flonZ A r~ro%it st L TWeby A Mool A > LTS,
FHA oW TIE . "aZ Ay~ B OXR—Y |55 BB LT 7 &0,

2—H AV RT7 — ADH fiF

Web~ 2oL I3—XHH & IR DA A—PITR SN TW 24N, 20D 7 1> R I U TE
NS ET,

av | & ! [f= @ | @ filey//C:/Program Files/Fortify/Fortify Weblnspect/datTCB/WebTruClientBrowser/extensions/TruClientBrowser@tc.com/newtabhtml
Ov By |, I |
Oster OV b NBC @

aaaaaaaaaaaaa
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VIV A AR
220: v/nxy Y A OWebv 7oL 3—XK7.1

KORIZ.2DD 74> N7OS ] 2~ LET .

vavkEy B

1 TruClient{ A—7 4> K7, ZD 24> R CIE . 505 &4 45 DR RE
Zay hp—)ILTCExEd,

2 TruClient7"' > 74 w7 4> R7, CDO 74> N &M LT, Weby A MZT 2
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Q: H4L DR TTOHBE DL AT IE? A TAZ—

07 A X—VIEIRDENH VET(F I N—7 D] OE [ #48 H).

' N
Security Questions

To protect your account security, please answer the following

questions.

What is your quest? ‘ ‘

What is the name of your favorite pet? ‘ ‘

What is the capital of Mongolia? ‘ ‘

~ J

F oL PV AR VAT R vl A H O~ 7o &%

FL YPILAE VAT R A7 DOl A VA ic~vrasiliE 258 12007 4 U ICFh
LD A E HDEDH Ty MDA BIR SN B E TH. % 26N 3T XTOH [ &a & D
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B 2= ENAT—FOEIEREMEH L Tal/ A LIR T, 2—7 vy b A Mk
F VT AV I AF 2% T IROFEHE >Cs —HOE B FE 4 A7 97 52F 5l
TIERLES,

1. ~7o@F0 & F 2. TruClienty  RA—OHEIE] 7 /()2 7 Vv L&,
2. TruClient { RA—T. [A7 7D IN] 74 2@ Step )5 200 2L 57,
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3. A AT Y157V L. [ X 2VFAOBRIE 2B AT w7 % 7 )y LTEL R Sz
AT 7 KT L ET,

OSTEp Ov v = o [ A 1

Functions Flow Control  Miscellaneous Composite Steps 17

s

Answer Security Question

Close

HLWAF o7 MER & £7.

3| # Answer Security Question get the question from
[¥ Choose an object and set the corresponding answer in
[¥ Choose an object

4. FH LOAT 7 ORAI D[ Z7VyILTATY 27 b8 IR 4 3]V 2% 27Uy L TOIR IS
TruClient7' 574 71> FUT, Bl 2R 472 =7 NEH & 70V E 27Uy s L Ed

5. I LWAT v7D2OH D[ 2YvZLTATY =2 baRIR § 3] V> 7% 7)y /LT IR
TruClient7' 574 74> FUT, B 2R TATV 27 MBEHE I TFA MR IR &Yy
LEd.

6. TruClientt4 FAX—=T. [t ¥ 207 DY [ 1c% 2 B AT w7 OIAT v LT 4K 7 A 2/

VEZUvILET,

AT v7 TF 4 RHBH & 7.

7. [ 297 4DE By 520y o(RH)LET.

8. T2Vl T, X 2T ADE M 7 12%8 &£,

9. t* U7 (DE M =7 12T [BH LOWEROBM] 7 A 2/(T) 220970 &7,

HLOEM AT 7400 METE 11 TR R SN ET. 7087 12k [B ]I
DT F AR yIA(T 7+ MEDNHE RBI1] 4K IR) & [EK]&c@a/\)vbsﬁwtrﬁFx
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@ Security Questions Editor — [m| *
+ @ * Question: "What is your quest?”
. * Answer: "happiness”
"What is your quest?”

1. [E&]R v7 R, IELORZ 25 AR CHATA I LET,

12. A7 w797 1144 ik LT, Web_R—v F OF UG T e R Sh 226D H 22F H 0H
M OBREAEEMLET. COF TELTERICAN DDy MDA HTE? 1w > [ 2ff
MLET.

13. A7 979711 %4 ViR LT, Web_X—Y L OF U5 T cR /m SN 3280 H 23% H Y
RIOERAZEMLET. OB T TEVTILOEEIL? Je0IEM 2 H LT,

14. [OK]z7Vv7L £9 .
B ERIZ &, ~/aRT7 97Dl F 27« OE M2 /7y 2o DR BN S &5,

Security Questions +
Question Answer
“What i= your gquest?” “happiness”

“What is the name of your favorite pet?” "Rusty”

“What is the capital of Mongolia?” “Ulaanbaatar”

EY M CEM 3R E 2R E T IV ERD LGS tF 27 DE M =
TAREHRER &7,

T WebN“/J:O)pODEF%E%O)iﬁFﬁo)??DZT/7/]3757 LEd. B eRZraai
1”E55zLT$JAM0)’E£F"ﬁ% 3 zid. [VE M e 22BN LT O M 216 N3 3"
TR ET,

B R AZEM LT E OE M 28N+ 3
B LR Z 2B LT OB B 28§ 20 IKOFEE2ETLET.

1. IROWTNOEANE #1T 5T 2% H O [ R /R S 2 TWebX—Y 255 L &
T

e TruClient7 7% 71> Kol #27Vy7 L, <F5>F—%# L £ 7.
o TruClient7' 7 71> RYN TH 27V 7L, [BatAIAR]| 743> #I& R L L7

2. ["f“*\’"/ ‘/\‘//‘/Xd’%\/ijﬁ Q7/r\/)zﬁ @77D@§a§§%" &‘—“\/266]®X7—“/702~14%%§% O
E LT, Web«~/o>2%.§ H O35 T 12 23 DD [ Ll % D2% H D¢ v Ml D~ 2
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3. MODWTNHDEAE 21T >C. 3% H O M R /8 SN B ETWebRX—Y 2 F L &
T,

e TruClient7 7% 74> RN #27 Vv L. <F5>F—%# L £ 7
o TruClient7' 74 74> RN T 2 Vvo L. [Bot #IA K] 7 2> RN L &5,

4. ['"FrLoo/L AR ATl AV O~ 705l iE" N—U266]D AT v7214 %4 D
& LT, Web_X—yD3% H O 1o d 2350 ] &R ZD3FH Oy Ml D~ 2
DATv7 #B I LEd.

BN AT w7 DR #%
% 26N BT NTCOE M Ll 2 Ol A& b-ICH T 2AT w7 #EMR LR B DAT v
TECERT BLEAD BB KOFIERIT LT

1. TruClient% A =T, B NER LIz AT w7 5382 R L £
2. R 71 3O V)D Ray7 RV REN #2770y oL, BIR LIzRAT v7" O (CRT 8% ] 2
WLET.

o Step | Record before selected step (N I |
Record after selected s&p

v 1 i © Mavigate to "hitp://zero.w - et "
l Record after selected step |

w2 i+ Signin

3. W EBVRLER 2T LET
fEIE]17 A a(O)% 7YoL &7
5. v/usfELTRMAFLET.

25 X WAl DfE

/Ay~ gl iR Lics 2B ERRBRE /V—7 AT vk~ 7mZiB N L . Fortify
Weblnspect % 7z1& Fortify ScanCentral DAST®D 2 % > C23 K Wil 6 ]l T& %7

s

YE: 258 % 2 5F 4 . Fortify Weblnspect Enterprise Tld #£— &N T E ¢ Ao
BE! 2ERAM A2 AF o> CHA T2 0Ce—TTA M 25 51E. F92E KR

AE 2> bo—v b v R—EFortify2FAE N AV T 7V —y s 2% E T AL ERH VLY.
BRI DLTIE, "5 O A" XN—Y 3191 25 R L T2 a0,

1HE 32

Fortifyld . 7 A MNH EiE LT AMIE T A= VT FLADAEH T § 5 4HER L £,
N1 AR OB 2o N DE R AL 7 FL A LawTEsn,

Micro Focus Fortify Weblnspect (22.2.0) N—269/379



V=LA AR
#7520: vouryy i E OWeb~ 7oL 0—XK7.1
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o [ OID— % (UIDL) &4 K — 9 2POP3H— DA MY R— SN £T .
o BTE. YR — S T 2Dk Androidf 77 B &G DA T3

HHsh 9.
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HANTA

2ﬂ‘%nu nEé’r&%?%i’ﬁA EgN 0\0)7'7’1, |\7/f/6a_filé(433§—§_
e 2ERBME I/ N—T AT v ERN O2BEBE /V—T AT v TN IZ

Tho

AETHIULETEE

e 2BERBIEI/IN—TAT TN I2DODQFARFI B AT v 45 LI TE £ A

o O/ A 7 Ut AERE [ T3 2FAREB AT v 7 DB I AN AT VT eI VI AT o7
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4 Zg%nu nEﬁHC;U74/77Q%n&IE—§A6i’ﬁ

3 i £ Click on Login link

4 i = Email Twofactor authentication demo@fortify.ninja

n-Factor Authentication step allows you to automate
the "something you have” fac t ri ft o-factor
authentication.

To use Two-Factor Authentication in a scan:
1. Configure a Two-Factar Authentication Contro
(and Two

SMS)in se

Center

gs.
2. Configure the relevant arguments for this step. Mote: If
using SMS, the phone number in this step must match

the phone number in the Two-factor Authentication Mobile

Application settings.
3. Ensure that the "Wait For 2FA” step is properly placed
after the step that initiates two-factor authentication.

\ For more information, refer to the documentation.

2

3

4

5

¢+ Login
¢ @ Wait for 2FA TwoFactorResponse
¢ & Type TwoFactorResponse in 2FA Taken textbox

i @ Click on Validate button
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¢ [BEBEE|L v/ A SMSIGE 22 5 T 2B E S
ENTILET.
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M28 2R AE FH D /35 2—RDE " X—286] %
Z LTI S0,

o [EHRMBBRIR vZAT. SMSIEE 75 h—2> DA &4
HI2EHEH 2MELES.

EVY b U7V DIEREBRICOOLBTE., ey X o>
KREI &7V o L TLZS0,

BT A& a. A7y ERERLET,

v F4 oD b. [77¥ YA INT, [BF A 2BRRBA]ER L &
(UIDL) %+ #— ko KK

2POP3+H—/ 3Dk c. FIFAERM L. IROKE #1T VW &7,

L o [EF AMA v ATETF A IB B 2% 1E T 3%
R F A=IWT FLAEN ST L &T.
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DEATEHREET A—IVT FLATH 20 B
HNET NIA—RL BN T22L8TEET
SEAR DL TE, T2 HK AL O /35 A=%D
TER" R—286] %5 ff LT 2 a0,

o [H—NRKRvIALZ. BT A—IH—DIP7 FL R &
F2lEURLEAN JJ L&,

o [Hr—23R— NAK v RIZ. B\&T A= Avte—IfH
M3 28— N1 LET.

o [TLS]H vZ AT\ & T A= )4 —0TLS7'm b
T 20EMEERLET.

VE: 7 74V NRGE dtrue T,

o [NAT—RR IR BT A=IWTHTY MDA
T—RFEANTILET

o [ERRBRBIAvIAT. BT A WILE S I—0Y
DA EHH T 2IEH KRB 2L L7,

EY M HYIIVDIEREBR ICOWTIE. Fey s’k
TUREN #2)y7 LT IES0,

2FA 415 257 v 7 DER E

2EERBIEE I NV—T AT vl R E T AV E D 22FARHE A7 7 s TLh £
T, 2FAZGHE 27 o713 2B EEE 2V ha—ib b > X—h A2 25 2 EE I & 2N I &
2055 ET,

BEE! QFAYRBHB A7 73 2B EBIEI/INV—T AT v N COAEIT C&ET, AX
YRTOYAT T ELTEAIT T BEE TEET A

QFAEFEHE 27 7 4 T2 IROFEE#EIT L ET,

1. T 74V FClE AT YT EA ATV MC~ /7oA K 2180 & s &4 . 777
T =N\ BDIGENIE WA 8 BARM 2SR T3 AT v
BALT 7N EOEERK &LLET.

2. Bl AR L. [BEIR v RACERH L ENT]T LET.

R DA A— Tld. ] £L TTwoFactorResponse &#1#i il L T &3
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20 v b B
@ Wait for 2FA TwoFactorRespanse

Step

Arguments

* Variable: TwoFactorResponse B

Transactions
Web~v /oL a—Kid, a> ba—Lt v XZ—hoDG & 2 OB IEFELET.

NI AT 7' e Vw7 AT v7 DiB N
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2. BBEIX7C B AT 27 NP Iy DNAT 97 % 2 )y L TELER SN2 AT 97 Ry
7L\ 2FARFRS AT v DE B 2B RRBIE I/ NV—T AT 7N Fay7' L&,
3. WMDENAT v7 4K ELET .
a. [17‘\/17 b@%ﬁ]%?”/?b ?EIT k—ﬁé O’CZﬁ‘%nu A FL;%Q 7 ¥R Fﬁ‘77x}2i%
RLET
b. A7 v %R L. [72Y YA SN FEIR L &7,
c. SIFEEMLET.
d. ME]E v/ ATUS]#EIR L 7.

Arguments
* Value: B
Clear: Default (true) ~ B
Typing Interval: | Runtime Settings (0) & ﬁk
L
Object

Transactions

e. MEIR v/ A 2ZFARFFH AT v/ CIERR LB A 2N I L& T . Wi D7 oy —
¥ % Tl il £L TTwoFactorResponse #{# il L Ty 7,

4. [TruClient] 1 F/3—C. [AF y7DEIN] 74 2/( @ Sten ) 292 L £ 4.
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27 o7 DE 18 O B (7E & LT a0,

25 oalv b B
@ Wait for 2FA TwoFactorResponse

Step

Arguments
* Variable: TwoFactorResponse @

Transactions

E |V[>L_”I|E|{‘-¢

= Type sssssssssssssssss in Cnter Response passwordbox

Step
Arguments

* Value: TwoFactorResponse &~
Clear: Default (true) ~ B
Typing Interval: | Runtime Settings (0) ~ B~
Object

Transactions

4|§§ 2 Click on Signin button
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Regex
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Run Logic Actions Function Libraries
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CDRAT T ~/70D 8 4 EE . BLUOHA 2T 0T,

~r7aN\D7 7y a>0iE i

v oI T oy BN T Bk IR DERAE BT L E S

1. TruClient {f N\—2 4> PO LB h B[ 77 s DEB 7 2(2) &7 Vv L &
ER
[7 7y s OB BIZA Tl Ry ANE R SR ET,
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(@) Manage Actions — O X

Actions List

+ W T Jd

Init_Seq g W
Action_Seq
End_Seq

2. [723y avDBEIMTAAT)VELYVILET. T2Y b DR T WL R 545 1 2 &
Uy,

77y DA O U 2
70y avDEF 21 X 2 2121k IROERAE 4T W E T,

1. TruClientt A =742 F7O4 FH 3[7 73 s DEH 74 2> (B3) 527Uy L &
R
[727y o DFBIZA 70l Ry ANK R SN ET.

2. 7Oy AR LT,

3. 74y HEVAIMITLE FEBE T2, [EAN&E[FAI7A 24T V)&s002
LEd.

7 7y 2 DH| &
7oy 2w R T B IROEANE E4T W ET,

1. TruClient¥ { b= 4> FoOf LI ICH B[T7 7Y OB B 74 3(E) 57 Vv L &
o
[7 2y 2 OERKAT7al R ys ANE R SN ET.

2. HIbg 43770 av#IEIRL LT,

3. BIg 74 (% 2VysrL &,
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=20 v ouryy Ui E OWeb~ /7oL 0—XK7.1

I Z A= RO

v IOER IR TR A E . NI A—REE ] LTIk OB AE 247 W &4,

22— ERAT—RDNRFA—REE R LTy 7 AZ—RNAF v DB th I 12 3 025
GREERAEMH L0, vV Fa—5F ol A AF v E B OE K ER & H Lz i
LN ET FFACODOTE "= £ AT— RS A—2DfF H" F 15 B LT
2,
URLD R A—Z%ER LTy ~20DFEATH 12T AL—2X B URLEIE E TE3 4920
9. k.@ﬁzza EN 77V —y R DR AFE L kst A > 7 7L —y a6 &
UZL tH) 7 VR U—(CICD) A 7' 54 > D—#F ELTAF ¥ 5E AT ¢ 256 8 H ©
iﬁﬂi IOV TEL TMURLA Z A—=RDff " X—22831 #Z IR L T2 &0,

Emﬁﬁv\ BT A, BEUVE T AW AAT— RD RS A—REER LT 7 AZ—532

%%uwﬁ’éﬂ% ET BN TF 2Ol AV AF v EFREITTEBENLET. sF 4l IcDOL
Tl T28E 2532 5 FH D /8 5 A—RDVE " X—2286 ] 25 1R LT 2 &0,

RILF UNLF XA T 537 A—24
RS A2 TR LT UM L FHK I S N F OB £5 Gl Eab 0T

2 LA R85 A— 2D ]
/A ~raEER LTTANIAR . FLEE SNTE 23T A— R (LB &R 2 22— 4 &
NRAT—=PRDNRIGA—ZEERTEET. ZDB . BAEF IC2—5 L EXRAT—RDRFA—R%E
B X IAMEOVAMAER TEET .

AT w7 TD /85 A—ZDVE Bk

22— LR AT —RD AT A—RE, AV TFA Mo % H L TCAT v/ CHBEEKR T&
ES 2N

AT T TCNRIA—REAE R T B2 IRDOFNEHE D F

1.

2R EFE AT I T AT YT LT AXT A3 )2 UL ET,
AT V7 TT AXHE & &,

2. BIBIE2Vvo(EB)LET.
3. HHIR v/ AT ##IN L. 5 7UvoL &7

Micro Focus Fortify Weblnspect (22.2.0) N—280/379



VIV AA R
#7520: vouryy i E OWeb~ 7oL 0—XK7.1

Arguments
* Value: M.
Clear: Default @ CUt Text Ctrl+X
) inlime Copy Text Ctri+C
Typing Interval: | Runtime Paste Text culey

Object ]
Create New Param@tjer From Selection...

Transactions
Replace Selection With Parameter 4

4. [Create New Parameter From Selection...(( &R 2> 537 L13/3 5 x— K &4E 5R)] £ IR
LFd.
[NIA=RZ DN INEAT Ol Ry A & &£7,
5. [/8FA—&4 K v7 AlZusername EN JJ L. [OK]Z 27U v oL &9,
®
Enter Parameter Name

Parameter Name username]|

Origina Value

If the parameter name you use does not already
exist, it will be added as a type 'File' and the
Original Value will be set to 'username’.

0] 4 Cancel

BE! RS54 RL TCERLFEUNLFERXF SN N L FDAEZCUBERND
Oi—a—o

6. "NAT—REFCAT VI TN AT YT TTARTA 2 V7 VvI7 L &7,

AT 7 TT A0 &7,
7. BI¥ 22y o(BE)L £,
ME]A v/ ATHE #IER L. 5 27V oL ET .

9. [Create New Parameter From Selection...GE 3R 2> 587 LW3/8 5 x— KX &{E BR)] %1% 1R
LEd,

[T A—=RZ DN INEA Tl Ry A6 &7,

10. [/3FA—RL] A v AiZpassword EN ST L. [OK]Z 27Uy oL £,

22— ENAT— DA A=K HAER I sh 2277 CHEBEEKR S Twh i1,
"RFGA=RZA Tl T D VA NAE N 2" IR DA—Y DG A—ZEA 7l #FH LT
2—HE LR AT— NS A—KDE D VA MAER T 20 ERHNET

o
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RIA—ZEA T/ THEDYA MAERR T 3
NIGA—=BEA T 5#HH LT, 22— % ENAT—RD RS A— 245 E X 2 2[HD VA M

fERL L 4.
HOYRMAER T 212 IROFE %354T LET,

1. TruClient¥ o FAA—T, [NFA—RDE] 71 2% 7007 &7,
IS A—=REZAL Tl W & NFGA—ZRN— B RKR SN FT.
@ Parameter Dialog — [m| X

~+ Add Parameter

Y

usermarme

password

®

2. 2—HLZ RS A—RE Iy L ET,
2—HFZDED VA MIFE R SN FT, v 7OZECEE SN 1270 OfE & ~ 7 o A B ol

T 2mP]0MBEELT—BERINFT.

@ Parameter Dialog

Parameters username

-+ Add Row

- a X

-+ Add Parameter

Masked

usemame p E
New Col 1 &

password
1 Username

Policy

Select next row: Sequential -

®

EY b Y% R T B FINVRDIREE T A 3> %7 Vv LT H LW 4 2N
J1L E9. #il:Uuser Names.
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#20: v /x>y Al OWeb~ 7oL 3—X7.1

3. (A7 Y 2NANS LA <A 0T B12UE. [F R8I L7

H: Web~v /oL a—X T~ A 73t f{E & . FortifyWeblnspect$ & O
FortifyWeblnspect Enterprise T4 1 M} EAF x> &3 € T2 L& v RIS &
ER

4. (A7 2 )F O BN+ 22 (12 A1 vV Fa—HFal (v AF x> Da—H4Z DY
A NAERL T 2356 % &),
a. fTOEM]Z2VvILET,
b. 7=V EH LT ICEHE) LEd,
c. vI/ulMAR I 72RDEENTILET.
d. BN T2 J&iz. A7 v7ansc i TEEE DR LET.
5. NAY—FNRIGA=REI7VyIL &7,
NAT—ROEDYVA MIKIR SN ET . v 7OCRLER SN I DE & ~ 7o AR
2ROl LT BER SN LT,
6. (A7 NANSI LI E~YA 04 21003 [RRI) RN L £
¥:Web~v /oL a—XT~vRA73N 14E & . FortifyWeblnspect$ & U

FortifyWeblnspect Enterprise T4 1 M} EAF v &5 & T2 L& vR7SN &
ER

7. (A7'y 2)F O FB N 2101 (2 E2E vV F2—F sl (> A% x> DA AT— RO
YA MR T B35 A 7% £).
a. [TOBMZEVy7LES .
b. A—YIWEH LT CKEEIL &7,
c. vIufiERRICEH TAROMEEN I LET
d. BN 43l 8. A7 v7anbcETasd iR LEd.

8. [OK]Z 2V v/ L TNRIA—RES ZORAE Ly NI A—RXA 70/ 2 L& ¥,

9. v/ uzl A LT, ol A NIE LML LET.

10. v/ozfRfF L &7

RY—

INTA=REA T aT IR~ S SR Yy —i% € (&« FortifyWeblnspectiZ i3 H T& &€ A

URL /S Z 4—xDff H

/A < raEER LTT A NI RL B SNl £ /35 A— &4 (LB & 2 BURL/S S
A—REAER TEET .

AT w7 TD /N5 A—RONE Y,
URLNAFA—RIE, I T F A AZ2—3H LTCAT N ICHEER TE T,
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AT T CNIGA—REVER T2 IROFIE5#ET LES,

1. URLEE © A7 w7 (T BB T 3)) T AT YT TF4RTA 22 V82V L£7.
AT o7 TF AXHH & F T,

2. Bl ¥%E 27V (BB 7.

3. BRATIR v /AT R L. A 2VvoLE5

Arguments
* Location: http:/izero.webapps e T ] B...
Cut Text Ctrl+X
Transactions Copy Text Ctrl+C
Paste Text Ctrl+V

4 Signin
B 9 Create New Parameter From Selection...

© @ Wait until Settings exists
Replace Selection With Parameter k

4. [Create New Parameter From Selection...((& R 7 637 L1y/8 5 A—K%&4E pR)] 1% R
LEd.

[NIA=RZ DN KA Tl Ry A0 & &7
x

Enter Parameter Name

Parameter Name starturl

Original Value http:/izero.webappsecurity.cg

If the parameter name you use does not already
exist, it will be added as a type 'File' and the
Original Value will be set to
'http:/izero webappsecurity. com/login_html'.

OK Cancel

BE! NS4 RE TCERLFUNLFERXP SN N LFDAEAES DL ERD
NET.

5. [/AFA—RE ] K v/ Allstarturl s EDL R #N 11 L. [OK] 22V vy 7L &9
starturl /85 A— &g, AT H SN 2AT7T v 7 ICHBER SN TWET, 22Ty /85 4—
ZEA 7 a7 &#E ] LT, starturl S Z A—ZDE DO VA MER T 2L ERHVET,

RIA—ZEZA Tl THED YA MAER T 3
IS A—=REAL Tl 5 LT, starturl 85 A— K58 &P 2 2OV bEERR L £
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BHOYRMAER T 212k IROFNE#FE4T LET.

1. TruClient# A FA—T, [N A—2D&E] 71 2(B) 520l &7

INFGA=BEAL Tl HB & N IA—EN—ER R SN £T.

@ Parameter Dialog -
~+ Add Parameter

Y

starturl

®

(]

>

2. URLA\FA—&%27VyrL %9 ., ZOf| Cldstarturl &4 >Twr 9,

URLE D YR MR IR S &9 . v/oi ik St O ~ 7l AR i 33

RYU]OE ELT—B- R RINET.

(@ Parameter Dialog — O *
~+ Add Parameter —+ Add Row
Masked
starturl 7|
New Col 1 &
1 | http/zero.webappsecurity.com/login.html
Policy
®

B> b B4 28R 5 I SN VRO E 7 3> % 2 )y LT B LA 4 2N

FJ1LEJ . fHl:URLs Listo

(A7'> )P O BN T 2 IKOTFNEEET LET.
a. fromEsVvsL &4,

b. #—YWEH LT ICHEEILET,

c. v/ufi R ¢AROMEEN L&,

d. BIN$ 3 &, A7 v7ahscETELE R LET.

o

~v/uslE LT, o/ A Ik LOREE L £,
~/aEfRF L ET

Micro Focus Fortify Weblnspect (22.2.0)
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% 20: v /oy A E OWeb~ /oL 2—X7.1

A Yy—
INFGA=BEXAL T a7 IZRK R S B4R V2 —a% € & FortifyWeblnspectiZid i ] T& € A

25 Z FREE FH D /3 F 4x—KDAE [k

B7 Ay~ 7nZfEMRLTT AR Bl &5 BT A BLUE [ A LVDAAT—
FASA—REER CEET. 20 AT ICIN 5D/ F4A— L5 E & 2 2[HD VA b5
ER CEFT 2B EDRIDNRGA—REFH T 2E, vV Fa—Hal A AF v 5FET T
&9,
Ev bk vroz> Y EH LTWeb~27aL a—K T/ 5 A—REEK LI2B 7.1, v F
2=l AV AF v ERE L. BMOEFES . BT A VT LA BLUET
A—)L /R 27— N %FortifyWeblnspect D[ A ¥ > &% € SR AL XA 7 a7 R v 7 AN F T
FESIE

B 5 /85 A—ROIE K&
QEERBHEIN—T AT 7T AV TF A M3 LCEFE RS oA X5 H
ERTx %7,
B S NFGA—REER T2 IRDa~v FEETLET,
1. 2BRBIE S NV—T AT 97T AF YT LTARTA 3 )2V L&,
AT 7 IT AZHE X7,
2. B2V (BB L £
3. [BFEBBIRv/ATE ST 2B N L. A 27Uy L&Y,

v P By @
— SMS5S Two-factor authentication 1212
Step
Arguments
* Phone Number: 121 ™
o Cut Text Ctrl+X
* lan- +
Regular Expression: | /\d+)Ng Copy Text Ctri+C
Paste Text Ctrl+v

Transactions

Create Mew Parameter From Selection...

1|i  Two-Factor Authentication stej Replace Selection With Parameter 3
4. [Create New Parameter From Selection...(Z# R 4> 637 LWy /3 5 A— K &4E )] 2158 4R
LEd,

[SFA—=RZ DN INEA Tl Ry AN &7,
5. [/3FA—&4 K v AiZtwofa_phone EAN 11 L. [OK] 22V v /L &9
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x
Enter Parameter Name
Parameter Name twofa_phone |
Original Value

If the parameter name you use does not already
exist, it will be added as a type 'File' and the
Original Value will be setto ' 1212

oK Cancel

BE| RS54 RL TERLF EONLFHXA SN /NLF DA EESOLERD

NE9,

BT A B EOE T A=/ S AT— R85 A—RDAE B

2BRRBRE V=7 AT v Tld, AV T HFAMAZ2— % LTE T AV B SUPE T A—

WDNRAT— KRS A—REHIEER TEET,

BT A—IWBLVE T A—IWVDNRAT— RS A—REER T 22E . IRDa~v>y FEFEITLE

T

1. 2B BB/ NV —T AT w7 T AT YT TTARTA 3( V22U L &7

AT w7 TT AR & £9,
2. BI¥IEIVvo(ER)LET .
3. [BF A W]R v ATE T A—VT7 FLAZER L. A 7V ET,

v P
= Email Two-factor authentication {@email.com
Step
Arguments
* Email: T L
. ) Cut Text Ctrl+x
Server:
. 2000 Copy Text Ctrl+C
Sener Port Paste Text Ctrl+V
TLS: Default {true
* Pagssword: ssssssss | Lreate Mew Para@er From Selection...
* jon: /0
Regular Expression: | f0d+)/g Replace Selection With Parameter 4

4. [Create New Parameter From Selection...(i2 R 5> 68 L1y /35 A—R%&4E )] 212 4R

L&d.
[NIA=RZ DN KA Tl Ry A0 & &7
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5. [/8FA—&LZ| K v/ Alltwofa_email EN F1 L. [OK] 22V v 2L £7 .

6. [NAT— KRR yIATRAT— &R L. A 7VvoLE9

Enter Parameter Name

Parameter Name twofa_email| |
Original Value

If the parameter name you use does not already
exist, it will be added as a type 'File' and the
Original Value will be setto ' {@email.com'.

OK Cancel

BE! RASARELTCERLFUNLERX P SN N L FDAEAES UL ERD

D&Y,

7. [Create New Parameter From Selection...(i& R 2> 587 L1y /85 x— K %&{E B )] £1E IR

L&d.

[NIA=RZ DN KA Tl Ry A0 & &7

8. [/NFA—&L A v AlZtwofa_emailpassword EN 71 L. [OK]Z 27 Vv 2L &9

F7v 27 MBI 4+ B AT v 5] $

TruClientCid . B Bl M S e A7y =2 M E 4 2R O AT w7 B B 41l T %
T,

"A—T AAOEE" K DA

"T IO E " IR D=
"Fry IR v ADE E" X—293
"H AT R O E" K—293

"E R O H|" KN—v293

"Z 7V 7 A E" XN—3298
"Flash#4 7Y =7 FOP " X—3298
"7 r—HAN] e 1 E" X—298
"YR bRy 7 2D " X—3299
"Multi_listbox D% #|" X—3299
"SUX T N—7 DHLE" K—2300
"2 ZA XD E" X—2300
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o« "FER K I ADHE]" K—2301
o "EFAORE" X—301

F—7F 44 D% E

WORGE AT AAKEN AT 27 bNDY—0T7 02 2 DAT w7 B OWTEH LT &
9,

By b WEBI B 22— A > R7 =205 B L DL AR VR TR SN &d. X
TD5| ¥ 14 JavaScript 2— P8 L UTruClientié it 218 L T 5l T 22 ENTE£T,

5 % A
Ry F—F A OB O B (FP) 25K E £721308 L&,
7 5 D% E|

DR 77O E A7 27 M § 227 975 B HOWTEL LT &1,

B b BHGI B 2 A X7 ADF| H L OLE M OCE TR S &3, X
TD5| # & JavaScript 2— N8 L UTruClienti it 218 &L T i T 32 ENTEET,

777474
DR T I27 47T 73 D AT v7 5 B OWTERB LT &1,
5] #t i B
FH mEreLcER SN ET.
X4 P NFHELTER SN ET,
W A DV ST CHBICE B S B A7 o7 el T
RETEET,
[7 77 4747
WORE [T 2T 47WET T 2y s DAT v7 5 B DL T LTw &,
5 ¥ i B
T TIFA7WN T BT () EIRE LET.
24 v VY ELTER SN ET.
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5l % B
W A VRSP H B CE R S B AT v LT
RETEES,

[FH L 3]sx7

WKDRIE[FALBETT 0y DAT w75 B OB TR LT £,

5 % B

T P37 feE L&d.

24 by RE LT Z0 T4y RO 7477 77 BB L& . L5

ELTERE SN T,
W 2 MVEER ST CHEBIRCE T sh. RE X7 v7¢L T

RETEEY,

[E n) &7

WORIE[BINETT 72 2D AT w75 FC OO T LT E T,

GIE wt B

% B LB w27 B B DURLEE € L&,

74¥ K T7Vr—y 2207 a—/ V74 RuA7 Y 27 b efg LET
¥E: window.location4 7Y =7 M . Internet Explorer Tl f#
HT&ithi. X 0iZdocument . URLAT Y =2 paffi FH L TK
1230,

¥ &)

WORG BT 72 DAT 75 OO LT Ed.

5 # . B

BAT . % E) ODURLEYR & L &7,
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)

WOFE[JR BT 7y aDAT v7 5 B ODOTEH LT &S,

5| ¥ i B

ATV b RAEXN—UH 2R ELFT,

1 &

WORE [T 2y DAT 7G| B OWTHP LT &7,

51 ¥ B

ATV b HEOR—VH ERE LET,

DA R

WDRIE[VFAR]T 73 2 DAT w7 B OB TEH I LTWL &9,

5l % B

& HLOEZEE LET. COMAETHDEEIT 5L BOY AU
THEINLVLEOLITEIR L NET,

=K Lo SERELLET. COMEFHDEXICT 2, & SO A
RIFAETH SN OB EV IR R ICH VET,

A 7a—)v

WO A2a—T7 oy aDAT 75 FIZOHWTE ] LTw 7.

51 ¥ B

XPE TR HLUOXEEEZR LET. TEHDEFICT 26 XTI >TAZ7u—
WLGWIEEmEK LET.

Y AR HLOYHBIE 2R LET. COMEZTEADE LT 2L, yHlcH -

TAZ7a—)L LW EEER L ET,
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A 70l - R
MOFRG[KAT70l - MR T 72 2 DAT v7 5 B OO THH LTwET,

5 ¥ i B

0 % [OK] 721 [F v> &V ]ER LET.

XA T7as7ar7
WORIE, ZAT7as 707 v 72y avDAT 75 HICOWTEHBH LTwL T,
5 $t i B

18 AT 2LFH %R LET.

HRY [OK] &/2d[F v n]am LET.

A7l -
WOFE.[FA 70l -7 7y 2D AT 975 F OO TEH LTwET,

5 B i B

2—4 AT 22—FZ #EELET.
SRAT—F AT 2B/ RAT7—FERE LET.
P AT BRA 58 ELET,
g 0% [OK] &/2d[F v en]aem LET.

LA 707 - NAT— RO R
RDR G [KAT 0T - RAT—ROWMER] 7 7 s> D AT w75 B DOOTEHH LT &9,

5] ¥ i B
RAT—F AT B 27— E LLT.
g % [OK] &/2d[F v n]aem LET.
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#20: v /oy AL H OWeb~v 7oL 3—47.1

T3 AL

MOFRERGE]T 72 2D AT w7 B B OO T LTh T,

5 B i B

& MGE 4 27 037 4D 278 LET S

7'anT 4 WAL 427 0 74218 E LET . 7979472 27 MR D7 0k
TAEMGE T&E LT,
o« R MV-TFTH T4 RTDRA MUETRE LET.
o« BT - 75U T FUDIG T 1R E LET .

M il &7/ 87 D5 [ OBAR 245 2 L& 7.

F v R v ADI E

WOFRE FrolR ol AEENATY 20 NOBRE T 7 2D AT w75 B DOWTE I LT
WET,

By b MEBI B 22— A > R7 =205 B L DL AR VR TR SN &d. X
TD5| ¥ & JavaScript 2— N8 L UTruClientié it 218 L T3k T 22 ENTE£T,

3 B
* Fry /R v A% A (true) £121d A F(false) ik & L £ .

H A 28 3R O )

ROFR & BAEIREE A7 =7 CNO[EAT DR R 7 7 2D AT 975 Fiz D THL B
LTW&ET,

EY M LA G 2— AV RT7—ADG| % DL WE TR 3N F4., X
TD5| % idJavaScript 2— N8 L UTruClienti it 21l L T3 T 32 ENTEET,

5 ¥ it B
i H BHARLFT. [HIE1~3108H T3,
55 25 0% E|

WOFRG.EEOKE AT 2/ M E T 227 975 OO T LTw 1.
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By b ZEGI IS 2= A X7 2= ADF] A4 DR R TR S Ed. T

TO5| ¥ 14 JavaScript 2— P8 L UTruClientt At 218 L T3k T 22N TE£T,

<7 A

WODRE, vTART Y, STAT YT YTAF——, 72U, BLUVEKTIW IV ID& T o
L DAT 7B I OWTERR LTw &9,

VE: v URA—AN—IZIEXIYEE S| B A Eh 2 H A

5 ¥ B
AR TV BT AR EH A L9,
X FE F7T 2 NOKE FM R LT 7y D4 7 v M B Ei#
MLET.HELEWES . F 700 M A7 Y 22 bOHF Y1220
F9.
Y R A F7 2 MO FRE AR LT 7Y D4 Ty MY B Fik
MLET.HBELAVWES .. 7T 700 NI AT Y 22 FOF gLz 0
EQc
[Ctrl]+— 7oy P IDF—EM T 0E M ERLET,
[Alt] ¥ — 7oy I IOF—EM T hEmER LET,
[Shift] ¥ — 7oy DR T I ER LET,
N4
WODFNE[FF9717 7y 2 DAT w75 OB T LT ET.
5 ¥ B
Vi 9 TV BT ARXEH A L9,
XA 7€ vk il b CATY 2o b NS/ A2 DE R LET . IEDH

A AND RS R LET,

YA7€ vk yiith b CA7Y 22 b RS9/ T 520V DR %8 LET . IE D3
. RS8RV ER LET,

XA 2—HDRIYI NRRAERTHIEDVA MR E LET. CO5] i
AEE LW T2 E0n,

[Ctrl] % — 7oy PR IOF—E M T 0EIMERLET,
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5] ¥ i B
[Alt] £— 7oy I IDF—EM T 0EMERLET,
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EndnEd,

Pt 27 o7 %N T 212 IROFIEHEETLET,

1. [TruClient] 1 KA—T. [R7 v DI 74 2( @ Step )5 297 L £,
[R7 971K v A0 & 5.

2. [V oL ET.

3. AT v AT 2o NOBEHEAT v E Yy LT BLERE S c AT v OH
[ DG T C RS9 LET .

4. A7V 20 MO AT v BN LIS G [2Vy2LTATY =2 MERIR) U £ %0
RLUC T7Vr—y v DE—7 9y - A7 227 MBI L &7

~7aDT /N

INASDRAIER LT, v /& T N/ T 52ENTEET.
o "HAELITORR" KON

o "vI/ODEATFIHE" IR DR—Y

o "TL—URA Y D" IR DR—Y

o "AT v L NYVDAEFH" XR—U 311

o "Fifk AT v D" I

o "AT v7 DI NG B X—312

o« "AT VT EFTY 2T B" N—312

o "7 v7 DEF A" X—312

o "AT I o7 radE O NETHAE T " N—Y313
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VIV H AR
% 20: v /oy A E OWeb~ /oL 2—X7.1

B L 5—0%FK R

HAFRCRKRBLIEAT RO BIGE1E. 25— T4 23 /(a)ll&>Tv—2r8N £7.
T5—OFFA RN T B RO EEEEAT LET .
o I5—T7AIVD LIV ARA T REFSE) LE T
T5—D I AR IR SN 7.
el;i & Wait ¥ Choose an object

Step 8: Wait Choose an object failed - Target object was not found. Reason:
Object not sat

~7nDFEATFIH

AT v NA AT w7 A Tl B AT v 7 DB Il A BN—E Ik 3 2720, >— 7> A% 4D
W oL, avra—L LA NSRBI ENTEET,

Y IOaDAT vINART v7 EFEAIT T BIE IROFNE2FEITLET,

o TruClientt 1 FA—T, [BE]7A 22 v)D P e v7 K7 R %2 Uy oL, [AT v7 734 R
7y7 CHAE]FERLET.
B D(E TG IR DY AT w7 A S, FFRAE 27 1R L &5

B AT 7T DIE CIOFNE 54 IR LT AT w7 A AT w7 CHAE 2T LET,

7L—2rkRA > bOMEH

TVL—R Ay MNE AR I I/oDFEAT EFILET2LAFRR LET. v /nDT N v
AL DT VL—0R AV AR N (12 MWV ANTEE T AT v7 W7 L— 0K A > badii A
Lt v~ 70l 7L — 7R/ A >V bETHAE LT—RKEILLET . COFF & T, TruClient7"5>
PORIICA VAR IR ZIVHH & ET, 2018, 7TL—2FK A Mo~ 7o 4 24047
T&&Fd,

F:Web~/olL a—Ki&, BAER /7B LGS T v—0R 14> bMeEHBIH
BINLET,

TL— KR A > FOHE A

TL—0RA Y b T B IR OEAE 2T W E T,

1. TruClient7’SUH T, 7L —0R AV b’ aFi N T R2AT v 72BN L £7,
2. 7V—U0KRAY D NIWTA (B %27V L ET
TL—U0RA Y MAAT Y7 IBE I &N £7 .
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TL—R A NOH B
TL—oHA Y MBI B0 R DR AE #4T D 1,

1. TruClient7’ >4 T, 7L —2R A b N SN AT 7 B R L E T,
2. 7Vv=U0KRAY D NWTA (B E 7V L ET
TL—0RA Y IR RT 7ol R S £7,

AT w7 L)L DAS B

7712%;6%%@'6&: TruClientit & 7\7 /7° 1MA3DL NV EE| DM T 9, f 21F. v
W LRXWADAT w7 HAT R T s B DR W77 Vr— a/@ﬁﬁiﬁfﬁéiz?éW)/ﬁx
FoZld . LNV2IZEI 0 Toan &4, v TAF—N—RA7 o7 3l . v /ld ANE LR &
S, LNWIIE Y TN 9.
v 70A7 v 7. TruClient 7’573 D LB H 2V — I NN—D AT v 7' LX)V AFA X T L)L
1.2, FRESCHHEINTRE TCRRABLIVOFHAEINIT. R EE VR E X LNL3ITT,
AFGARELRVIERE T 28 LN 2, BLUBTITRNTDRT w7 HBER IR B O A &
NET. AR T2 0O EZ2EHT20ER”D 25 G5 07D VLT H. Thi
SO nDFEAT R H BB BEERDHVET . T 740 Tl AZV7 bLXUIE1IZRR
EINTHET,

B EoTlk. v /a8 Tl R M EDAT w7 DL RV ATFE OB FH LEWGE S 236
NET, EZITHFEDYIAF—N—AT w7 4R RN BLUVFELIWG S 2 ETT,

AT 7 DL EIEEE T2 IROFIEEFEATLET,

1. TruClient# 4 FA—T. R7 v/ 42 H ¥ AT w7 TFART A 3 Va2Vl &
AT V7 TT AR & &7,

2. [RAT Y7V RV Ry K7V RENE 7Yy 7L HIIOL NV EEIR L&,

: T}D Gy e S E I
Change the level of this step exists 2 t until Settings exists
Step | P
Arguments ments
Object Object
Transactions Transactions
r y

BE! 279N N—T AT 97D ThH 255 FV—TAT v7 il * DAT v7"D
W A 2L ERH VLT,

EY b AT v #7—T W B [Crl| F—% Lans 2y /L TIEH D AT v7'%
BIR L. WINDPDRT w7 %G 7V LT [INV—T AT v %7V L &T
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IHHHTH R BEn,

AT w7 DAL

RLER LICAT w7 3N T 28, 7ol IR 0. BRI ICH A c&Ean HBAEES
nNELA

HAEFICI/aRT 7 E ) LB NICT B IROFIEEFEAT LET,

1. TruClientt A NNX—T, A7 w7 8B E § IRAT YT TTARTA 3 V&2 VvrL&d.

AT V7 TT AZHGH &£ T,
2. A7 7 DY A—O[FEFEAF R T 3 (R) 2 7Yy LET,

EY M 12 EDORTFT v RS 123 OE 12T B12iE. CtrlF—%3 Lo hd
57V LTCAT w7 %I L. AT w7 D12%4 7Yy/ LTy AYTF A MAZ2—D[AT v
TEBNCT B EIE[RAT Y7 BT B2V &4,

Y A A WA VA R
WOPDFNEEATY N TEET AT DAT Y7 E . ZDOATY 27 MR, D) 645 0
LA HER AT TEN T,
AT T HEATY AT B IRDOFNE 24T LT,
1. TruClientt o NNX—T, A7 w7 8B H § IRAT YT TTARTA 3 V&2 VvrL&d.

AT 97 IF AR & £
2. AT y7 VW A—D[RT v7 ATV S ELTREIT A /(@) 8 7 Vv L&

EY M AT EHUATY LB WG EE TAaVvEHRE 2y L ET .

AT w7 DR

HEDAT w7 H#HAE LT AT V7 IRLER SN Ie T VT AT A% B T&E T,

1 DD AT w7 5FEAT T 212 IROEVE 24T Wi,

1. TruClient f NNX—T, A7 v7 42 H ¢ AT YT LT AXT7 A 2( VeV LT,

AT 7 TT ARG & &7,
2. AT 7Y NA—D[ZDART vy DEBE]TA > E) &7V /L ET .

Micro Focus Fortify Weblnspect (22.2.0) N—312/379



=LA R
=20 v ouryy Ui E OWeb~ /7oL 0—XK7.1

AT w7 e~ r7udD& b NEFTHAE T35

FfE D AT v7 CHA IR L. v /D8 & THA 4500 21208 . IR O#AE 25217 L &
R

1. HAEZHIE T2RAT7T w7 28R L &7,
2. AT v7EE 2VyI L. AV TFAMAZ 2—D[ZDAT 7 6B EZER L LT,

SEEN = H 73

A7 =7 Nk ) ) 7 ODfg ik

) 2WebY A Tl BCEE SN ATV 27 MNE Z DG & a7 oY EBE) F1203 %
G BRIENTEET. A7 27 O & Web 2077 V75— 3Dt bf ElA B 3
BKOMBEDIDTT., N sDHA OB ZEE LD, ~7aih4 7Y 27 MO R 125k
T B[ EetERDHVES .

Web~ 7oL a—X2ld . #7227 b5 O AT v7 N OWRAR R . A7 =7 MBI OBt
B EBR. BIVHEBATY I M T v b COME SR T 272005 0 AH=X
LDE ENTHET I 6DAT Y a2 3212 77 0Vr—y s> TAZ Y =7 hEiE R
TRALERDNEST, STAA—N—R TR Y I E ATV 27 MR T B0 77
3 2 CEESE LTIy 2 2154 & <CtrI>+<Alt>+<F4> 47> av g L
T AT 2 MR N ENBETCAHTY 27 NEIR T— FE—HfZ 1k L. B
<CtrI>+<Alt>+<F4> 521 L A7 =/ MR IR T & £ 7,

T4V RELER SN2 TN —y DA T 27 b T 25 E kL [T4Y R &7 &
FALTIE LW 4 RUIRIRN SN TH B EAER LET.

TEOOTNNERIT LI, ETERMLEED AT v 12284 L, IRicv7os i
REALET. SR &0, 54 LR BE VS 00 & o TR TR S 12 E D %M EE T & &
ER

WD NEwITUE A7 =7 MR O B 2R § 25 D0 T L4,

o "7V 2y bR FR IR IX DRA—Y

o "ATY 2l Nl DEE" IR DR—Y

o "RE& X7 v O H" RDR—Y

o ATV 22 N T i OLE H " X—316

o« "vrORA T OEE" A—317

o« "MhDATY 2/ MODATY 27 ORI A} 1" X—318

o "7V 2/ bDHE & 2" N—Y319
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VIV A AR
220: v/nxy Y A OWebv 7oL 3—XK7.1

A EYANOG: N

AT v7 CLARNCE IR LIcA TS =7 MG S D1 R 3R § 2121 IROFIH 252
ITLET,
1. TruClientt { RN—T, A7 w7 5 H T 2ATYITT ARTA 3 V&7V L &F .
AT w7 TT A& & & T,
2. [A7Y I NEZ V(BRI L &F.
3. BHEAEBRIZZVILT. 7T7Vr—y s N DAY =7 MEH I L &5
F7Y 20 M, OB e — IR v A TR R R SN &7,
ATY 27 MR OMBH VI E I T Ay — VU NR IR SN LT . FFAIIC DO T,
["A72 =7 Nl O E" R 1S 8 L T80,

EY M COZS—IE. R OTH BRIV 7O BE., £/23 472 27 MR DU H
FTIELOWAR—UARAER R ENTOLEVWIEER LTWRA e RHNET,

FAEYAS ViIOBEE

F7°Y 27 MR PR IR KM LIS & A7 =7 N OMGE RS 265 LTx—7 v
ATV 27 NERIEIRTE LT,

AT 2 NEFIERIR T 200 IROFIE#EAT L ET .

1. R LEAT v DAT v7 27 4K CL [ID AV v K| 74—V OB 12 H B[A 7Y =27 Nl 7]
DRE]7 A 3(®) 27V L ET,
Web~v /oL 3—Xi&, A7 =7 NO7' a7 4&F 2 H L, iU e E Licy a7+«
CHEER L. B S AMIE S I OO T BB AR E AT OCENTEES., 77
r—3 2 OFNAE & oTE s A7Y 27 M OSCE HE GE 248 £ 8 4 200 3
HET,

2. A7 y7EFAE LT B BRIR SOl Em iR L&,

RE 27 7 DfF H

KRB A7 97 Cld. A7 v 7 W CHlRE LG B W R U7 7y 23T T2 50 i 4%
RNRCEET . HJRIBELEIHE LV EHEDODD B~/ 75— AD D, £123 7Ny HW T
AT 7 EE T T&EET .

F2EZUE HAEICESTTFAMB T RVANDATY 325 7)) 2IENTEES., 7
FAMIIEDOTIVIT 28 AT 7R T 256 HHVET. VA M OATY 2 DfF
BICHEDOOTYRA N OIHH 28R 7285 A7 07 2 H 728 7 A MR L 7Yy
IR LET .

RE A7y a2 #fF DAT v EMNARE RAT 97 T4 3 (a0) RIS S ET
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& A7 w7 O~ SEIR

KRB AT v72RRN LCGEIR T2 IROFINFHE & T,

1. RE AT VT TA T Na) B0 Uv0T B8 ZORAT 7 ORE A7 s BE R SN EF .
EY M AT V7 TT AR BTV BAIG A I AT v7’ DY —u/N—IZ[F U7 A a>hdk
NSt A CHERE #EAT LT

2ol b By @ e
#£? Click on Signin button
Step
Arguments
Object

Transactions

RE 277 NER SN FT,

3 & Back

Alternative Steps - Select active step:

#7? Click on Signin button > E
## Select Signin from listbox (1) listbox [ =
£? Select #2 from listbox (1) listbox > E

2. MOWTNMEEITLET,

o 77—y 2 TE AT v ER IR T R NE DL M ICH B[AUTTAZY =2 b
FRPERR|TAIE)E )9 LET

EYMAUTEE . TANMP O 77 Vr—y sk LET,

CHIE AT 27 NOFR R R BT OX—U TELEH LD EfF U A A ME&RE 2
TUs ~20A7 v 7 W T E 1D DIl R n T& B L0 FF 2B RE 26 2 Tw

ES 2N
o 77—y N TRE AT v lA T B RE DM ICH B[BE]TA 2P
YEIVy oL ET

3. MEEIVILTT 77470 LETS

4. AT VT ITARIR DG G R B &7y oL ET
BIR LR BEDORT 7R R SN £7.

5. v/urfHAELTT AN &7,
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VIV A AR

#20: v /oy AL H OWeb~v 7oL 3—47.1

A7y 27 Nl i J7 15 DA B

Web~ 7oL 3—&NATY 27 M il T 27715 #2842k A7 97 TT7 AZD[AT7Y =
I N sy arTAZY =7 Nl J7 15 (DT IR) 228 L& 9.

i FH AT RE 27 ik
W OF &AL T fE % A7 =2 MRBIT OO BI LT &7,

VAN
&

Xpath

JavaScript

Bt B

HE) AV vRiE. T 740 bTH O, HER SN 3472 =7 M3 51T
T, COAY Y NEM 428 Web~v 2oL a—XKIE N OE E 2 7T
VRLEFHH LTAT Y 27 MM ETEET,

EY M EHARCCOTETATY 27 MAIEH ICH O en nig S
& [A7Y 22 MR OB B 7 A 2 (=) & 7Yy L Te/uEH U
A LY.

A7V 27 N B IE A7 27 OME A 2 Lk Tl B
B (R B LT A s XPathai i1 75 v #486 F LCA T2 a0,
COJ %k DOMY V—H D A7y =7 M€ & 3 2XPathal (25 D0
TAZY 27 M LE T AL RER T 3B R & &Y O
MR &R 28R 3 200 E A D 2855 14« XPathi i) 21 H] 3 3 &l
FTH.

EY b XPath ID 05 & =74 a2 B e R OB AR I D
NET. COTATAV%IYvIT BE AV E—TAATATY =27 I %
R L. [ 3 2XPath2/E R T & £9,

DAY yR& . A7 27 b ik §JavaScripta— F2H L &d. 72&2
IX'\ document.getElementById("SearchButton")id SearchButton] &
L IDOM IDJ& % 47 DE R %Ik L £

DAYy REH 38 IR Sz M 24> &SI 4 2JavaScript
I—NEELIR T& &9 . CSSt L 728 LMt OFE #EF& e 211 ] T& %
ER

FEZUE L =3 8iR ShfeR—ac, [6] UTtitle ] J& 1 (B R 45 ) &
FOBEH OV o0 E an T8, A2V MR H AT RE % Vo 2D1 D %
IRy L TIF L EL &7,

CO G OATY =27 Nk & . JavaScriptii 71 77 2 A LT IRk D
LANLNET,
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AV 9 R B

I%lj

var my_results = document.querySelectorAll('a
[title="SearchResult"]");
random(my_results);

BF IF AN DT ONRT AN ETAT Y 27 M A CE LT FEAI DOV T
&« https://admhelp.microfocus.com/tc/ja/2022-2022-
r1/Content/TruClient/descriptors.htm @ TruClientit iR 7 2% i L T <
1230,

A7 27 N 5 ik DIER
M OA7Y =7 NHN TR 28I T 212 IROTT IR EFATLES

1.

w

TruClient4{ NNN—T, A7 v7 2B E § BAT YT ITFARTA 2 Ve Uy L &ET .

AT w7 TT AZMG &&F .

(A7 =7 NE 7V o(RB)LET .

[IDF¥E] o v R YR M S5 D)5 1% #1847 L &7 .

WOFNEHE N ET .

c [BEE)ZER LIGE . FIHEET T,

o XPath £ L1354 | [IDJ7 L] YA MOR OXPath7 F A bR v 7 AL 3— A=y |
MF RSN ET. LB CTL [XPath] 7 F R bR v 7 ZADRE (CH B Fa vy 7' K7 VR
B &27YyoL, 7Y 27 FOHESREXPath 3 — F&IER L £

kB> b XPath7 ¥ & bR w2 2045l (2 b B[HRE] 71 AP ) e 7V od B &,
XPath T7 4 &4\Bf &. #fE32 S 2XPath 23— P4 £ T & £,

« JavaScript#iE R L/ & [IDJ7 £ VA O DJavaScript 7 F A bR w7 A a— K
A=y MR IR SN E 4. U B 125 LT [JavaSeript] 7 ¥ A bR v 2 2040 H B
4171 24 )% 2 Vv L. JavaScript=7 1 & %5 &. #E 3% &h 2JavaScripta— K
ERELET.

o RFIZFERLIAGE . [IDFIE]YA MDD TR DFt iR T 7F A bR v ANE IR
SNET. A7V MORLIR F 6 2E R T 200 [T 3/ )22 Vv oL &

T . #EAH I DV T . https://admhelp.microfocus.com/tc/ja/2022-2022-
r1/Content/TruClient/descriptors.htm @ TruClientit i& 7 & B L T 280,

A= S NS0k Nl

24

T BSCFAIA O E A7 27 MR D065 WG G BH V&S . Bl 2L v 7anT

TNVr—y W IZHBEATS 27 bEE L THBDI., 270D B A 253 & T, ¢ TI2p o
R—=VWZHEATHWBRIGELETT A7 £ERIBOME TA7Y 27 bH D a1
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=LA R
=20 v ouryy Ui E OWeb~ /7oL 0—XK7.1

ER LN G E AT 7 EFANTCEET. A LT T 27 o7 o5 "
N—o309] #Z W L T2 30,

M OATY 27 MODATY 27 NOB HE AT U

o DATy s TAZY =7 M O EARIR L WG & . [BEA7Y =22 NA 7Y 3~
P LTA T &0,

AT 27 NEM B ] T 200 L < o A i RO L 0B DR WATY 27 M
HOWTAT Y 2 MIFNNAT T TCEET. 12828 B TR R WATY =7 bEIEIR L.
Z— b A7 27 M AT F 2] e TEFT. ABREHRENCER Sh. o477
Yzl MO (E2 R VAN >TATY =2 b AT U 5. R E . A7V 22 b
TEZIDAY YR EZE R SN T EDATY 27 FDID XV v Nizxt LT 3 O 15 A3
EBINTVWBEES . ATy 7 4Bl T 212 [l 57 O IA TR UAZY 27 MR DO 20
EnbHnEd,

COKkRE AFH 72101 IRDavy FEETLET,

1. R LIEAT Y7 DRAT v 7' TF ARXC (A7 22 NE IV /(B L &9,
2. [BEATY I NEs V(B &S,
MR 7—7 W oR Sh &7,
Related Objects (0)

+

Anchor Hame Roles

Select Add to add & new relation

3. B LVBBEEBMIZA 2 ()22 L &7
[BE A7y =7 bOIB N7 4> RURR IR S ET,
4. HTH QBRI >THBFEEER LT,
Ty A—F7Y 2 M A 7Y 27 N7 —7 B I S £9.

Related Objects (1)

+ 7w RFE &

Anchor Hame Roles

Forgot your password ? link, focusable, element
(w7

[B A7Y 2/ NATZ'Y av 2E ] § 255 6 & IRD Y MIHRE T &0,

o VW—ADEMMBE WIS NHVETDT. COMERE L fth OB 71k NKE LI5S
DA LT &0,

o RI73—vrA%N b S8 312F. /MR RAE 2F H L TEsn,

o ATV I ME VAV R ARUMMAE LET YAREEH 38, 72 27 bOf
BB DG ENDHVET, INEEEICAN TS0,
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o ZE 3 51 (E B . XPath, JavaScript. 8 & UGCIA F) ik B 4 2472 27 bOJH
HOty MHET, CHLADOBEATY 27 ME B TR cirdtF sh ¢ A.

o WEBOBBRIMFIE S 2356 Wil 2T ¥ 2720128 $NTORR 2hr th 3 240
EHRdHnEd.

P VADEVANON- -3

FLEE TR IE ofe AT 2 bEIBIR LI & 13472 27 MK G T ShTw
BIGE G ATy EBE &SR Z B DAT Y 2 MCE SR Z BTN TEEL T, I
O TCDRT v WM 21228 B(BR 2 &) 2HIBR L. A7 o7 & R c Ve v hC& T,

[B# ATy a2 328 HIE AT 7 TSR SN THEAT7 Y 27 MOIE L L 2em
~7ulL —KHE R &N T, v /oL a—KiE, A7V 27 M 1 2B E ORIk X TH
B L iBIR LA 7Y 22 b2 LET, LIS >Tl 5Lk P & o247y =227 b T
LG & DA, [BIRATY a2 T 20 ERH VLT,

A7 2 B &R ZBEIROTIEEFET LET,

1. TruClient¥ { FA—T, A7 w7 54 W § 2AT T TFARTA 2 V62 Vv L&,
AT 7 TT A0 &9,

2. [A7Y I NEI V(BB &F.

3. [Vl &9,

4. HiLluAT7Y o7 b EIEIR L LT,

5. vurHAELET,

A% E DR R

7' 7R E &t Al AL A% T 1 TruClient— s 8 TIT L &9

TruClient— k58 e D7 7t A

— R BT VAT B IR EEFEITLET,

1. TruClient¥ A bA—T, [~ E] 71 7)) 27 VyIL £,
TruClient— i 5 74> RUBERIR SN E T,

2. WD LEy/OF B IHE >THE 1T VW T
o "XPEG M ATy M X— 324
o "QEL K NAE" X—325

3. BT 15 2Vyr L Tak i 20k 47 L. TruClient— it e & 74> PP L &7,
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7 TIW R

KOFE[TIVFREBIZTDAT Y 2O T LT &S

R E B

22— IT—Y v p TSI D 22— I—Y = MCFI FIRE LET,

CHTTPA X FortifyWeblnspect&é~ 7o ¥ > 454 ODWeb~v /7oL 2—X
7AW J7 CRIM 4 22— z—v x>y MEE AR C& &
E
KODOYAMEH > 7 WMEZR LTOWET A EETEHNEE
Ao
7 74V b

Mozilla/5.0 (Windows NT 10.0; Win64; x64; rv:71.0)
Gecko/20100101 Firefox/71.0

Internet Explorer 6

Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1;
.NET CLR 1.1.4322)

Internet Explorer 7
Mozilla/4.0 (compatible; MSIE 7.0; Windows NT 5.1)
Internet Explorer 8

Mozilla/4.0 (compatible; MSIE 8.0; Windows NT 5.1;
Trident/4.0; GTB5; .NET CLR 1.1.4322; .NET CLR
2.0.50727; .NET CLR 3.0.04506.648; .NET CLR
3.5.21022; InfoPath.2; .NET CLR 3.0.4506.2152; .NET
CLR 3.5.30729)

Googlebot 2.1

Mozilla/5.0 (compatible; Googlebot/2.1;
+http://www.google.com/bot.html)

Bingbot

Mozilla/5.0 (compatible; bingbot/2.9;
+http://www.bing.com/bingbot.htm)

Yahoo! Slurp

Mozilla/5.0 (compatible; Yahoo! Slurp;
http://help.yahoo.com/help/us/ysearch/slurp)
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VIV AA R

220: v/nxy Y A OWebv 7oL 3—XK7.1

W RE

22— T—yYzr

- F ey =21 &—7 24
A

F—TTIATRALT Y
ME D AR ZR~>A X

— R AV E—F v T A
1%

i B
iPhone. iOS 14.3

Mozilla/5.0 (iPhone; CPU iPhone 0S 14 3 like Mac 0S
X) AppleWebKit/605.1.15 (KHTML, like Gecko)
Version/14.0.2 Mobile/15E148 Safari/604.1
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Yyl ETAIWARAE LIZEG &k D200 v vy 21208 E Fn £,

1O FE DX vy 352074 B2k
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Rt — DR &

Web Proxy 74> RO R &8 cH B3> bo—v e LT, & (View)] 27, B #|
(Split)] X7, &1 15 (Info)] X7 1F 3 SN B Ave—o N O # 4R TE£7.

Ay —Y EM R § I

1. & (Search)] VA b6, BB T 27BN L E7.

2. BRERF—AFoN A v /A BB T 275 A NI G THA MR TERER)EZA
HLET.

3. AT v72TCIEH KRB AN LI A k. IERRB(Regex)] 7 =/ R vo A% 4L
£,

4. BERFind)] 52Vl %7,

E: FRROFHEEN LTFE TRR LAOGTHC L, F 2o 2 TR 2R R

T2V EEM T2 TEET. [MRE MR LEIR" N—U3441 68 FUT"K

E 7
7" XN—v3451 %S B L TS0,

TRTOD At —T D&

TRTCODL vy > THREDHFREZR R TEET,
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TRTD Ay —Y MR T BI2UE:

1. V= —0 BRE e2—01] h& %2 (Toggle Search View)] & s 4% 2y 7L £4(&
1zid R (View)] x=2—»5 BZE (Search)] ZE R L £9).
& zY7(Search Area)] VA rfi I LT, X TD L vy 2 ON Bk 2K 4
20\ HFE DL A MR E LTHRER T2 E LT,
3. BREF—AXSearchFor)] Ry A MR T27FA R TIEHREH 2NN L Z
ER

4. P& (Search)] #/7Vy/L &9
E: LR OFEEZEH LTFH TRELAVCTHEL LU, & Loy 2 THR 2R R

TAL—IWEER TR CEET "R E MR EBHR" X—U344 1 B LUK E: 7
SO X—U3451 #2 HR L T30,

N

F7° 3 DA

Web Proxy 47y s> #4255 ¥ 31214

1. Web Proxy# VA LT 254 5 IROWThh£F4T LET,
o PuFy(Proxy)] x=2—%2YysL. fE1E(Stop)] #iEIR L £,
o« V= A—OB%EZ) v LET .

2. PRE(Edit)]> B E(Settings)] 27 Vy2L. P'oX4—s3(Proxy Servers)] 7%
EIRL &7,
FEANCOWLTE TR e 7o o — " X—o341 1 22 8 L T30,

Web Proxy ® &7

FHTTPE vy ax(1DDE K & 24U IR ¥ 2)0 &) 25 Web Proxy®D L XA > ic—&
RARSINET . Lyy a2 28R § 2 & Web ProxyD | #H XA 22D v a2 § 21
WK RSN ET RN SN BEREBIR T 22700 -TRLVET,

AT —RAN—DFT L WCH2a> bo— B2 H LT 6D X7 TR E D a> 7 > Y 28 &R
T&%7.

% 7~ (View)

BaANView)] 272 LT A T 2HTTP A v —V R R LET. K7H FD FryrK
TR MSER T&EB47Y a3 IR D EB DT,

o v a(Session): T4 K&t v (B R LGB O] ) ER R LET
o 7 774 5 5Web Proxy N\ D 3k (Request from browser to Web Proxy): 7" Z 7+ 23Web
Proxy(Zxl LCTIT ofc B R DA #RIN L &T
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» Web Proxy > 54— 3 \DE 3K (Request to server from Web Proxy): #— 3~ DWeb
ProxyZE K O& #F /R L7

o H—/3m5Web Proxy Dt & (Response from server to Web Proxy): Web Proxy (2
T2 L EDAER R LET

o Web Proxy 567 774 D> & (Response to browser from Web Proxy): 7' w4 (k7
3 2Web Proxy}h % DA 4R/~ LET

7 E (Split)

Br&8(Split)] 27 % 27Uy /LT 12D v SAR2ODER V7 2ER L& . o &zlds 7
SUHI & >TE R SN ZHTTPE K Avt—Y(120 V7)) & H— N & >TE K S iz
HTTPILZRQEFEH DTV 4R R T&ET .

1% # (Info)

B (Info)] 27 %L LC. ZR B T 25 4B IR 2R R L& 3. B CiE B ov ol
TA—LOH . ANVRER . BLUR—=2 D7 0 740 g £7

7 Z 74 (Browser)

PS4 (Browser)] X7% 2V v 2 LTy 750 C74—v v SR R O & 85 L &
¥

Web Proxyxt 7% 8 £— K~

Ayt —\Web Proxy (2 Ji W7k S T8 757 ER &5 — G B 2R N T BRI Xt
M E—rEEH LET. BECend)] #2003 34T Avb— IS8 S ia) U THE 2
A EHA INICED, Ave—V 4R S RTICAEE C& T,

B (Deny)] 22Uy LT Ave—V 09— NER SN WEINTBIELTELT,

Web Proxy#% 5 (Web Proxy Settings)] 71> K7D & #% (General)] &7 %1f H L .
Web Proxy %5 i [ 12X O & He—RefF Ik T& &7

o BER DI

o KIHE DB

o BR XIS BHFE DT F AN, DT AR (R Vv—v & )
Web Proxy>t 55 £ £— FO A x—Y

W DA A= 1& %} 55 B £— FOWeb Proxy 47~ LT &7,
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[ a

E_H Interactive hode EI@

Response To Client:  Saved Data |Original

HTTP/1.1 200 QK -
Date: Mon, 22 Dec 2014 193955 GMT

Server: dpachefz.2.22 (Ubuntu)

Cache-Control: no-cache, max-age=0, must-revalidate, no-store
Content-Language: en-LS

Wary: Accept-Encoding

Content-Type: text/hkml;charset=UTF-3

Viar 1.1 5PI

Prosv-Connection; Keep-alive

Conkent-Length: 14677

m

ZIDOCTYPE bkl =
<html lang="en"=
<head=
<meta charset="utf-3"=
<title =Zero - Account Summary < title =
=meka name="viewpart" conkent="width=device-width, initial-scale=1.0,1
<meka http-equiv="%-Ua-Compatible" content="IE=Edge" =

<link type="text/css" rel="stylesheet" href="{resources css/bookstrap . mir
<link type="text/css" rel="stylesheat" href="{resources css/font-awesonm
<link type="text/css" rel="stylesheet" href="fresourcescss/main.css"f =

<scriph sre="{resources)jsfiquery-1.8.2.min.js" = <fscripk >
<sctipt src="resources s boakskrap, min, j5" = =) scripk =

<script sre="{resources)js/placeholders. min. j5" = </ scripk = -
Fl it [

Save Data Cancel Interactive [ Send ] | Deny

x5 M £— FOF gk

PRI Sl N S NN a TN = &

1. Pofy(Proxy)] A=2—%72Yv7L. {Z1k(Stop)] ZiER L 7.

2. WOOBTNHhEEIT LET.
o PoF(Proxy)] A =2—%2VvsL. kt5EE (Interactive)] ZiE R L 7.
* == g ryysL T,

3. Poxy(Proxy)] »=2—%2YysL. BA%(Start)] Zi#R L L7,

¥¥: Web Proxy 35t 55 B £— FDIG & . P'af ¥ (Proxy)] A=2—0 kiag L
(Interactive)] a~> FOREIZF zvr~— 00 f & M FE R 74 3> DRy 4 "3 fT L

JRBE R 00 7Hav &0 Yy ot 2h, v NERIR T 260 k5 R £— PO A
YEXTBY) VB D VET .
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X 7€ (Settings)
D7 a7 42— b LT, Web Proxy®D 1 > &7 x— 2D &« 7' 0¥ >+ —/ Dil il .
BEUER 123 )55 N OF € DE IR IR 7 2720 DIE R OE R 21T &7

HE: Web Proxy DS AT HH 3R 22 H C& &t A. PoF(Proxy)] A=2—»5 &
1 (Stop)] ZEE4R L. 3% € 22 ¥ L C. Web Proxy #H 8 L £9,

Web Proxy® §% i€ (Settings)] 7' m/37 43— MZlE IRD A7 DDV ET .

o &t (General) (M%z: &= T 125 HH)

7'm¥ > 4—/3(Proxy Servers) (["#% £ : 7 oF o — " L OX—2 | 5 1)
Fi % £ ¥ (Search and Replace) (T"i% i : i 22 LB " XN—2344 1 25 1])
757 (Flag) (Mg : 757" XN—v345] % 1])

6] 38 (Evasions) (" 5 - [ it " X—345] %5 &)

% v b7 — 788 & (Network Authentication) (T4 72 : 4 v b7 — 708 GE" X—2349 | 25
i)

YT A T
B % (General)] 27 (2ld IRDATS av Vv En &4

7'n¥ v YA+ —Di% i€ (Proxy Listener Configuration)

IP7 NLZEF— MES 2N J LET. 7 741 kT Web Proxyld 7 FL 2127.0.0.1 £ —
8080 %1% i L &9 45, W B UCAS T CE &7,

¥E: Web Proxy EWeb 7' 5%+ Ofli 77 T+ [f UIP 7 L R &4 — Nl il 3 206 B 30 0 &
T,

H 7> DA A L DWeb Proxy #jil] D A T 3 2 & JTEE § 212 v—UIP7 FL
ADEEEE T 2L ERNHVET. 7 74V DT FL ATH 3127.0.0.11% . #F 3+ 2 STl
[ TEEtA. COE 27— 2A7—> 2 OREDIPT FL AL E T4, VE— PR
T— 2 CEFDOV— A T—y 57 nx LT TE £,

At #% L% \»(Do Not Record)

COA7y av# ] LT, R € DRA7D 7 74 )L 5Web ProxyiZ & > T & 2D %7 <
EREBR 7V REERLET. I & BB RA71E. TTET 74 bEL TSN S Tw
9. 1220, 20 D KXA 7 (MPEG. PDF 5 £) 64 T& & 3. COH MG, Avbe—Y R
L AEANE T —REHI B L HTTPE K /52 DAT ENvRICHE R 24 TB2ETT.
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%} & T (Interactive)

XFEE T — AT L Cuw 285 4 . Web Proxy 257k OFE %47 45 & 12— R 458 11 256 ]
T&d.

o UIAT U IMHAER EZIET 2

o Y—NDBINE EZIET B

o EM LB V—VE 2T T+ A MR T 2( P57 (Flag)] 47 %14 )

N 047y OWLTN»EEIR LG B (Allow)] R X% 27Y w7 L% » EWeb
Proxyld 1T LE€ A

&2 750 #% (Logging)

0y 77 AOVICELER T RIHH O XA 7 HEIR L, 0l Z7AVERGF T 27 4L 7 M VEFRE L &
ER

LR F12d G & O 8 AR R Lf:i%é“l;t\ Base 64> a—7 47 #fH LTT—R%E%

BLCo/RiRT 5o Eb IR TELT . TR WS G RO/ A V7 =K1 4=
Flash 7 71 V7% E) 2V Fh T 335 LJE%JT@“

o HDER LiE. 254 T ~rAWeb ProxyiZik g S 3HTTP Ayt —Y 498 L &4

o AZTH A% R &L Web Proxy 64— N2k fF SN ZHTTP Ayt —Y %4 L& § .

o L ODIGE LE . H—/3hAWeb ProxyZik 5 S BHTTP A vt —Y 548 L £ 7,

o AETHAB G Lk Web Proxy 7362754 7> M G SN BAHTTP Xy —v %1 L £ 7

= & % HTTPf# #T (Advanced HTTP Parsing)

i EA EDWebR—2 i 330 F £y M7 I7F M 68 2B RO s T g
T, COFE N IE HTML R+ 2 x> h\OHEAD + 73 2> @Content-Type)ts & ™\ vX( & 7zid
HTTP-EQUIV/JE 14 2%F DMETAXZ) 2 LTIT b &d. L F 2y b7 7> AL T

WA —YH (ZWeb Proxy Tff FH 9§ NEXL F v M4E € T&E T,

BRE: 7 oF i H—AN

DT Y7 %F H LT Web Proxyll & >Tv—7 4> 7 S 29 X TOE R 2iE I § 21DL
LFo7axey—n"E2EMLE&T. LB 2EHOH— N ’/\ﬁﬂl?‘éc‘ﬁﬁﬂj ORI D L <%
i Ny A= MR NAREN > AT L& L& DL TE AT RE T D & 277 % 2B L Cu
EQ A

B O7ax o — " %fi ] 4 3154 . Web Proxyld B3k 2T 57> Fobey | CALEE L £9
(D% 0. Web Proxy!d i #] DE K 25 ¥] D4 — NMZiE(E L. 2% H OE R 1E2% H 04—
NEE T 20 ol A&7 af o — "D YR MEERALEE L E4).

TaX YN T T /AT BIP7 L AEIRE T3 TCEET,
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7'a¥ 4 —/3NDIE N
Web Proxy B sk O)v—7 4> 7 Ot &4 27 0% o4 — B 1 ¥ 242

1. P'oF¥> 7 FL A(Proxy Address)] & v27 ZiZ. Web Proxy % >k #)v—7 1> 7 3 ZFF 12
BHTE2H—DIP7 FLAEANTILET.

2. P'mxyR— MProxy Port)] X v/ ATHA—MES 282 LET,
3. Ve O (Proxy Type)] YA bh A7 0% o OFf K (15 4 . SOCKS4. 721k

SOCKS5) #I# R L £ .

4. BIT O LT, B L(None)]. EEj(Auto)]. Kerberos]. NTLM]. 721 &
7 (Basic)] ## R L £ 7.

1 Fl 4 208 58 2R B 235 4 1d . B B (Auto)] #3%4R L £ 9. Web Proxyld NTLMZZ
AE LA 3R AE O U7 23T L &7

5. COH—N\TRRAL DL E 2354 1. B—¥ 4 (Username)] K v/ & PRRAT—F
(Password)] + v 7 22 ﬁ%i‘%f WENSLET,

6. BIMAdd)] 227Vyrd 28 2OH—ARNEI SN, [EHTRE L7 0F 94—
(Available Proxy Servers)] VA MZIP 7 FL ARFK R SN &6

Z'a¥ o —1DAR— |
7 aF Y —DVA N A Vv — T B2

1. Ef‘/rF— Mimport)] 2 7Vv 7L £9 .

RO T ANIBIRKA 70 Ry A% EH LT, 7 axs 34— D VA MF
Delimited Text 7 7{ )L #1# R L £ 7

3. B {Open)]x2VUvsL&7d,

TaF I EREEC 7 AANVEIROER T 2L ERHNET.

o BATWIDDL a—FREF B, ZOBCF YoV VEA—V B LUVKRAIT X F 545 F £7 .
e LI—FHNDE 74—V NigtIaa> XY NET.

» 74—V NI, address;port;proxytype;username;password;authenticationtype DJIH (2 %
N9,

o WG ENAT—REATY TT . RELHERME 2 H Lawg &, 7L —A%
WEELT2DODE aar 25 20 ERHNET.
1l -

128.121.4.5;8080;Standard;magician;abracadabra;NTLM
127.153.0.3;80;socks4; ;None
128.121.6.9;443;socks5;myname;mypassword;None
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7'aF o — D4 B

7'aF S H—ND VR M E T BT

1. [ER 88 %7 2% > +—/3(Available Proxy Servers)] VA h 54— &€ L £
ED

2. pP'eFr 7 L A(Proxy Address)] . P'e¥ > 4A— MProxy Port)]. Pofsy (7
(Proxy Type)]. E—## (Username)]. &7zi& PXA7— K(Password)] ® 2> ho—)v
RSN AERELTE LET.

3. E#(Update)] #2VvrL &7,

7'aF >4 — D

DA b 67 0% 4 — N EH] i $ 211

1. [ER T Bk &7 0% 4— 3(Available Proxy Servers)] YA hh 54— 3518 4R L &
o

2. BiBx(Remove)l #/UyrL &7,
3. BEw(Yes)]#27Uys LT, HIk: #EwE LT,

7'a¥ o —/ND/NA RN R

K E OURL(K B 7 A A b O)NDT 72 A7 BF L H—" 5§ ] § 20 A5 0G4
& PoFs04/52YR NBypass Proxy List)] TU7T1DLL L DK 2 ~afEE T& 4
THFE DY A MNIT 72 AT BT oo — 2/ (/2T 51214

1. BmAdd)] z2Vyr7L &7,
Pro® > @A /3 Z(Bypass Proxy)] X4 70/ K v AR IR SN &7,
2. NAAZF ZHTTPURLDH A M4 #N 1 L £
70k au(http:/ Ze )& B2 DT E &,
F2EZ1E8 . COURLD 7 o v H— 3534 K27 B35 &
http://zero.webappsecurity.com/Page.html
COXLFHENTILET
zero.webappsecurity.com
I COLFH ENTILET
zero.*
HEIIP7RLAEN ] T32E8TEE9 . Web Proxyld & 2 1 %2IP 7 L A fi#E IR
LAEWCEFERE LTS, DEN IPT RL A%HEE L. 2 OHTTPE R (CFE R 12
ZOHAE DIPT FLAHE L4 T 25515 . Web Proxyld 2O A bO7 0 o 4—
NWaENANRALET . L L HTTPE R (CHF Eh T 2048 df8 € LEIP7 KL
AHRIR SN BH A MG TH 254 (KA ML 638 2 L W 9) Web Proxyld 5 &
Gr &7 oo —/NCER #EE LET.

3. OK]z7VvIL &9,
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7 KL ADH B

Pro¥ s dA (38R YR MBypass Proxy List)] 72567 FL Z%H| & 4 212id. 7 FL ZA%IE R
LT BHIBk(Remove)] #2VyoL &7,

AXE R CE B

CORTHEH LT HTTP Ay —Y N DFF A MR E AR BLUOE R T 20—V %1{E

RLET. COMERE L. B DY IaL—y 22 H B AT -0 OIEF IR 2V —L %

R LEFT RSN ZHBRERDEBNTT,

o YR RNAAT— N EDHE T —LDT A

o BHRADZyF—DIE N

o AcceptBE R NvX 74— )L FEETE LT G THR SNBAT AT A7 #BIN £121& Hl
42

o BRURINDEE #/70RY A NAZVT T4V 7B ICEHR T2

7 ¥ X MO R LH
BER FLEIGEDTFAMNERER LTCHE &R 2 3120

BinAdd)] 270y 7L &9,
Web Proxy(Z & o CT7—7WIZT 74V hO T MNUDMERL S £9.
> D R 74— N(Search Field)] %) # 2 Vy 7L £,
3. PRI RN 27Vv /LT RER T2 A0—Y T Y7 4R L &7
l/]‘ﬁ;i?7"*-*5Z(Search For)] 4 1o MR + 27 —K(&rd 77— 25K TIEHEH) 2N T
5. B#7—%Replace With)] 5. H.O»-olc7 —%458 & 2 57— 25N 1 LT,
6. MENL—IWEBIMTIER T B AT v71-5%4 DR L &7,

FRNIGZENLV—NVERRF SN TOREF CIEXRER SN &4, &L H2L—uh
HTTPS#SSLICZE B L. 2018 (2%t UV—IVMSSLASECURECZS § 4 285 & & &5 1 1
WHTTPS/ASECUREIZAS B & £,

R EBER DL —ViE . Web Proxy s 65— Nk 5 S BE R Ayt —Y B LU
Web Proxy 767 774 1CIE (G SN BIG 8 Ave— Wkt LTRIT SN Ed. FR
(Info)] #7 #1E R 3 27>, R~ (View)] 27 £7-1& §3#](Split)] K7 ##E IR L. 27D
HRMNZHDZRayZ XTI YR MR DOT IR LT LB S iz Avbe— 21
WMTEET

o 13K :WebProxy ->+4—/3(Request: WebProxy -> Server)

o &% 7 774 <- WebProxy (Response: Browser <- WebProxy)

e L v z3(Session)

—

N

B
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—IL DY 5
IV EHI B 4 2

1. HIBR 20— %EiRIR L ET,
2. HIBR(Remove)] £2Vv/L &4 .

JL—IL D4 &

VIV EHREE T BT

1. & 74— B(Search Field)] 5. & 7—X(Search for)] %l . £1zl&d BE#®7—X
(Replace with)] 5| D> M%7 Uy 7L & .

2. TRERHE L&Y,

L—)L DM % Ak
IV EHI BT R T B

1. BAON)] F=vrF vr 25207 LET,
2. OK]#2YUvsL &+,

WE: 757
BERBIVIGE Avb—VDIVTER R LT B E LT — XM R BLUEH LR TE &
ERD

1. BinAdd)]%2VysL£5.
Web Proxy(Z & > C7 =727 74V hO T MUBME RS s £5.

> MO R 74—V N(Search Field)] %] # 27V v/ L 7.

FRyZ ROV R E 7Yy L TR R T2 A=Y YT HIER L £

fR&E (Search) |4 ic. MR § 27— K& 7 —2&RTIEREBEHFEN I LET.
> D PZ7(Flag)] sl #2Vy oL 9.

NOyZ K7V RED &7V LT 7 —RER AR R T 20 Do &) 28R L &
ER
7. MEL—VEB I TER T 3 A7 v71-6%4: DR L &7,

o0k Wb

S =l 1B i:
[l Sl RANFEH S AT Ly B=K A=T 7 7747 74—, 07 /8=, F1IEHTTPE

RKEZAOVIUEE LT AT LEBE SR i Ld ST 27 /31 %[ 3 272012Web
Proxy2ME ] 4 281 3. BH . S s 7OV REER O 2 L. BEDH 28
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BEIE AT A F 2T 4D 25 2R TTE L IZRRE LET. Ch6DFE L
DR S e BERIETES sh &9,

B R EE 4 272010 Web Proxyld HTTPEE SR 28 B L T 7OV &AM R ¢ 28 4 &7 W
FELETH 20— T A=V B — N >TUH SN 2004 B S 255 L &
1. £H53A. Web ProxysMifi ] 28 #7 3 L L LRI T 38R D&t A . BT E 1X.
B OF S 248 % I £ T A o T M PLFIE 28 A A & £9.

ER! COMREE.RATAN—VELTHER §52%2H ML Tw &7, Fortify
Weblnspect T/ 55 PE ¥ Al AF v> 2R AT T 285G & COY—v e LIvE Rl
2L WT 2 &0,

[0l 36 28 2N B IROFME HE WL E9,

1. [El# %5 %23 3(Enable Evasions)] #E# R L £ 7,
2. MOy av Tl 42 4& 2. 120, L DnlkE 75k 2R L £7

Ay RD— 5]

Web Proxy(d . GET XV v F#HEADIZE &R 2 £9. Chik. GET TR £ 28 & 2 &R
TB7 N REBNICL & HET Bk A T

F2 218 T ITHIEIR D Ayt — #Web Proxy (2% {5 L 7,

GET http://www.microsoft.com/secretfile.txt HTTP/1.1

Web Proxyld . X D Avt— &4 — i fE LET.

HEAD http://www.microsoft.com/secretfile.txt HTTP/1.1

URLZ > a—F 4>/

Web Proxy!d URLPY DL F % 1ISO-8859-13L “F £ v M DL FE I s T 2. [%1 &
ZAzHt QODIGHE L F ] L &7,

F2eZUE . 7 STHIEIR D A vk — #Web Proxy (3615 L £7,

GET http://zero.webappsecurity.com/cgi-bin/filename.cgi HTTP/1.1

Web Proxyid . X D Avt—Y &4 — i E LET.

GET %21%63%67%69%2d%62%69%6e%21%66%69%6C%65%6€%61%6d%65%2e%63%67%69
HTTP/1.1
Host: zero.webappsecurity.com

73 AW 4 &L Tl egi-bing 28R 935 A [ %63%67%69%2d%62%69%6€e | &> 9
LFH E—HLawDT ERGIESR Sh €A

. E DA 3 vy o

Web Proxyld . & 25y 2(N\ 2~ E D ATy a(l)ZWEHR L 7.

feeZUE N 77 IEIR D Avt—Y #Web ProxylZis 5 L 9.

GET http://www.microsoft.com/en/us/secrets.aspx HTTP/1.1
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Web Proxyld X D Ayt — &4 —/NZiEfE LT

GET //en//us//secrets.aspx HTTP/1.1
Host: www.microsoft.com

7 ADVE 4 LT secrets.aspx] #1& 315 & . [l/secrets.aspx] &u> L F Fl] &—
BLALOT, EREIET SN EEA.

U N A 1

CODJ5 % Tld . Te DE R LR S5 O 7 4L 2 PINDS AN § 2 2LT R EDY
VR §RER ERE LS OLLET.

J2 8208 7 5THIEIR D Ayt — 5Web Proxy (2% 5 L £4 .

GET http://www.TargetSite.com/cgi-bin/some.cgi HTTP/1.1

Web Proxyld . X D Ayt — &4 —/NZIEfE LT

GET /d/../cgi-bin/d/../some.cgi HTTP/1.1 [which equates to GET/cgi-

bin/some.cgi]
Host: www.TargetSite.com

HOZ® 7 4L 27bY

Web Proxyld« # 7 4L 2 M U(.J) ALY N AL 2 MU DR FD 208 LT R 24 5
tLEd.

F2 218 7 STHFIEIR D A vk — #Web Proxy (3615 L £7,

GET http://www.TargetSite.com/cgi-bin/phf HTTP/1.1

Web Proxyid . X D Avt—Y &4 — i E LET.

GET /./cgi-bin/./phf HTTP/1.1 [which equates to GET /cgi-bin/phf]

Host: www.TargetSite.com

N F A= ZDIE K 78

FRCIE ZAF IvIR—Carv T o VOE R SN 285 A— K55 H B ENTE
Fd. INBDNRITA—RIEIHE R ER FLLBIRMT b L& i H sn.
WO EWNET,

/anypage.php?attack=paramhiding&evasion=blackhat&success...

COTF A BERIFF ()1 hi <R O IF & N BT A Rk LTH R T . 1272
L NIA=RA P r—REMHH LT, Sl § 27 —REYRAITEET,
feeZE N 77 IEIR D Ay —Y #Web ProxylZis 5 L 7.

GET /index.htm%3fparam=/../cgi -bin/test.cgi

Web Proxyid Ik D Xyt — 49— \IZiEE LET.

GET /index.htm?param=/../cgi -bin/test.cgi

HTTPJE 2\ D&% 9
HTTPZE SRk O i I ICE R SN TWHLW E T,
Method<space>URI<space>HTTP/Version<CR><LF>
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1272 WebH— N2 & 5Tl IR D & A2 AR—ZDR b N2 &7 F 58 QB R 2%
AN B ERDNET .

Method<tab>URI<tab>HTTP/Version<CR><LF>

MET2EL DO ELTAR—RAEBOD avF—3 > bOM )4 AN A THL 2741
AL BERDOIEF R LET .

£ LWURL

SO IR BRI T I SR 2T 70l SLT g &R SO4 7 v M Y] D50
LFBENWDAER T 27 1A A& R LT ET . Web Proxyld 23R O H 102
DXL &N L ZROBERE T 207> 2. 7OV E-TIHlH A S 5
TYV7DIM R LI L &7

F2EZUE N 7 STHIEIR D A vk — #Web Proxy (23615 L £7,

GET http://zero.webappsecurity.com/ HTTP/1.1

Web Proxyld . X D Ayt — &4 —/NZiEfE LT,

GET /YPVIFAHD[hundreds of characters]NIWCIBXZPXMP/../ HTTP/1.1

Host: zero.webappsecurity.com

DOS/Win7 1L 7 kUi 3L

FF € DF 4 (Icgi-bin/some.cgiz &) #4% H L & D& 7 2Windows X— 2D 7 1)L K& . A
Svv 2% 5 B &R 2128 A (/cgi-bin\some.cgiZt &), 72 & S 20 BE b 0 &
7, Windows X—ADWeb+—/3Tld. 7 4L 7 b IE 2 2L &I A5y 25
LT L ET, LI oT, COREFERGA R TT. 2220, HTTPL—Tld. URI
DBV DL FBATyy 2 TH L ERHVET .

NULL #Y v ROAL 3

COFTE Tk AV vy FOHE 1% (CURLT > 32— FONULL S 7 #54F N\ &1 ¥ 9 (GET%00
e E)e SHLER T LT FHEAE A LL &7 27 00 K IR FE S TH 0,
N ASDOLFH FA7IVENULL L F 2 H LT FH O b ER LEd . COKRBE
DTN 2 & NULLSC 2 O Hi 12 & 0, 7734 RUE Ay — DR VO 7y 516 25 C &
BANET.

R 7 &N DX

SO RILF N LF A S 3370 2R T 2701 K&l it 3 2 & i
RErsnTuwEY,

Fz 208 T ITH IR D Avt— #Web ProxyZi& {5 L& 7.

GET http://zero.webappsecurity.com/cgi-bin/some.cgi HTTP/1.1

Web Proxyld . X D Ayt — &4 — N6 LET

GET /CGI-BIN/SOME.CGI HTTP/1.1

Host: zero.webappsecurity.com
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AR E D Ay N7 — TR EE

Za¥ B —"TAHy 77— 7nL.|:xE7\’7“ ‘E@i S WebProxy%ﬁ'%@ ﬁ\“/]‘?"?%ﬁ
(Network Authentication)] %7 T & T& & @“

N /I“7"7nu nﬁ}énﬁﬁj—%

1. By bv—288EE 2K %) 3(Enable Network Authentication)] %% L £

2. REE £17(Authentication Type)] YA b S5 HE XA 7 %18 L &4, fd FI 1] fE % K
A7ERDEBENTT,

« ADFS CBT

H & (Automatic)

# & (Basic)

£4Y A MDigest)
Kerberos

23— MNegotiate)
NT LAN Manager (NTLM)

3. B—¥4(Username)] & v7Ac2—4#ID%#AN f1 L. PSA7—F(Password)] + v7 2
2= DNRAT—REN S LET,

Web~ 7 o DAE K

Web Macro Recorder £ 72(dWeb Proxy #fi HH L T, v—2/7mn—~/nffcidn/fr~/o%
EC& &7,

v—s7a—~/snld. 77Vr—y s OFEE DH T Iy AE A TR b & F
& 4. ik, Micro Focus 2% ¥+ 2DV 7~AO &1/ ] + 2URL %15 € L £
T /A AEREST DBV TEETH AX I T T NVr—y avhb6nl/ 77 b 328%
Bi <oy w2l & & &€ A. Web Proxy T v7 F vt fc vy av &Ml 922 &4, Burp
Proxy 7 74 LDt v k12 HTTP 7— 44 7(HAR) 7 7 L (8 il T 24T & 4

nZA4>y~vrold . Web 74— LR EF I &, AF v 77 Vr—y 2 iZnl/ A > C&5&
NLETe AFAvFER SCT 7 Vr— 2ombnl 77 e 30%f {ay vwiH AN &
YTC&Ed,

Burp Proxy & 72idHAR 7 71 )L D1 A

Burp Proxy 7 7 v Dt v s & 12IdHTTP 7— 44 7(HAR) 7 71 )Wy 67— 2 70—~ 7 a 21E i,
ERCIES
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—

P 71 v(File)]> B {Open)] #7VUvs7L 7.
EHE OWindows D B {J XA 70l R w7 AH & &7 .
2. Fay7’ X7 YA RNC. Burp proxy (*.*)] £/-i& HarZ 71 v(*.har)(Har File (*.har))]
FERLET.
3. Burp Proxy &7z(& Har 7 7AW B L CBH & £ 4.
Web Proxy Tt v av g /R S &7,
4. THRR snf-v vy avn60OWeb~ 7o0DfE K" T JWCHE A £7.

BN Sh 72k v 3 50OWeb < 7 oD J§
Web Proxy T& 7~ &72ld ¥ v7 F va&nfzt vy o % ] L TWeb~ 70 %1E il 4 21214

1. BRI O CF zyr~v—0%f 0T, w70l 02wy 582N LT,

2. P r(File)] x=2—%7Vy2LC. Web~vZ7udfE g (Create Web Macro)] %#i%
LEd,

Web~ 7 oDfE 1 (Create Web Macro)] X4 7 a2 R v/ A%k & &7,

3. (7> =) Web~ 27 oDfE 1l (Create Web Macro)] X4 7 aZ R v/ AT, BZ 77 +D
F zv2 %% %129 3(Enable Check for Logout)] #i# R L. 2—# A/ 77y 2&
& i ol ALz ua— A Ri#E SN ZURLAND 7 7 A2 E K § % £&I2,
;~/<@HTTPFB’§~ TRAETAHEDOTFA MG 7L—X 535 ¢ 2 E R EAN
LEd.

B8 DORAF v s, AF v FlE F—LAR—Y THA FOWeb#E R £ L 5.
A DV —=ZAND V> 75k S 3 & (8 H Id<AHREF> HTML &2 {1 ). %
DURLICFE &) L CEF Al 25517 LET . 07 77 MR—UAD V> 751 8B & (&1
—E DB LI — oA T vEE BRI 0l 77 M LG &),
AT MRl AL TR OWERH TELGIBIND VY —RZAF vFIE T 7L AT
& NET. COTHvhal 77 MFRAE LGS . A v Hid 22— O AE 2
LICHE /A TE2LERHVET. COT7 0L Rk 0l A R B8 Tt % <& of-
CEILAF v R ENER T CEBDEIM A>T ET,

—WOTTVr—y 2Tl 2—F (R R b DIy ho—v %Yy L)y
77 hLIdG A — Nk Have aniceday ] % EDJE A D Ayt—Y 2K R LET.
CDTL—REH—"0al 77 MEZ ELTIRE T84 AF v FRIEE Avk—UH
P 20D T7L—R 5B LET, COTL—AMHE SN 2E. AF v H i 22—
G ENAT— R CHTTPE R 255 LTHE o/ (v 2l A &7,

777 NIzl eERF v M TEBH DRI ELTE NAT— N TR Sz
URLIZAF vF BT 72 A% & 2DWK LT —35F 8 DG & Avbe—v %5
TG ENHVET. I2E21E . y— B A7 —%Z 2— T 302 Object moved | TJis
BESBGENDNET. COILE PSR TRNENE 2 AF v+ BDEMKK R LT
WAGE . OBl SAEal T NIl 5B L. u/ A VIREE 5L C& £
ER

FOB LT, 2= 77U —y avmenl 77 b4 2B T Have a nice day | &
ED Aye—Y M —3m61R Sh 235 A 1k IE#H R I &L CMHave\sa\snice\sday ] A
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HLEFT(EBR R CTEAXN—2&48 2 § 27zowcNs) 2ME ] st &9). & Ol gEHE 2
= O 3302 A7 — XA 3— &R L. BT LOURLAZ I 328,64 T9. 2O
% 4+ T[STATUSCODE]302 AND [ALL]http://login.myco.com/config/mail? | %5 —
M HERRBEO7L—R a2 et b 0&+. EHRBHOERICHE §25E> MO
WTIE TE R R B O R" IR DX—,

4. 7oL HET 21 0 TR (Save Macro As)] R v 7 RN AET AV ENTT T 5
. BB (Browse)] # 27V v/ L THERE D 7 7/ WIRIR KA Tl K v A%E & 771
HERELET .

5. OK]z7Vy7L &9,

254 7> NaF B &

Web Proxyzs\Web+—/32s 551 B 3 DEL K %52 (FHL 7235 6« AL B & OFF € 23K » 251
7al Ry AR IR SN ET IR, 707 SAGERINNE £ — BN | TF vy 2l &
To LIzthoTy 201 7 E OH—/Nzxt LR OFE B & 2148 4 335 & 1& .« Web Proxy
EIE L THOEREI L. Fyvr 22207 T 2L ERDHVET.

1AL R B

EM B DSR2 KR A F =7 Y A LUER Sh &9, IROF 2. 2h
SO FD—H &/~ Ly 2O B 2B 25 Lad. R T2 DS &L T
'Regular Expression Library | 3% D &3

] B 245 ik 5 &7 SEE T oL TIE B EZ B ORI oX—v 1 2B L TK
1280,

XF B
\ WO F 5w L F L T~v—2LF T G SCFInjie—s Lid.
=7 AN/l AT L F L&,
A AN &7 OREC—H L ET,

NF AL T2 BEXTF 2R K LET. L2
content7 4L 7 kYN ®/content/en $ & Uf/content/ca #F% <4 X T %%
4h 3 2121« /content/[*(en|ca)].* *#fE H L& 3. \S\D\WLS | LT

&,

$ AN EREITOREBC—HLET,

* Fet7 4+ F D0 LL EORIE &~ L&d. /z0*1kTz) £4Tzoo] &
;L&Y

+ HAT T2 FO1IE L OB & LFT. /zo+dTzoo io—F L
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X F . B
FeA Mz — M LER A,

? AT T3 FO0R £ 1R OHE R &—3 L 4. /a?ve?/L
never]Dlve Jic—F L £,

AT X F 2R EB DI FIC—H L &7,

[xyz] LF Ay b FEYLH OB D13 Fic— 5 L &9, /[abc)/id plain] @
fajiz—#8 L7,
\b AR—R EORGER L ic—3 L £7 . /ea*r\b/id . Tnever early] ®
ferjic—#& L&7.
\B JEHGERE T C— L &9, lea*r\B/id Tnever early ] O Dl ear] &—
HLET,
\d 120 71— LEd.[0-9]&[ LTY.
\D HE LA D1 F e — B L &7, [*0-9] &R LT
\f MAR—=Y LTI L&Y,
\n BAT XL F B LET,
\r FrUyP Y=V FIC—F L&,
\s AR—R, BT\ A=Y EOF HIC—F L FJ . [\An\nt\v] &[F CT
ER
\S FHXTFUADOL F I L E&d. [*WMn\ntw] &F CTds,
\w TYR—=RAAT7 %% CAEE OBREE XL FI1c— 8 L &7, [A-Za-z0-9_] &[F
CT9d,
\W EEOIFERELFIC—HLET. ["A-Za-2z0-9_]&E LT,

IE F 3% B O ok

18 OIF #5138 TR AE S 1okt 4 235 58 #5Micro Focus DT> ¥ =712 & VB 5 8 L UNE I an
TOET IEHREBHRAMERT25 853 RO EEE T #FH &4,

Micro Focus Fortify Weblnspect (22.2.0) N—352/379



VIV HA R
% 21: Web Proxy

IE R %7

[HEADERS]
[COOKIES]
[STATUSLINE]
[STATUSCODE]
[STATUSDESCRIPTION]
[ALL]

[BODY]
[SETCOOKIES]
[METHOD]
[REQUESTLINE]
[VERSION]
[POSTDATA]
[URI]

MR B A 7

 AND

OR
NOT

[]
()

1

o QAT —RAMTILAT—RAI— 2001 H53F EN TE D, HO(b) Ay —Y KL DEIHIZ
MNogged out] & FREF) 038 FN TH AL L 1 H 77212 IRDIER K H 2 H L %

T

[STATUSCODE]200 AND [BODY]logged\sout

o BR SNV —AN— K FIH OURI (VRA L 7 NIAFAE T 32 E%R LTE D DG
B DEIHZ/ARTLogin.aspl NDZ HE & 1 2)0E 1 H 32121 IRDIEHL R B

Micro Focus Fortify Weblnspect (22.2.0)
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[STATUSCODE]302 AND [ALL]Login.asp
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o (@Q)AT—&Aa—F%31200]. »Dllogged out] £7-i4 session expired] &u» & ) HA
L DEIHIE FN TS, 12l (D) AT —XRAI— K302 DI ZF D ETHIZ/AR
[/Login.aspl NDZ B NE 4N THAGEZEDWT N4 21k IROIEH EH %
fERHL&d,

([STATUSCODE]200 AND [BODY]logged\sout OR [BODY]session\sexpired ) OR (
[STATUSCODE]302

AND [ALL]Login.asp )

FBE 145 IR £ 723 TR CIIE I OFT 12 12 AX—Z(ASCII 32) 55 » 2L B R D VET. 79
Lawe IR oCIER KRB O— I &R e s £

o UXAL 7 hLocation\ v&XD & ZH izl login.aspx] HFL 1L 3 VKA L 7 M & #4594 21
E IRDIER R AFHLET,

[STATUSCODE]302 AND [HEADERS]Location:\slogin.aspx

o A7 —A&Z1T MReason-Phraseiil (24 & DO 7 %1 ([ Please Authenticate ] % £)h % &
BPIGE AR T3 IROER B EH LET.

[STATUSDESCRIPTION]Please\sAuthenticate

754 DT B 5% E

Web Proxy V—iL/\—® PS4 DAL 8 (Launch Browser)] = % 7 )y 7 L T tWeb7' 774
FEB) LR WG S E. Web Proxy 22—+ 4 X7 —ADHE T 509 B C& &4, 12
U 777907 ax i 217 W EHLAHVET . AR 2FIHICOWTE, 777D~
a7 WEZR L TS0,
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WebH—E R (2= Tl 2 077 0r—y 2 8BEE L BROER S ZE 4270
7 S5LTY . 1 A EDWebH—E R4 . SOAP (Simple Object Access Protocol) 214 J L
T.WebH—bREMERER 2B UG L2254 7> MWeb 77 V47— 3o EDfH TXMLT —
RaiFfE LET. WebX—Y DFE IR 715 DA i B 97 ZHTML &id 52 4 0. XMLIFE i &
NIT—REH P L. G CkoD7L—L0— 0% LEd. 75147 N\Web7 7 V75— 3
ViELIR SN T —REEE TR L. 2O R AT F2—F IR R CT&ET.

WebH—CRIZT7 72 AT 3277147 N\Web77'Vr— aid . WSDL (Web Services
Definition Language) N = 4> b 52 (FHL O, —ERA LDIEAF ik #8 i T& £ 9. WSDL
N 2 A2 MZIE WebY—EBRIZH gn 370/ 5307 ankz7ay—y v, #h 607 oy —
Ol RS A—R BEVN IS4 T \Web 77 Vr—3 av W52 FEL 8 ME R D x4( 7
IR ST T,

Web Service Test Designer #fi ] L T. WebH—E A A x> DFEAT I IEAE 3 20 B A
b M8 # % CWeby—E A7 A MEEF 7 71 v (filename.wsd) #1E B L £ 7.

X OF IF Tl . Fortify Weblnspect® P/—)v(Tools)] x==—»>5Web Service Test
Designer {2 &) L £ 9 %3, Fortify Weblnspect® [ i X—(Start Page)] »*5 Web#—k
AR ¥ > DB 4 (Start a Web Service Scan)] ZiE R L. 70> 7 MR IR SN 2674 A+
Dt By #1%& 7 L C. Fortify Weblnspect 2 ¥ v> 7 14— K674 (7 2B <C&bTEE T

¥E: Web Service Test Designer #Fortify Weblnspect 2 ¥ +> 7 44— Fhs 52 B 3 235
A WSDLA E25% € S Tuha v &, 7 A+ H I CWSDLE A > A — kL. &
RIA=T B BE 1 %F] 025 T, §XCOBAE IO L& 3. Jhid, Fortify
Weblnspect® [/—)(Tools)] A=a—&/cid £ F 27 4V —vF v sy —L &L d L
I a EFEELEEA

1. P—(Tools)]> Web Service Test Designer] #iE R L £ 7.
2. BEIKA Tl Ky AT IROOBTN»#IERLET .
o ¥rLuuWebs—EZ7 2 NNew Web Service Test)]-#1 L\ >"WebH—EAT A %

BErL&d.
o« Web#—ERX7 2 2B {Open Web Service Test)]-LL 5 (21F il L7zi% &1 %40
LEd,

ROFM TR EER T 25 G 2B E LTnET,
3. WOWETN»EFEITLET.
« WSDL®DA > #— MImport WSDL)] # v2 2 ¢, WSDL+ 1 FOURL(7z &2
http://www.webservicex.net/stockquote.asmx?WSDL 7 £) &\ 77 7213 4R L.
WSDL®D 1 > #— NIimport WSDL)¥!1 # 7 yv s L 25

* WSDL®D% Hg (Browse for WSDL)] = % 2 )y 2 L. LLRT c o— i 47 L7z
WSDL 7 7/ W &R L £ 7
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DA RE L A el 7 e o — 88 H CSOAPEL K 1T I E 03D

L& E. FEHizonT, M

5E (Settings)" X—v 3671 25 IR LT E &0,

Fre T 74V bTIE B D4 —b Z(Other Services)]| E /8 S a2 & biEm LK
&, COBERE & —ERABWSDLIZBIE AT s Tz W& —ERAEFEH) T
BN T 270 S 3. B COLTE T"FH 10 L 20— RDIE " X—

3611 %% I

LTEE0, COTEH O D F v r~—2%0b LT

AR — SN I-WSDLD A A—Y
R DA A—2 1 . Web Service Test DesignertD A > — S 7:WSDL %7~ LT &

ER

&8 Web Service Test Designer
File Edit View Help

Web Services

= [ http:z//www.webservicex.net/stockquote
= & [ StockQuote

= ; [#] stockQuoteScap
“2 [¥] GetQuote
= .4 [¥] StockQuoteSoap12
“2 [#] GetQuote
]5 [&] other services

< >

Test Results

# Run Selected| | [ Stop| | 5 Clear

Lij Run All

0 _‘r d 3 4 || # | Import wsDL: | http://www.webservicex.net/stockquote.asmx?WSsDL

= 0| wsdl

WSDL Overview

WSDL URL:http:/ /wwew.wiebservicex.net/stockquote.asmx?WSDL

£?xml version="1.8" encoding="utf-8"?>
<wsdl:definiticns xmlns:soap="http://schemas.xmlscap.org/wsdl/soap/"
*mlns:tm="http://microsoft.com/wsdl/mime/textMatching/"
®¥mlns:sospenc="http://schemas.xmlsocap.org/soap/encoding/"
*mlns:mime="http://schemas.xmlsoap.org/wsdl/mime/" xmlns:tns="http://
wew . webserviceX .NET/™ xmlns:s="http://www.w3.org/20@1/XMLSchema™
¥mlns:soapl2="http://schemas.xmlsoap.org/wsdl/soapl2/" xmlns:http="http://
schemas.xmlsoap.org/uwsdl/http/" targetMamespace="htip://
W . webserviceX NET/" xmlns:wsdl="http://schemas.xmlsoap.org/wsdl/">
{wsdl:types>
<s:schema elementFormbefzult="qualified™ targstMamespace="http://
Wl . webserviceX . NET/">
<s:element name="GetQuote">
{5icomplexType:
<siseguencer
<s:element minOccurs="8" maxOccurs="1" name="symbol"
type="s:string” />
</s15equence’
</s:complexType>
</s:element>
<s:element name="GetQuoteResponse">
<{s:complexType>
{siseguence’
<s:element minOccurs="8" maxOccurs="1" name="GetQuoteResult"

FE .

]

=L

ottt

tl

Result Web Service Port Url

Service Port Operation Error Message

Qutput Test Results

4. K ORA>TH—EA TV AR— bR T 2 &, L0 OXA R — MERHPE IR S
NETo A= MI. AV FDT7 FLAZIRE TEET YD FRA MEER L E
4, WSDLODOEE IR iCSOAPNA—Y 3211 8N—2 o120 57 3& N 256 . 8L
M 77 Ot ik OFAE M C a8 . L eDNN—2 s d [/ — ER 2 . A—Y 22110
P—ERPPUIBRE SN ET. T ON— v 28 5 25 51015, N\—Y 21204
YEDF 9 oh v A% F LTI &,
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E:SOAPN—Y 32120 [R— l\@i‘%%(Port Overview)] /S 3 uiZid s HTTPA &
WSOAPT 7y s #E BB IN A7 av Vg N TH Ed,

Port URL: http://www.webservicex.net/stockguote.asmx

[ 1Include SOAP Action in HTTP Header

SOAPH: 1 TIESOAPR—Y 221 20SOAP 7 73 3o 34 7'y av & S T 925,
T—XT77F ¥l EoTE INBULEDIGE bR UTA LN ZWIGHE 8 HVET. FFE
DEBEE 120 LTy SOAP 1234 > F 4> 7 DSOAP 7 73 2o 55 28 4 3 20 %1%
IRNT&ET.SOAP12R— DG DA F IRy I ANE IR SN E T 7 74V DK
E Ztrue Td,

ER! RPCya—FDH—EATEFTH DR ENPVE TS, REF—74—ILEK
(Schema Fields)] 474+ 7 74V FDSOAP A ¥ —~< &l i LT\ J1 & &4 . B
FF 70Xy F 7 F o 6H ) DSOAP Ayt —Y 2IM3 L. 2D Avb—Y %

KML] X7l OFF 0 2( £ 7208 R 7E LI Ave—S & 77 A Lin oA v R — b 2) &
WCEEd. 20% . BEfESend)] 27V v/ L THEETANCE LT
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HY—BR FFVAR—NHE—MER DA A—

DA A—DIE BN LI bV AE— R NDE—MER ZR LT ET,

&8 web Service Test Designer,

File Edit View Help

|_] ﬁ B b 4 || ® | Import wsDL: Lhttp:f’fwww.webser\aicex.net.l'stoc:kquote.asmx?WSDL

CE R pp—

Port Overview

ﬁ +f feivew.websarvicex. netfstockquote. asmx?V) Port Name:

= @ [¥] StockQuate Port Soap Version: Soapil

StockQuoteSoap

=] -& B StockQuoteSoap

| http://www.webservicex.net/stockgquote. asmx |

%z [v] GetQuote Port URL:
= .4 [¥] stockQuoteSoapiz
2 [ Getquote O ws Security

S [&] other services

Service Details:l"'t"Eb Service

Ws-Security | ws Addressing |

ad- W) B X

# | Type

| Marne

< i | >

Test Results

aRun All | Run Selected | Stop . Clear

Result Web Service Port Url Service Part

Operaticn

Error Message

Output| Test Results

5. ¥ 2070 E LG A
a. WS Security] #iER L £9,

b. p—EADF A (Service Details)] VA b4 7y av #IEIR LT
c. WELBIRENSNLET. ¥ 297 %€ DFfAl ICDOWTE T"WSH F 27 1

N—o369] #Z B L TS0,

6. HIEE7VvIT 2L BERDAF—(HMOXA>DEF7) UG E (T 70 )RR &

nxd.
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FHRIBE AF—vDA( A—
IKDA A—DIE BN LIZERDAF—v 2R LT ET,

B Web Service Test Designer |;||§”z|

File Edit View Help

D il by @ | ® | mport wspL: L http://www.webservicex.net/stockguote. asmx?WSDL Jv L iiE=
Web Services * 1| |Reguest - Operation: GetQuote

. °Send 4 Import | # Export| @ Auto Value

% [¥] hitp:/fenww.webservicex.net/stockquote.asmx?V| || Soap .ﬂw:tion:| |
= @ [ StockQuate
[S StockQuoteSoap

L |Schema Walue -
* - — ]
Gﬂw 5 Envelope

=l StockQuoteSoapl2 ;

%z GetQuote EJ H:eader [ 4 |
% Other Services B Ly (array) &
(=) Body E
[} GetQuote

P - i %

Schema Fields | XML |

Response - Operation: GetQuote

Schema Yalue
EJ Header
B a0y (array) o
[}{Body
E}- GetQuoteResponse
i|[T] GetQuoteResult

) |

Schema Fields | ML |

Test Results

L;—jRun All | Run Selected ] Stop , Clear

Result ‘Web Service Port Url Sarvice Port Operation Error Message

Qutput Test Results

7. HAEOEEN ST LET. ZOB Tk 2—4HMFGP (Micro FocusONYSE + > L) &
ANSL&Lrz,

¥: BEE)E(Auto Value)] 27Uy 03 2&. 7H A FI1C & >TEAE (E 2% 024 T5H
NEd. COEEFERDNTNNTT,

* GlobalValuesDefault.xpr 7 71 )L 5 SHLF 4L B( 2D 7 74 ) /8 T A— KD Hif (2
—HF BT PUBE EN TR E). sEAHIC DL TS ["Global Values
Editor" X—362] #Z Hf L T 23w,

o T—RAATWEEDNT, THAF W E-oTER SN B, ZOHI TlE THAFIC Lo
T/8Z x—&l'symbol | (2 Tsymbol1 1 23N 7] St £ 9

A DWLTE S T E)E Off " X—23631 % LT 280,
8. P:f5(Send)]® x2VvsLiT.
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SR E TEHOBERA VR RSN ET WY 627520y T
XMLE2—%Y] 0 2 32EMT&ET .

ER OEE DA A—Y

WDA A=V IEE SNTEERDOTFAMERERLTHET.

B Web Service Test Designer,

AF—vbEa1—¢

8[(=1E9

File Edit View Help
T_1 ,__E; H b 4 || &  Import WSDL: L http://www.webservicex.net/stockquote. asmx?WSDL ] - m s
Web Services * [ Reguest - Operation: GetQuots -
- o Senci: 4+ Import ]. Export i Auto Value
5 hittpe/fwww.webservicex. net/stockguote.asmx?V| | | Soap N:tion:| |
= @ [¥] StockQuate
= .5 ] StockQuateSoap |Schema | Yalue |
* SEILILY |=} Envelope
a2 48 StockQuoteSoapl2 X >
s GetQuate .j H:eade.r
& [7] Other Services o Bany (amay) +
(=) Body
[} GetQuote
schema Fields | XML |
Response - Operation: GetQuote =
Schema Yalue
|=HEnvelope
El{Header
Any (array) +
[=){Body
.j GetQuoteResponse
LT GetQuoteResult <5StockQuotes><Stock>< Symbol=MFGP </Symbol=
hd > Schema Fislds | HML |
Test Results * 0 X
,'_j Run All | J# Run Selected | Stop '—iclear
Result ‘Web Service Port Urd Sarvice Port Operation Error Message
ld\u’alid http:/fwoww.websarvicex. net{stockquote.asmx StockQuots StockQuoteSo  GetQuote
Qutput Test Results

9. HHAF M 5] V4 TTF A MG A (ZOH TE1DDERAE Lo ST ERAD)
KD ENLET
a. P71 (File)]> tRf(Save)l 27 Vv/L &,

b. FEHED 77 IIER KA 7l K v7 2% H LT, Web¥—E R it 7 71 )L (.wsd) D
G EH T IR L &7,

VE: WSDLICHE 21 OFRA/E 35 SN TL 3G & AE L F 2y o~—200F 1 e T B0
EMNIE e & B EAE DT —80MEAE SN &9, Fxyo~—2l% B ICHE 238 75 12
R SNBEERTWBEET A
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FH#ic L 2H—E2DIE M

WSDL A ff 1 1 Tur/e WWebH—ERBFEIE T 25 & Hd D& d .

}- £71& . Fortify Weblnspect Recommendations € 2—)Lid A% v> 2B 8 L. MUK L7z
AF o> DF P &I T e b wn . BE . ElE 7/~ VERE LEd. Web+s A MDA
F v ICSOAPEL R £ H 2L, ZDH A FOWebHy—EARF v> &4 24 AHfER L

T. Z0HM TWebﬁ-‘thZ Nk BT 7 71 v (filename.wsd) EAE B L 3. WSDL 7 71 11
ME C&25 6 LU C&avwganbnis.

WOBNR T L. H—ECREFF ER TE£T.

1. 7741V bD B D+—E Z(Other Services)] +—tA%4 7Uv/L. Br—EADE
1N (Add Service)] #iR L 7.

fr Luyyr—EZ1(New Service 1)] 23/ ] DX A > OWebH—ERY V—IZFR /N S &
?—

2. BAEPDE B E . WSt’ﬂF:.'}fff(WS Security)] FER L DELEKIERE
AN L&ES.

3. P Luypr—EA1(New Service 1)] 41 7Vv2L. [— +DE N (Add Port)] iR L
9. . BOAP 1.1] £72i& BOAP 1.2 Dt h#iZiR L &7,

WebH—E 2y U—iZ B LLyR— M (New Port 1)] & /R &1L £ 6.
4. [—NURL(Port URL)] £ vZRiz. +—EADIE LOWURLEAN /) L£T.
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5 FrlLuA—r(NewPort )] &4 7)v7L. #4E DiBJ1(Add Operation)] £iE 47 L
9,

&8 Web Service Test Designer |Z”E|rg|
File Edit Wiew Help

0 |y @) & 1mport wspL: L Other Services I 'J & &
Web Senices v [ || Request - Operation: New Operation 1 -
x E 0 Send 4 Import & Export & Auto Value
= g Other Services Soap .ﬁvction:| http://tempuri.org/Mew Operation 1 |

= & [ New Service 1
= -4 [#] New Port 1
v New Operation 1

| Schema |

: Schema Fislds | KML |

Response - Operation: New Operation 1 -

Schema

schema Fields | XML |

|output|Test Results|

F:—ERZ . A— M. B EL ZEE T2 LT 2X7 02y oL &
9o

6. SOAPT>RO—7 % & L 771 > h— T 208 Z 5 Web Proxyy—iv 2 L ¢
E15). B 3¢ 2ol 15 L7zSOAP =>Rp—7"% KML] &7 ae—L Tl 0ffir 32
MTEET,
7'aF X T F bR — T 2545 SOAP T 7 SEHTTPA YR H N E T
(Soapaction=<action_name>).

7. BE G LT, RE—7Z4—V F(Schema Fields)] #7°%7:1& KML] 27" &4 fi LT
A LEd.

8. +—LR&T AT AIE. BEfE(Send)] £/:1&3 BRTEAF(RunAll)] DLFinng s
VoL &7

Global Values Editor

BHE ﬁiﬁ“é*ﬁéﬁﬂﬂ@%FJIJ/TE/\7)<—‘§ZOD7477U%1’EE§Z’C%§$T WSDL 7 71 L %A

A= LR B E O 5 (Set Auto Values)] 8 %4929 5 E. Web Service Test
Designer (&« WSDLEE{E (25 1 2/35 A= RDLHI 27 0—/UE 7 7A VTR L& T,
— T 2L AR OB & B AT U SN IAE BT AV 58T A=K T 4L RICHEA &
nEd,
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Ja—/UE FIB N9 5121

1. R4 (Edit)]> Global Values Editor] # 27 Vv7 L £ .
Global Values Editor#3f &. GlobalValuesDefault.xpr & 5% 85 O 7 7 4)L ~Oxml s <
A—RL PR MUXpr) 7 7AWV DN E BRI S ET .
2. BinAdd)]&£2Vy2L &7,
I & D, 7 740 M [Name] &7 7 4L Ml [Value]lD T ~UZME i S & ¢
3. T NIDMEE DG #2097 T 740 MEEPBE DL T CE TE &R 2 7,
AT v72-3%%E VR LTV IBIM O bUBER L 7,
5. MOWETNhEEITLET.
e OK1%227UysL T, 77/ IWERA LT LET.

o BET 2 U TR (Save As)| £ 2y LT Bl D774 121335 BT %48 ] L.
ZAWVEERR LT L&

A & 5 OfE H

NIA—=RT U E OB AFH CA NI T22E0R B HEELT. BEIMEMRE #FH L&
4. Web Service Test Designerid % /8 5 A—R%&53 1 L. —ERAEAE &3l 2wl gEtE 23b
BIEZFN LET . S & 0. KRB 2 WebH—E R 24 B KR (R 28 &4 T& &
ER

WSDL 7 71 )V %% R L1415 :
1. A= 70V H 728 IEOMOF zv /R v 2% 42 L &7

2. HEE D% E (Set Auto Values)] ® 227Uy L &7,
[7 70V M 22 F % A0D7 o—UE ICE & 2 £ 5?(Would you like the default
values to be replaced with the defined global values?) | £y I Ayt —Y NE IR Sh &
ED
Fuw(Yes)| 22Uy rd 28 FEICAN I LIE G E SN &4, £/ (FEDE/ED
INGA=REG 3T a—/ B 7 7 AV DR T A=K b~ T 28 6 k. TOE1E Tl
WA SN BE D7 74V OB EAT s TAH TH Stz on 7.
PO Z(NO)] #27Vy o3 28 BEREIGER T LET .
3. [Ew(Yes)]=7VvsL &9,

B

4. BFRTOFAMEEFT(RunAll Tests)] © %270y £5.

Web Service Test Designerid . £ #{E (N SHLfAH Lebich—ERE R #1515 L
¥4,

5. A MER(Test Results)] X7 (74> FYDO TR )& 2 )y L £

6. T7—%ik THAE VD oIy & k. ZOEREEXT VIV T E K (Request)] XA >
TH & EEFEITAILET,

ZHHH TS LFan

"Global Values Editor" gif D~X—

Micro Focus Fortify Weblnspect (22.2.0) N—363/379



V=LA AR
%1 22: Web Service Test Designer

BAEDA v R— e 7 AE— |

BAE LN 60E] Y Ton B D47 V&R LT, fh ODWebH—EZADK T 2% . <
BRI, I eDayR—4 > bl OB FEH 17 A ME Y H EXHR LIZ0T 52enTEL
To K EY 2 B OB CER L2k OFESR D & 52 XML7 71V EL TR AFE S &4

<Envelope >

<Header />

<Body>

<GetQuote >
<symbol>MFGP</symbol>
</GetQuote>

</Body>

</Envelope>

B 2R £ A R — M Bzl

1. OS> CHEFHERLET.

2. EROA>#— MImport Request)] ¥ 7 )v s L CefE #o— L.
3. EXRDxZ2KX— MExport Request)] ¥ %21y L CHIE 25 L& ¥

21 2 —

AX nf D7 A b

fEE D, FE TXNTOEIEDKR E #HDTEHTANTEET,

WSDL% A >F— LB . FRTOF R F4EFT(Run All Tests)] #2727 L £,

Run All Tests

&8 Web Service Test Designer

Import WSDL:

TP A FE R LIS N TORAE O AF £k & L 4 B aR R L&

Bl 7z A M R (Test Results)] XA > &BH A2id . A7 —KXAAN—0D R M R (Test
Results)] # 7y 7L £
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TAMER DA A=Y
K DA A= . Web Service Test DesignertD 7 A Mt R 278 LT &7,

B web Service Test Designer

File Edit View Help

J = H 3 4 | & ImportWsDL: | hitp:ffzero. webappsecurity com/CustomerAccounts/WebService. asmx?wsdl |_"J E [
\
Web Senvices » B wsdl -
= WSDL Overview
-
5, [] http:/ {zero.webappsecurity.com/Custome || ycoy URLihitps/fzeroiweb L counts/WebService.asmxdwsdl
=) Q E webSarvice
.WMUWWSDW <2xml version="1.8" encoding="utf-8-2» :'
+ ] UinkTaTestingDacumentatian <wsdligefinitions xmlns:sosp="http://schemas.unlscop.org/wsdl/soap/ " xalns:tm="http:// ®
*; [& UstTestAccounts microsoft. com/wsdl/mime/textMatching/" xalns:scapenc="nttp://schemas . xalsoap.org/soap/ =
3 [4] 1svalidCustomer 5§ encoding/™ xmlns:mimes"http://schemds . xals00p . or g/widl/aime/ " xalns:tns="http://www.hp.com/ 7
i [¥] GetCustomerAccounts asc/zerows” xmlns:se"http:/ /wee.w3.org/ 2001/ XMLSchema™ xmlns:soapl2="http:// =)
4 ClaseAccount 3§ schemas . xmlsoap.org/wsdl/soapl2/™ xmlns:http="http://schemas . xnlsoep. org/wdl/ htte/" =
> Addaccount 3 targetiamespaces"http:/ /www.hp. com/asc/zerows” onlns:wsdl="http://schesas.xmlsoap.org/wsdls/ ">
7[5 InbemalFundsTrarsfer 3§ Wsdlitypesy
AddCustomerRecord 3§ <s:5chemd elesentFormDefoulte"qualified” targetNamespaces"http://wew. hp.con/ asc/ 2erows™
H CustomerSearch ¢s:element name="LinkToTestingDocumentation™>
= .= [] wabServicescapt2 <s:complexType />
3 [ unkToTestingDocumentation «fsielement>
3 [ ustTesticcounts ¢5ielement name="LinkToTestingDocumentationResponse™>
+ [ 1svalidCustomer <s:complexType>
1+ [] GexCustomeraccounts CgiseguUencel
*3 [ Closerccount <s:element minOccurs="@" maxOccurse==1* names*LinkToTestingDocumentationResult®
7 [ Addaccount type="sistring™ /3
"2 O ntemalFundsTransfer c/sisequence>
3 [ AddCustomerfiecord <5 complexTypes
. [0 customersearch <f5:elements
W [ Other Services ¢sielement name=“ListTestAccounts=>
<s:complexType />
</s:element
A S > »

¢u:alamant AaRss™l fLrTALtAr s AunT LRATAAATA™ S

“]Run alf | b Run Selected| | 1§ Stop| | TR Clear

Result Web Service Port Ud Sarvice Port Operation Error Message -l
valid http://zero.webappsecurity.com/CustomerAcco. WebService  WebSenviceSa  LinkToTasting
valid hittp: [ zero webappsscurity.comfCustomerazes  WabService  WebSeniceSa  ListTesthcoou
Failad hittp: [/ zero.webappsecurity.com/CustomerAcco  WebService WebServiceSo  IsWalidCustorm  Server was unable to read request. -—=3> There is an ermor in the XML docur
valid hittp://zaro.webappsecurity. com{Customeracco  WebService  WebSenviceSo  GetCustomers
Failed hitp:/fzero webappsecurity. com/Customenicco. WebService  WebSenviceSo  CloseAcoount  Server was unable to read request. > Thene is an error in the XML docur
Failed hittp:/fzero.webappsacurity. com/Customerdocn WebService  WebSericeSo  AddAccount  Server was unable to read request. - There is an ermor in the XML docur
Failed hittp: [ zero. webappsecurity. comfCustomeracco  WebSenvice  WebSeniceSa  InternalFunds  Server was unbble to read request. —> There is an effor in the XML docur
Failad hittp: [/ zero.webappsecurity.com/CustomerAcco  WebService WebServiceSc  AddCustomeri  Server was unable to read request. - Thene is an emor in the XML docur
Valid hittp:{/zero.webappsscurity.com/Customerdcco  WebSenice  WebServiceSo  CustomerSear
b NotRun hitp:/fzero mummacmm WebService  WebServiceSo  LinkToTesting
b Kledlaan bt Planes 1eimbanmsss e en b ctamnaet een Wik am dea Minhfamdeate | kTl sea |
1%L 3
Output Test Rasults

- A bt B (Test Results)] XA >izid IRDIE R R R SN &7,

o R (Result)]-7 A ME R, Al EME LD BHEIGIRDEB VT,
o HEH(Valid)]: y—/ 3T 5—£/213SOAPIE E % L CEIE AR I L& LT
o [RFEAT(NotRun)]: #:/E pUR IR SH & 2 ofehN(F 20K w2 ANA Tl % ). R A1E
MIEAE SN BRTIC {5 15 (Stop)] B Koo Szt HBEAE 3515 Sh F ¥ AL

o [RF¥ T (Pending)]: EE47(Run)] & XA Sh £ L7zas, - 4E 2 £ 250645 sh Tw
Ao

o PH(Failed)]: B3R 2SI Ladrofe, — BT I5— Xy —V iR Lz, &1zl
SOAPE E N2 (5 Sh iDL FhnTd.
«  Web#—ERH£— MURL(Web Service Port URL)]-JH H (28 3 {} 1 55 Tur BURL
o fHr—EA(Service)]-JH H B ff I s T2 —ER
o [R—MPort)]-JH H B fF F s T B KR—
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» #:{E(Operation)]-18 H #°% ¥ #:1E
o [E5—Xyt—Y(Error Message)]- 7—Dx)i
b~ 2 bk F (Test Results)] Y —IL A\A—I2E  IRO R XD VES .
B ~TEAT(Run All) -7 1 Fid F o2 SN % 1 0t LTH—ERBR 3545 L
ES I

R E1T(Run Selected)]-7+ 1 F+1d. [ A Mk F (Test Results)] <A > Ci#4R L1
EAE K LT —ERER 25E LT,

& 1E(Stop)]-+—ERAE R DIEE 25 v LET,

P U7(Clear)]- [ A pah R (Test Results)] XA > 469 XTOIHH #H| & L9,

[ 2 M 5 (Test Results)] <1 > CIH H #8700 2 Voo B8, FHAF & >T RE—~
74—V N(Schema Fields)] X+ > TR I 3 24 4F 258 i K 78 S, Z2ITHK N7 A— XD
ENJITEET,

BAESBRALZ R SNIHERE A T5—DA 41—

R DA A=k RF—%74—)L N(Schema Fields)] X »ZFK R SR IF A T5—¢
TORAEER LTV ET,

B vieb Service Test Designer

File Edit View Help

| P a| E | importwsDL: | hitp://zero.webappsecurity.com/CustomerAccounts/ WebService. asmx7wsdl |- i

Wb Senvices ~ B | Request - Operation: IsValidCustomer -
eSend f Import l- Export - Auto Value

= W [ hetp:ffzero.webappsacurity.com/Customera || Soap Action:
= W [E] webservice

= .1 [#] webSarvicaSoap [ Schema value ] -
4 LinkTaTestingDocumentation F Envelepe
¢ [¥] ListTestAccounts s

- [ 1svalidcustomer 55 Ch Header L4

: [#] GetCustomeraccounts - [Bany (aray) -

+ [+] ClossAccount 3§ (=} Body

N Addaccount 3§ =} Isvalid Custamer

InternalFundsTransfer 5§ LT

- i~ name 4 v

¢ [#] addCustomerRacord 5§ L =18

¢ [#] CustomerSearch —\Lpin .
st Resilts - m—

[Z]Run all | B Run Selected| | @ Stop| 5 Clear

Rasult: WSOL Sanvice Port Operation Error Massage Ai
Valid hitp:)  WebSenice WabSanicaSoap LinkToTesting
Valid hitp:] ‘WebSendice WebSandceSoap ListTestiooom
L L Server was unable to read request. --—-> There is an error in the XML document. -— > Inpal

k) Failed hitp:! WebSendce  WebSendceSoap ClosaAccount  Sarver was unable to read request. -—> There is an error in the XML document. -—-> Input string was

b Failed http:]  WebSenace WebSenacesoap Adddccount  Server was unable to read request. —3> Thene i5 an error in the XML document. —> Input String was

£§ Fail=d hittp:!  WabSandice WabSandcaSoap InternalFunds Sarver was unable to read request. > Thena is an error in the XML dooument. ---> Input string was

k) Failad htip:/ ‘WebService  WebServiceSoap AddCustome i  Server was unable to read request. —-> There is an eror in the XML dooument. === Input string was

g Valid http:! WebService  WebSeniceSoap Customersear

b NotRun hittp:/! WebSendce  WebSeniceSoapll  LinkToTesting

I NotRun http:/ WebService  WebSendiceSoapll  ListTesthocou

b MebDiim (R P T I N |

]
OQutput| Test Rasults
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X 7€ (Settings)
Web Services DesigneriZid . IX D20 47 3 VD% & Bd D&,

o "Aybhy—r7OFI" R
o "2y hNT—IRRAE" IR DX—Y

ry hNT—r7aF

Iy hT—07ax T ERTE T B2

1.

P'o¥ 7’0771 )v(Proxy Profile)] VA b67 07 7V 218 L L9,

E# (Direct)]: 7oF o4 —_ % L&t A.

B 8% 1 (Auto Detect)]: WPAD (Web Proxy Autodiscovery)7'o b v 1§ i L
T7ud v HERE 77 AVER L Sh 2l LT7 779 OWeb7 v+ L% & £17
WEd,

P R7 47 0%y % H (Use System Proxy)]: o—/L v »m b7 ¥ o 4—/ 3
WEA v E— I LET,

PAC 7 71 )v %{# i (Use PAC File)]: PAC (Proxy Automatic Configuration) 7 7
Whe7 o i 20— RFLET. I URL] R v 2R TT7 7/ v D5 ft 248 ¢ L &
ER

BRI &7 0% 5% 2 %% F (Use Explicit Proxy Settings)]: o+ O /R )
77X 5 (Explicitly Configure Proxy)] € 73 s> I & LI #16 H L. 7'm¥ >
Y= NEN LAV E—2y MZT 72 AL ET .

Mozilla Firefox % i (Use Mozilla Firefox)]: Firefox#>67 0% » 4 — & # % A
yHR—brL X,

E: 75007 ax iR B A H T 328U TH. 7aF v —EEH OA >
K=y N7 72 AMRGE SN 20U Tld & &t A . Firefox7 774 OF Gt 7% E 03
[ToFs—3H LAV ICERE SN TVRIEES. 7o 3 H S ¥ A.

PAC 7 7 v %% Fi (Use PAC File)] #3% 4% L7-45 4 1&. URL] & v2 ZIZPAC T 71 )L

DLt &N I L&,

BRI %7 ox vk € %18 F (Use Explicit Proxy Settings)] #i# R L7215 & 1d . X

DIFRENTILET S

a.

b.

B—sX(Server)] £ vZ 27 0% v —AOURL /212 IP7 KL ZZA Jj L %50
( R— MPort)] £ vZ7Ri2)F— pE 5 (80804 &) 2N I LET.

A 7 (Type)] VA b5 5. 7' 0% 24— % OTCP F57 192 20 4 270 b
(SOCKS4. SOCKS5. &7-id ) 2R L 27,
FRRE L 25 A 1k . BREE (Authentication)] VA b6 X 7 #IER L L9,
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(¢]

H B/ (Automatic)

F:HIME 2488 758 AF v DU 28 < 0E 5. 48 LTw 35
DRRFE AV v REIRE § 2L AF w2 D AT 4= ALK L LET,

#: A (Basic)

£4 Y =X MDigest)

Kerberos

% I v x— MNegotiate)

°© NTLM (NT LAN Manager)

4, 70X H—NTRAE PN EZIGE B 22— % ERXAT—FEAN T LET.

5. B EDIP7 FL AN 7 A MA M EWT 28 A 2007 mF o H— A& 4 3
VENE WG E G Pudy e/ (/327 394 NBypass Proxy For)] & v 7 A1 7§
LAZTZGURLEA I LET. =2 NVAEX Y 256 Av~&# T H LET.

6. [Rf-(Save)]z/7VUvsL &7,

(¢]

[¢]

[¢]

[¢]

Aoy b7 — 7R L

H— \FRRE 2 4 WG AL TFEE(Method)] YA b4 Br L(None)] i 4R L &7,
INLIAN DG G FRAE T L FIRIR L. A v N — B IR AN TSI L ET . fBAE AV v R
EIRDEBNTT .

 ADFS CBT

H # (Automatic)

% & (Basic)

&4 Y =X MDigest)

Kerberos

4 ¥ x— MNegotiate)

NTLM (NT LAN Manager)

754 7 > bk i & Off A

A7V MERAERIE AN T35 2—FE 2—HL L AT7—F 2N 1 T 20T % &
ATV NMEHE AR R T3CENTEET, 0— Ly v oif Bl E 2RI+ 2288,

BEDO2— B 0 CTonialHE 2B IR T2 TEET. avEa—RIE G S
HLiH 7 78 AH— F(CAC) V=K% EDBNANT NA A 6DFE I E 28I § 22T &
T 7747 MEH & 2 H 3 212

1. Poxsy s34 7> NEBH S 25 3127 3(Enable client certificate on proxy)] 7 =v
IR I AEFNILET
2. P54 7> bk B & (Client Certificate)] 27 Vv /L £ 7.
BOAP 754 7> hal B & (Soap Client Certificate)] 7 1> N5 & £ 9.
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3. MOLTHhEETLET.
o AVE2—RZESTHE—AVTY AV E2— R EDTRXTD2—HIZE-TT n— LR
& & 4 312id. E—Av <3 >(Local Machine)] #i%4R L 3.

o IVEa2a—REDZ—FTHTY MNZEoTa—AVaiE lE A T2, RED
z2—4#(Current User)] %% L £ 4.

E: 3B 7 72 24— NCAC) V=X ll s 2a Ml & i 2—¥ 5L & TH Y,
PL1E ® =—4(Current Usen) ] (TR & S & ¥
4, WOWTFNEEITLET.
o TMENIT~A1)AEAF A TSR F IR T 2121 Fay/ Ko IR s [
A(My)] #ER L £7 .

o [ERHENTOV— NE & IR T 21014, Foyr7 &7 YR bC [L— NRoot)] i
WLET.
5. Web# 4 FCIEFCAC Y—XK % H L £3 H
e NIWIDGEHEE IRDFIE#FEAT LET .

i. B #F (Certificate)] VA bh 4. [(SmartCard) | &0 57V 747 AL o 1251 B
FHEERLET,

AR U7-RE B 2B 4 215 3R EPIN 74— A FiE B 2 55 3 (Certificate
Information)] T V7 ICR /N S £ 7,

ii. PIN»E 285 1E. PIN] 74—V FICCACOPINZA 1 L&

VE: PINAVL B 2315 4100 COBE 5 TPINAA J1 Lawb &y A% v 12PIN
DN ] %R & 5 272002 WindowsD e+ 217 4] 74> RZIZPINEA /)
TI2LERHNET,
i. FAMNTest)]z27Uv/L &Y.
ELOPINEZAN S LG & T Ave—Y R IR SN E7.
e Tz 1054 k. HEBIF (Certificate)] VX by ol Bl & #IBIR L & ¥

AR U7ak B & B 3 215 3k A §iE 9 & 1 ¥k (Certificate Information)] = V712
NN ET.

6. OK]z7Vy7L &9,

WSt F2U7r 4

WIR TS84 H— 25 H LT, Weby—ERAX— M DT XRTOEE/EWCHE § 2+«
F2UT AR E BT A ET

o WebH—tX(I"WebH—E 2D E" Ik DA— | 55 1])

» Windows Communication Foundation (WCF)+—EA(["WCF +— & A(CustomBinding)
S N—v3721 25 1K)
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e WCFH#—ERA(7x7L—y o) (T"WCFH—EA(7 27 L — 2) D E" A—v373] 4%
H”)

o WWCF+#—EA(WSHittpBinding) (I"WCF +— & A(WSHttpBinding) D&% i " \—3374]
)d"_z?z‘% Hn)

fr—EeZ5E 4l (Service Details)] VA b 81 1) 49— E AR L. TR SN FR 2N
JiLEd.

Web+#—E ZADE E

h—2Y UIFIEN 2% 2 ')74%1%9 R ASOAPE SR (IZ N\ > T 315 4 . WebH—/3E 20
BIEIEHRHAEIETH B xR L TH 6. Web—ERIZ T U”f“/a/@%ﬁ e TING
&F4.Webyr—bL2DtF 27 4}25&:%&;@:&”:\ SOAP Ayt —SI2IE 7 ¥ RVE 4
AW S 2 T 2081 T3 . SOAP Xyt —U X7 U RIVE L 528240,
BRIE P Ay — VB SN TOR W EETIER T& &7 . SOAP Xyt —Y 215 510 32
& H W O AE B LLAR S Ayt — /@V\]%‘r’éaﬁ{)@ﬁi@%ﬁczﬁ”)\Webb“*‘l:“XODJcﬂfl‘)
FAEMEIR § 2 FE TR L BT

WS-Security] &7

1) 2YF A2V EEM T2 B 200000, 2o 47 ERIR LT, B S
mr WENSILET,

e B—¥4% (UserName)] D h—ovig, 2—H4 ENAT7—REI E L 7. nonce
55 0B EDIERR AL DI — N AAT— NEIRE T2 ( FFA b
(Text)]. B L(None)]. &7zid P> 2(Hash)])DIEE « 8LV RA L AR T 55 B
BHEIMDIEE #AT ICENTEET .

« X509%E B & (X509 Certificate)] . <D b—7 1 X.5095E  F ik DT &9,
VeriSign, Inc. % EDFREE J& 2> S5 B 2 ZHE N\ 3 270, S H OFE I &F r— e R %%
ELCIE M 2RAT §52EMTEET . 1F LA EDOWindowsH—/3 4 . A B & 21E
WTEBAME ALY TIA LT T PRI I LT &5, 2044 SRAERICE L L
TEe M BERSIN TR WVIEHE AT CE T it F 2RIR L. 2R 217
(BinaryCertificateToken & 7zi& Reference) 46 € L £ ¥

» Kerberos /Kerberos2] . (WmdowsZOOSit (& XP SP1LL[% D5 & ). Kerberos~’
ZhaviE, A—72 T F VT MEE SN TR VWA YT EDa—H EHh—L A%
*Hlic;mﬁ@“%t&)u%ﬁﬁ Shgd. LAMEREZEALT 2—VVEKIERE

S eLU0EFELLLET, KerberosﬁF—‘EﬂZ‘ﬁ t+ > &—(KDC) &L 24— K/ 3—
Tm%*%r WERF LET . BALB . 2—FE A v h7—2ED1DL LD —ELX
T 72 ART 312D —ERFry MEER TEET . 77y M. 2— O S 1k &
ntmnﬁfﬁa&ﬁndfﬁi&érﬁ FNE&d. Frobd. BAED2— D& M1 W] 2 H
L THU 15 s £ 9 . Kerberos h— 7> &Kerberos2 b— 7> D %1& Wik . Kerberos2
M F 2VF 4 R— b7 B K—A > &7 2—A(SSPN) &{§i 1] 4 255 T3 . LT,
74T NG R AR T RO AE SRR L EHVEEA. SHIT.
Kerberos2t # 27 4 b—2 1k . Web 7 7— A THE AT S T AWebH—E RITIE (S
S BSOAP Ayt —Y %R 3 21D H T&E T FANENAMVEFRE L &
ER
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« BAML +—7>/(SAML Token)] . SAML (Security Assertion Markup Language)
AV E—2 v EB L TEY A AN— M —f] T, 7H—y av PN 2 F 297 1
B R 2500 4 210 OXMUERE T4, 74—y i B AT — AV MR
AE S IRTE AT —MAY M BEUMHERAT HIRE AT — AV METHBEEBNTELT,

P71 vh 60— F(Load fromfile)] #27Vy 7L C. SAMLAE H&F 2B L &3, §iL
i & (Certificate)] # 7 Vv /L C RE M E 2/ >R — L ET. B . AL E S &
A 7(X5097 —X &/zIdRSA) #1E R L £ 7.

2. Avt—VELZEEMT 2. N2s0orL . ERShEREN T LET.

v
H
o B4 +—27>/(Signing token)] . & 4 (i [ § 3 b— 2> (I8 H £ X.509 21 7). &
&Nz TO M2 D VA M SIEIR L ET,

o [E# 4 713 YX A(Canonicalization algorithm)] . [E#R 4L (il 42703 UX
LDURL. Fay7 X7 YR M — B 2 7 VT VR LR RSN EFT M 35
EAAH LG EGE T 74V D EFEZLET

o B 7T YX A(Transform algorithm)] . vt — F L@ 4+ 228 713
A LDURL, FoyZ’ X7 YR MG — I 2 7V T YR LR R ST i H 3
PEBAH LG A T 74V D FEIZLET,

e BH& A 2—ALARX—RYR MInclusive namespaces list)] . L& sh 24D L TH b
N2, #<TXY) 6Niz7L 747 AD YA NATY 32).

o B4 ¥ 213 (Whatto sign)] . & %4 9 2SOAPE % (SOAPA . XA L ARVT,
8 S U'WS-Addressing).

« KPath (4#7'v =)(XPath (optional))] . & % &2 Ayt —Y N OE 4 i€ ¢ 5
XPath. T H D X2 %&. 4 A7 3>/(Signature options)] 7 L N TIE 4R
LI-E R 038 % Sh £ 3. #: //*[local-name(.)='"Body']

o [ AA7v 2)(Token (optional))] . & % 28— v b—2> B S izd
RCD =72 DRay7 T VA MPSIEIR LET FEAEDH—EATIE, 2O 74—
WRET DZFIZTAZULERHNET .

3. Ave—VEEBEEM T 20, B 5200/l BR SAEHR AN S LET,
o [M—2>OE S 4k (Encrypting token)] . I 5 46 (A 42 ~— 2> (G H (£ X.509
RZA7)o LATWAE R LE2T RTD h—2> D VR Mol IR TE£7,

B 5 4t 21 7(Encrypting type)] - %0 J¢ B & &k 205 54k 3+ 24 20 a> 7>y
D& ST 28R LET.

§2 713 YX 4(Key algorithm)] . © v a3 ORE S 4L (2 371 T YR A
RSA15 £ /(X RSAOAEP.

k2 v 3> 7T YX h(Session algorithm)] . SOAP A vt —y D% 54k i fdi Fil 4 3
TIWT VR Lo HEE D VA b SR TEE T

KPath (47" a>)(XPath (optional))] . K5 51k § 3 Ay —Y D4y 27 §
XPath, 25 4 D & £12§ 2 & SOAPA XL 12U 235 S 4k s &9,
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e [ AA7¥ 2)(Token (optional))] . % 51k Stz h—2> DL T . B I S /e
FTXRTD b= DYA M RO YT RT YRy ACER IR SN ET . (FEAEDH—LART
N CO74—V NI DT IUNERDNET,

4. FTORET * HEALT tF 207 (EZ R 2EBREOHCKE L £,

WS-Addressing

WS-Addressing] 47 %{# il L T. 4—E A TWS-Addressing &1 ] 3 25:& 9% 8 &
THT2556E " —YaoHF5#EBELET.

WCF +— & Z(CustomBinding) D5k 7€

WCF #—E Z(CustomBinding)(Z & V. i 5 L NV D # AKX~ A XA g T3 . WCF
customBindingff ¥ (23 DL T Bfc. I A T 2 &1E A EOWCFH—ER &3z,
WS - <spec_name>tt: % i il 4 2JavaN—ADH—b AL E M DT S5y b 7r—L4 D
Y—EAETAPCEET .

[F5>A#— MTransport)] . HTTP]. HTTPS]. #7zi& AutoSecuredHTTP] #i# R L
1. LHI T & SATETCP F SV AE—MEHFA— SN TL ER A

v a—74>7(Encoding)] . [+ X NText)]. MTOM]. £7:i& WCF/ X1+ YWCF
Binary)] #1ZR L &7,

fe ¥ 297 4(Security)] - i U] Zzc YR b SFBAE E— FET— bR M Tv7 R Vo —#IER L &
£
B v be* 297 4(Net Security)] . A NU—24t* 207 4DFEHH: fx L(None)]. Windows

A bYU—24 € F 297 4(Windows stream security)] . £72l& BSLA h—L L F 27 4(SSL
stream security)] .

{5 OF v xyk&—Y 7 (Reliable Messaging)] . 15 5 1E O W xvbv—v > 7 &
¥ 212l B R (Enabled)] i L. iz JBF ® Y(Ordered)] £7zi& JEF % L(Not
Ordered)] D\ DI X ZIZIR L 5.

5515 3R (Identities) ] . /N1 > 7 1> 7 Lilk W 2 Ok 7 15 3R 232 4t L £
o p—%#4(Username)] & pSA7— N(Password)]

o« W—/35EBHF/ 254 7> it B F (Server Certificate/Client certificate)] . +— Y &7
& 754 7> bOHBAE R 384 5 25E W] & . B (Browse)] A x> & I LT, HE
i & Di% R (Select Certificate)] X1 70/ R v/ A% & & ¥,

« 73 &h 2DNS(Expected DNS)]. SPN]. & £* UPN]. DNS. SPN. #7-(3UPN
W& B, H— DT W St Ba 1 R . localhost. IP7 L A, &2k — 4 218 E T &
EQ A
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V54 7> MWindowss# 7! 1& 3R (Client Windows Identity)] . 751 7> tWindows D 3]
BIwRENTILET.
o BfE ®Dz—4(Current User)] . v i uZ 4> Lic2—H O 515 # .
o WARZL2—(CustomUser)]. 2— % NATV— PN, 8L AL V2R E L LT

FEAT R 2 (Advanced)] # 7 Vv LT, FEANER 52 (Advanced Settings)] X4 707 R v/ A
P & E T BFACOLTET" v 27 (DFEAN R " N—3761 S B LT En,

WCFH#—EA(7z7 L—3 22) D% &

WCFH—ER(7=7 L —y )il 3 235 & . 7Z4 7> bidSecurity Token Service
(STS)izx} LCRBRE 21T o b—2 2B LET. 7547 NE b—20 & LTT77Y
T—3 3N ujd- —é—%nu nIE i”/ﬂi WET,

H—N

o [FF¥AAKR—NTransport)] . FZ7> AH— bRAZHTTP £/2idHTTPS.,
e EYa—74>7(Encoding)]. Y—/ DT> a—7 4> R Y — 7F A bEIEMTOM.

¥ 2V 4
o $R:iL £ M(Authentication mode)] . 2L OF] fit % E— FD Fa vy L 7> YA b
( AnonymousForCertificate] . MutualCertificate] % &).

e P—1ARMFy7 R Y —(Bootstrap Policy)] . Secure ConversationiZ ik O g % 7— b
A NZy7 RYy—D Fay7 X7 YR N BspiNegotiated] . [UserNameOverTransport]
5 E).

nijﬁIJ T i&'
INA 2T 4> 7 ERE B O 31 R

o Pp—/ i B B (Server certificate)] . 47“—*/\0);%@ RIEH 2Rt T2 HE. BIR
(Browse)] # &> & ] L. §f ¥ & Di% R (Select Certificate)] K1 72/ * v A %5
X¥9d.

o {F#) &h 3DNS(Expected DNS)]. DNSIZ & 2. +—/3DF ] & 235 771 175 3 .
localhost. IP7 FL R, E/2ld— N\ 52488 C& 7.,

STS (Security Token Service) D& 4

« EYFRAY 7 FLA(Endpoint address)] . STSO > MK A > 7 FL X, localhost.
IP7 NL A, &lld ¥ — 4 i E C& &7

e P> F 4>Z(Binding)]. STSWH: KL T 531> F 427 4B R+ 52+ VA,

Al 3% 2 (Advanced)] #27 Vv 2 LT, FEAN X € (Advanced Settings)] X4 707 K v 2 &
B & E 9. sEA DWW TEN" v F 2 )7 (DFFAl L E" XN—3761 25 1R L T2 &0,
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WCF +— & X (WSHttpBinding) Dk

WCF - —E2(WSHittpBinding) & Fil 4 2 & 38 AL OfE M % fx L(None)]. Windows].

[ B9 & (Certificate)] . &/zid — 4% (A vt — YR )(Username (message
protection))] D A» 5 41 c &F¥. /94T |\nu AL D— B et 7y v FIER L
T IR 2L D IBIISG CTRLE 2B IR AR £0E T,

A7 NFGA—R

% L(None) .

Windows .

Br— & % 18 R # 2 7> =— b4 3(Negotiate server
credentials)] - Web—EADFE B &FH 24—/ &x T2 — L ET .
H—/SDDNSIH# &35 € § 6L TELT

fr—E A5k B 3B %48 & 4 3(Specify service certificate)] . —k
ADFEHE DG . COA7'Y av B IR LG4 . B—eRAE#K
& # £ 27> =— b 3(Negotiate service credentials)] #7'> 2
EBRHVEE A,

fF 83 &h 39—/ \DNS(Expected server DNS)] . N A>3 —L4L
AT L E B, —DT W St 58 51 1% ) - localhost. IP7 KL X,
Fld— YL 2R E T&ET. o iEHFOFEAT WM SN 3
— G T BV TEET,

k¥ 27% € vy %K %7 3(Enable secure session)] . i B
HERATRA A L a7 voy 40 LET,

3 &h 24—/338 71 1& 8 (Expected server identity)] . +—t 2
723 V4 (SPN) £ 721d 22— 7> > 73004 (UPN).. SPN %15 &
¥ % & SPN &, SPNIZ B I A} 1 6 7245 ' OWindows 7 #7772 b &
L& oTH—LRAD &N &9 . UPNZIEE § 2 & H—EL ALK E
OWindows 2—# 7 A7 bCEAT SN 28 VET . 2— T HY
YMENBRAE BT A L T0 22— 20 R D2—F T AV b
TEAIT SN TL B —EBRIZL 2HDOLFTIHMATT .

U 74 7> tNWindowsak 5l & 3R (Client Windows identity)] . 7>
7> NWindows D& 71| 1 R «
o« BfEDz2—%(CurrentUser)]. v> o/ 4> LT 32—
DEMIEREMH L £,

o WAZLa—(Custom User)] . =z—# & #& 1% $|§i(1"*7“4‘%
AT—=R, BEUFAL ) ENTT Ly BLS U TR 3% umv{ﬂ%
RLEFT(F—B2FAT Y MDAV TF A MCFEAT CEBERIENC
NTREVET) Bon LNVIGIRDEBNTT,

o [ L(None)]-L LR S £8 A

° B % (Anonymous)]-4—Nd 2547 b et LIz 0 W
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A7

ENRGER S
(Certificate)

22—
(Ave—o1fR
% )(User
Name
(Message
Protection))

NI A—R

ALz 228ETCEERAS

o {47 (Identification)] -—/\l& 754 7> bOE ) IE R S5 4
PR CEETN, /94T M2 728 TE &R A

o &% (Impersonation)]-#—/Nd . a—VY AT AL TOIA
7Y hDEF 2742V TH A MBI TELT.

o E1L(Delegation)]-#—N g YE— b AT LETIIA4 T b
DeF 271> TFAMBEETEES,

k¥ 27 %€ v> av%F F 27 3(Enable secure session)] .
WindOWSﬂ/f7nu nE ’i’ﬁﬁﬁ LIzt a7h ¥ w3 a/%an—f Lij_

U 54 7> ML B 3 (Client certificate)] . 751 7> bl B & 0
Fir. B (Browse)] t & & H LT, §iF B & DR (Select
Certificate)] X4 70/ R v/ A%h] & ¥,

Br— & % 18 R # 2 7> =— b4 3(Negotiate server
credentials)] - Web—EADFE B &F 24—/ &x T2 — L ET .
H—/ DDNSIH M &35 € § 6L TELT

fr—E A5k B 3B %48 & 4 3(Specify service certificate)] . —k
ADFEH FE DG . 2047y v RN LGS . —BKE
W # 23> x— b B(Negotiate server credentials)] # 7' a4
2T

fF ¥ &h 24—/ \DNS(Expected server DNS)] . DNSZ & 3.
H— DT i Sh 2 1 # - localhost. IP7 L A, &7zl H—
YERECEET. I AEEORAT M s 2 — 4 &7 3
ZEHLTEET S

k¥ 27% € vy %K %7 3(Enable secure session)] . i B
HERATRA A L a7 oy 40 LET,

E—¥4 . "RA7— K(Username, Password)] . 751 7> FNDi &
E A%

Br— & ¥ IE IR £ 5 7> — b 3(Negotiate server
credentials)] . Web—EZDGE & #4— /N erTyz— L ET.
+—/NODNSTE R 218 € $52L4T&ET,

pr—Ee X5k B & %45 € 7 3(Specify service certificate)] . ++—t
ADFEHE DG . COATY s £ LGS . BP—ABBE
¥R # 3 2> — ¥ 3(Negotiate server credentials)] # 7'y a4 fi
BT,

fF 81 &h 24—/ DNS(Expected server DNS)] . DNSIZ & 3.
H— DT H S 2555115 ¥ - localhost. IP7 FL A, &izld H—°
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A7 NI A—R

HERETCEET. Il AEHFORIT M S 32— 4 &9 3
EVTEET,

e Rkexa7%wyy av%F T 3(Enable secure session)] . 2 —
WY A TR LiceF 270ty 25 LET.

v Fx 2) 7 4D %
CDEATaT R YyIATIENIRDETTCTAMDELF 27 4R E 5 WARVARTCEET,

> a—7 4> 7 (Encoding)] &7
fr> a—7 1> 7 (Encoding)] 7 Wl& IR DAT'Y >3 V&7,

[ a—7 4> 7(Encoding)] . Avt— A § 3T a—7 1> 7 %47 FF AL
(Text)]. MTOM]. &7:i& WCF 31+ Y(WCF Binary)]).

WS-Addressing /3 —¥ a>(WS-Addressing version)] . i# iR Lic=>a—7 4> 7D
WS-Addressing®/i—% ([ L(None)]. WSA 1.0]. /& WSA 04/08]).

i /%442 % (Advanced Standards)] 27
[ 7 A% 4E (Advanced Standards)] X7121& IRDA 7'y >3 H DET .

{5381 OF » xyE&—Y 7 (Reliable messaging)] . WS-ReliableMessagingft: £ %
KBS 2 —CADFE DR W A=YV T ERE L ET, Ave—Y i 45T
L a—F 427 847 ¥ A MText)]« MTOM]. &7z1& WCF /A + YWCF Binary)]).

BB OF » Ayke—Y >~/ DR £ i} (Reliable messaging ordered)] . 5 #6 T & 3
oy MEF &4 T 20 E M ER LET .

BB O/ » XAyke—Y > 7 D/3—Y 5>(Reliable messaging version)] . *vt—12
1# ] & 33—y 3> WSReliableMessagingFebruary2005 & /-1
WSReliableMessaging11.

7 FL A& H TR & ¥ 3(Specify via address)] . A vt — #H1 [ H—E AL L.
ZIMBRBEDOH—/NEE SN & . N T AT X Ave— Y EELE T 215
BRVEH SN 2587503, 2Lt WCF clientVia {E i s LT &9 . Ih
&V Avb—Y NFEFRICEE SNAYH 7T RL A%, Avb—VDREFBL ORI 7 L R &
X 3l 4 23 & (R T .

7 FL A& i (Via address)] . Ayt —Y DiE(E 5 OB 7 FL A, | &8 — DY #
SR DL H 218 E C& & . SOAP Ay —Y IR D & IR R SN £,

<wsa:Action>http://myLogicalAddress<wsa:Action>

AT L AL 22— AV RT7 Al G SN 4. 7 74V b TIE. WSDLTHE & S
127 RLATY, CO74— IV FEEH LT, CO7 L A% EEETEET,
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fz % 2U7 4(Security)] X7
fz & 2 U7 1(Security)] K7WIE IR DAT'> 2> DFET .

e+ 7% € v> %K B2 3(Enable secure session)] . WS-SecureConversation
A L Tex2U7 4307 A MEME LET,

pr—ex&#% 1% 3R # % 7> =— 4 3(Negotiate service credentials)] . +—E20D+
F )T 4EATIT— T 20 WCFE ] A0y z— s> L&Y

74V b 7w 3 YX A A — MDefault algorithm suite)] . x5 #R/3E xF #8551k (2
437 V3 VR L. 7IbT YR LD YA ME . WCFDSecurityAlgorithmSuiteik & 7> 5\ 77
SN &£,

{R#& L~V (Protection level)] . SOAPA XL #1540 /F X § 200800 %€ LET.
feE A BE Ml &+ e L(None)]. &4 (Sign)]. B &0 [ 51k £& 4 (Encrypt And
Sign)](7 74V F) T,

Xvt—4% 7% D)NE Fr (Message protection order)] . & % iz S 4L DIEF . 51k
R 123 44 (Sign Before Encrypt)] . I 5 4L AT (0F 4 L. & % %15 5 1k (Sign Before
Encrypt and Encrypt Signature)] . & 4 Bl (% 5 1L (Encrypt Before Sign)] 7> 51% R L
9,

Kyte—Y v F 297 4/3—Y 3>(Message security version)] . WS-Security ¥ 27 «
W= av, e Ayve—Y DIRAE F—DPUHANEINEIRE T2 TE&ET .

k2 297 4N v&XL A 7 MSecurity header layout)] . Av—YNyXDLA 77 I

Btrict] . [ax]. L[ax Timestamp First]. £7zi& [ax Timestamp Last] .

fr—=x > bz E—%— N(Key entropy mode)] . ¥ 2V7 4F—D > hpb—%— . A]
BE Ml & o147 x> boe—(Client Entropy)]. [z 2U7 11> b E—(Security
Entropy)]. 8 &0 § & > bz E—(Combined Entropy)] T4 .

¥ 271227+ R MO F v &)L Huh B (Require security context cancellation)] -
LF2YTATAVTFAIDF ¥ VBB ENEIMER LET COF7Y 2T 3
&. WS-SecureConversationt v s> CA7— b7V £ F 27 4 =0V BE R % 5T
WA A ZD M=V MER S &7,

BA L AX7 %8 ® 3(Include timestamp)] - N\ VX XA L AR T H#F O ET

BER Y7L E 4 v—2> %3 7] T 3(Allow serialized signing token on
reply)] . IB{5 T U7 E L b0 &K T& T,

& & O R 4% B (Require signature confirmation)] . /i & T& 4 i 21515 4 3
ENH— RN L ET S

VE: IRDADDAT Y a1k X509 & 2 3+ 255 & 1cDAE ] sh 9,

K509 & £— F(X509 Inclusion Mode)] . X.509:F i & 2\ D& » 3048 L £

i 122 15 & 12 (Always to Recipient)] . [c L(Never)]. [~ (Once)]. fFicf=>
T—XiZ(Always To Initiator)] -

K509 {8 2 &1 1(X509 Reference Style)] . it HE DS R ik e L&d: I
i (Internal)] £7-1& PR3 (External)] .

K509 i3 IR 4= F—4%h B (X509 require derived keys)] . X.509:F ] & 25k 4F ¥ —%
W T 2ME I ERLET
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o K509 *—# 71 T A OFE 3 (X509 key identifier clause type)] . X.509 * —0; i 12
H sh 20 OFE 8 [E &2 (Any)]. B EI(Thumbprint)] . B&E1T & > U7 v (Issuer
Serial)]. Br7Y =z b El%ﬂJ%(Subject Key Identifier)] . H 7 —&+—3# il 7 (Raw
Data Key Identifier)] -

HTTP & 7o 3+ (HTTP & Proxy)] 47
HTTP & 7' 2 (HTTP & Proxy)] 27 2i& IRDA7 > 2> HH V& T .

{£1% £— N(Transfer mode)] . £ K /I & OZiE HiE T FRE I RE 2 fEH & Yy
7 7(Buffered)] . [R ~FU—4(Streamed)]. [R ~V—4%E 3K (Streamed Request)] . & & U

X b YU— 2 2 (Streamed Response)] T4,

B KI5 & 44 X (KB) (Max response size (KB))] . i 4% i OJ5 2 O K+ 4 X

U v%—% 1 ¢ 2(Allow cookies)] . 7 vF—%H W CT 20T 2R LET.

Br—7"7 541 7% %l (Keep-Alive enabled)] . *—7'7 51 74 &t #H 32§ 20485
W3 dhEmR LET.

#8 3L 2 *— 4(Authentication scheme)] . HTTPREGE J7ik: fx L(None)]. Ko =2
MDigest)]. B 7> =— M(Negotiate)] . NTLM]. i WindowssZ ik (Integrated
Windows Authentication)] . & A< (Basic)] . £7:(& B % (Anonymous)] -

v 4A(Realm)] . URLIE X OFERE ZF—L DLV 4

V54 7> Mt B & 4% Z (Require client certificate)] . SSL b 5> 2K — MZEE ] & %
WEL T 2 EIMERLET

714V FOWeb7 u 3 %{# F 3 3(Use default web proxy)] . v > D7 74 +D
¥ R E EH T a0 E AR LET.

P—VT7o* v %/31 /327 3(Bypass proxy on local)] . +—ExAn—aL~vy v b
CH2LEETRF L2l T E0hEIMERLET.

P'ex> 7 FL A(Proxy address)] . 7'o& > +—/3DURL.

Pox 585E A% — 4 (Proxy authentication scheme)] . 7'+ > OHTTPREE BE J5 V2

K1 =X MDigest)]» B I3 =— MNegotiate)]. NTLM]. & A (Basic)]. &7zl
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